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1 Tekla Tedds 2022 Product
Guides

Welcome to Tekla Tedds documentation!

What's new in this version?

For new features and improvements, see the Tekla Tedds 2022 release notes
(page 16).

New to Tekla Tedds?

Start your learning journey using our interactive elearning courses which
consist of tutorials that you can take in any order. Alternatively you can read
the Tekla Tedds Quick Start Guides (page 61).

Other ways to access Tekla Tedds Product Guides

PDF documentation

Offline help package

Other resources

The Tekla User Assistance services are 24/7 online support channels for fast
self-service, where you can find all the product guides, additional knowledge-
base articles and instructional videos.

The Tekla Discussion Forum is the place to meet other users and discuss
topics related to Tekla products. You can ask questions, contribute to the
community by sharing your knowledge or get answers from support
personnel.

The Tekla Helpdesks support your daily operations so that our systems
function as expected and any problems are solved as quickly as possible.
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2 Tekla Tedds 2022 release notes

Welcome to Tekla Tedds 2022!

Check the information below on the many new features and improvements in
this version.

Some features documented here were included in previous updates to Tedds
2021.

• Engineering library (All Regions) (page 16)

• Engineering library (Eurocode Design) (page 19)

• Engineering library (American Design) (page 28)

• Engineering library (British Design) (page 30)

• Engineering library (Australian Design) (page 33)

• Engineering library (Canadian Design) (page 34)

• Interoperability improvements (page 37)

• Writing custom calculations enhancements (page 37)

• General enhancements (page 39)

2.1 Engineering library (All Regions)
The following engineering library calculations (applicable to all regions) have
been significantly updated for Tedds 2022.
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Batch design
Enhanced to include a new 'Input variables file (.xml)' option. When an input
variables file is specified, each design will start using the variables from that
file and then the variables defined on the input Excel sheet will be applied.

This feature makes it easy to use an existing Tedds for Word document as the
starting point for batch designs. Using Tedds for Word you can setup the input
for your calculation, using either a calculation from the Tedds Engineering
Library or your own custom calculation. Then create the variables file by using
the Variables\Export Variables command which is available from the Tedds tab
on the ribbon in the Tools group.

Once you configure the batch designs 'Input variables file (.xml)' option to use
the file you saved then the only variables you need to define on the input
sheet are the variables you want to change for each design, all the other
inputs can be left undefined as they will already be defined via the input file.

Enhanced to include a new "Send input to Word" command for copying the
design cases to Tedds for Word. This is useful if you just want to use the batch
design to create a document with one or more designs in Tedds for Word with
predefined input but you don't want to calculate the designs from Excel.

Component calculations
Added a new folder to the Engineering Library for "Component calculations". A
component calculation encapsulates a small engineering solution which can
be easily reused by other calculations. They are typically used by calculations
in the Tedds Engineering Library and can also be integrated in your own
custom written calculations.

• Component calculation: Steel section sketch

Creates a drawing of a Steel section profile which can then be used in the
user interface or output of another calculation. Supports section types I, T,
Channel, Pipes, Hollow Rectangle, Angle, 2 Angles, 2 Angles (log leg) and 2
Angles (short leg). The drawing can be customised to include dimensions
and section properties as appropriate. The component is compatible with
the input variables for Eurocode, American, British, Australian, and
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Canadian design standards.

Other updates
Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• 2D analysis - Frame Wizard

• 2D analysis - Truss Wizard

• Bolt group analysis

• Rigid diaphragm force distribution

• Rolling load analysis
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See also

Engineering library (Eurocode Design) (page 19)

Engineering library (American Design) (page 28)

Engineering library (British Design) (page 30)

Engineering library (Australian Design) (page 33)

Engineering library (Canadian Design) (page 34)

2.2 Engineering library (Eurocode Design)
The following Eurocode design engineering library calculations have been
significantly updated for Tedds 2022.

RC raft foundation (EN1992)
New calculation which checks the ability of the elements of a raft foundation
to support various loading arrangements without exceeding the allowable
bearing pressure. The calculation also determines the quantities of
reinforcement required to support the loads whilst spanning over theoretical
circular depressions in the sub-soil which are assumed to form beneath the
raft.

In accordance with EN1992 and the national annex for the UK, Ireland,
Singapore, Malaysia, Finland, Norway, Sweden or the recommended Eurocode
values.
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Video demonstration
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RC pile cap design (EN1992/EN1997)
Enhanced to include the option to design a triangular three pile-cap which is
designed using the strut and tie model.

Video demonstration

Cross-laminated timber wall panel design (EN1995)
New calculation which determines the capacity of a vertically spanning, cross-
laminated timber wall panel subjected to a horizontal wind load applied to the
face of the panel and a series of vertical loads applied to its top edge.

The design is in accordance with EN1995 and the national annex for the UK,
Ireland, Finland, Sweden, Norway or the recommended Eurocode values.
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Video demonstration

Cross-laminated timber floor panel design (EN1995)
New calculation which determines the capacity of a horizontally spanning,
cross-laminated timber floor panel subjected to a series of vertical area loads
applied to its top edge. Floor panels may feature one or more openings and
shear, flexure, perpendicular compression and deflection checks are
performed.

The design is in accordance with EN1995 and the national annex for the UK,
Ireland, Finland, Sweden, Norway or the recommended Eurocode values.

Video demonstration
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Cross-laminated timber section design (EN1995)
Calculation which determines the longitudinal and transverse properties of a
cross-laminated timber panel section and checks its design while subject to
bending, shear, perpendicular compression and axial tension and
compression in both directions. In accordance with EN1995 and the national
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annex for the UK, Ireland, Finland, Norway, Sweden or the recommended
Eurocode values.

Video demonstration
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Cross-laminated timber section properties (EN1995)
Calculation which determines the section properties of a cross-laminated
timber panel using the extended gamma method in accordance with the
recommendations of Eurocode 5.

Video demonstration

Windpost design (EN1993)
New calculation which checks the design of a vertical steel beam acting as a
windpost providing lateral support to a masonry wall subjected to a uniformly
distributed wind load. Checks the capacity of the wall ties to distribute the
wind loads from the loaded leaf to the other leaf. In accordance with EN1993
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& EN1996 and the national annex for the UK, Ireland, Singapore, Malaysia,
Finland, Sweden, Norway or the recommended Eurocode values.

Video demonstration

Timber member design (EN1995)
Enhanced to allow built up sections to be wider than they are deep.

Component calculations
Added a new folder to the Engineering Library for "Component calculations". A
component calculation encapsulates a small engineering solution which can
be easily reused by other calculations. They are typically used by calculations
in the Tedds Engineering Library and can also be integrated in your own
custom written calculations.

• Component calculation: Steel section classification (EN1993)
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Checks the section classification of carbon steel or stainless steel sections.

Other updates
Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• Column base plate design (EN1993)

• Crane gantry girder design (EN1993)

• Foundation analysis & design (EN1992/EN1997)

• Gabion retaining wall analysis & design (EN1997)

• Masonry bearing design (EN1996)

• Masonry column design (EN1996)
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• Masonry wall panel design (EN1996)

• RC column design (EN1992)

• RC design toolkit (EN1992)

• RC corbel design (EN1992)

• RC slab design (EN1992)

• RC stair design (EN1992)

• RC pile cap design (EN1992/EN1997)

• RC wall design (EN1992)

• Retaining wall analysis & design (EN1992/EN1996/EN1997)

• Snow loading (EN1991)

• Steel beam supporting hollowcore slab design (EN1993)

• Steel beam torsion design (EN1993)

• Steel column design (EN1993)

• Steel masonry support (EN1993)

• Steel member design (EN1993)

• Steel member fire resistance design (EN1993)

• Steel sheet piling design (EN1997)

• Steel to concrete simple connection design (EN1993)

• Timber connection design (EN1995)

• Timber 2D analysis & design (EN1995)

• Timber member analysis & design (EN1995)

• Timber member design (EN1995)

• Timber frame racking loads (EN1991)

• Windpost design (EN1993)

See also

Engineering library (All Regions) (page 16)

2.3 Engineering library (American Design)
The following American design engineering library calculations have been
significantly updated for Tedds 2022
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Calculations Updated in accordance with IBC 2021
• Footing analysis & design (ACI318)

• Flagpole embedment (IBC)

• Masonry column design (TMS/MSJC)

• Masonry wall panel design (TMS/MSJC)

• Pile analysis (FHWA)

• RC pile cap design (ACI318)

• Retaining wall analysis & design (ACI318/TMS/MSJC)

• Wood ledger design (NDS)

• Wood shear wall design (NDS)

Wood member design (NDS), Wood member analysis &
design (NDS), Wood 2D analysis & design (NDS)
• Enhanced to allow built up sections to be wider than they are deep.

• Enhanced to allow for the design of flitch composite sections.
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Footing analysis & design (ACI318)
Enhanced to allow an optional pedestal to be defined for each column or wall.
The user experience has also been improved when a design is beyond scope
so that more detailed information is provided in the user interface and the
output document, results that can be calculated are also now presented for
the partial design.

Other updates
Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• Anchor bolt design (ACI318)

• Column base plate design (AISC360)

• Footing analysis & design (ACI318)

• Gabion retaining wall analysis & design (ASCE)

• Masonry wall panel design (TMS/MSJC)

• RC 2D analysis & design (ACI318)

• RC beam analysis & design (ACI318)

• RC beam design (ACI318)

• RC wall design (ACI318)

• Seismic forces (ASCE7)

• Wind loading (ASCE7)

• Wood member design (NDS)

• Wood 2D analysis & design (NDS)

• Wood member analysis & design (NDS)

• Wood shear wall design (NDS)

• Wind loading (ASCE7)

See also

Engineering library (All Regions) (page 16)
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2.4 Engineering library (British Design)
The following British design engineering library calculations have been
significantly updated for Tedds 2022.

Hoarding design (BS5975)
A new calculation to the British Standards which checks the design of a timber
hoarding using the recommendations and methods described in the
Temporary Works forum (TWf) publication, ‘Hoardings - A guide to good
practice’. The various hoarding elements designed include timber posts,
timber rails, face material and connections as well as the hoarding foundation,
which can be either a post-in-hole or a kentledge block foundation.

The design is in accordance with 'BS 5975:2019 Code of practice for temporary
works procedures and the permissible stress design of falsework' and 'PD
6547:2004'.

Video demonstration

Concrete specification (BS8500)
Updated in accordance with BS8500-1:2015+A2:2019. Improved user
experience so that the majority of the input can be entered on the main page
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of the user interface.

Other updates
Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• Concrete specification (BS8500)

• Crane gantry girder design (BS5950)

• Masonry bearing design (BS5628)

• Steel beam torsion design (SCI-P-057)

• Steel sheet piling design (BS8002)
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See also

Engineering library (All Regions) (page 16)

2.5 Engineering library (Australian Design)
The following Australian design engineering library calculations have been
significantly updated for Tedds 2022.

Calculations updated in accordance with (AS/NZS 1170.2:2021)

• Aerodynamic shape factor (AS1170)

• Basic wind loading (AS1170)

• Cold formed local wind purlin design (AS1170)

• Comprehensive wind loading (AS1170)

• Wind pressure coefficients (AS1170)

Calculations updated in accordance with AS3600-2018 Amendment No. 2.

• Pad footing analysis & design (AS3600)

• RC 2D analysis & design (AS3600)

• RC beam analysis & design (AS3600)

• RC beam deflection (AS3600)

• RC beam design (AS3600)

• RC circular column design (AS3600)

• RC column design (AS3600)

• RC corbel design (AS3600)RC slab design (AS3600)

• RC wall design (AS3600)Retaining wall analysis & design (AS4678/AS3600/
AS3700)

• Strip footing analysis & design (AS3600)

• Tilt-up wall panel design (AS3600)

Other Updates

Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• Aerodynamic shape factor (AS1170)

• Cold formed local wind purlin design (AS1170)

• RC slab design (AS3600)

Tekla Tedds 2022 release notes 33 Engineering library (Australian Design)



• Pile analysis (AS2159)

• Steel 2D analysis & design (AS4100)

See also

Engineering library (All Regions) (page 16)

2.6 Engineering library (Canadian Design)
The following Canadian design engineering library calculations have been
significantly updated for Tedds 2022.

Steel section design (CSA-S16)
New version of this calculation which has a significantly improved user
experience and has been updated in accordance with CSA S16:19 (Dec. 2019).

• Improved design productivity by allowing the majority of the input for a
design to be quickly entered on the main page of the user interface.

• Clearer preview results in the user interface allowing designs to be
modified and reviewed quickly.

• Section sketch included in the user interface and in the output document.

• Option to include a summary table in the output for an overview of the
design results.

• Flexible output options including user notes and an editable calculation
title.
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Base plate design (CSA-S16), Steel column design (CSA-S16)
Above steel design calculations updated in accordance with CSA S16:19 (Dec.
2019)

2D analysis
Updated the load combination generator so that the Canadian option includes
all the relevant load combinations applicable to NBC 2015.

Snow loading (NBCC)
Updated in accordance with NBCC 2015.
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Timber design calculations
Calculations updated in accordance with CSA-086 19:

• Flitch beam design (CSA-086)

• Timber connections (CSA-086)

• Timber design (CSA-086)

Concrete design calculations
All reinforced concrete design calculations updated in accordance with CSA
A23.3 2019:

• Anchor bolt design (CSA-A23.3)

• Footing design (CSA-A23.3)

• RC beam design (CSA-A23.3)

• RC column design (CSA-A23.3)

• RC corbel design (CSA-A23.3)

• RC one way slab design (CSA-A23.3)

• RC pile cap design (CSA-A23.3)

• RC two way slab design (CSA-A23.3)

• RC wall design (CSA-A23.3)

Other updates
Other enhancements and corrections have been made to the following
calculations, for detailed information about these changes select the "New and
updated (Tedds 2022)" group in the Tedds Engineering Library and refer to the
preview window.

• Anchor bolt design (CSA-A23.3)

• Footing design (CSA-A23.3)

• RC beam design (CSA-A23.3)

• RC column design (CSA-A23.3)

• RC corbel design (CSA-A23.3)

• RC one way slab design (CSA-A23.3)

• RC pile cap design (CSA-A23.3)

• RC two way slab design (CSA-A23.3)

• RC wall design (CSA-A23.3)
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See also

Engineering library (All Regions) (page 16)

2.7 Interoperability improvements
Tedds 2022 features a number of improvements to interoperability.

Tekla Tedds Integrator
The Tekla Tedds Integrator (page 503) which can be downloaded from the
Tekla Warehouse allows Tedds documents to be linked to Tekla Structures
models. You can link existing documents or create new documents which you
or other Tekla Structures users can then easily modify or review during your
BIM workflow.

Integration with Tekla Structural Designer
Tekla Structural Designer integrates with Tedds (page 504) to allow you to
design specific structural elements in your Tekla Structural Designer models.
Seamless integration transfers the design forces to the appropriate Tedds
calculation where you can check and refine your design, the final properties
for the elements will then be updated in the Tekla Structural Designer model.

Recent improvements have significantly increased the speed of these
integrated design calculations.

Trimble Connect
Tekla Tedds integrates with Trimble Connect, for construction project
collaboration on desktop, mobile and web. Store your Tedds documents or
publish PDF documentation in the cloud using Trimble Connect for effective
project collaboration on all your projects.

Tedds 2022 includes a new Trimble Connect Project Explorer (page 504)
window which allows you to publish and share your completed documentation
at the click of a button.
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2.8 Writing custom calculations enhancements
Tekla Tedds 2022 introduces new functions which can be used when writing
custom calculations, including:

• CubeRoot: Calculates the cube root of a value including support for
negative values.

• EvalText: Calculate a string containing multiple delimited expressions
including direct variable assignments (a = …).

• StrListJoin: StrListJoin can be used to concatenate two string lists.

• StrListUnique: Removes all consecutive duplicate elements from a sorted
string list.

• StrListMerge: Merges two sorted string lists into a single string list.

• StrListUnion: Creates a sorted string list consisting of the elements that
exist in one or both sorted string lists.

• StrListIntersection: Creates a sorted string list from two sorted string lists
which consists of the elements that exist in both lists.

• StrListDifference: Creates a sorted string list from two sorted string lists
consisting of the elements which exist in the first list but not in the second
list.

• StrListSymmetricDifference: Creates a sorted string list consisting of the
elements which exist in either of two sorted string lists but not both.

The Tedds calculator has been enhanced so that it can support locally scoped
variables. The lifetime of a locally scoped variable is limited to the operation
which creates the variable. This allows new calculator functions to be
implemented which make it easier to write reusable and reliable expressions
which do not have unintended side effects.

New functions which use locally scoped variables include:

• Let: Assigns values to named variables which can then be used in a
calculated expression for which those variables only apply within the scope
of the Let function.

• InitLocalVar: Assigns a value to a local variable if that local variable doesn’t
already exist.

• InitLocalVars: Assigns a value to one or more local variables if the local
variable doesn’t already exist.

New optimization processing when Word Calc Items are stored in Calc
Libraries which can reduce the storage size of individual calc items by up to
75%. Smaller items will calculate more quickly due to the reduced data which
needs to be processed.

User interfaces embedded in documents now support the _CalcUI variable.
This variable can be used to conditionally show or hide the user interface
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which allows the calculation to be automated, for example using the Tedds
batch design.

User Interfaces created using the Interface Designer Pro application can use a
new optional Debug command button on the toolbar which can be used to
execute a custom expression to perform operations which help to resolve
bugs.

Enhanced Save Marked Up Calc Items command. The command has been
optimized to ensure that Calc Items are only saved if the item content of
properties have been modified and the document insertion point is now
restored to its original location when the command has finished.

Progress Log

New option to indent the items listed in the progress log. The displayed indent
increases as each Calc Item is calculated and decreases when an item has
finished calculating so that you can visually determine which items in the log
relate to which parent calc item.

Debug events for example when using WatchVar and WatchFunction are now
logged using their own Debug Item in the log.

Update the styling and default colour scheme used by the progress log for
improved visual fidelity and overall consistency with the rest of the product.

2.9 General enhancements
A number of general enhancements have been made for Tedds 2022. (Note
that some features documented below were included in previous updates to
Tedds 2021).

Identity Sign In
When you are required to sign in to Trimble Identity to use your Tekla Online
License or to access Tekla online services the default web browser is now
used. This means you are signed into all Trimble products and online services
which use the default web browser for sign in, which significantly reduces the
frequency that you are asked to sign in.

Windows 11
When using Tekla Online licensing, Tedds 2022 is compatible with Windows 11.

When using On-premises licensing, Tedds 2022 is not officially compatible
because a version of Sentinel RMS which supports Windows 11 is not yet
available.
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Tekla Tedds API
Enhanced the Tedds application API to include the following new features:

• Save documents in the active project to PDF.

• Determine whether an active project exists

• Link the active project to an online BIM project

• Application events for ProjectCreated, ProjectOpened and ProjectClosed

Fixes and Other Enhancements
• [TEDDS-6276] Modified the default colours used for drawing the axis on

drawings to the same colours used by Tekla Structures (X=Red, Y=Green,
Z=Blue).

• [TEDDS-5619] Modified the behaviour of the developer commands for
creating calculation examples to always save the variables in SI units so
that numeric precision issues are avoided when saving US examples using
US units.

• [TEDDS-5620] Enhanced VerifyEqual so that when the result is different the
warning message indicates the percentage difference between the two
values.

• [TEDDS-5546] Fixed the Data List design application not initialising the
"Hide grid" and "Fixed splitter" options correctly which resulted in these
options being applied randomly when building a data list.

• [TEDDS-5842] Fixed all functions which expect dimensionless values (e.g.
exp) from throwing an error if a computation results in a value with very
small dimensions close to zero (< 1e-15).

• [TEDDS-5748] Fixed Section Properties Calculator not importing
Continental Tee sections.

• [TEDDS-5761] In the Library Access System enhanced the Manage Libraries
dialog so that when the SHIFT key is pressed the Copy command on the list
views context menu will only copy the library file names.

• [TEDDS-5849] Added a warning shown in the progress log when Debug
mode is enabled for when a variable is assigned or referenced using a
name which exceeds the maximum variable name length of 32 characters.

• [TEDDS-5687] When editing a document header the label for the "Save
these settings as the default for new documents" may have been truncated
depending on the Windows DPI settings.

• [TEDDS-5923] Fixed Project Manager window in Tedds application not
redrawing correctly if the window is shown after being hidden and a
project is already open.
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• [TEDDS-5937] Optimized calculation performance when WatchVar and
WatchFunction are not being used.

• [TEDDS-5938] Fixed the logging of WatchVar events for variables with a
value which is a string or expression so that if the variable is deleted the
logged event states "deleted" and not "modified".

• [TEDDS-5939] When an undo save state is restored or discarded, do not log
delete events for variables which have WatchVar enabled.

• [TEDDS-6072] Fixed input controls in calculation user interfaces redrawing
incorrectly on Windows 11.

• [TEDDS-6027] Fixed the User Interface Designer sometimes crashing with a
"System argument out of range exception" when changing the Type of an
input control from Edit to EditDropList.

• [TEDDS-6033] Updated the Tedds Add-In so that the location of the Tedds
for Word templates is included as a trusted Microsoft Word location. This
prevents Microsoft Word showing an unnecessary security warning when
creating new Tedds for Word documents “This document contains fields
that can share data with external files and websites. It is important that this
file is from a trustworthy source”.

• [TEDDS-6166] Fixed the ListAllUnits function not working correctly due to
always reporting the error “unable to enumerate units in the unit
database”.

• [TEDDS-5989] Improved the loading of add-ins for the Tedds calculator so
that if a user written custom add-in fails to load it does not stop the system
add-ins from loading which previously resulted in an undefined variable
error “DListSetFile and SolvCreateSolver” when attempting to calculate any
calculation which uses DataLists or the solver functions.
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3 Installation and licensing
workflow

To use Tekla Tedds, you need to have a license. The installation steps you need
to take are different depending on the type of license you have: for server
licensing, you need to install additional tools, which are not necessary when
using online licenses.

Click to expand the section relevant to you and follow the links in the text for
detailed instructions.

3.1 Tekla Tedds license types
Tekla Tedds cannot be used without a valid license. There are two types of
license: online and server*

• An online license is connected to your Trimble Identity. The license is
delivered directly to the Tekla Online Admin tool, where your company's
Tekla Online account administrators can assign the online licenses to
individual users. When Tekla Tedds starts, you log in to Trimble's cloud to
reserve your license.

• If you have a server license, you need to install a license server on your
computer or on a separate server in your internal network. Tekla Tedds
connects to your local license server to check your license.

*Local and local USB legacy licenses are still supported, but are no longer
available as new purchases.

3.2 If you manage your own installation of Tekla Tedds

NOTE To ensure a good experience using our software, make sure your computer
meets the Tekla Tedds 2022 hardware recommendations (page 44) .
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If your organization has no main user who manages Tekla Tedds for you, your
installation proceeds like this:

1. Make sure you have your Trimble Identity set up:

a. If you have received an email invitation from Trimble to create a
Trimble Identity, follow the instructions in the email to create your
account to ensure you have the correct access rights.

If you wish to use a different email address for this account, create
the account using your invitation first and then change the email
address.

b. If you have not received an invitation, you can create a new Trimble
Identity to download the software. Click here to create a new Trimble
Identity.

To have access to your online licenses, you must be added to an
organization group in Tekla Online by your organization's account
administrator.

2. If you have a new account, Log in at https://account.tekla.com/, fill in all
the required profile information, and click Save.

3. Download the installation package for Tekla Tedds from Tekla Downloads.
At the site, click Download for a guided experience that ensures you have
all necessary files.

4. If you have an online license, install the software:

• Run the Tekla Tedds installer and make sure the installation finishes
successfully.

See Install and license Tekla Tedds (page 48) if you need more
detailed instructions.

• After you have completed the Tekla Tedds installation, you can now
start Tekla Tedds
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5. If you have a server license, install the software:

• At the Server - Install the license server software on the server and
activate your licenses.

See also: How can I centrally deploy Tekla software? (page 53)

• At the Client PCs - Run the Tekla Tedds installer and make sure the
installation finishes successfully.

See also: Install and license Tekla Tedds (page 48) if you need more
detailed instructions.

6. Start learning how to use Tekla Tedds:

• For a brief overview, see Get familiar with Tekla Tedds (page 57).

3.3 If someone manages Tekla Tedds for you
If your organization has a Tekla Tedds administrator (IT administrator or main
user), you should follow their instructions for installation and licensing. You
may still need to consider the following points:

• You need an account to access Tekla online services and online licenses. If
your administrator has not invited you to your organization and assigned
online licenses to you, ask to join so that you have access to all Tekla online
services and licenses:

Click here to create a new Trimble Identity

• In most cases, your Tekla Tedds administrator will prepare an installation
package for you or install the software for you. Ask your administrator for
further instructions.

Start learning how to use Tekla Tedds:

• For a brief overview, see Get familiar with Tekla Tedds (page 57).

3.4 Tekla Tedds 2022 hardware recommendations

System requirements for effective operation

Item Requirement
CPU • Multi core Intel i3 Series or above,

Xeon or AMD equivalent

• Highest affordable performance
recommended.
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Item Requirement
Memory • 2GB

• Memory requirements are
dependent on document content.

OS • Microsoft Windows 11 64bit / 10
32-bit or 64bit / 8.1 32-bit or 64bit

• Operating systems must be
running the latest service packs /
updates.

• See Test Environments (below)
for full details of supported
operating systems.

Graphics • 1920 x 1080 resolution

• 1GB or higher of dedicated RAM.
Disk space • 1GB or more of free space for

installation.

• Operational disk space
requirements are highly
dependent on document content.

Internet connection • Required for access to Online
Services and some
documentation.

Microsoft Word • 32-bit or 64-bit version of
Microsoft Word Office 365, 2021,
2019, 2016 or 2013

• Microsoft Word needs to be fully
service packed.

License Service • Tekla Structural License Service
4.0 including Sentinel RMS 9.7

License Server • The latest version of the Tekla
Structural Licence Service, at time
of release, is shipped and installed
with the software. If you have
chosen to have a separate licence
server, it is always our
recommendation that you also
run the latest version of the Tekla
Structural License Service on it to
ensure compatibility.

• Please see 'System requirements'
on this page for specific version
details.
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Item Requirement
On-premises licensing (Sentinel
RMS)

• On-premises licensing using
Sentinel RMS does not officially
support Windows 11 due to the
fact that a version of Sentinel RMS
which supports Windows 11 was
not available at the time of the
2022 release. Windows 11 is
officially supported when using
Tekla online licensing.

Test environments
The application is tested and supported on the following business versions of
Microsoft Windows with the latest updates applied:

• Windows 11 64-bit

• Windows 10 32-bit & 64-bit

• Windows 8.1 32-bit & 64-bit

3.5 Create your Trimble Identity
You need a Trimble Identity to download Tekla Tedds and to use your online
licenses. The Trimble Identity is connected to a Tekla Online organization (a
user group for your physical organization).

Creating a Trimble Identity on your first license purchase
• If you did not have an existing Trimble Identity, Trimble sends you an email

with an invitation to complete your account creation. Create your account
using the link in this email and make sure you fill in all of the required user
profile information.

• If you are a company's named contact, you are invited to your Tekla Online
organization by Trimble when the organization is created in Tekla Online.

You will receive an email to accept membership in your new Tekla Online
organization. You are then responsible for managing the organization
together with other administrators that you may assign.
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Creating a Trimble Identity to join an existing organization
To create a new Trimble Identity account:

1. If you have received an email invitation from Trimble to create a Trimble
Identity, follow the instructions in the email to create your account to
ensure you have the correct access rights. Otherwise, Click here to create
a new Trimble Identity.

2. Complete the Create new account form and click the Create new
account button.

If you have several different email addresses, use your company email
address
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3. Look for a verification email in your inbox and click the link provided to
verify you account. You must verify your account to access your Trimble
Identity.

NOTE If you do not receive this email in your inbox, check your Spam/
Junk email folder.

4. Log in with your new account, fill in all the required profile information,
and click Save.

5. Join your Tekla Online organization in one of the following ways:

a. Switch to the Organization page on your user profile page, select an
organization that you would like to join, and click Send request. If
there are no organizations listed, it means your email address does
not match with any existing organization's email address.

b. Ask your company's Trimble Identity administrator to invite you, and
accept the invitation when it arrives via email or on your user profile
pages at https://account.tekla.com/.

Your Trimble Identity is now active, and you can install and license
Tekla Structures.

NOTE Membership in an organization can also affect your access to
your organization's cloud-stored data, such as Tekla Model
Sharing models. Make sure you do not switch between
organizations unnecessarily. When available, use your
company email address with your Trimble Identity.

3.6 Install and license Tekla Tedds
When you install Tekla Tedds, you will be asked to select your license method
from a range of options. These are fully explained in the "Tekla Engineering
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Software - Installation and Licensing Guide" which can be viewed during the
installation process by clicking the button shown below.

To install Tekla Tedds:

1. Download the installation file from Tekla Downloads to your computer.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

Subscription Licenses
If you have Subscription Licenses they will use the Tekla Online License
Method and the 2022 license(s) should already have been added to your Tekla
Online Organization. Select the “Tekla Online” license method option when
installing as shown in the picture below:
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• In order to use a Tekla Online license you will need: a verified Trimble
Identity & Tekla Online Account; to be a member of your company's
Tekla Online Organization; have an Online License assigned to you by
your Organization’s Administrator; to Sign In to your Tekla Online account
when you run the program.

• For more guidance on using Tekla Online Licensing see the following
videos; Using Tekla subscription licenses and Managing Tekla
subscription licenses.

• Sign-In - there is a change to the behavior when you sign-in to run this
version as follows:

• The sign-in process now uses the Windows default web browser - when
you run the program a new dialog box appears informing you of this,
then your default browser will open at the Trimble Identity sign-in page,
as shown in the picture below. Simply sign-in as usual and close the
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browser window, then the program will open.
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On-premises (Perpetual) Licenses

ATTENTION For perpetual licenses using Sentinel RMS (both local and server), Tekla
Tedds 2022 will require the activation of a new 2022 version license.
You should already have received your 2022 Product Activation Key
(PAK) as these are distributed prior to the software release. Please
contact your local Service Department now if you do not have your
PAK. To minimize any down time, we recommend you activate your PAK
BEFORE installing this release.

ATTENTION License Server Version - if you are using Sentinel RMS Server
Licenses, the Tekla Structural License Service on your license server
must be updated to version 3.2.x or later (incorporating Sentinel RMS
9.7) to be compatible with this release. The installation for this can be
obtained from Tekla Downloads. Sentinel RMS server licensing will not
function correctly if this update is not performed!

• For more information about this please see the TUA Article Tekla
Structural Design Releases for 2021 & Sentinel RMS Server Licensing
- the License Server must be updated and the associated FAQ
Article.

• For any type of On-premises (Perpetual) Licenses, select the “On-
premises'' License Method option when installing, then the appropriate
option on the next page as follows:

• For a mix of pooled Subscription and Sentinel RMS server licenses,
select the “Automatic” option as described in this TUA Article.

• Otherwise, select the “Server Sentinel RMS”, “Local Sentinel RMS” or
“Local Hardware Key” option appropriate to your license type*.

• *If you have a mix of license methods per product, you can edit the
license method used by each product after the installation as
described in this TUA Article.
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How can I centrally deploy Tekla software?

I want to centrally deploy Tekla Tedds what do I need to do to be able
to do this?
Tekla installations are designed to support distributed deployment scenarios
using Windows Group Policy or proprietary Software Management Systems
(SMS). The SMS software will vary depending upon your chosen deployment
process and therefore we are unable to offer detailed technical assistance on
how to implement this. What we can provide is a list of requirements /
components and how to install them to allow you to package up a centralized
install in your chosen deployment process.

Where is the information found?
Every release of the software has different dependencies so the best way for
us to distribute this information is to ship it in the installation download.
Because the vast majority of users will never need to know this we do not
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provide links to the information via the installation wizard - you have to
unpack the download to find the information.

How do I unpack the install to extract the Distributed Deployment
details?
1. Run the downloaded installation package

• Allow the unpacking process to complete and the Installation wizard to
launch

2. Cancel the Installation wizard

3. Open a Windows explorer and navigate to

• C:\Program Files (x86)\Common Files\Tekla\Structural\Install Cache

4. In here there should be a sub folder related to the product and release
you are trying to install, e.g. "tekla_tedds_YYYY_MMYYYY"

5. Open this subfolder and open

• Distributed Deployment.htm

3.7 Tekla Tedds service packs
Service packs update the existing installed version software. You do not need
to separately install previous service packs in order to install the most current
service pack. For example, you can install service pack 2 without installing
service pack 1.

• Service packs can include new features, and improvements and fixes to
existing features. We recommend that all users install the latest service
pack.

You can find the service packs in Tekla Downloads.

Install a Tekla Tedds service pack
You can install a service pack to update a version or a previous service pack.
Service packs can contain new features, and improvements and fixes to
existing features

If you have the related Tekla Tedds version or a previous service pack installed
on your computer, you do not need to remove it before installing a new
service pack.

To install the service pack

1. Download the service pack software installation file from Tekla
Downloads to your computer.
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2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

3.8 Upgrade Tekla Tedds to a new version
If you already have Tekla Tedds installed and are upgrading to a new major
version please note that the existing version will be replaced - so 2022 will
replace 2021 for example. (Service packs are slightly different as these are
cumulative updates, so for these you only need to install the latest.)

To upgrade your version, simply proceed to Install and license Tekla Tedds
(page 48) as if you were a new user.

The Update Service

Using the Update Service is the easiest way to keep your Tedds installation up
to date. It runs inside Tedds and will notify you if updates are available. You
can then install them directly from the list of updates in the Software
manager.
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A message appears in the Tedds Status bar (bottom of window) if updates are
available. Click this to open the Software Manager to list and install the
updates. You can also check for updates at any time by selecting the "Check
for Updates" button on the Help tab of the Ribbon.
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4 Get familiar with Tekla Tedds

Tekla Tedds is software for performing structural engineering calculations. You
can choose to run it as Tedds, or as the more sophisticated Tedds for Word.

Using Tedds you can:

• Access standard calculations by using the Library Access System.

Using Tedds for Word you can:

• Define and perform your own calculations in any Microsoft Word
document quickly and simply.

• Access standard calculations by using the Library Access System.

• Access component calculations by using the Library Access System.

• Include engineering data in your calculations by using data lists, data
tables, and data graphs.

• Calculate anything from a single calculation to an entire document.

• Automatically verify the dimensional accuracy of your calculations by
specifying the appropriate units for your variables.

• Define multiple calc sections in your document, so that the same variables
can have different values within your document.

See also

Tedds and Tedds for Word – what’s the difference? (page 60)

4.1 Start Tekla Tedds
1. To start Tekla Tedds do one of the following:

• In the Windows start menu, find and select Start Tedds.

• On the desktop, double-click the Start Tedds icon.
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The Tedds Start wizard appears.

Follow the instructions below to continue.

NOTE See Tedds and Tedds for Word – what’s the difference? (page 60) for
more information about the choices.

Launch Tedds (the Tedds Application)
At the Tedds Start wizard:

1. Click Tedds. 
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The Tedds Start Page appears.

On the Tedds Start Page you have the following options:

• If you have purchased additional regional libraries, you can set the
default region locale by using the Locale list.

• To create an empty document and select a calculation in the
calculation library, go to the New tab and select New Document

TIP If necessary, on the New tab, you can also click the calculation
name in the Recently used calculations list. Tedds then creates
a new document containing the selected calculation.

• To open an existing document, either click Open Document and
browse to find the document, or click the document name in the list
under Open Document.

• To create an empty project, go to the New tab and click New Project.

• To open an existing project, either click Open Project and browse to
find the project, or click the project name in the list under Open
Project.

• To open the Tedds quick start guide, release notes, user guide, or help
in a new window, click the required command under Learn the
product.
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Launch Tedds for Word
At the Tedds Start wizard:

1. Click Tedds for Word. 

If you have more than one version of Microsoft Word installed on your
computer, click the version that you want to use.

NOTE After launching Tedds for Word, you may want to adjust some
Microsoft Word settings. For further information, see Microsoft
Word settings (page 361).

4.2 Tedds and Tedds for Word – what’s the difference?
When you launch Tedds, the Tedds Start wizard typically displays two
editions:

1. Tedds

2. Tedds for Word

Tedds

Tedds is very simple and powerful and completely self-contained. In addition,
Tedds requires no knowledge of any other package. This edition gives you
access to all the major Tedds calculations and to most of the utilities. If you are
new to Tedds and have access to both editions, we recommend that you start
by using the Tedds edition.

NOTE For clarity, the Tedds edition is referred to from this point on as the
Tedds Application.
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Tedds for Word

Tedds for Word gives you access to all Tedds calculations (including
component calculations) and all the utilities. However, Tedds for Word is even
more powerful: you can include multiple Tedds calculations in the same
document along with text, pictures, and output from other applications.

Tedds for Word is entirely integrated with and operates within Microsoft Word.
That is why you need to have access to and some knowledge of Microsoft
Word to use Tedds for Word.

In Tedds for Word, you can write and format documents according to your
needs. You also have all the editing features of Microsoft Word at your
disposal to create professional-looking reports.

In addition, Tedds for Word allows you to write your own calculations. You can
simply type the variables and formulae within a Word document, and then use
Tedds for Word commands to automatically resolve the calculations. When the
inevitable design changes occur, modify your calculations and re-calculate the
document, and Tedds for Word calculates the new results for you.

See also

Introducing the Tedds Application (page 236)

4.3 Tekla Tedds Quick Start Guides
To get you up and running quickly, we recommend working through the Quick
Start Guide appropriate to your locale. The aim is to have you creating your
own calculations in about an hour. After that, you will easily go from novice to
expert, simply by using the 'Help' menu and the Product Guide.

• Quick start guide - US design examples (page 61)

• Quick start guide - Eurocode design examples (page 119)

• Quick start guide - Australian design examples (page 178)

Quick start guide - US design examples
The Quick Start Guide comprises the following 5 exercises, which are best
worked through in sequence:

• Using Tedds (page 62)

• Writing Tedds Calculations - Stage 1 (page 83)

• Using Library Calculations in Tedds for Word (page 95)

• Writing Tedds Calculations - Stage 2 (page 104)

• Enhancing Calculations (page 112)
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Using Tedds (US design example)
In this exercise you will design a steel beam in order to learn how to use any of
the calculations in the extensive Tedds Engineering Library.

Allow about 15 minutes to complete this exercise.

Design information required for this exercise

We wish to check the following RHS steel beam:

Design Information
Design Code AISC 360
Dimensions Length 16 ft

Effective length factor 0.80
Design Forces Moment 90 kips ft

Shear 15 kips
Axial compression 10 kips

Proposed section Shape Rectangular HSS
preferred

Steel grade A500 Gr C50

Running Tedds and locating calculations

You need to find an appropriate calculation, run it and enter the design
information. You will see just how easy this is.

1. Launch Tedds from the Start Tedds icon on your desktop.

2. If this is the first time you are starting Tedds, or if you are updating from a
previous version of Tedds, then you will see the Tedds Setup Wizard
which allows you to configure Tedds with your company details and so on.
Work through the various pages of the Setup Wizard and when you reach
the end click Finish.
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3. From the Tedds Start wizard click Tedds (as opposed to Tedds for Word)
as the version to run.

4. Now you will see the Tedds Start Page: 
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NOTE For these exercises, the locale shown above can be set to either
USA or Canada).

5. First, click the New tab.

6. Then, click New Document:
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You will see the Select Calculation dialog box appropriate to your locale:

7. Click on the All folder.
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• The instructions about using Tedds are displayed in the right hand
panel.

• Every Tedds calculation is listed in the left hand panel.

• When you click on a calculation, notes relating to it are displayed on
the right side.

NOTE If the Show Examples option is checked, you will also see all of
the examples that are included in the library - these demonstrate
the potential scope of each of the calculations, show you the
typical output, and can be used to start your own designs.

To find a calculation – you could simply click on a folder in the list to open
it, then click a heading to select a calculation. However for this example
the Find in list feature will be used instead.
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8. Type steel member design in the Find in list field. 

NOTE Find in list will locate the first item title in the library that
contains the exact text entered. Keywords in the item description
are also considered provided the option to Find in item
descriptions remains checked.

9. The first item in the library matching the entered text is selected - we are
looking for the 'Steel member design (AISC360))' calculation. If necessary
click Next until it is selected as shown below.
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NOTE Note there is also a 'Steel beam analysis & design (AISC360)'
calculation available which will determine the design forces
before proceeding to the design.

10. Click the Calculate button at the bottom right of the dialog: three things
will happen: 

• A new calculation document will open – you will see this in the
background.

• The Interface for the chosen automated calculation will be displayed at
the first page.

• Another window, titled the Progress Log will also be displayed – we will
explain this shortly.

Entering data in the automated calculation user interface

The user interfaces for all of the calculations in the Tedds engineering library
use a consistent style which ensures they are easy to use. You select the
design options you require and enter values for dimensions, loading etc. all of
which are clearly explained. See the box below for more information.

The General Automated Calculation Interface Explained
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The General Automated Calculation Interface Explained
An '(i)' symbol to the left of a variable description shows that there is
more information available about this particular variable. The
information area (at the top of the dialog) displays any information
about the selected variable (if available). You can also see this
information by hovering the cursor over the '(i)' symbol.
Notes - display details about the calculations being performed.

Variables - lists all the current variables. Values can be selected from
here to enter into the current interface.

Feedback - this allows you to send feedback to the development
team.

Support - tells you how to obtain support in your region.

Data fields - enter information in these fields . Where appropriate,
variables may have validation which prevents invalid information
being entered.
Buttons... - allow you to enter more information or select a particular
item.

Next/Back/Cancel/Finish - continue to the next page / return to a
previous page /stop the calculations at the current point / return the
data to your calculation document.

1. In this calculation all the values for design forces and section details can
be specified on the first page of the interface and the calculation results
are also displayed.
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Note that additional design and output options are available by clicking
the appropriate buttons.

Before we proceed to enter the data take a moment to review the design
information given at the beginning of this exercise.

2. Enter the Design bending moment - major axis as 90 kips ft.

3. Enter the Design shear force - major axis as 15 kips.

Get familiar with Tekla Tedds 70 Tekla Tedds Quick Start Guides



4. Finally for the Axial load applied, click No axial strength required,
change to Required compressive strength and enter a value of 10 kips. 

NOTE With Preview results selected, as you change the values and
options for your design the calculation results are immediately
updated.

5. Now you need to choose a section to check, but you don't need to go off
and find a list of section properties, since all the data required can be
accessed within Tedds. In the Span details area, click the Selected section
'...' button to display the Data List for steel sections.

Data Lists

You are now looking at a Data List: a tool that allows you to choose a section
and see its properties at the click of a button.

Data Lists Explained

Choose the shape from the left hand pane.

Choose the size from the right hand pane.
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Data Lists Explained
Details - click to see properties of the chosen selection.

Select - click to select the chosen selection.

In this case, both a HSS 10x6x3/8 and a HSS 12x8x1/4 may prove adequate but
which is the lighter?

1. Click the Rectangular HSS section type - this is known as the Data List
page you require.

2. Select the size and thickness you require.

3. Click on the Details button to see all the properties of the selected section
– (note that the details window updates instantaneously when you click on
another section).

4. Check the properties of both sections. The HSS 12x8x1/4 section is lighter
and may be preferred – choose this section and click Select to continue
with the calculation using this section size. 

NOTE You will find Data Lists for all kinds of engineering data
throughout Tedds calculations; there are data lists for bolts,
reinforcing bars, timber sections and much more. However, they
all work in just the same simple and intuitive way.

5. The number next to 'Selected section' allows you to design beams using
two or more sections. In this example a single section is sufficient so no
change is required.
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6. Set the steel grade to A500 Gr. C.

7. Enter 16 ft for major and minor axis and torsional restraint spacings.

8. Click the Design options... button to view another interface page for
defining equivalent uniform moment factors etc.

9. Leave the default values as shown. 

10. Click OK to return to the main page of the interface.
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11. Click Preview output... and scroll through the output, click Cancel when
done. 
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12. You can now choose the level of output you require by clicking Output
options... From here you can also give the calculation a title.

13. Click OK

Automated calculations and library items

You have probably realized by now that this calculation caters for all kinds of
steel sections, dimensions and loading. For each possibility and check, there is
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an item in the Library - in fact this calculation has over 150 items. When you
use a calculation like this, Tedds automatically chooses the appropriate items
for your options and input, and puts them together to make up the complete
design.

• To accept the results and continue, click the Finish

The progress log

The progress log helps to keep you informed about a calculations progress
during lengthy calculations, it is also used by some calculations to report the
status of specific checks or other pertinent information. When writing your
own custom calculations you can add information to the log or you can modify
the default options to provide more detailed information about what your
calculations is doing which can be helpful for resolving errors.

This particular calculation does not use the progress log to report any
additional information.

Examining finished calculations

OK, but how is your chosen section performing? The main interface displayed
the design forces, capacities and utilizations but you may want to examine the
results in more detail.

1. Scroll through the calculation and examine the flexural buckling check: 

2. There’s another really important point to note about the calculations
displayed – they don’t just show you results, but how those results have
been arrived at. 

NOTE Tedds is not a ‘black box’ where all you can see is the result, and
all you can do is accept it. In Tedds you can see exactly what’s
going on. You can see what checks Tedds does. What design
method does it use? From where did that number come? The
answers to all these questions are right there in front of you! This
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is a major reason why Tedds is so popular with engineers the
world over.

Furthermore, if you need an example of how to write your own
calculations, then look no further. That's exactly what you are
looking at - every calculation in the library is an example of how to
write your own. How do I write a math expression in Tedds? How
do I use logic or a math function in Tedds? Look again at the
check shown above and you will see the answers to these
questions. We will look more closely at how to write your own
calculations in the next exercise Writing Tedds Calculations -
Stage 1 (page 83)

Re-calculating

Changes are a fact of life for engineers, they always have been, and they
always will be! You need to be able to take account of any changes and update
your calculations quickly. With Tedds this is no problem.

Say that your beam needs to be 1.0 ft longer since the beam which supports it
needs to be moved, to avoid a clash. Is your section still OK?

1. Click Calculate on the Home tab (highlighted above). 

The calculation will run again, but this time all the information you
entered last time is remembered. It’s a simple matter to change the
required data.

2. Change the distances between restraints to 17 ft.

3. What is the effect of this change on the design? Check the Calculation
results and/or the output to see. 

Tedds makes it easy to update calculations – simply re-calculate and you
can update your design quickly.

Hidden text

All the calculations performed by Tedds are available in the output and in
general so they are – but at times some intermediate calculations are hidden
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to reduce the amount of output. It is simple to view these and to include them
in your printout.

1. Open the application’s View tab then use the Hidden Text option and
examine the check again. You will see all the hidden text underlined with
dashed lines.

2. In this example there are no hidden calculations but you will see the
names of the Library items used in the output. 

3. Select View/ Hidden Text again to hide the Library item names. Now let
us consider how to print calculations.

The header & printing

Obviously you want professional looking printed output. You will see that you
have a header region at the top of the calculations, but how do you set its
details?

1. Click the Header button highlighted above – this opens a dialog where
you can enter some project details in your header.
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2. On the Company page you can define your own company details. Do this
now, if you want to. If you don’t, then remember to do so before you print
your first “proper” set of calculations.

3. On the Template page you will see the Tedds template which your
calculations will use and the logo file which Tedds will add to the template.
You can change the template and logo if necessary – click this tab and
check that its details are correct.

4. Maybe you would like to try a different style of template, there are a
number of standard templates to choose. Click the Select… button to see
these. Choose the template you want to use and you will see a preview of
what calculations produced with that template will look like. When you
have found the template you want to use click OK to use it. 
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5. If you have a copy of your company logo in electronic format, and the
template style you select supports a logo, then you can add your logo to
the template. Make sure that the logo is available on your computer,
Browse to find it, and then click OK to add it to the template.

6. Click OK to exit the Header Properties dialog and view your finished
calculation.

7. If the logo is not the right size open the Header Properties dialog once
more and change the Scale of the logo to make it fit the template
correctly.

8. Once the template and logo are correct click  to display the file
menu. From here you can Print the calculation to obtain a hard copy.

9. Congratulations, you have produced your first piece of work with Tedds!

To finish this example let’s look at a few points about saving and outputting
your results.

Saving and output options

You can save every Tedds calculation to a unique file that you can recall and
edit any time in the future. The file extension .ted is unique to Tedds.

1. Click  to display the file menu.
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2. Save your file and give it a name - it’s a good idea to save all the examples
you will produce in the course of completing the guide, for future
reference.

3. The output you see in the document can be printed direct to a printer, but
you have other options.

4. Click the drop-down button adjacent to Send To on the file menu to view
these.

5. Choose the option of sending the output to Word and experiment with
the other options if you wish. Once your output is in a Word document,
you can edit it as much as you wish.

6. By clicking the drop-down button adjacent to Save As on the file menu
you can also save the active document, or all documents in the active
project to PDF.

Performing a new calculation

How do you start a new calculation in Tedds?

• Click  to display the file menu; then click  

The Select Calculation dialog will open, from where you can select and start
a new calculation in a new document.

Managing multiple related calculations

Can several calculations be saved in a single document?

As stated earlier, each calculation must be saved to a unique file - however
multiple files can be collected together in a single project. They can then be
organized as required using the Project Manager.

Benefits of projects include:

• you can specify a shared document header for all the project files,

• locating files is made easier - when you open the project all files within it
are opened automatically,

• calculations can be placed into named groups, making them easier to
manage.

To start a new project:

1. Click  to display the file menu; then from the menu choose the New
Project button. 
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A new empty project is created in the Project Manager.

2. New or Existing Documents are then added and arranged into folders as
required, either by right-clicking, or via the Project tab. 

What next?

Congratulations! You have completed the first exercise and now know all you
really need to make use of the wide range of calculations available in the
Tedds Engineering Library and to begin using Tedds productively. Take a look
through the index and try some more. How about:

• carrying out a wind load calculation?

• designing a retaining wall?

• designing an RC footing?

• analyzing and designing a timber rafter, beam or post…

The choice is yours, and all these calculations work in the same
straightforward, intuitive way. Some calculations may also include Data tables
which are designed to look like tables from printed references, so that you
immediately feel at home with them. Indeed we hope you will find yourself
recognizing them.
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What can you do if the Library does not contain the exact calculation for which
you are looking? You need to perform a number of calculations, and could do
with a calculation to help you out with these. First of all, TELL US:

• if you are running a calculation, then you will see a Feedback button to the
left-hand-side of the interface,

• if you are not running a calculation, then you can choose the Feedback…
option from the Help menu.

We are constantly working to expand our Engineering Library and your input
helps us do this!

But you don’t have to wait until we produce these for you – you can write them
yourself. We will look at this in the next exercise: Writing Tedds Calculations -
Stage 1 (page 83)

Writing Tedds calculations - stage 1 (US design example)
Having looked at using calculations from the Tedds Library we can move on to
look at one of the most exciting and powerful features of Tedds - the ability to
create your own calculations. This is where an initial investment of time can
give you huge returns later. Once you have invested time writing a calculation,
you can use it over and over again, you can also update calculations in an
instant, making further great savings. You can also customize and extend the
Library of Tedds calculations to match the calculations that you use most
frequently in your office.

In this exercise we will see that writing Tedds calculations simply uses the
math and logic conventions with which you are already conversant. We start
by looking briefly at very simple examples introducing the basics of calculating
with Tedds for Word. We then create a “real-world” example, covering the
main features of writing effective calculations in depth.

Allow about 30 minutes to complete this exercise.

Running Tedds for Word

To write calculations you need to use Tedds for Word.

1. Launch Tedds from the icon on your desktop.

2. Click the option to run Tedds for Word - Microsoft Word will now open
with Tedds integrated. If this is the first time you've run Tedds for Word a
Release Notes document and the Library Access System will open too. 

NOTE It is important to realize that you are looking at Microsoft® Word
with the Tedds capabilities added. We only add to the
functionality of Word, so you can do anything you would normally
do in Word. Treat a Tedds Calculation Document just like you
would any ordinary Word document. You can type reports, import
files and text, embed spreadsheets and so on. And of course you
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can add calculations to your reports; either straight out of the
Tedds Engineering Library, just as you did in the previous
exercise, or create your own.

The Tedds interface

The commands you will need to use in this exercise can all be found on the 
Tedds Tab of the ribbon as highlighted below:

You will find a Word Document open, which looks very similar to the Tedds
output document.

The document Header can be edited in a similar manner to that in Tedds by
clicking the Edit Header button - this button is highlighted above.

• In this exercise two documents will be required, so open a new blank one
by selecting File/ New Tedds Document

Now we are ready to begin writing our first calculation in Tedds.

The basics

Writing calculations in Tedds for Word is easy. Tedds follows standard
mathematical rules and uses standard mathematical operators. For example 1
+ 2 would add 1 to 2. To write an equation use the = sign, and to specify where
you want to see the answer use the ? symbol. For example:

1 + 2 = ?
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• Type the above anywhere in your document. When you calculate this
equation the ? will be replaced with the answer.

Calculating in Tedds for Word

To calculate equations in Tedds for Word you can use one of several
Commands:

All - this will calculate the whole document.

Calc Section - this will calculate the Calc. Section your cursor
is in.

Selection - this will calculate only equations you have
highlighted.

1. In the Calculate ribbon group, click All to calculate your equation: 

1 + 2 = 3.000

2. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and troubleshooting
section below.

Units in Tedds

Tedds automatically takes units into account, so you don’t need to apply
conversion factors to get the right answer. Tedds will also check that the units
you are using are dimensionally correct and warn you if they aren’t.

1. Type the following in your document using the same case as you see here:

890 mm + 1 ft + 8.5 in = ? m

2. In the Calculate ribbon group, click All to calculate this equation: 

890 mm + 1 ft + 8.5 in = 1.411 m

3. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and troubleshooting
section below.
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Defining and using input variables in Tedds

Defining variables is the key to writing effective Tedds calculations. We will use
the following calculations to demonstrate this. Do not type this yet - we will
show you how to enter the calculation below (in stages).

1. Close the current document, (because two documents were opened at the
beginning of the exercise you should still have an empty one displayed).

2. Type in the following two paragraphs in the empty document.

The first paragraph is just a title for our calculation. The second paragraph
is a standard Variable Definition which uses a superscript in its units.

3. Once you have finished typing, read the notes in the box below for an
explanation of a standard variable definition, and to check you have typed
it correctly. 
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The Standard Variable Definition Explained

Note the following:

• The expression defines the variable's unique name, current value and
units.

• Variable names are case sensitive, cannot contain spaces or be function
names (like sin for example). Other than that you can use pretty much
anything you like as you can see, including Greek text and Subscripts.

• The semi-colon is important. It is a delimiter that separates an expression
from text, or another expression in the same paragraph. If you omit
delimiters in either of these cases, then you will get an error when you
calculate your document.

• The equality sign '=' defines an expression. Without it no calculation will
be performed.

• Spaces and Tabs are not significant in this, or any other, expression. Use
as many or as few as you wish to make your calculations look presentable
and easy to read.

• We will look at Units in more detail shortly but, for now, note that they are
also case sensitive and have a correct syntax, that you must use (as shown
above).

4. Now enter the following paragraph which uses this variable:

5. Use the Insert multiplication symbol  button to enter the ×
mathematical operator - do not use a lower-case x.

6. Check the notes in the box below for a detailed explanation of the
components of this paragraph. 
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Mathematical Expressions Explained

Note the following:

• The same observations as before apply to delimiters, explanations, spaces
and units.

• You cannot omit math operators in expressions: Tedds cannot calculate
0.6Fy, you must type the expression as shown above, including the × .

• The result field ? is used to tell Tedds where the result should be output -
when calculated the ? will be replaced with the result of the expression.

• The value of the result will be in the result unit you specify. Ensure this
has the correct form and dimensions. Do not omit this.

• The expression contains a variable (Fy) that is defined in the calculations
before (that is above) the point where it is used. Expressions should not
contain variables that are not yet defined.

• The expression contains two equalities and performs two functions:

• calculates and displays the value we wish to know - the result.

• assigns this result to a variable named - Fa

• It is not obligatory to always do this. You can write a valid expression to
perform just one of these functions by either omitting the variable name
and the first equality, or the second equality and the ? and unit.

7. In the Calculate ribbon group, click All.

8. Your expression has been calculated and the result has replaced the ? as
before. if you have an error, take a look at the Errors and
troubleshooting section below.

9. Here are the next two paragraphs of the calculation. The first paragraph is
a standard variable definition, while the second uses both T and Fa to
determine the minimum section area and creates a variable AMIN with this
value.
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10. Type the first paragraph, then follow the steps below to enter the second.

11. The second paragraph contains examples of the use of Subscript (often
used for name suffixes) and Superscript (used for powers).

12. To type the variable name AMIN, first type the A, then click the Subscript

 button.

13. Now type MIN, then click the button again to return to normal text.

14. To type the unit in2, first type in, then click the Superscript  button.

15. Now type 2, then click the button again to return to normal text.

16. Click Calculate All to calculate these expressions once you have entered
them.

17. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section below.

18. Here are the final three paragraphs of the calculation. Follow the steps
below to create these.

19. Here we define two new variables to be used in the expression in the final
paragraph.

20. Type the first paragraph, entering the subscript for the name Le as you did
before.

21. Follow the steps below to enter the second paragraph.

22. Use the Greek text  button to enter the name λL
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23. First click the button indicated, then type the Roman equivalent of the
Greek letter – (l in this case for lambda).

24. Now click the button again to return to normal text, then enter the
subscript suffix as you did above using the Subscript button. 

NOTE A much easier way of entering Greek characters and more
complex units is to use the Tedds Greek Characters, Tedds SI
Units and Tedds US Units toolbars which can be selected from the
Tedds Tab on the ribbon.

25. Use Copy and Paste to enter this name in the final expression.

26. Now click Calculate All to calculate these final expressions:

27. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section below.

Storing variables in Tedds

1. Click the Variables button.

2. The Variables dialog box will open, displaying the stored values.

3. You will note that we do not just store the variable name and value, but
also the dimensions. This is how Tedds handles all the unit conversions
for you. 

NOTE You can Delete variables from this list if you wish:
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4. Cancel from this dialog, and edit one of the values on the page - say the
tie force to T = 150 kips. Now check back in the stored variables and you
will note the stored value has not changed.

5. Re-calculate the document and check back in the list of variables - the new
value has now been stored. 

NOTE An important observation — the stored value of a variable only
changes when you re-calculate the definition, not when you just
edit it on the page. If you edit the value of a variable you must re-
calculate the variable definition, and any calculations that use it
to update them.

More about units in Tedds

1. Change the tie force back to its original value T = 100 kips. Calculate again
to store this new value.

2. Look again at the values displayed in the Variables dialog box. You will
note that many of these values are not those displayed in the document.

3. The values in the dialog are in the Base Units in which Tedds performs all
calculations and from which all the other units are derived. The base units
are shown in the following table: 

Tedds Base Units
 Metric

Length m
Mass kg
Time s
Temp °C

NOTE If you hover over a variable name in the Variables dialog box a
summary list is displayed showing the value of the variable in all
applicable standard units.

4. Note that our calculation does not include any conversion factors. 

NOTE Tedds’ unit handling is a massive help – Tedds comes with a huge
number of defined units and you can add more if needed.

Dimensional Checking - Tedds checks all dimensions in your
calculation and will inform you if these are incorrect. This is why
you should use units consistently throughout your calculations.
Do so, and you can have total confidence that your calculations
are dimensionally correct.

Get familiar with Tekla Tedds 91 Tekla Tedds Quick Start Guides



5. Save the document and give it a name - call it “Exercise 2” - as we wish to
build on it later in the guide.

To complete this exercise, in the next section we will take a brief look at
handling errors in calculations.

Errors and troubleshooting

The problem with a lot of guides is they only show you the right way to do
things, and then you have no idea what to do when something goes wrong!
Let's look at a couple of errors and how to fix them.

• If you have an error in your calculations, Tedds will inform you when you
calculate your document and the error is encountered. The first thing you
should do is Interrupt the calculation process.

• If you have jumped to this section because you have encountered an error
previously, then click the Interrupt button in the dialog (see step 11 below),
review the details and then return to fix the error in your calculations and
continue with the exercise.

If your previous calculations were error free, then you will have had no need to
look at this section. We shall therefore create some calculations which do have
errors so that we can see how to handle them.

1. Open a new blank document for this example.

2. Click the Tedds options  button (on the More menu).

3. The Options dialog box will open, click on the Calculating / General page.
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4. Make sure that the options above are checked and then click OK. We can
now proceed to create some calculations with errors.

5. Enter the following 2 paragraphs as they appear here - see if you can spot
any errors as you do, but don’t fix them yet!

6. Now click the Calculate All button to calculate the calculations - you
should see the Expression Error dialog: 
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Expression Error dialog Explained

This is the specific error.

This line is the one that Tedds cannot evaluate, so look here to spot
the error.

This is an explanation of the error, together with some typical
causes.

This is the button you should generally click,

7. Tedds flags the first error, and gives you some help in fixing it.

8. When you are ready, click the Interrupt button. Tedds highlights the error
for you in the document as shown below: Once we fix the problem and re-
calculate, this error message will automatically disappear. 
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9. Check the rule about delimiters (see The Standard Variable Definition
Explained info box earlier in this topic). There should be a semi-colon
between the expressions to separate them. Add this in and re-calculate
the entire document.

10. Now we will get the next error – the variable WD is not defined. We have
typed WD instead of wD and variable names are case-sensitive.

11. Click the Interrupt button to stop the calculation.

12. Correct the variable name on the page to wD and re-calculate. The
calculations should now complete with no problems. Tedds automatically
deletes all error messages from the page.

What next?

Congratulations! You have completed your first Tedds calculation. You can
now begin writing effective calculations in Tedds for Word. There are more
great features that make such calculations even more powerful, and we will
show you these later.

Now we are going to look at using calculations from the Engineering Library in
Tedds for Word: Using Library Calculations in Tedds for Word (page 95)

Using library calculations in Tedds for Word (US design example)
We have shown that you can write your own calculations in Tedds for Word,
but you can also use the Library Calculations. The advantage of this is that you
can add additional text to your output easily, because it is already in a Word
document. You can also combine more than one calculation in a document,
add pictures and tables - anything you need to create a polished report. And if
you need to update the calculations you can do it directly in the document.

Sometimes, of course, you just need an answer right now and the polishing
can wait. That's why we have Tedds too. With the two modes, you have both
bases covered.

In this exercise we will use the Seismic Force calculation to show you how to
run a typical calculation from the extensive Engineering Library in Tedds for
Word.

Allow about 15 minutes to complete this exercise.
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Information required for this exercise

Design Information
Use the following information for the calculation.
Code version ASCE 7-10
Override R value for IBC No
Risk Category II
Site Class D
Short Period 0.2
1 sec Period 0.3
Determine SDC from
Table 11/6-1 alone

No

Include vertical load
distribution

No

Building height 40 ft
Effective seismic wt 5000 kips
Structure is regular and
less than 5 stories

Yes

Lateral Force System Steel Frame (eccentrically braced)
System Type Building Frame Systems (selected in Data Table)
Basic seismic-force-
resisting system

Type 1. - Steel
eccentrically braced
frames

(selected in Data Table)

Override approximate
fundamental period

No

Long-period transition
period

8 sec  

Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Tedds tab as shown below:
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Using Calculation Sections in Tedds for Word

As stated, one of the reasons for running library calculations in Tedds for
Word is so that you can combine a number of calculations in a single
document. In this case, each calculation should be placed in a separate
Calculation Section, so we will start off by introducing one of these. Calculation
Sections will be explained in more detail later in this exercise.

1. Open a new Tedds document.

2. Insert a New Calc Section by clicking the appropriate button.

3. The following dialog will appear - enter a name for the section. This will
form the title for the calculation in the document.

4. Click OK and this will enter a Calculation Section Title in the document. We
place a calculation below this title and thus within the section. You should
note that your cursor is now on the line below the section title.
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Selecting calculations from the library

All the library calculations are available from the Library Access System. To use
a calculation we retrieve it from the Library, place it in our document and
calculate it.

1. If it is not open already, launch the Library Access System.

2. Click the Index button if the index is not displayed and ensure you have
the Tedds calculations (US Units) index option selected.

3. To open a folder in the index simply double-click it. Open the Loading
folder, then the Seismic forces (ASCE7) folder, then select (click on) the
Seismic forces (ASCE7) item

4. To place this calculation in the document, click the Execute button in the
library. (You can also double-click on the selected item to do this.) In both
cases you will see the Insert Calc Item dialog.
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5. This dialog allows you to control where the item will be added. Simply
choose the options as above then click OK and the item will be pasted at
the cursor position in the document. 

NOTE Note that one of the options in the dialog is to add a new Calc
Section. In this example we have already added one manually, so
as shown above, on this occasion the option should be
unchecked.

6. You should now have the following in your document.

7. We can now close the Library - there is no need to have it open while a
calculation is running.

8. Click the Calculate Section button to start the calculation.
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9. The Interface for the calculation will now be displayed, along with the
Progress Log. You are now in familiar territory as everything from this
point works exactly as you learned in the first exercise – Using Tedds
(page 62)

10. Click the Notes button and briefly look at the notes before proceeding.

11. You will be comfortable with entering information in the interface by now,
so we won't show every input step in detail. The data to be entered is
given at the start of this exercise.
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12. When you get to enter the Site Class (= D), click on the down arrow at the
side of the information pane (as shown below) to see all the help
information available for this input.

13. When you are ready, click on the up arrow (to which the down arrow has
changed) to reduce the information pane, and continue on to the next
page. 

NOTE Information about a particular item will also appear adjacent to
your cursor if you hover over the information symbol associated
with that item.

14. Continue to enter the information required by the interface. When
specifying the Response modification factor you will find that a Data
Table will be displayed.

Using Data Tables

Data tables are designed to look like tables from printed references, so that
you immediately feel at home with them. Indeed we hope you will find
yourself recognizing them.
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1. When the table displays, note the four tabs at the bottom: Table,
Variables, Notes and Sketches (the latter tab being dimmed because there
are no sketches associated with this particular table).

2. Take a look at the variables for the table by clicking on the Variables tab.
This informs us which variables still need selecting before the design
coefficients and factors can be determined and copied back to the calcs.
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3. Return to the Table tab and select the required System Type by clicking on
a heading in the first column of the table. Also ensure an appropriate
Basic Seismic-Force Resisting System is selected in the second column.

4. When you are ready to continue the calculation, exit the table by clicking
the Copy to calcs button or hitting Enter on your keyboard. DO NOT close

the table using either of the  buttons to the top right of the window -
this will abort the calculation!

5. The Copy to calcs button will enable when you have made a selection.
Click this or hit the enter key to continue when you are ready and the
calculation will be completed.

6. Enter the rest of the design information, then click Finish - the calculation
will be completed.

7. Close the Progress Log and examine the calculations - they are of the
same form as the ones you saw in Tedds, and they show you exactly how
the results have been determined.

Viewing hidden text in Tedds for Word

There is a slightly different way of viewing Hidden Text in Tedds for Word.

1. Check the Hidden Calcs box to view any hidden text.

2. Uncheck the button to re-hide. 

NOTE This particular calculation has no hidden text, although it is worth
pointing out that some do.

Re-calculating in Tedds for Word

This is accomplished in a similar manner to Tedds.

1. Click the Calculate Section button.

2. The calculation will now run again - try changing some of the input data in
the interface.

3. DO NOT overtype values on the page prior to re-calculating - this is not
the way to change input data when using our library calculations (as
distinct from ones you have written yourself in the manner shown in the
previous section of the guide) in Tedds for Word.

Adding another calculation to the document

To start a new calculation in this document create a new Calculation Section.

1. Place your cursor below your existing calculations.

2. Click the Add New Calc Section button.
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3. Type a name for the new section – this will be the title of your next
calculation. Then click OK.

4. A new calculation should be placed below this title and thus within the
section.

5. Retrieve another calculation from the library and place it within this
section

6. To calculate just one section, we place our cursor within the section and
use the Calculate Section button.

Calculation Sections Explained
Refer back to the section Storing variables in Tedds (page 90). You will note
that here we have just one list of saved variables, known as Document
variables, as we have not used Calculation Sections. When we

use Calculation Sections, Tedds for Word saves the variables for each
calculation in a separate list unique to each section. These are knows as
Section variables. This ensures that all your input values are retained
separately from those for another calculation.

When you need to update a single calculation within a document that
contains many calculations, simply place your cursor within that section and
use the Calculate Section command. Place your cursor within the first
section in your document, and click the Variables button to view the unique
list for this part of the document.

Tedds for Word also has commands which enable you to manipulate the
calculation sections in your document. You can delete a calculation section,
copy it, paste it into a new location in your document and change it’s name.

What next?

Congratulations! You have completed the third exercise of the guide and
learned all you need to run calculations from the Library in Tedds for Word.

You can now save the document and re-use it as appropriate.

In the next section you will learn how you can make your own calculations
even more powerful: Writing Tedds Calculations - Stage 2 (page 104)

Writing Tedds calculations - stage 2 (US design example)
In this exercise we will investigate the use of math and data functions to build
on the stage 1 calculation, extending its capabilities and introducing some
more Tedds features.

Allow about 30 minutes to complete this exercise.
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Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Library and Show/Hide groups of the Tedds tab as shown below:

Defining input variables

Here are the new calculations we will add to the document you created in
exercise 2 in order to check the adequacy of an actual section.

1. Type the first two paragraphs, which are just text, below the existing
calculation.

2. Type the third paragraph and note that here we are defining three input
variables which are properties of the section we are checking. Ensure you
separate the text and all the expressions using delimiters (;) as shown.

Tedds math functions

1. Now type the fourth paragraph. Note how the Tedds math function min is
used here.
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NOTE A math function is always followed directly by its argument(s) in
parentheses as shown here. There are many more such functions
available in Tedds for Word. For full details of this and other
functions, consult the Mathematical functions topic, or refer to
the Writing your own custom calculations Index item in the
Library Access System, where all functions are completely
documented.

2. Now type the fifth paragraph - this is a simple expression that determines
and displays the actual stress in the section and assigns the result to the
variable fa.

Result accuracy and formats

It is sufficient to display the slenderness to one decimal place. To do this we
use a format string to override the default result setting of three decimal
places.

1. Now type the last paragraph of the new calculations as follows. Use the
Greek text button as you did earlier for the variable name λ.

2. The characters f1 following the ? are the format string. The format string
must immediately follow the ? with no space in between as shown. See
below for a fuller explanation.

3. Once you have finished typing this last expression, check the new
paragraphs carefully. Have you included all the delimiters? Have you used
subscripts correctly? Have you used the correct case for variable names
and units?

4. When you are satisfied that everything is correct, click Calculate All.

5. If you have an Error, then Interrupt and take a look at Errors and
troubleshooting (page 92). Fix any errors until your calculation works fully.

6. Review your results and look at the last paragraph to see how the format
string we used has operated:
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7. Click the Variables button to examine the list of saved variables and check
the stored value for this variable:

Result Format Strings Explained
You can override the default result setting, and reduce or increase the
number of decimal places for a displayed result, by using a result format
string after the ? result field. For example typing ?f2 will display the result to
two decimal places. It is important that there is no space between the format
string and the ?. The format string characters signify the following:

f = fixed format, and 2 = result to be displayed to 2 decimal places (can be
from 0-15)

Note that format strings only control the precision of the result displayed in
the document, not any result that is stored by Tedds.

For full details of this and other result formats, consult the topic Result
formats and precision (page 545).

Using data functions in calculations

The calculation as written is very useful, but we can enhance it further. One big
improvement is to include a Data List in the calculation, making the properties
of a huge number of section types and sizes instantly available.

1. First edit the two paragraphs underneath the heading Check Section as
follows:

2. Delete the following text for the section name - Try a Channel 9"x20".
Leave an empty line here.

3. Next delete just the values for the properties of the section. Replace them
with a ? result field. You should end up with the following:
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4. Finally, place your cursor as shown at the very end of the heading.

Retrieving Data Lists from the library

1. Click the button to Launch the Tedds Engineering Data. This opens a
special Set in the Library where all the Data Lists and Data Tables are
accessed. There is a lot of data in this set. We wish to find a Data List that
includes steel channels suitable for this calculation.

We will use the Find facility to help us locate such a table.

2.

3. Each item in the set has both a short and a long name, we are going to
find by the short name, so ensure View/Long Names is unchecked before
continuing.

4. Now select the Group we want to search in - US standards. Select Edit/
Find in the library, and type in channel as shown.
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5. The Library Access System finds the first item containing the find text, this
is not the item we require so click the green down arrow to find the next
item until the required item shown below is located, which is also
highlighted above. Channel section (LRFD 3-US)

6. Now to bring this item into your calculation, either double click the item,
or click the Execute… button. You should find the following has been
entered in your document.

7. This text inserted is a Tedds Data List Field which launches the specified
Data List (further details on Tedds Fields are given below),

8. Close the library once you have retrieved the Tedds Data List Field.

9. Now click Calculate All to calculate the document again.

10. The Data List will now be displayed when the Tedds Data List Field is
calculated:

11. Select the C9x20 channel section then click on the Details button to
examine the variables defined in the table.
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NOTE Note that we have used exactly the same names for the
properties in our calculation as those defined by the Data List - A,
rx and ry. This is the key to integrating all Data Functions with your
calculations. Remember that variable names are case-sensitive.

12. Click the Select button to return these variables to your calculations - you
will see that the section's properties from the Data List replace the ? fields
in your document and the Tedds Field displays the choice you made in the
Data List.
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13. The Data List is now integrated with your calculation. Re-calculate a few
times, each time changing your selection of channel size in the Data List,
to test this.

14. Click the Variables button and you will see that all the variables defined
by the Data List are listed and are thus available to be used in calculations.

15. Save the calculation at this stage, as we will build on it in the final exercise.

NOTE Whilst in this exercise the Data List was inserted into the
calculation via the Tedds Engineering Data button, it could have
been inserted via the Tedds Field button instead. The use of
Tedds Fields is covered in the next exercise Enhancing
Calculations.

Tedds Fields

1. Check the Field Codes box.

2. Look at the Tedds Field in your document and you will see the following:

3. The command that runs the Data List is now revealed. Uncheck the Field
Codes box again to return to the normal view of the document.

Tedds Fields Explained
Field Codes enable you to see and thus edit the hidden commands which are
Tedds Fields. These commands run special functions in Tedds like the Data
Lists. We will see some more Tedds Fields shortly. A Tedds Field will run when
it is calculated, like any normal expression. We hide the Tedds field, since you
would not want it to appear in a printed report. The Field Codes button
reveals the Tedds Fields. Tedds Fields should be treated like expressions, and
separated from text and other expressions in the same paragraph using
semi-colons.

What next?

Congratulations! You have completed the fourth exercise and learned
everything you really need to write powerful Tedds calculations. Maybe now
would be the time to have a go at writing a calculation of your own. It's a good
idea to start with something simple and build on the complexity as you
become more familiar with Tedds.

The next step in the guide, Enhancing Calculations (page 112) is about making
Tedds calculations still easier to work with, and is especially relevant if you
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envisage writing calculations for others to use. Even if your calculations are for
your own use you may find these further features beneficial so we
recommend that you review them. You might like to leave this step until you
have had a go at writing a calculation of your own using what you have
learned so far.

Enhancing calculations (US design example)
There is even more functionality available for our calculations than we have
seen so far. Whether you use these enhancements depends both on the
purpose of the calculation, and on the time you have available. Certainly these
features are very useful when you are writing calculations which others will
use (as we do at Trimble). Hence the Tedds library is packed with examples
which use these features, and you have already seen many of them when
running our calculations.

In this exercise we will enhance the previous calculation and you will see what
we are talking about.

Allow about 15 minutes to complete this exercise.

Buttons used in this exercise

The only new command you will be introduced to in this exercise is located on
the Insert group of the Tedds Calcs ribbon as shown below:

Tedds Input Fields

The Tedds Input Field speeds up the editing and often the creating of input
variables. We will replace all the existing variable definitions in the calculation:

1. Delete the entire definition for the Min. yield strength, Fy, from your page.
Leave your cursor on the empty line.

2. Click the Tedds Field button.

3. The following dialog will appear.
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Tedds Input Field
Prompt tells the user what the variable is and

appears on the page
Name the unique name of the variable
Units if the property has dimensions then

enter a unit here
Default value this value will be displayed initially for

user to edit or accept
Format the format displayed on the page
No. of decimal places the number of decimal places

displayed on the page

4. Enter the details shown to define the input for this variable: 

Prompt = Min. yield strength

Name = Fy

Units = ksi

Default value = 36

Format = Fixed

No. of decimal places = 0
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5. Accept the defaults for other options and click OK when you have
everything entered. 

NOTE We do not put a value in this dialog - this is entered when the
statement is calculated.

6. The following will appear on the line containing your cursor:

7. With the Field Codes button on you will see the following Tedds Input
Field preceding the text on the line.

8. Calculate your document to run it.

The Set Variable Value dialog appears, as shown above.

9. Because we already have a value defined for this variable it is displayed in
the input. You can accept it, or edit it as required. There is no need to find
and edit the variable value on the page, as it is automatically updated
when you enter a value in the Set Variable Value dialog.

10. Delete and replace the 3 remaining variable definitions in the same
manner – the table below shows what you need to enter in the Insert
Tedds Field dialog for each of the three variables in order from left to
right. When you have done this, recalculate your document to ensure that
your definitions are correct. 
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Insert Tedds Field Properties
Input Tf Le λL

Prompt Tie force Tie effective
length

Slenderness
limit

Name T Le λL

Units kips ft  
Default value   300
Format fixed fixed fixed
No. of decimal places 2 3 0

NOTE To enter Greek characters in the Insert Tedds Field dialog for
variable names like λ simply click the Greek character button

(  ) and then type in the equivalent Roman character, in this
case you need to type l (i.e. lowercase letter L) to get λ. To enter
Subscript or Superscript characters simply click the Subscript or

Superscript button ( ,  ) and then continue and type in the
subscript or superscript. Once you have reached its end click the
button again to switch back to typing normal text.

The Default value is entirely optional. If you enter one it will be
displayed the first time a calculation is run, otherwise the input
box will be empty. Delete the stored variables and re-calculate to
see the defaults in operation.

Tedds Interface Designer
Although The Tedds Input Field can be used to create all the variables
required in a calculation, if you would like to give your calculations a slicker
appearance we would strongly recommend using the Tedds Interface
Designer instead. This easy to use tool allows you to place all the input
variables on a single interface along with sketches and notes if required. For
a worked example and further details of how to use the Tedds Interface
Designer refer to the Tedds Help.

Tedds Show Fields

The final thing we would like the calculation to do is automatically assess our
section and report in the document whether our chosen section is passing or
failing and, if it is failing, why. We use a Tedds Show Field to do this.

1. Enter the following two paragraphs after your existing calculations:
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2. These last two values help us assess the utilization of the section for the
two checks. Assigning them to output variables will help us with creating
Tedds Show Fields. Calculate your document once you have written them
to ensure they are working properly before proceeding.

3. Place your cursor beneath these paragraphs and click the Insert Tedds
Field button.

4. Select the Show tab. The Show Field we want to create will test whether
the section is failing stress and output a message to give the status of the
check.

5. Select the Condition type option and input the following information:

6. The output of the Tedds Show Field consists of two text messages known
as output strings. Only one output string is displayed in the document
depending on the status of the condition.

7. Check your input carefully, then click OK to enter the Tedds Show Field in
the document.

8. When you have OK'd the input, click the Field Codes button to view the
resulting Tedds Show Field. It should be as shown below. If your Tedds
Show Field is incorrect, the best thing to do at this stage is to delete it and
run through the Insert Tedds Field dialog again.
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Using logic In Tedds

Take a close look at this Tedds Show field, and you can see how we use a
simple logic statement to output one of two pieces of text using the if logical
operator.

if(check_stress > 1, “Section fails stress check” , “Section OK for 
stress”) 

The general form of this logic expression is as follows:

if(condition, true_output, false_output)

NOTE You can use this kind of expression to define variables using a
condition. The outputs can be values, expressions or further logic
expressions.

For example:

a = if(b > c, 10, 20) = ? 

Check the table of Logic Functions in the Mathematics (page 524) topic
for full details.

1. Now calculate your document to calculate the Tedds Show Field. You
should find you have something similar to the following in your Progress
Log and you will also see the output text on the page where you placed
the Tedds Show Field.

2. Change some of your input values and re-calculate a few times to test
your full calculation and both the pass and fail output of the Tedds Show
Field.
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Tedds Data List Fields

In the previous exercise we inserted a Data List Field into the calculation using
the Engineering Data button. However, it could have been inserted more easily
using the Tedds Field button:

1. With the Field Codes button on you will see the following Tedds Data List
Field:

2. Delete the entire definition of this field from your page. Leave your cursor
on the empty line.

3. Click the Tedds Field button.

4. Select the Data List option and scroll down to select the same .dls file
name as that shown in the line you just deleted above.

5. Input the Prompt as Select Section.

6. To input the Default page and Default item click the ellipsis button ( ) and
then select the page and section size that you want to appear as the
default.

7. Accept the defaults for other options and click OK when you have
everything entered.

8. Calculate your document to run it once more.

What next?

Congratulations! You have completed the final exercise in the guide and are
ready to begin using Tedds to its full potential.

Here are a few things you could try next:

• Create another Tedds Show Field similar to that above for the slenderness
check - following is the logic statement you would use for this:

Condition    check_slender > 
1

• Create a Tedds Show Field to give the overall status of the section, checking
both slenderness and stress. Try the following:

Condition    check_slender > 
1

Yes PASS
No Section fails!

• Take a look at Tedds Message Fields. The input for these is the same as
Tedds Show Fields but their output is displayed in a Message box, rather
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than in the document. You will see examples of their use in the Tedds
Engineering Library Calculations.

• Try creating Messages using the Value of Variable option to show the
values of the minimum area and radius of gyration in the Log before the
Data List is displayed.

Of course there's much more for you to discover. We wish you an enjoyable
and productive time in using the program in your day-to-day work, and
exploring its capabilities more fully.

If you would like to read up on further information about Tedds, then we
recommend the Tedds Help system, which you can access in the usual way.

Some Tedds dialogs have context sensitive help. To see this simply click the
Help button in the dialog.

We also run training courses in most locales, for further information on
availability contact the Tedds support team in your region, simply click the
Support icon in any of Tedds’ automated calculations.

Quick start guide - Eurocode design examples
The Quick Start Guide comprises the following 5 exercises, which are best
worked through in sequence:

• Using Tedds (page 119)

• Writing Tedds Calculations - Stage 1 (page 140)

• Using Library Calculations in Tedds for Word (page 152)

• Writing Tedds Calculations - Stage 2 (page 162)

• Enhancing Calculations

Using Tedds (Eurocode design example)
In this exercise you will design a steel beam in order to learn how to use any of
the calculations in the extensive Tedds Engineering Library.

Allow about 15 minutes to complete this exercise.

Design information required for this exercise

We wish to check the following RHS steel beam:

Design Information
Design Code EN1993
Dimensions Length 5.0 m

Effective length factors 0.85
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Design Information
Design Forces Moment 135 kNm

Shear 60.0 kN
Axial compression 40.0 kN

Proposed section Shape RHS preferred
Steel grade S275H

Running Tedds and locating calculations

You need to find an appropriate calculation, run it and enter the design
information. You will see just how easy this is.

1. Launch Tedds from the Start Tedds icon on your desktop.

2. If this is the first time you are starting Tedds, or if you are updating from a
previous version of Tedds, then you will see the Tedds Setup Wizard
which allows you to configure Tedds with your company details and so on.
Work through the various pages of the Setup Wizard and when you reach
the end click Finish.

3. From the Tedds Start wizard click Tedds (as opposed to Tedds for Word)
as the version to run.

4. Now you will see the Tedds Start Page: 
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NOTE For these exercises, the locale shown above should be set
appropriate to your region ( UK, Europe, or Asia).

5. First, click the New tab.

6. Then, click New Document:
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You will see the Select Calculation dialog box appropriate to your locale:
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7. Click on the All folder.

• The instructions about using Tedds are displayed in the right hand
panel.

• Every Tedds calculation is listed in the left hand panel.

• When you click on a calculation, notes relating to it are displayed on
the right side.

NOTE If the Show Examples option is checked, you will also see all of
the examples that are included in the library - these demonstrate
the potential scope of each of the calculations, show you the
typical output, and can be used to start your own designs.

To find a calculation – you could simply click on a folder in the list to open
it, then click a heading to select a calculation. However for this example
the Find in list feature will be used instead.

8. Type steel member design in the Find in list field. 

NOTE Find in list will locate the first item title in the library that
contains the exact text entered. Keywords in the item description
are also considered provided the option to Find in item
descriptions remains checked.

9. The first item in the library matching the entered text is selected - we are
looking for the 'Steel member design (EN1993)' calculation. If necessary
click Next until it is selected as shown below. 
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NOTE Note there is also a 'Steel beam analysis & design (EN1993)'
calculation available which will determine the design forces
before proceeding to the design.

10. Click the Calculate button at the bottom right of the dialog: three things
will happen: 

• A new calculation document will open – you will see this in the
background.

• The Interface for the chosen automated calculation will be displayed at
the first page.

• Another window, titled the Progress Log will also be displayed – we will
explain this shortly.

Entering data in the automated calculation user interface

The user interfaces for all of the calculations in the Tedds engineering library
use a consistent style which ensures they are easy to use. You select the
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design options you require and enter values for dimensions, loading etc. all of
which are clearly explained. See the box below for more information.

The General Automated Calculation Interface Explained

An '(i)' symbol to the left of a variable description shows that there is
more information available about this particular variable. The
information area (at the top of the dialog) displays any information
about the selected variable (if available). You can also see this
information by hovering the cursor over the '(i)' symbol.
Notes - display details about the calculations being performed.

Variables - lists all the current variables. Values can be selected from
here to enter into the current interface.

Feedback - this allows you to send feedback to the development
team.

Support - tells you how to obtain support in your region.

Data fields - enter information in these fields . Where appropriate,
variables may have validation which prevents invalid information
being entered.
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The General Automated Calculation Interface Explained
Buttons... - allow you to enter more information or select a particular
item.

Next/Back/Cancel/Finish - continue to the next page / return to a
previous page /stop the calculations at the current point / return the
data to your calculation document.

1. In this calculation all the values for design forces and section details can
be specified on the first page of the interface and the calculation results
are also displayed.
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Note that additional design and output options are available by clicking
the appropriate buttons.

Before we proceed to enter the data take a moment to review the design
information given at the beginning of this exercise.

2. Enter the Design bending moment - major axis as 135 kNm.

3. Enter the Design shear force - major axis as 60 kN.
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4. Finally for the Axial load applied, click No applied axial force, change to
Design axial compression force and enter a value of 40 kN.

5. Click Preview results 

NOTE With Preview results selected, as you change the values and
options for your design the calculation results are immediately
updated.

6. Now you need to choose a section to check, but you don't need to go off
and find a list of section properties, since all the data required can be
accessed within Tedds. In the Span details area, click the Selected section
'...' button to display the Data List for steel sections.

Data Lists

You are now looking at a Data List: a tool that allows you to choose a section
and see its properties at the click of a button.

Data Lists Explained

Choose the shape from the left hand pane.

Choose the size from the right hand pane.
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Data Lists Explained
Details - click to see properties of the chosen selection.

Select - click to select the chosen selection.

1. Click the Rectangular Hollow Section section type - this is known as the
Data List page you require.

2. Select the size and thickness you require.

3. Click on the Details button to see all the properties of the selected section
– (note that the details window updates instantaneously when you click on
another section). In this case, both a 250x100x10 RHS and a 300x200x6
RHS may prove adequate but which is the lighter?

4. Check the properties of both sections. The 300x200x6.0 RHS section is
lighter and may be preferred – choose this section and click Select to
continue with the calculation using this section size. 

NOTE You will find Data Lists for all kinds of engineering data
throughout Tedds calculations; there are data lists for bolts,
reinforcing bars, timber sections and much more. However, they
all work in just the same simple and intuitive way.

5. The number next to 'Selected section' allows you to design beams using
two or more sections. In this example a single section is sufficient so no
change is required.

6. Set the steel grade to S275H.

7. Enter a restraint spacing of 5000 mm for both the major and minor axes.
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8. Click Design options... to view another interface page for defining
equivalent uniform moment factors etc.

9. Leave the default values as shown. 

10. Click OK to return to the main page of the interface. 
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11. Click Preview output... and scroll through the output, click Cancel when
done. 
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12. You can now choose the level of output you require by clicking Output
options... From here you can also give the calculation a title. 

13. Click OK

Automated calculations and library items

You have probably realised by now that this calculation caters for all kinds of
steel sections, dimensions and loading. For each possibility and check, there is
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an item in the Library - in fact this calculation has over 150 items. When you
use a calculation like this, Tedds automatically chooses the appropriate items
for your options and input, and puts them together to make up the complete
design.

• To accept the results and continue, click Finish

The Progress Log

The progress log helps to keep you informed about a calculations progress
during lengthy calculations, it is also used by some calculations to report the
status of specific checks or other pertinent information. When writing your
own custom calculations you can add information to the log or you can modify
the default options to provide more detailed information about what your
calculations is doing which can be helpful for resolving errors.

This particular calculation does not use the progress log to report any
additional information.

Examining finished calculations

OK, but how is your chosen section performing? The main interface displayed
the design forces, capacities and utilisations but you may want to examine the
results in more detail.

1. Scroll through the calculation and examine the y-y axis flexural buckling
resistance check: 

2. There’s another really important point to note about the calculations
displayed – they don’t just show you results, but how those results have
been arrived at. 

NOTE Tedds is not a ‘black box’ where all you can see is the result, and
all you can do is accept it. In Tedds you can see exactly what’s
going on. You can see what checks Tedds does. What design
method does it use? From where did that number come? The
answers to all these questions are right there in front of you! This
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is a major reason why Tedds is so popular with engineers the
world over.

Furthermore, if you need an example of how to write your own
calculations, then look no further. That's exactly what you are
looking at - every calculation in the library is an example of how to
write your own. How do I write a math expression in Tedds? How
do I use logic or a math function in Tedds? Look again at the
check shown above and you will see the answers to these
questions. We will look more closely at how to write your own
calculations in the next exercise Writing Tedds Calculations -
Stage 1 (page 140)

Re-calculating

Changes are a fact of life for engineers, they always have been, and they
always will be! You need to be able to take account of any changes and update
your calculations quickly. With Tedds this is no problem.

Say that your beam needs to be 0.1 m longer since the beam which supports it
needs to be moved, to avoid a clash. Is your section still OK?

1. Click Calculate on the Home tab (highlighted above). 

The calculation will run again, but this time all the information you
entered last time is remembered. It’s a simple matter to change the
required data.

2. Change the distances between restraints to 5100 mm.

3. What is the effect of this change on the design? Check the Calculation
results and/or the output to see. 

Tedds makes it easy to update calculations – simply re-calculate and you
can update your design quickly.

Hidden Text

All the calculations performed by Tedds are available in the output and in
general so they are – but at times some intermediate calculations are hidden
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to reduce the amount of output. It is simple to view these and to include them
in your printout.

1. Open the application’s View tab then use the Hidden Text option and
examine the check again. You will see all the hidden text underlined with
dashed lines.

2. In this example there are no hidden calculations but you will see the
names of the Library items used in the output. 

3. Select View/ Hidden Text again to hide the Library item names. Now let
us consider how to print calculations.

The header & printing

Obviously you want professional looking printed output. You will see that you
have a header region at the top of the calculations, but how do you set its
details?

1. Click the Header button highlighted above – this opens a dialog where
you can enter some project details in your header.
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2. On the Company page you can define your own company details. Do this
now, if you want to. If you don’t, then remember to do so before you print
your first “proper” set of calculations.

3. On the Template page you will see the Tedds template which your
calculations will use and the logo file which Tedds will add to the template.
You can change the template and logo if necessary – click this tab and
check that its details are correct.

4. Maybe you would like to try a different style of template, there are a
number of standard templates to choose. Click the Select… button to see
these. Choose the template you want to use and you will see a preview of
what calculations produced with that template will look like. When you
have found the template you want to use click OK to use it. 
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5. If you have a copy of your company logo in electronic format, and the
template style you select supports a logo, then you can add your logo to
the template. Make sure that the logo is available on your computer,
Browse to find it, and then click OK to add it to the template.

6. Click OK to exit the Header Properties dialog and view your finished
calculation.

7. If the logo is not the right size open the Header Properties dialog once
more and change the Scale of the logo to make it fit the template
correctly.

8. Once the template and logo are correct click  to display the file
menu. From here you can Print the calculation to obtain a hard copy.

9. Congratulations, you have produced your first piece of work with Tedds!

To finish this example let’s look at a few points about saving and outputting
your results.

Saving and output options

You can save every Tedds calculation to a unique file that you can recall and
edit any time in the future. The file extension .ted is unique to Tedds.

1. Click  to display the file menu.
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2. Save your file and give it a name - it’s a good idea to save all the examples
you will produce in the course of completing the guide for future
reference.

3. The output you see in the document can be printed direct to a printer, but
you have other options.

4. Click the drop-down button adjacent to Send To on the file menu to view
these.

5. Choose the option of sending the output to Word and experiment with
the other options if you wish. Once your output is in a Word document,
you can edit it as much as you wish.

6. By clicking the drop-down button adjacent to Save As on the file menu
you can also save the active document, or all documents in the active
project to PDF.

Performing a new calculation

How do you start a new calculation in Tedds?

• Click  to display the file menu; then click  

The Select Calculation dialog will open, from where you can select and start
a new calculation in a new document.

Managing multiple related calculations

Can several calculations be saved in a single document?

As stated earlier, each calculation must be saved to a unique file - however
multiple files can be collected together in a single project. They can then be
organised as required using the Project Manager.

Benefits of projects include:

• you can specify a shared document header for all the project files,

• locating files is made easier - when you open the project all files within it
are opened automatically,

• calculations can be placed into named groups, making them easier to
manage.

To start a new project:

1. Click  to display the file menu; then from the menu choose the New
Project button.
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A new empty project is created in the Project Manager.

2. New or Existing Documents can then be added and arranged into folders
as required either by right-clicking, or via the Project tab.

What next?

Congratulations! You have completed the first exercise and now know all you
really need to make use of the wide range of calculations available in the
Tedds Engineering Library and to begin using Tedds productively. Take a look
through the index and try some more. How about:

• carrying out a wind load calculation?

• designing a retaining wall?

• designing an RC footing?

• analysing and designing a timber rafter, beam or post…

The choice is yours, and all these calculations work in the same
straightforward, intuitive way. Some calculations may also include Data tables
which are designed to look like tables from printed references, so that you
immediately feel at home with them. Indeed we hope you will find yourself
recognising them.
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What can you do if the Library does not contain the exact calculation for which
you are looking? You need to perform a number of calculations, and could do
with a calculation to help you out with these. First of all, TELL US:

• if you are running a calculation, then you will see a Feedback button to the
left-hand-side of the interface,

• if you are not running a calculation, then you can choose the Feedback…
option from the Help menu.

We are constantly working to expand our Engineering Library and your input
helps us do this!

But you don’t have to wait until we produce these for you – you can write them
yourself. We will look at this in the next exercise: Writing Tedds Calculations -
Stage 1 (page 140)

Writing Tedds calculations - stage 1 (Eurocode design example)
Having looked at using calculations from the Tedds Library we can move on to
look at one of the most exciting and powerful features of Tedds - the ability to
create your own calculations. This is where an initial investment of time can
give you huge returns later. Once you have invested time writing a calculation,
you can use it over and over again, you can also update calculations in an
instant, making further great savings. You can also customise and extend the
Library of Tedds calculations to match the calculations that you use most
frequently in your office.

In this exercise we will see that writing Tedds calculations simply uses the
math and logic conventions with which you are already conversant. We start
by looking briefly at very simple examples introducing the basics of calculating
with Tedds for Word. We then create a “real-world” example, covering the
main features of writing effective calculations in depth.

Allow about 30 minutes to complete this exercise.

Running Tedds for Word

To write calculations you need to use Tedds for Word.

1. Launch Tedds from the icon on your desktop.

2. Click the option to run Tedds for Word - Microsoft Word will now open
with Tedds integrated. If this is the first time you've run Tedds for Word a
Release Notes document and the Library Access System will open too. 

NOTE It is important to realise that you are looking at Microsoft® Word
with the Tedds capabilities added. We only add to the
functionality of Word, so you can do anything you would normally
do in Word. Treat a Tedds Calculation Document just like you
would any ordinary Word document. You can type reports, import
files and text, embed spreadsheets and so on. And of course you
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can add calculations to your reports; either straight out of the
Tedds Engineering Library, just as you did in the previous
exercise, or create your own.

The Tedds interface

The commands you will need to use in this exercise can all be found on the 
Tedds Tab of the ribbon as highlighted below:

You will find a Word Document open, which looks very similar to the Tedds
output document.

The document Header can be edited in a similar manner to that in Tedds by
clicking the Edit Header button - this button is highlighted above.

• In this exercise two documents will be required, so open a new blank one
by selecting File/ New Tedds Document

Now we are ready to begin writing our first calculation in Tedds.

The basics

Writing calculations in Tedds for Word is easy. Tedds follows standard
mathematical rules and uses standard mathematical operators. For example 1
+ 2 would add 1 to 2. To write an equation use the = sign, and to specify where
you want to see the answer use the ? symbol. For example:

1 + 2 = ?
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• Type the above anywhere in your document. When you calculate this
equation the ? will be replaced with the answer.

Calculating in Tedds for Word

To calculate equations in Tedds for Word you can use one of several
Commands:

All - this will calculate the whole document.

Calc Section - this will calculate the Calc. Section your cursor
is in.

Selection - this will calculate only equations you have
highlighted.

1. In the Calculate ribbon group, click All to calculate your equation: 

1 + 2 = 3.000

2. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and troubleshooting
section below.

Units in Tedds

Tedds automatically takes units into account, so you don’t need to apply
conversion factors to get the right answer. Tedds will also check that the units
you are using are dimensionally correct and warn you if they aren’t.

1. Type the following in your document using the same case as you see here:

890 mm + 1 ft + 8.5 in = ? m

2. In the Calculate ribbon group, click All to calculate this equation: 

890 mm + 1 ft + 8.5 in = 1.411 m

3. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and Troubleshooting
section below.

Get familiar with Tekla Tedds 142 Tekla Tedds Quick Start Guides



Defining and using input variables in Tedds

Defining variables is the key to writing effective Tedds calculations. We will use
the following calculations to demonstrate this. Do not type this yet - we will
show you how to enter the calculation below (in stages).

1. Close the current document, (because two documents were opened at the
beginning of the exercise you should still have an empty one displayed).

2. Type in the following two paragraphs in the empty document.

The first paragraph is just a title for our calculation. The second paragraph
is a standard Variable Definition which uses a superscript in its units.

3. To type the unit N/mm2, first type N/mm, then click the Superscript 
button.

4. Now type 2, then click the button again to return to normal text. Once you
have finished typing, read the notes in the box below for an explanation
of a standard variable definition, and to check you have typed it correctly. 
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The Standard Variable Definition Explained

Note the following:

• The expression defines the variable's unique name, current value and
units.

• Variable names are case sensitive, cannot contain spaces or be function
names (like sin for example). Other than that you can use pretty much
anything you like as you can see, including Greek text and Subscripts.

• The semi-colon is important. It is a delimiter that separates an expression
from text, or another expression in the same paragraph. If you omit
delimiters in either of these cases, then you will get an error when you
calculate your document.

• The equality sign '=' defines an expression. Without it no calculation will
be performed.

• Spaces and Tabs are not significant in this, or any other, expression. Use
as many or as few as you wish to make your calculations look presentable
and easy to read.

• We will look at Units in more detail shortly but, for now, note that they are
also case sensitive and have a correct syntax, that you must use (as shown
above).

5. Now enter the following paragraph which uses this variable:

6. Use the Insert multiplication symbol  button to enter the ×
mathematical operator - do not use a lower-case x.

7. Check the notes in the box below for a detailed explanation of the
components of this paragraph. 
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Mathematical Expressions Explained

Note the following:

• The same observations as before apply to delimiters, explanations, spaces
and units.

• You cannot omit math operators in expressions: Tedds cannot calculate
0.6Fy, you must type the expression as shown above, including the × .

• The result field ? is used to tell Tedds where the result should be output -
when calculated the ? will be replaced with the result of the expression.

• The value of the result will be in the result unit you specify. Ensure this
has the correct form and dimensions. Do not omit this.

• The expression contains a variable (Fy) that is defined in the calculations
before (that is above) the point where it is used. Expressions should not
contain variables that are not yet defined.

• The expression contains two equalities and performs two functions:

• calculates and displays the value we wish to know - the result.

• assigns this result to a variable named - Fa

• It is not obligatory to always do this. You can write a valid expression to
perform just one of these functions by either omitting the variable name
and the first equality, or the second equality and the ? and unit.

8. In the Calculate ribbon group, click All.

9. Your expression has been calculated and the result has replaced the ? as
before. if you have an error, take a look at the Errors and
troubleshooting section below.

10. Here are the next two paragraphs of the calculation. The first paragraph is
a standard variable definition, while the second uses both Tf and Fa to
determine the minimum section area and creates a variable AMIN with this
value.
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11. Type the first paragraph, then follow the steps below to enter the second.

12. The second paragraph contains examples of the use of Subscript (often
used for name suffixes) and Superscript (used for powers).

13. To type the variable name AMIN, first type the A, then click the Subscript

 button.

14. Now type MIN, then click the button again to return to normal text.

15. To type the unit cm2, first type cm, then click the Superscript  button.

16. Now type 2, then click the button again to return to normal text.

17. Click Calculate All to calculate these expressions once you have entered
them.

18. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section below.

19. Here are the final three paragraphs of the calculation. Follow the steps
below to create these.

20. Here we define two new variables to be used in the expression in the final
paragraph.

21. Type the first paragraph, entering the subscript for the name Le as you did
before.

22. Follow the steps below to enter the second paragraph.

Get familiar with Tekla Tedds 146 Tekla Tedds Quick Start Guides



23. Use the Greek text  button to enter the name λL

24. First click the button indicated, then type the Roman equivalent of the
Greek letter – (l in this case for lambda).

25. Now click the button again to return to normal text, then enter the
subscript suffix as you did above using the Subscript button. 

NOTE A much easier way of entering Greek characters and more
complex units is to use the Tedds Greek Characters, Tedds SI
Units and Tedds US Units toolbars which can be selected from the
Tedds Tab on the ribbon.

26. Use Copy and Paste to enter this name in the final expression.

27. Now click Calculate All to calculate these final expressions:

28. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section below.

Storing variables in Tedds

1. Click the Variables button.

2. The Variables dialog box will open, displaying the stored values.

3. You will note that we do not just store the variable name and value, but
also the dimensions. This is how Tedds handles all the unit conversions
for you. 
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NOTE You can Delete variables from this list if you wish:

4. Cancel from this dialog, and edit one of the values on the page - say the
tie force to Tf = 600 kN. Now check back in the stored variables and you
will note the stored value has not changed.

5. Re-calculate the document and check back in the list of variables - the new
value has now been stored. 

NOTE An important observation — the stored value of a variable only
changes when you re-calculate the definition, not when you just
edit it on the page. If you edit the value of a variable you must re-
calculate the variable definition, and any calculations that use it
to update them.

More about units in Tedds

1. Change the tie force back to its original value Tf = 450 kN. Calculate again
to store this new value.

2. Look again at the values displayed in the Variables dialog box. You will
note that many of these values are not those displayed in the document.

3. The values in the dialog are in the Base Units in which Tedds performs all
calculations and from which all the other units are derived. The base units
are shown in the following table: 

Tedds Base Units
 Metric

Length m
Mass kg
Time s
Temp °C

NOTE If you hover over a variable name in the Variables dialog box a
summary list is displayed showing the value of the variable in all
applicable standard units.

4. Note that our calculation does not include any conversion factors. 

NOTE Tedds' unit handling is a massive help – Tedds comes with a huge
number of defined units and you can add more if needed.

Dimensional Checking - Tedds checks all dimensions in your
calculation and will inform you if these are incorrect. This is why
you should use units consistently throughout your calculations.
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Do so, and you can have total confidence that your calculations
are dimensionally correct.

5. Save the document and give it a name - call it “Exercise 2” - as we wish to
build on it later in the guide.

To complete this exercise, in the next section we will take a brief look at
handling errors in calculations.

Errors and troubleshooting

The problem with a lot of guides is they only show you the right way to do
things, and then you have no idea what to do when something goes wrong!
Let's look at a couple of errors and how to fix them.

• If you have an error in your calculations, Tedds will inform you when you
calculate your document and the error is encountered. The first thing you
should do is Interrupt the calculation process.

• If you have jumped to this section because you have encountered an error
previously, then click the Interrupt button in the dialog (see step 11 below),
review the details and then return to fix the error in your calculations and
continue with the exercise.

If your previous calculations were error free, then you will have had no need to
look at this section. We shall therefore create some calculations which do have
errors so that we can see how to handle them.

1. Open a new blank document for this example.

2. Click the Tedds options  button (on the More menu).

3. The Options dialog box will open, click on the Calculating / General page.
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4. Make sure that the options above are checked and then click OK. We can
now proceed to create some calculations with errors.

5. Enter the following 2 paragraphs as they appear here - see if you can spot
any errors as you do, but don’t fix them yet!

6. Now click the Calculate All button to calculate the calculations - you
should see the Expression Error dialog: 
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Expression Error dialog Explained

This is the specific error.

This line is the one that Tedds cannot evaluate, so look here to spot
the error.

This is an explanation of the error, together with some typical
causes.

This is the button you should generally click,

7. Tedds flags the first error, and gives you some help in fixing it.

8. When you are ready, click the Interrupt button. Tedds highlights the error
for you in the document as shown below: Once we fix the problem and re-
calculate, this error message will automatically disappear.
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9. Check the rule about delimiters (see The Standard Variable Definition
Explained info box earlier in this topic). There should be a semi-colon
between the expressions to separate them. Add this in and re-calculate
the entire document.

10. Now we will get the next error – the variable WD is not defined. We have
typed WD instead of wD and variable names are case-sensitive.

11. Click the Interrupt button to stop the calculation.

12. Correct the variable name on the page to wD and re-calculate. The
calculations should now complete with no problems. Tedds automatically
deletes all error messages from the page.

What next?

Congratulations! You have completed your first Tedds calculation. You can
now begin writing effective calculations in Tedds for Word. There are more
great features that make such calculations even more powerful, and we will
show you these later.

Now we are going to look at using calculations from the Engineering Library in
Tedds for Word: Using Library Calculations in Tedds for Word (page 152)

Using library calculations in Tedds for Word (Eurocode design example)
We have shown that you can write your own calculations in Tedds for Word,
but you can also use the Library Calculations. The advantage of this is that you
can add additional text to your output easily, because it is already in a Word
document. You can also combine more than one calculation in a document,
add pictures and tables - anything you need to create a polished report. And if
you need to update the calculations you can do it directly in the document.

Sometimes, of course, you just need an answer right now and the polishing
can wait. That's why we have Tedds too. With the two modes, you have both
bases covered.

In this exercise we will use the Timber member analysis & design (EN1995)
calculation to show you how to run a typical calculation from the extensive
Engineering Library in Tedds for Word.
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Allow about 15 minutes to complete this exercise.

Information required for this exercise

Analysis Information
Use the following information for the calculation.
Beam span Length 3000 mm
Supports: Pinned
Loading
Self Weight factor 1
Dead Load Full UDL 2 kN/m
Imposed Load Full UDL 3 kN/m
Load Combination 1 1.35 x Dead + 1.5 x Imposed

Design Information
Use the following information for the calculation.
Type of beam Flitch
Breadth of timber members 44 mm
Depth of timber members 195 mm
Number of timber sections 2
Timber grade stresses C24
Service class of timber 1
Breadth of steel members 8 mm
Depth of steel members 190 mm
Number of steel members 1
Steel design stress 235 N/mm2
Bolt diameter 12 mm
Characteristic tensile strength 400 N/mm2

Length of bearing 100 mm
Compressive edge of beam Restrained
Duration of loading Long term
Maximum allowable deflection 0.004 x span

Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Tedds tab as shown below:
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Using Calculation Sections in Tedds for Word

As stated, one of the reasons for running library calculations in Tedds for
Word is so that you can combine a number of calculations in a single
document. In this case, each calculation should be placed in a separate
Calculation Section, so we will start off by introducing one of these. Calculation
Sections will be explained in more detail later in this exercise.

1. Open a new Tedds document.

2. Insert a New Calc Section by clicking the appropriate button.

3. The following dialog will appear - enter a name for the section. This will
form the title for the calculation in the document.

4. Click OK and this will enter a Calculation Section Title in the document. We
place a calculation below this title and thus within the section. You should
note that your cursor is now on the line below the section title.
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Selecting calculations from the library

All the library calculations are available from the Library Access System. To use
a calculation we retrieve it from the Library, place it in our document and
calculate it.

1. If it is not open already, launch the Library Access System.

2. Click the Index button if the index is not displayed and ensure you have
the Tedds calculations index option selected.

3. To open a folder in the index simply double-click it. Open the Beams
folder, then the Timber member analysis & design (EN1995) folder,
then select (click on) the Timber member analysis & design (EN1995)
item.
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4. To place this calculation in the document, click the Execute button in the
library. (You can also double-click on the selected item to do this.) In both
cases you will see the Insert Calc Item dialog.
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5. This dialog allows you to control where the item will be added. Simply
choose the options as above then click OK and the item will be pasted at
the cursor position in the document. 

NOTE Note that one of the options in the dialog is to add a new Calc
Section. In this example we have already added one manually, so
as shown above, on this occasion the option should be
unchecked.

6. You should now have the following in your document.

7. We can now close the Library - there is no need to have it open while a
calculation is running.

8. Click the Calculate Section button to start the calculation.
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9. The Interface for the calculation will now be displayed, along with the
Progress Log. You are now in familiar territory as everything from this
point works exactly as you learned in the first exercise – Using Tedds
(page 119)

10. Click the Notes button and briefly look at the notes before proceeding.

11. You will be comfortable with entering information in the interface by now,
so we won't show every input step in detail. The data to be entered is
given at the start of this exercise.
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12. Click the Design options... button, enter the bolt diameter and tensile
strength. Take a moment to review the other inputs asked for on this
page, then click OK

13. Click the Geometry... button, enter the span and support data then in the
Section box, click Select...

14. Check the Flitch box, then enter the timber and steel plate properties.

15. In the droplist at the top of the dialog, select Timber (EC5) to display the
timber strength classes datalist, and from there click Softwood species, C24
and Select

16. Click OK to close the Section dialog.

17. Click the Loading tab and then on the right side of the dialog click + Add
to add a Beam member load. Enter this as a Permanent Load Case UDL of
2 kN/m in Global Z.

18. In in the next row enter a second Beam member load, this time an
Imposed Load Case UDL of 3 kN/m in Global Z.

19. Click on the Load Combinations tab - as the factors are the those we
require, simply click OK.

20. Select the nominal yield strength for the steel plates.

21. At this point you can review the force and deflection diagrams if required.

22. Click the Deflection criteria... button, enter choose span/250, enter a
deflection limit of 12mm then click OK

23. Click OK to return to the previous page of the interface and you will see
the calculations have been performed and utilisation ratios determined
while you are still in the interface.
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24. If the design is not satisfactory it is a simple matter to use the Member
details... button to adjust the section to achieve a satisfactory design. You
should find that the flitch beam passes all the checks so click Finish to
close the interface and place the calculations into the document.

25. Close the Progress Log and examine the calculations - they are of the
same form as the ones you saw in Tedds, and they show you exactly how
the results have been determined.
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Viewing Hidden Text in Tedds for Word

Some calculations are hidden however. There is a slightly different way of
viewing Hidden Text in Tedds for Word.

1. Check the Hidden Calcs box to view any hidden text.

2. Uncheck the button to re-hide.

Re-calculating in Tedds for Word

This is accomplished in a similar manner to Tedds.

1. Click the Calculate Section button.

2. The calculation will now run again - try changing some of the input data in
the interface.

3. DO NOT over-type values on the page prior to re-calculating - this is not
the way to change input data when using our library calculations (as
distinct from ones you have written yourself in the manner shown in the
previous section of the guide) in Tedds for Word.

Adding another calculation to the document

To start a new calculation in this document create a new Calculation Section.

1. Place your cursor below your existing calculations.

2. Click the Add New Calc Section button.

3. Type a name for the new section – this will be the title of your next
calculation. Then click OK.

4. A new calculation should be placed below this title and thus within the
section.

5. Retrieve another calculation from the library and place it within this
section

6. To calculate just one section, we place our cursor within the section and
use the Calculate Section button.

Calculation Sections Explained
Refer back to the section Storing Variables in Tedds. You will note that here
we have just one list of saved variables, known as Document variables, as we
have not used Calculation Sections. When we

use Calculation Sections, Tedds for Word saves the variables for each
calculation in a separate list unique to each section. These are knows as
Section variables. This ensures that all your input values are retained
separately from those for another calculation.

When you need to update a single calculation within a document that
contains many calculations, simply place your cursor within that section and
use the Calculate Section command. Place your cursor within the first
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Calculation Sections Explained
section in your document, and click the Variables button to view the unique
list for this part of the document.

Tedds for Word also has commands which enable you to manipulate the
calculation sections in your document. You can delete a calculation section,
copy it, paste it into a new location in your document and change it’s name.

What next?

Congratulations! You have completed the third exercise of the guide and
learned all you need to run calculations from the Library in Tedds for Word.

You can now save the document and re-use it as appropriate.

In the next section you will learn how you can make your own calculations
even more powerful: Writing Tedds calculations - stage 2 (page 162)

Writing Tedds calculations - stage 2 (Eurocode design example)
In this exercise we will investigate the use of math and data functions to build
on the stage 1 calculation, extending its capabilities and introducing some
more Tedds features.

Allow about 30 minutes to complete this exercise.

Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Library and Show/Hide groups of the Tedds tab as shown below:

Defining input variables

Here are the new calculations we will add to the document you created in
exercise 2 in order to check the adequacy of an actual section.
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1. Type the first two paragraphs, which are just text, below the existing
calculation.

2. Type the third paragraph and note that here we are defining three input
variables which are properties of the section we are checking. Ensure you
separate the text and all the expressions using delimiters (;) as shown.

Tedds math functions

1. Now type the fourth paragraph. Note how the Tedds math function min is
used here.

NOTE A math function is always followed directly by its argument(s) in
parentheses as shown here. There are many more such functions
available in Tedds for Word. For full details of this and other
functions, consult the Mathematical functions topic, or refer to
the Writing your own custom calculations Index item in the
Library Access System, where all functions are completely
documented.

2. Now type the fifth paragraph - this is a simple expression that determines
and displays the actual stress in the section and assigns the result to the
variable fa.
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Result accuracy and formats

It is sufficient to display the slenderness to one decimal place. To do this we
use a format string to override the default result setting of three decimal
places.

1. Now type the last paragraph of the new calculations as follows. Use the
Greek text button for the variable name λ.

2. The characters f1 following the ? are the format string. The format string
must immediately follow the ? with no space in between as shown. See
below for a fuller explanation.

3. Once you have finished typing this last expression, check the new
paragraphs carefully. Have you included all the delimiters? Have you used
subscripts correctly? Have you used the correct case for variable names
and units?

4. When you are satisfied that everything is correct, click the Calculate All
button. A math function is always followed directly by its argument(s) in
parentheses as shown here. There are many more such functions
available in Tedds for Word. For full details of this and other functions,
consult the Tedds Help system topic Mathematics, or refer to the Writing
your own custom calculations Index item in the Library Access System,
where all functions are completely documented.

5. If you have an Error, then Interrupt and see Errors and troubleshooting
(page 149). Fix any errors until your calculation works fully.

6. Review your results and look at the last paragraph to see how the format
string we used has operated:

7. Click the Variables button to examine the list of saved variables and check
the stored value for this variable:
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Result Format Strings Explained
You can override the default result setting, and reduce or increase the
number of decimal places for a displayed result, by using a result format
string after the ? result field. For example typing ?f2 will display the result to
two decimal places. It is important that there is no space between the format
string and the ?. The format string characters signify the following:

f = fixed format, and 2 = result to be displayed to 2 decimal places (can be
from 0-15)

Note that format strings only control the precision of the result displayed in
the document, not any result that is stored by Tedds.

For full details of this and other result formats, consult the topic Result
formats and precision (page 545).

Using data functions in calculations

The calculation as written is very useful, but we can enhance it further. One big
improvement is to include a Data List in the calculation, making the properties
of a huge number of section types and sizes instantly available.

1. First edit the two paragraphs underneath the heading Check Section; as
follows:

2. Delete the following text for the section name - Try a 152 x 89 x 24 Rolled
Steel Channel. Leave an empty line here.

3. Next delete just the values for the properties of the section. Replace them
with a ? result field. You should end up with the following:
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4. Finally, place your cursor as shown at the very end of the heading.

Retrieving Data Lists from the Library

1. Click the button to Launch the Tedds Engineering Data

2. This opens a special Set in the Library where all the Data Lists and Data
Tables are accessed. There is a lot of data in this set. We wish to find a
Data List that includes steel RSCs suitable for this calculation. We will use
the Find facility to help us locate such a table.

3. Each item in the set has both a short and a long name, we are going to
find by the short name, so ensure View/Long Names is unchecked before
continuing.

4. Now select the Group we want to search in - Eurocodes.

5. Select Edit/ Find in the library, and type in steel as shown.
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6. Library Access System finds the first item containing steel, this is not the
item we require so click find next until the European steel sections item
shown below is highlighted.
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7. Now to bring this item into your calculation, either double click the item,
or click the Execute… button. You should find the following has been
entered in your document.

8. This text inserted is a Tedds Data List Field which launches the specified
Data List (further details on Tedds Fields are given below),

9. Close the library once you have retrieved the Tedds Data List Field.

10. Now click Calculate All to calculate the document again.

11. The Data List will now be displayed when the Tedds Data List Field is
calculated.

12. Select the 152 x 89 x 24 channel section then click on the Details button
to examine the variables defined in the table.
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NOTE Note that we have used exactly the same names for the
properties in our calculation as those defined by the Data List - A,
rxx and ryy. This is the key to integrating all Data Functions with
your calculations. Remember that variable names are case-
sensitive.

13. Click the Select button to return these variables to your calculations - you
will see that the section's properties from the Data List replace the ? fields
in your document and the Tedds Field displays the choice you made in the
Data List.

14. The Data List is now integrated with your calculation. Re-calculate a few
times, each time changing your selection of channel size in the Data List,
to test this.
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15. Click the Variables button and you will see that all the variables defined
by the Data List are listed and are thus available to be used in calculations.

16. Save the calculation at this stage, as we will build on it in the final exercise.

NOTE Whilst in this exercise the Data List was inserted into the
calculation via the Tedds Engineering Data button, it could have
been inserted via the Tedds Field button instead. The use of
Tedds Fields is covered in the next exercise Enhancing
Calculations.

Tedds Fields

1. Check the Field Codes box.

2. Look at the Tedds Field in your document and you will see the following:

3. The command that runs the Data List is now revealed. Uncheck the Field
Codes box again to return to the normal view of the document.

Tedds Fields Explained
Field Codes enable you to see and thus edit the hidden commands which are
Tedds Fields. These commands run special functions in Tedds like the Data
Lists. We will see some more Tedds Fields shortly. A Tedds Field will run when
it is calculated, like any normal expression. We hide the Tedds field, since you
would not want it to appear in a printed report. The Field Codes button
reveals the Tedds Fields. Tedds Fields should be treated like expressions, and
separated from text and other expressions in the same paragraph using
semi-colons.

What next?

Congratulations! You have completed the fourth exercise and learned
everything you really need to write powerful Tedds calculations. Maybe now
would be the time to have a go at writing a calculation of your own. It's a good
idea to start with something simple and build on the complexity as you
become more familiar with Tedds.

The next step in the guide, Enhancing Calculations is about making Tedds
calculations still easier to work with, and is especially relevant if you envisage
writing calculations for others to use. Even if your calculations are for your
own use you may find these further features beneficial so we recommend that
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you review them. You might like to leave this step until you have had a go at
writing a calculation of your own using what you have learned so far.

Enhancing calculations (Eurocode design example)
There is even more functionality available for our calculations than we have
seen so far. Whether you use these enhancements depends both on the
purpose of the calculation, and on the time you have available. Certainly these
features are very useful when you are writing calculations which others will
use (as we do at Trimble). Hence the Tedds library is packed with examples
which use these features, and you have already seen many of them when
running our calculations.

In this exercise we will enhance the previous calculation and you will see what
we are talking about.

Allow about 15 minutes to complete this exercise.

Buttons used in this exercise

The only new command you will be introduced to in this exercise is located on
the Insert group of the Tedds Calcs ribbon as shown below:

Tedds Input Fields

The Tedds Input Field speeds up the editing and often the creating of input
variables. We will replace all the existing variable definitions in the calculation:

1. Delete the entire definition for the Min. yield strength, Fy, from your page.
Leave your cursor on the empty line.

2. Click the Tedds Field button.

3. The following dialog will appear.
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Tedds Input Field
Prompt tells the user what the variable is and

appears on the page
Name the unique name of the variable
Units if the property has dimensions then

enter a unit here
Default value this value will be displayed initially for

user to edit or accept
Format the format displayed on the page
No. of decimal places the number of decimal places

displayed on the page

4. Enter the details shown to define the input for this variable: 

Prompt = Min. yield strength

Name = Fy

Units = N/mm2 (type the main part of the unit, click the superscript button
and then type 2)

Default value = 275

Format = Fixed

No. of decimal places = 0
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5. Accept the defaults for other options and click OK when you have
everything entered. 

NOTE We do not put a value in this dialog - this is entered when the
statement is calculated.

6. The following will appear on the line containing your cursor:

7. With the Field Codes button on you will see the following Tedds Input
Field preceding the text on the line.

8. Calculate your document to run it. 

The Set Variable Value dialog appears, as shown above.

9. Because we already have a value defined for this variable it is displayed in
the input. You can accept it, or edit it as required. There is no need to find
and edit the variable value on the page, as it is automatically updated
when you enter a value in the Set Variable Value dialog.

10. Delete and replace the 3 remaining variable definitions in the same
manner – the table below shows what you need to enter in the Insert
Tedds Field dialog for each of the three variables in order from left to
right. When you have done this, recalculate your document to ensure that
your definitions are correct. 
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Insert Tedds Field Properties
Input Tf Le λL

Prompt Tie force Tie effective
length

Slenderness
limit

Name Tf Le λL

Units kN m  
Default value   300
Format fixed fixed fixed
No. of decimal places 2 3 0

NOTE To enter Greek characters in the Insert Tedds Field dialog for
variable names like λ simply click the Greek character button

(  ) and then type in the equivalent Roman character, in this
case you need to type l (i.e. lowercase letter L) to get λ. To enter
Subscript or Superscript characters simply click the Subscript or

Superscript button ( ,  ) and then continue and type in the
subscript or superscript. Once you have reached its end click the
button again to switch back to typing normal text.

The Default value is entirely optional. If you enter one it will be
displayed the first time a calculation is run, otherwise the input
box will be empty. Delete the stored variables and re-calculate to
see the defaults in operation.

Tedds Interface Designer
Although The Tedds Input Field can be used to create all the variables
required in a calculation, if you would like to give your calculations a slicker
appearance we would strongly recommend using the Tedds Interface
Designer instead. This easy to use tool allows you to place all the input
variables on a single interface along with sketches and notes if required. For
a worked example and further details of how to use the Tedds Interface
Designer refer to the Tedds Help.

Tedds Show Fields

The final thing we would like the calculation to do is automatically assess our
section and report in the document whether our chosen section is passing or
failing and, if it is failing, why. We use a Tedds Show Field to do this.

1. Enter the following two paragraphs after your existing calculations:
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2. These last two values help us assess the utilisation of the section for the
two checks. Assigning them to output variables will help us with creating
Tedds Show Fields. Calculate your document once you have written them
to ensure they are working properly before proceeding.

3. Place your cursor beneath these paragraphs and click the Insert Tedds
Field button.

4. Select the Show tab. The Show Field we want to create will test whether
the section is failing stress and output a message to give the status of the
check.

5. Select the Condition type option and input the following information:

6. The output of the Tedds Show Field consists of two text messages known
as output strings. Only one output string is displayed in the document
depending on the status of the condition.

7. Check your input carefully, then click OK to enter the Tedds Show Field in
the document.

8. When you have OK'd the input, click the Field Codes button to view the
resulting Tedds Show Field. It should be as shown below. If your Tedds
Show Field is incorrect, the best thing to do at this stage is to delete it and
run through the Insert Tedds Field dialog again.
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Using logic in Tedds

Take a close look at this Tedds Show field, and you can see how we use a
simple logic statement to output one of two pieces of text using the if logical
operator.

if(check_stress > 1, “Section fails stress check” , “Section OK for 
stress”) 

The general form of this logic expression is as follows:

if(condition, true_output, false_output)

NOTE You can use this kind of expression to define variables using a
condition. The outputs can be values, expressions or further logic
expressions.

For example:

a = if(b > c, 10, 20) = ? 

Check the table of Logic Functions in the Mathematics (page 524) topic
for full details.

1. Now calculate your document to calculate the Tedds Show Field. You
should find you have something similar to the following in your Progress
Log and you will also see the output text on the page where you placed
the Tedds Show Field.

2. Change some of your input values and re-calculate a few times to test
your full calculation and both the pass and fail output of the Tedds Show
Field.
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Tedds Data List Fields

In the previous exercise we inserted a Data List Field into the calculation using
the Engineering Data button. However, it could have been inserted more easily
using the Tedds Field button:

1. With the Field Codes button on you will see the following Tedds Data List
Field:

2. Delete the entire definition of this field from your page. Leave your cursor
on the empty line.

3. Click the Tedds Field button.

4. Select the Data List option and scroll down to select the same .dls file
name as that shown in the line you just deleted above.

5. Input the Prompt as Select Section.

6. To input the Default page and Default item click the ellipsis button ( ) and
then select the page and section size that you want to appear as the
default.

7. Accept the defaults for other options and click OK when you have
everything entered.

8. Calculate your document to run it once more.

What next?

Congratulations! You have completed the final exercise in the guide and are
ready to begin using Tedds to its full potential.

Here are a few things you could try next:

• Create another Tedds Show Field similar to that above for the slenderness
check - following is the logic statement you would use for this:

Condition    check_slender > 
1

• Create a Tedds Show Field to give the overall status of the section, checking
both slenderness and stress. Try the following:

Condition    check_slender > 
1

Yes PASS
No Section fails!
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• Take a look at Tedds Message Fields. The input for these is the same as
Tedds Show Fields but their output is displayed in a Message box, rather
than in the document. You will see examples of their use in the Tedds
Engineering Library Calculations.

• Try creating Messages using the Value of Variable option to show the
values of the minimum area and radius of gyration in the Log before the
Data List is displayed.

Of course there's much more for you to discover. We wish you an enjoyable
and productive time in using the program in your day-to-day work, and
exploring its capabilities more fully.

If you would like to read up on further information about Tedds, then we
recommend the Tedds Help system, which you can access in the usual way.

Some Tedds dialogs have context sensitive help. To see this simply click the
Help button in the dialog.

We also run training courses in most locales, for further information on
availability contact the Tedds support team in your region, simply click the
Support icon in any of Tedds’ automated calculations.

Quick start guide - Australian design examples
The Quick Start Guide comprises the following 5 exercises, which are best
worked through in sequence:

• Using Tedds (page 178)

• Writing Tedds Calculations - Stage 1 (page 199)

• Using Library Calculations in Tedds for Word

• Writing Tedds Calculations - Stage 2

• Enhancing Calculations

Using Tedds (Australian design example)
In this exercise you will design a steel beam in order to learn how to use any of
the calculations in the extensive Tedds Engineering Library.

Allow about 15 minutes to complete this exercise.

Design information required for this exercise

We wish to check the following RHS steel beam:

Design Information
Design Code AS 4100
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Design Information
Dimensions Length 5.0 m

Effective length factors 0.85
Design Forces Moment 135 kNm

Shear 60.0 kN
Axial compression 40.0 kN

Proposed section Shape RHS preferred
Steel grade C450

Running Tedds and locating calculations

You need to find an appropriate calculation, run it and enter the design
information. You will see just how easy this is.

1. Launch Tedds from the Start Tedds icon on your desktop.

2. If this is the first time you are starting Tedds, or if you are updating from a
previous version of Tedds, then you will see the Tedds Setup Wizard
which allows you to configure Tedds with your company details and so on.
Work through the various pages of the Setup Wizard and when you reach
the end click Finish.

3. From the Tedds Start wizard click Tedds (as opposed to Tedds for Word)
as the version to run.

4. Now you will see the Tedds Start Page: 
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5. First, click the New tab.

6. Then, click New Document:
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You will see the Select Calculation dialog box:

7. Click on the All folder (indicated above).
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• The instructions about using Tedds are displayed in the right hand
panel.

• Every Tedds calculation is listed in the left hand panel.

• When you click on a calculation, notes relating to it are displayed on
the right side.

NOTE If the Show Examples option is checked, you will also see all of
the examples that are included in the library - these demonstrate
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the potential scope of each of the calculations, show you the
typical output, and can be used to start your own designs.

To find a calculation – you could simply click on a folder in the list to open
it, then click a heading to select a calculation. However for this example
the Find in list feature will be used instead.

8. Type steel member design in the Find in list field. 

NOTE Find in list will locate the first item title in the library that
contains the exact text entered. Keywords in the item description
are also considered provided the option to Find in item
descriptions remains checked.

9. The first item in the library matching the entered text is selected - we are
looking for the 'Steel member design (AS4100)' calculation. If necessary
click Next until it is selected as shown below.
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NOTE Note there is also a 'Steel beam analysis & design (AS4100)'
calculation available which will determine the design forces
before proceeding to the design.

10. Click the Calculate button at the bottom right of the dialog: three things
will happen: 

• A new calculation document will open – you will see this in the
background.

• The Interface for the chosen automated calculation will be displayed at
the first page.
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• Another window, titled the Progress Log will also be displayed – we will
explain this shortly.

Entering data in the automated calculation user interface

The user interfaces for all of the calculations in the Tedds engineering library
use a consistent style which ensures they are easy to use. You select the
design options you require and enter values for dimensions, loading etc. all of
which are clearly explained. See the box below for more information.

 The General Automated Calculation Interface Explained

An '(i)' symbol to the left of a variable description shows that there is
more information available about this particular variable. The
information area (at the top of the dialog) displays any information
about the selected variable (if available). You can also see this
information by hovering the cursor over the '(i)' symbol.
Notes - display details about the calculations being performed.

Variables - lists all the current variables. Values can be selected from
here to enter into the current interface.

Feedback - this allows you to send feedback to the development
team.
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 The General Automated Calculation Interface Explained
Support - tells you how to obtain support in your region.

Data fields - enter information in these fields . Where appropriate,
variables may have validation which prevents invalid information
being entered.
Buttons... - allow you to enter more information or select a particular
item.

Next/Back/Cancel/Finish - continue to the next page / return to a
previous page /stop the calculations at the current point / return the
data to your calculation document.

1. In this calculation all the values for design forces and section details can
be specified on the first page of the interface and the calculation results
are also displayed.
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Note that additional design and output options are available by clicking
the appropriate buttons.

Before we proceed to enter the data take a moment to review the design
information given at the beginning of this exercise.

2. Enter the Design bending moment - major axis as 135 kNm.

3. Enter the Design shear force - major axis as 60 kN.
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4. Finally for the Axial load applied, click No applied axial force, change to
Design Axial Compression force and enter a value of 40 kN.

NOTE As you change the values and options for your design the
calculation results are immediately updated.

5. Now you need to choose a section to check, but you don't need to go off
and find a list of section properties, since all the data required can be
accessed within Tedds. Click the '...' button in the Span details area to
display the Data List for steel sections.

Data Lists

You are now looking at a Data List: a tool that allows you to choose a section
and see its properties at the click of a button.

 Data Lists Explained
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 Data Lists Explained
(1) Choose the shape from the left hand pane.
(2) Choose the size from the right hand pane.
(3) Details - click to see properties of the chosen selection.
(4) Select - click to select the chosen selection.

1. Click the Rectangular Hollow Section section type - this is known as the
Data List page you require.

2. Select the size and thickness you require.

3. Click on the Details button to see all the properties of the selected section
– (note that the details window updates instantaneously when you click on
another section). 

In this case, both a 250x150x8 RHS and a 300x200x6 RHS may prove
adequate but which is the lighter?

4. Check the properties of both sections. The 300x200x6.0 RHS section is
lighter and may be preferred – choose this section and click Select to
continue with the calculation using this section size. 

NOTE You will find Data Lists for all kinds of engineering data
throughout Tedds calculations; there are data lists for bolts,
reinforcing bars, timber sections and much more. However, they
all work in just the same simple and intuitive way.

5. The number next to 'Selected section' allows you to design beams using
two or more sections. In this example a single section is sufficient so no
change is required.
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6. Set the steel grade to C450.

7. Enter a restraint spacing of 5000 mm for both the major and minor axes.

8. Click the Design options... button to view another interface page for
defining equivalent uniform moment factors etc.

9. Leave the default values as shown.

10. Click OK to return to the main page of the interface.
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11. Then click Preview results

12. You can now choose the level of output you require by clicking Output
options... From here you can also give the calculation a title.
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Automated calculations and library items

You have probably realised by now that this calculation caters for all kinds of
steel sections, dimensions and loading. For each possibility and check, there is
an item in the Library - in fact this calculation has over 150 items. When you
use a calculation like this, Tedds automatically chooses the appropriate items
for your options and input, and puts them together to make up the complete
design.

• Accept the results and continue, click the Finish button when done:

The progress log

The progress log helps to keep you informed about a calculations progress
during lengthy calculations, it is also used by some calculations to report the
status of specific checks or other pertinent information. When writing your
own custom calculations you can add information to the log or you can modify
the default options to provide more detailed information about what your
calculations is doing which can be helpful for resolving errors.

This particular calculation does not use the progress log to report any
additional information.

Examining finished calculations

OK, but how is your chosen section performing? The main interface displayed
the design forces, capacities and utilizations but you may want to examine the
results in more detail.

1. Scroll through the calculation and examine the y-y axis flexural buckling
resistance check: 
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2. There’s another really important point to note about the calculations
displayed – they don’t just show you results, but how those results have
been arrived at. 

NOTE Tedds is not a ‘black box’ where all you can see is the result, and
all you can do is accept it. In Tedds you can see exactly what’s
going on. You can see what checks Tedds does. What design
method does it use? From where did that number come? The
answers to all these questions are right there in front of you! This
is a major reason why Tedds is so popular with engineers the
world over.

Furthermore, if you need an example of how to write your own
calculations, then look no further. That's exactly what you are
looking at - every calculation in the library is an example of how to
write your own. How do I write a math expression in Tedds? How
do I use logic or a math function in Tedds? Look again at the
check shown above and you will see the answers to these
questions. We will look more closely at how to write your own
calculations beginning with Writing Tedds calculations - stage 1
(Eurocode design example) (page 140)

Re-calculating

Changes are a fact of life for engineers, they always have been, and they
always will be! You need to be able to take account of any changes and update
your calculations quickly. With Tedds this is no problem.

Say that your beam needs to be 0.1 m longer since the beam which supports it
needs to be moved, to avoid a clash. Is your section still OK?

1. Click Calculate on the Home tab (highlighted above). 

The calculation will run again, but this time all the information you
entered last time is remembered. It’s a simple matter to change the
required data.

2. Change the distances between restraints to 5100 mm.
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3. What is the effect of this change on the design? Check the Calculation
results and/or the output to see. 

Tedds makes it easy to update calculations – simply re-calculate and you
can update your design quickly.

Hidden text

All the calculations performed by Tedds are available in the output and in
general so they are – but at times some intermediate calculations are hidden
to reduce the amount of output. It is simple to view these and to include them
in your printout.

1. Open the application’s View tab then use the Hidden Text option and
examine the check again. 

If there is any hidden text it will be underlined with dashed lines, however,
in this example there are no hidden calculations.

2. Select View/ Hidden Text again to hide the Library item names. Now let
us consider how to print calculations.

The header & printing

Obviously you want professional looking printed output. You will see that you
have a header region at the top of the calculations, but how do you set its
details?

1. Click the Header button highlighted above – this opens a dialog where
you can enter some project details in your header.
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2. On the Company page you can define your own company details. Do this
now, if you want to. If you don’t, then remember to do so before you print
your first “proper” set of calculations.

3. On the Template page you will see the Tedds template which your
calculations will use and the logo file which Tedds will add to the template.
You can change the template and logo if necessary – click this tab and
check that its details are correct.
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4. Maybe you would like to try a different style of template, there are a
number of standard templates to choose. Click the Select… button to see
these. Choose the template you want to use and you will see a preview of
what calculations produced with that template will look like. When you
have found the template you want to use click OK to use it.

5. If you have a copy of your company logo in electronic format, and the
template style you select supports a logo, then you can add your logo to
the template. Make sure that the logo is available on your computer,
Browse to find it, and then click OK to add it to the template.

6. Click OK to exit the Header Properties dialog and view your finished
calculation.

7. If the logo is not the right size open the Header Properties dialog once
more and change the Scale of the logo to make it fit the template
correctly.

8. Once the template and logo are correct click  to display the file
menu. From here you can Print the calculation to obtain a hard copy.
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9. Congratulations, you have produced your first piece of work with Tedds!

To finish this example let’s look at a few points about saving and outputting
your results.

Saving and output options

You can save every Tedds calculation to a unique file that you can recall and
edit any time in the future. The file extension .ted is unique to Tedds.

1. Click  to display the file menu.

2. Save your file and give it a name - it’s a good idea to save all the examples
you will produce in the course of completing the guide, for future
reference.

3. The output you see in the document can be printed direct to a printer, but
you have other options.

4. Click the drop-down button adjacent to Send To on the file menu to view
these.

5. Choose the option of sending the output to Word and experiment with
the other options if you wish. Once your output is in a Word document,
you can edit it as much as you wish.

6. By clicking the drop-down button adjacent to Save As on the file menu
you can also save the active document, or all documents in the active
project to PDF.

Performing a new calculation

How do you start a new calculation in Tedds?

• Click  to display the file menu; then click  

The Select Calculation dialog will open, from where you can select and start
a new calculation in a new document.

Managing Multiple Related Calculations

Can several calculations be saved in a single document?

As stated earlier, each calculation must be saved to a unique file - however
multiple files can be collected together in a single project. They can then be
organised as required using the Project Manager.

Benefits of projects include:

• you can specify a shared document header for all the project files,

• locating files is made easier - when you open the project all files within it
are opened automatically,
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• calculations can be placed into named groups, making them easier to
manage.

To start a new project:

1. Click  to display the file menu; then from the menu choose the New
Project button. 

A new empty project is created in the Project Manager.

2. New or Existing Documents are then added and arranged into folders as
required via the Project tab. 

What next?

Congratulations! You have completed the first exercise and now know all you
really need to make use of the wide range of calculations available in the
Tedds Engineering Library and to begin using Tedds productively. Take a look
through the index and try some more. How about:

• carrying out a wind load calculation?

• designing a retaining wall?

• designing an RC footing?

• analysing and designing a timber rafter, beam or post…
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The choice is yours, and all these calculations work in the same
straightforward, intuitive way. Some calculations may also include Data tables
which are designed to look like tables from printed references, so that you
immediately feel at home with them. Indeed we hope you will find yourself
recognising them.

What can you do if the Library does not contain the exact calculation for which
you are looking? You need to perform a number of calculations, and could do
with a calculation to help you out with these. First of all, TELL US:

• if you are running a calculation, then you will see a Feedback button to the
left-hand-side of the interface,

• if you are not running a calculation, then you can choose the Feedback…
option from the Help menu.

We are constantly working to expand our Engineering Library and your input
helps us do this!

But you don’t have to wait until we produce these for you – you can write them
yourself. We will look at this in the next example: Writing Tedds Calculations -
Stage 1 (page 199)

Writing Tedds calculations - stage 1 (Australian design example)
Having looked at using calculations from the Tedds Library we can move on to
look at one of the most exciting and powerful features of Tedds - the ability to
create your own calculations. This is where an initial investment of time can
give you huge returns later. Once you have invested time writing a Calculation,
you can use it over and over again, you can also update calculations in an
instant, making further great savings. You can also customize and extend the
Library of Tedds calculations to match the calculations that you use most
frequently in your office.

In this exercise we will see that writing Tedds calculations simply uses the
math and logic conventions with which you are already conversant. We start
by looking briefly at very simple examples introducing the basics of calculating
with Tedds for Word. We then create a “real-world” example, covering the
main features of writing effective calculations in depth.

Allow about 30 minutes to complete this exercise.

Running Tedds for Word

To write calculations you need to use Tedds for Word.

1. Launch Tedds from the icon on your desktop.

2. Click the option to run Tedds for Word - Microsoft Word will now open
with Tedds integrated. If this is the first time you've run Tedds for Word a
Release Notes document and the Library Access System will open too. 
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NOTE It is important to realize that you are looking at Microsoft® Word
with the Tedds capabilities added. We only add to the
functionality of Word, so you can do anything you would normally
do in Word. Treat a Tedds Calculation Document just like you
would any ordinary Word document. You can type reports, import
files and text, embed spreadsheets and so on. And of course you
can add calculations to your reports; either straight out of the
Tedds Engineering Library, just as you did in the previous
exercise, or create your own.

The Tedds interface

The commands you will need to use in this exercise can all be found on the 
Tedds Tab of the ribbon as highlighted below:

You will find a Word Document open, which looks very similar to the Tedds
output document.

The document Header can be edited in a similar manner to that in Tedds by
clicking the Edit Header button - this button is highlighted above.

• In this exercise two documents will be required, so open a new blank one
by selecting File/ New Tedds Document

Now we are ready to begin writing our first calculation in Tedds.
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The basics

Writing calculations in Tedds for Word is easy. Tedds follows standard
mathematical rules and uses standard mathematical operators. For example 1
+ 2 would add 1 to 2. To write an equation use the = sign, and to specify where
you want to see the answer use the ? symbol. For example:

1 + 2 = ?

• Type the above anywhere in your document. When you calculate this
equation the ? will be replaced with the answer.

Calculating in Tedds for Word

To calculate equations in Tedds for Word you can use one of several
Commands:

All - this will calculate the whole document.

Calc Section - this will calculate the Calc. Section your cursor
is in.

Selection - this will calculate only equations you have
highlighted.

1. In the Calculate ribbon group, click All to calculate your equation: 

1 + 2 = 3.000

2. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and troubleshooting
section later in this topic.

Units in Tedds

Tedds automatically takes units into account, so you don’t need to apply
conversion factors to get the right answer. Tedds will also check that the units
you are using are dimensionally correct and warn you if they aren’t.

1. Type the following in your document using the same case as you see here:

890 mm + 1 ft + 8.5 in = ? m

2. In the Calculate ribbon group, click All to calculate this equation: 

890 mm + 1 ft + 8.5 in = 1.411 m
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3. You should find the answer displayed in your document as shown above.
if you have an error, take a look at the Errors and troubleshooting
section later in this topic.

Defining and using input variables in Tedds

Defining variables is the key to writing effective Tedds calculations. We will use
the following calculations to demonstrate this. Do not type this yet - we will
show you how to enter the calculation below (in stages) in the following couple
of pages.

1. Close the current document, (because two documents were opened at the
beginning of the exercise you should still have an empty one displayed).

2. Type in the following two paragraphs in the empty document.

The first paragraph is just a title for our calculation. The second paragraph
is a standard Variable Definition which uses a superscript in its units.

3. To type the unit N/mm2, first type N/mm, then click the Superscript 
button.
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4. Now type 2, then click the button again to return to normal text. Once you
have finished typing, read the notes in the box below for an explanation
of a standard variable definition, and to check you have typed it correctly. 

The Standard Variable Definition Explained

Note the following:

• The expression defines the variable's unique name, current value and
units.

• Variable names are case sensitive, cannot contain spaces or be function
names (like sin for example). Other than that you can use pretty much
anything you like as you can see, including Greek text and Subscripts.

• The semi-colon is important. It is a delimiter that separates an expression
from text, or another expression in the same paragraph. If you omit
delimiters in either of these cases, then you will get an error when you
calculate your document.

• The equality sign '=' defines an expression. Without it no calculation will
be performed.

• Spaces and Tabs are not significant in this, or any other, expression. Use
as many or as few as you wish to make your calculations look presentable
and easy to read.

• We will look at Units in more detail shortly but, for now, note that they are
also case sensitive and have a correct syntax, that you must use (as shown
above).

5. Now enter the following paragraph which uses this variable:

6. Use the Insert multiplication symbol  button to enter the ×
mathematical operator - do not use a lower-case x.

7. Check the notes in the box below for a detailed explanation of the
components of this paragraph. 
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Mathematical Expressions Explained

Note the following:

• The same observations as before apply to delimiters, explanations, spaces
and units.

• You cannot omit math operators in expressions: Tedds cannot calculate
0.8Fu, you must type the expression as shown above, including the × .

• The result field ? is used to tell Tedds where the result should be output -
when calculated the ? will be replaced with the result of the expression.

• The value of the result will be in the result unit you specify. Ensure this
has the correct form and dimensions. Do not omit this.

• The expression contains a variable (fy) that is defined in the calculations
before (that is above) the point where it is used. Expressions should not
contain variables that are not yet defined.

• The expression contains two equalities and performs two functions:

• calculates and displays the value we wish to know - the result.

• assigns this result to a variable named - fy

• It is not obligatory to always do this. You can write a valid expression to
perform just one of these functions by either omitting the variable name
and the first equality, or the second equality and the ? and unit.

8. In the Calculate ribbon group, click All.

9. Your expression has been calculated and the result has replaced the ? as
before. if you have an error, take a look at the Errors and
troubleshooting section later in this topic.

10. Here are the next two paragraphs of the calculation. The first paragraph is
a standard variable definition, while the second uses both N and fy to
determine the minimum section area and creates a variable Amin with this
value.
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11. Type the first paragraph, then follow the steps below to enter the second.

12. The second paragraph contains examples of the use of Subscript (often
used for name suffixes) and Superscript (used for powers).

13. To type the variable name Amin, first type the A, then click the Subscript

 button.

14. Now type min, then click the button again to return to normal text.

15. To type the unit cm2, first type cm, then click the Superscript  button.

16. Now type 2, then click the button again to return to normal text.

17. Click Calculate All to calculate these expressions once you have entered
them.

18. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section later in this
topic.

19. Here are the final three paragraphs of the calculation. Follow the steps
below to create these.

20. Here we define two new variables to be used in the expression in the final
paragraph.

21. Type the first paragraph, entering the subscript for the name Le as you did
before.

22. Follow the steps below to enter the second paragraph.
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23. Use the Greek text  button to enter the name λL

24. First click the button indicated, then type the Roman equivalent of the
Greek letter – (l in this case for lambda).

25. Now click the button again to return to normal text, then enter the
subscript suffix as you did above using the Subscript button. 

NOTE A much easier way of entering Greek characters and more
complex units is to use the Tedds Greek Characters, Tedds SI
Units and Tedds US Units toolbars which can be selected from the
Tedds Tab on the ribbon.

26. Use Copy and Paste to enter this name in the final expression.

27. Now click Calculate All to calculate these final expressions:

28. You should find the result displayed in the document - if you have an
error, take a look at the Errors and troubleshooting section later in this
topic.

Storing variables in Tedds

1. Click the Variables button.

2. The Variables dialog box will open, displaying the stored values.

3. You will note that we do not just store the variable name and value, but
also the dimensions. This is how Tedds handles all the unit conversions
for you. 

NOTE You can Delete variables from this list if you wish:

4. Cancel from this dialog, and edit one of the values on the page - say the
tie force to N = 600 kN. Now check back in the stored variables and you
will note the stored value has not changed.
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5. Re-calculate the document and check back in the list of variables - the new
value has now been stored. 

NOTE An important observation — the stored value of a variable only
changes when you re-calculate the definition, not when you just
edit it on the page. If you edit the value of a variable you must re-
calculate the variable definition, and any calculations that use it
to update them.

More about units in Tedds

1. Change the tie force back to its original value N = 675 kN. Calculate again
to store this new value.

2. Look again at the values displayed in the Variables dialog box. You will
note that many of these values are not those displayed in the document.

3. The values in the dialog are in the Base Units in which Tedds performs all
calculations and from which all the other units are derived. The base units
are shown in the following table: 

Tedds Base Units
 Metric

Length m
Mass kg
Time s
Temp °C

NOTE If you hover over a variable name in the Variables dialog box a
summary list is displayed showing the value of the variable in all
applicable standard units.

4. Note that our calculation does not include any conversion factors. 

NOTE Tedds’ unit handling is a massive help – Tedds comes with a huge
number of defined units and you can add more if needed.

Dimensional Checking - Tedds checks all dimensions in your
calculation and will inform you if these are incorrect. This is why
you should use units consistently throughout your calculations.
Do so, and you can have total confidence that your calculations
are dimensionally correct.

Get familiar with Tekla Tedds 207 Tekla Tedds Quick Start Guides



5. Save the document and give it a name - call it “Exercise 2” - as we wish to
build on it later in the guide.

To complete this exercise, in the next section we will take a brief look at
handling errors in calculations.

Errors and troubleshooting

The problem with a lot of guides is they only show you the right way to do
things, and then you have no idea what to do when something goes wrong!
Let's look at a couple of errors and how to fix them.

• If you have an error in your calculations, Tedds will inform you when you
calculate your document and the error is encountered. The first thing you
should do is Interrupt the calculation process.

• If you have jumped to this section because you have encountered an error
previously, then click the Interrupt button in the dialog (see step 11 below),
review the details and then return to fix the error in your calculations and
continue with the exercise.

If your previous calculations were error free, then you will have had no need to
look at this section. We shall therefore create some calculations which do have
errors so that we can see how to handle them.

1. Open a new blank document for this example.

2. Click the Tedds options  button.

3. The Options dialog box will open, click on the Calculating / General page.
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4. Make sure that the options above are checked and then click OK. We can
now proceed to create some calculations with errors.

5. Enter the following 2 paragraphs as they appear here - see if you can spot
any errors as you do, but don’t fix them yet!

6. Now click the Calculate All button to calculate the calculations - you
should see the Expression Error dialog: 
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Expression Error dialog Explained

This is the specific error.

This line is the one that Tedds cannot evaluate, so look here to spot
the error.

This is an explanation of the error, together with some typical
causes.

This is the button you should generally click,

7. Tedds flags the first error, and gives you some help in fixing it.

8. When you are ready, click the Interrupt button. Tedds highlights the error
for you in the document as shown below: Once we fix the problem and re-
calculate, this error message will automatically disappear.
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9. Check the rule about delimiters (see The Standard Variable Definition
Explained info box earlier in this topic). There should be a semi-colon
between the expressions to separate them. Add this in and re-calculate
the entire document.

10. Now we will get the next error – the variable WD is not defined. We have
typed WD instead of wD and variable names are case-sensitive.

11. Click the Interrupt button to stop the calculation.

12. Correct the variable name on the page to wD and re-calculate. The
calculations should now complete with no problems. Tedds automatically
deletes all error messages from the page.

What next?

Congratulations! You have completed your first Tedds calculation. You can
now begin writing effective calculations in Tedds for Word. There are more
great features that make such calculations even more powerful, and we will
show you these later.

Now we are going to look at using calculations from the Engineering Library in
Tedds for Word: Using Library Calculations in Tedds for Word

Using library calculations in Tedds for Word (Australian design
example)
We have shown that you can write your own calculations in Tedds for Word,
but you can also use the Library Calculations. The advantage of this is that you
can add additional text to your output easily, because it is already in a Word
document. You can also combine more than one calculation in a document,
add pictures and tables - anything you need to create a polished report. And if
you need to update the calculations you can do it directly in the document.

Sometimes, of course, you just need an answer right now and the polishing
can wait. That's why we have Tedds too. With the two modes, you have both
bases covered.
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In this exercise we will use the RC circular column design calculation to show
you how to run a typical calculation from the extensive Engineering Library in
Tedds for Word.

Allow about 15 minutes to complete this exercise.

Information required for this exercise

Design Information
Use the following information for the calculation.
Column state Braced
Length of column 3000 mm
Diameter of column 300 mm
Effective height factor 1.0
Concrete characteristic compressive
strength

32 MPa

Reinforcement yield stress 500 MPa
Reinforcement bar size 20 mm
Fitments bar size 6 mm
Nominal concrete cover 30 mm
Exposure classification A1
Design axial load 600 kN
Smaller end moment 25 kNm
Larger end moment 55 kNm
Ratio of axial dead load to total axial
load

0.65

Ratio of axial live load to total axial
load

0.54

Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Tedds tab as shown below:
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Using Calculation Sections in Tedds for Word

As stated, one of the reasons for running library calculations in Tedds for
Word is so that you can combine a number of calculations in a single
document. In this case, each calculation should be placed in a separate
Calculation Section, so we will start off by introducing one of these. Calculation
Sections will be explained in more detail later in this exercise.

1. Open a new Tedds document.

2. Insert a New Calc Section by clicking the appropriate button.

3. The following dialog will appear - enter a name for the section. This will
form the title for the calculation in the document.

4. Click OK and this will enter a Calculation Section Title in the document. We
place a calculation below this title and thus within the section. You should
note that your cursor is now on the line below the section title.
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Selecting calculations from the library

All the library calculations are available from the Library Access System. To use
a calculation we retrieve it from the Library, place it in our document and
calculate it.

1. If it is not open already, launch the Library Access System.

2. Click the Index button if the index is not displayed and ensure you have
the Tedds calculations index option selected.

3. To open a folder in the index simply double-click it. Open the Columns
folder, then the RC Circular column design (AS3600) folder, then select
(click on) the RC Circular column design (AS3600) item.
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4. To place this calculation in the document, click the Execute button in the
library. (You can also double-click on the selected item to do this.) In both
cases you will see the Insert Calc Item dialog.
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5. This dialog allows you to control where the item will be added. Simply
choose the options as above then click OK and the item will be pasted at
the cursor position in the document. 

NOTE Note that one of the options in the dialog is to add a new Calc
Section. In this example we have already added one manually, so
as shown above, on this occasion the option should be
unchecked.

6. You should now have the following in your document.

7. We can now close the Library - there is no need to have it open while a
calculation is running.

8. Click the Calculate Section button to start the calculation.
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9. The Interface for the calculation will now be displayed, along with the
Progress Log. You are now in familiar territory as everything from this
point works exactly as you learned in the first exercise – Using Tedds
(page 178)

10. Click the Notes button and briefly look at the notes before proceeding.

11. The data to be entered is given at the start of this exercise. Use this to
enter the data for the first page of the interface. You will be comfortable
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with entering information in the interface by now, so we won't show every
input step.

12. Continue to enter the reinforcement information on the second page. At
this point we don’t know how many longitudinal bars will be required so
accept the default of 6

13. When you get to the Exposure classification, note the help information
available for the input displayed in the information pane (as shown
below).

NOTE Note that information about a particular item will also appear
adjacent to your cursor if you hover over the information symbol
associated with that item.

14. Fire resistance and any other data not specifically specified can be left at
the default value.

15. Proceed to the third page and enter the design loads.

16. Click Next to complete the interface and the calculation will be
performed.

17. Review the calculation result summary displayed in the interface. The
current configuration is clearly not suitable as there is insufficient
moment resisting capacity.

18. Click Back two times to return to the reinforcement page. Increase the
number of longitudinal bars to 8 and then progress to the result summary
once again. The revised configuration should now be acceptable.

19. The dropdown at the bottom of the page allows you to choose the
amount of output you require. For this example pick the Full option. Also
check the box to include a sketch and then click Finish to close the
interface and generate the report.

20. Close the Progress Log and examine the calculations in the document -
they are of the same form as the ones you saw in Tedds, and they show
you exactly how the results have been determined.
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Viewing hidden text in Tedds for Word

This particular calculation has no hidden text. It is worth pointing out that
some do, and that there is a slightly different way of viewing Hidden Text in
Tedds for Word.

1. Check the Hidden Calcs box to view any hidden text.

2. Uncheck the button to re-hide.

Re-calculating in Tedds for Word

This is accomplished in a similar manner to Tedds.

1. Click the Calculate Section button.

2. The calculation will now run again - try changing some of the input data in
the interface.

3. DO NOT overtype values on the page prior to re-calculating - this is not
the way to change input data when using our library calculations (as
distinct from ones you have written yourself in the manner shown in the
previous section of the guide) in Tedds for Word.

Adding another calculation to the document

To start a new calculation in this document create a new Calculation Section.

1. Place your cursor below your existing calculations.

2. Click the Add New Calc Section button.

3. Type a name for the new section – this will be the title of your next
calculation. Then click OK.

4. A new calculation should be placed below this title and thus within the
section.

5. Retrieve another calculation from the library and place it within this
section

6. To calculate just one section, we place our cursor within the section and
use the Calculate Section button.

Calculation Sections Explained
Refer back to the section Storing Variables in Tedds. You will note that here
we have just one list of saved variables, known as Document variables, as we
have not used Calculation Sections. When we

use Calculation Sections, Tedds for Word saves the variables for each
calculation in a separate list unique to each section. These are knows as
Section variables. This ensures that all your input values are retained
separately from those for another calculation.

When you need to update a single calculation within a document that
contains many calculations, simply place your cursor within that section and
use the Calculate Section command. Place your cursor within the first
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Calculation Sections Explained
section in your document, and click the Variables button to view the unique
list for this part of the document.

Tedds for Word also has commands which enable you to manipulate the
calculation sections in your document. You can delete a calculation section,
copy it, paste it into a new location in your document and change it’s name.

What next?

Congratulations! You have completed the third exercise of the guide and
learned all you need to run calculations from the Library in Tedds for Word.

You can now save the document and re-use it as appropriate.

In the next section you will learn how you can make your own calculations
even more powerful: Writing Tedds Calculations - Stage 2

Writing Tedds calculations - stage 2 (Australian design example)
In this exercise we will investigate the use of math and data functions to build
on the stage 1 calculation, extending its capabilities and introducing some
more Tedds features.

Allow about 30 minutes to complete this exercise.

Buttons used in this exercise

The new commands you will be introduced to in this exercise are located on
the Library and Show/Hide groups of the Tedds tab as shown below:
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Defining input variables

Here are the new calculations we will add to the document you created in
exercise 2 in order to check the adequacy of an actual section.

1. Type the first two paragraphs, which are just text, below the existing
calculation.

2. Type the third paragraph and note that here we are defining three input
variables which are properties of the section we are checking. Ensure you
separate the text and all the expressions using delimiters (;) as shown.

Tedds math functions

1. Now type the fourth paragraph. Note how the Tedds math function min is
used here.

NOTE A math function is always followed directly by its argument(s) in
parentheses as shown here. There are many more such functions
available in Tedds for Word. For full details of this and other
functions, consult the Mathematical functions topic, or refer to
the Writing your own custom calculations Index item in the
Library Access System, where all functions are completely
documented.

2. Now type the fifth paragraph - this is a simple expression that determines
and displays the actual stress in the section and assigns the result to the
variable fa
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Result accuracy and formats

It is sufficient to display the slenderness to one decimal place. To do this we
use a format string to override the default result setting of three decimal
places.

1. Now type the last paragraph of the new calculations as follows. Use the
Greek text button as you did on page 32 for the variable name λ.

2. The characters f1 following the ? are the format string. The format string
must immediately follow the ? with no space in between as shown. See
below for a fuller explanation.

3. Once you have finished typing this last expression, check the new
paragraphs carefully. Have you included all the delimiters? Have you used
subscripts correctly? Have you used the correct case for variable names
and units?

4. When you are satisfied that everything is correct, click the Calculate All
button. A math function is always followed directly by its argument(s) in
parentheses as shown here. There are many more such functions
available in Tedds for Word. For full details of this and other functions,
consult the Tedds Help system topic Mathematics, or refer to the Writing
your own custom calculations Index item in the Library Access System,
where all functions are completely documented.

5. If you have an Error, then Interrupt and see Errors and troubleshooting
(page 208). Fix any errors until your calculation works fully.

6. Review your results and look at the last paragraph to see how the format
string we used has operated:

7. Click the Variables button to examine the list of saved variables and check
the stored value for this variable:
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Result Format Strings Explained
You can override the default result setting, and reduce or increase the
number of decimal places for a displayed result, by using a result format
string after the ? result field. For example typing ?f2 will display the result to
two decimal places. It is important that there is no space between the format
string and the ?. The format string characters signify the following:

f = fixed format, and 2 = result to be displayed to 2 decimal places (can be
from 0-15)

Note that format strings only control the precision of the result displayed in
the document, not any result that is stored by Tedds.

For full details of this and other result formats, consult the topic Result
formats and precision (page 545).

Using data functions in calculations

The calculation as written is very useful, but we can enhance it further. One big
improvement is to include a Data List in the calculation, making the properties
of a huge number of section types and sizes instantly available.

1. First edit the two paragraphs underneath the heading Check Section; as
follows:

2. Delete the following text for the section name - Try a 150 Parallel Flanged
Channel. Leave an empty line here.

3. Next delete just the values for the properties of the section. Replace them
with a ? result field. You should end up with the following:
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4. Finally, place your cursor as shown at the very end of the heading.

Retrieving Data Lists from the library

1. Click the button to Launch the Tedds Engineering Data

2. This opens a special Set in the Library where all the Data Lists and Data
Tables are accessed. There is a lot of data in this set. We wish to find a
Data List that includes steel properties suitable for this calculation. We will
use the Find facility to help us locate such a table.

3. Each item in the set has both a short and a long name, we are going to
find by the short name, so ensure View/Long Names is unchecked before
continuing.

4. Now select the Group we want to search in - Australian Standards.

5. Select Edit/ Find in the library, and type in AS 4100 as shown.

6. Library Access System finds the AS 4100 group which contains the data
lists which are appropriate for AS 4100 design, click the plus sign to the
left of this group. Pick the Steel sections data list (AU) item which is also
highlighted above.

7. Now to bring this item into your calculation, either double click the item,
or click the Execute… button. You should find the following has been
entered in your document.
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8. This text inserted is a Tedds Data List Field which launches the specified
Data List (further details on Tedds Fields are given below),

9. Close the library once you have retrieved the Tedds Data List Field.

10. Now click Calculate All to calculate the document again.

11. The Data List will now be displayed when the Tedds Data List Field is
calculated:
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12. Select the 150 channel section then click on the Details button to examine
the variables defined in the table. 

NOTE Note that we have used exactly the same names for the
properties in our calculation as those defined by the Data List - A,
rx and ry. This is the key to integrating all Data Functions with your
calculations. Remember that variable names are case-sensitive.

13. Click the Select button to return these variables to your calculations - you
will see that the section's properties from the Data List replace the ? fields
in your document and the Tedds Field displays the choice you made in the
Data List.
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14. The Data List is now integrated with your calculation. Re-calculate a few
times, each time changing your selection of channel size in the Data List,
to test this.

15. Click the Variables button and you will see that all the variables defined
by the Data List are listed and are thus available to be used in calculations.

16. Save the calculation at this stage, as we will build on it in the final exercise.

NOTE Whilst in this exercise the Data List was inserted into the
calculation via the Tedds Engineering Data button, it could have
been inserted via the Tedds Field button instead. The use of
Tedds Fields is covered in the next exercise Enhancing
Calculations.

Tedds fields

1. Check the Field Codes box.

2. Look at the Tedds Field in your document and you will see the following:

3. The command that runs the Data List is now revealed. Uncheck the Field
Codes box again to return to the normal view of the document.

Tedds Fields Explained
Field Codes enable you to see and thus edit the hidden commands which are
Tedds Fields. These commands run special functions in Tedds like the Data
Lists. We will see some more Tedds Fields shortly. A Tedds Field will run when
it is calculated, like any normal expression. We hide the Tedds field, since you
would not want it to appear in a printed report. The Field Codes button
reveals the Tedds Fields. Tedds Fields should be treated like expressions, and
separated from text and other expressions in the same paragraph using
semi-colons.
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What next?

Congratulations! You have completed the fourth exercise and learned
everything you really need to write powerful Tedds calculations. Maybe now
would be the time to have a go at writing a calculation of your own. It's a good
idea to start with something simple and build on the complexity as you
become more familiar with Tedds.

The next step in the guide, Enhancing Calculations (page 228) is about making
Tedds calculations still easier to work with, and is especially relevant if you
envisage writing calculations for others to use. Even if your calculations are for
your own use you may find these further features beneficial so we
recommend that you review them. You might like to leave this step until you
have had a go at writing a calculation of your own using what you have
learned so far.

Enhancing calculations (Australian design example)
There is even more functionality available for our calculations than we have
seen so far. Whether you use these enhancements depends both on the
purpose of the calculation, and on the time you have available. Certainly these
features are very useful when you are writing calculations which others will
use (as we do at Trimble). Hence the Tedds library is packed with examples
which use these features, and you have already seen many of them when
running our calculations.

In this exercise we will enhance the previous calculation and you will see what
we are talking about.

Allow about 15 minutes to complete this exercise.

Buttons used in this exercise

The only new command you will be introduced to in this exercise is located on
the Insert group of the Tedds Calcs ribbon as shown below:
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Tedds Input Fields

The Tedds Input Field speeds up the editing and often the creating of input
variables. We will replace all the existing variable definitions in the calculation:

1. Delete the entire definition for the Yield strength, fu, from your page.
Leave your cursor on the empty line.

2. Click the Tedds Field button.

3. The following dialog will appear.

Tedds Input Field
Prompt tells the user what the variable is and

appears on the page
Name the unique name of the variable
Units if the property has dimensions then

enter a unit here
Default value this value will be displayed initially for

user to edit or accept
Format the format displayed on the page
No. of decimal places the number of decimal places

displayed on the page

4. Enter the details shown to define the input for this variable: 
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Prompt = Yield strength

Name = fu

Units = MPa

Default value = 430

Format = Fixed

No. of decimal places = 0

5. Accept the defaults for other options and click OK when you have
everything entered. 

NOTE We do not put a value in this dialog - this is entered when the
statement is calculated.

6. The following will appear on the line containing your cursor:

7. With the Field Codes button on you will see the following Tedds Input
Field preceding the text on the line.

8. Calculate your document to run it. 

The Set Variable Value dialog appears, as shown above.

9. Because we already have a value defined for this variable it is displayed in
the input. You can accept it, or edit it as required. There is no need to find
and edit the variable value on the page, as it is automatically updated
when you enter a value in the Set Variable Value dialog.
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10. Delete and replace the 3 remaining variable definitions in the same
manner – the table below shows what you need to enter in the Insert
Tedds Field dialog for each of the three variables in order from left to
right. When you have done this, recalculate your document to ensure that
your definitions are correct. 

Insert Tedds Field Properties
Input Tf Le λL

Prompt Tie force Tie effective
length

Slenderness
limit

Name Tf Le λL

Units kN m  
Default value   300
Format fixed fixed fixed
No. of decimal places 2 3 0

NOTE To enter Greek characters in the Insert Tedds Field dialog for
variable names like λ simply click the Greek character button

(  ) and then type in the equivalent Roman character, in this
case you need to type l (i.e. lowercase letter L) to get λ. To enter
Subscript or Superscript characters simply click the Subscript or

Superscript button ( ,  ) and then continue and type in the
subscript or superscript. Once you have reached its end click the
button again to switch back to typing normal text.

The Default value is entirely optional. If you enter one it will be
displayed the first time a calculation is run, otherwise the input
box will be empty. Delete the stored variables and re-calculate to
see the defaults in operation.

Tedds Interface Designer
Although The Tedds Input Field can be used to create all the variables
required in a calculation, if you would like to give your calculations a slicker
appearance we would strongly recommend using the Tedds Interface
Designer instead. This easy to use tool allows you to place all the input
variables on a single interface along with sketches and notes if required. For
a worked example and further details of how to use the Tedds Interface
Designer refer to the Tedds Help.
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Tedds Show Fields

The final thing we would like the calculation to do is automatically assess our
section and report in the document whether our chosen section is passing or
failing and, if it is failing, why. We use a Tedds Show Field to do this.

1. Enter the following two paragraphs after your existing calculations:

2. These last two values help us assess the utilisation of the section for the
two checks. Assigning them to output variables will help us with creating
Tedds Show Fields. Calculate your document once you have written them
to ensure they are working properly before proceeding.

3. Place your cursor beneath these paragraphs and click the Insert Tedds
Field button.

4. Select the Show tab. The Show Field we want to create will test whether
the section is failing stress and output a message to give the status of the
check.

5. Select the Condition type option and input the following information:

6. The output of the Tedds Show Field consists of two text messages known
as output strings. Only one output string is displayed in the document
depending on the status of the condition.

7. Check your input carefully, then click OK to enter the Tedds Show Field in
the document.

Get familiar with Tekla Tedds 232 Tekla Tedds Quick Start Guides



8. When you have OK'd the input, click the Field Codes button to view the
resulting Tedds Show Field. It should be as shown below. If your Tedds
Show Field is incorrect, the best thing to do at this stage is to delete it and
run through the Insert Tedds Field dialog again.

Using logic In Tedds

Take a close look at this Tedds Show field, and you can see how we use a
simple logic statement to output one of two pieces of text using the if logical
operator.

if(check_stress > 1, “Section fails stress check” , “Section OK for 
stress”) 

The general form of this logic expression is as follows:

if(condition, true_output, false_output)

NOTE You can use this kind of expression to define variables using a
condition. The outputs can be values, expressions or further logic
expressions.

For example:

a = if(b > c, 10, 20) = ? 

Check table of Logic Functions in the Mathematics (page 524) topic for
full details.

1. Now calculate your document to calculate the Tedds Show Field. You
should find you have something similar to the following in your Progress
Log and you will also see the output text on the page where you placed
the Tedds Show Field.

2. Change some of your input values and re-calculate a few times to test
your full calculation and both the pass and fail output of the Tedds Show
Field.
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Tedds Data List Fields

In the previous exercise we inserted a Data List Field into the calculation using
the Engineering Data button. However, it could have been inserted more easily
using the Tedds Field button:

1. With the Field Codes button on you will see the following Tedds Data List
Field:

2. Delete the entire definition of this field from your page. Leave your cursor
on the empty line.

3. Click the Tedds Field button.

4. Select the Data List option and scroll down to select the same .dls file
name as that shown in the line you just deleted above.

5. Input the Prompt as Select Section.

6. To input the Default page and Default item click the ellipsis button ( ) and
then select the page and section size that you want to appear as the
default.

7. Accept the defaults for other options and click OK when you have
everything entered.

8. Calculate your document to run it once more.

What next?

Congratulations! You have completed the final exercise in the guide and are
ready to begin using Tedds to its full potential.

Here are a few things you could try next:

• Create another Tedds Show Field similar to that above for the slenderness
check - following is the logic statement you would use for this:

Condition    check_slender > 
1

• Create a Tedds Show Field to give the overall status of the section, checking
both slenderness and stress. Try the following:

Condition    check_slender > 
1

Yes PASS
No Section fails!
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• Take a look at Tedds Message Fields. The input for these is the same as
Tedds Show Fields but their output is displayed in a Message box, rather
than in the document. You will see examples of their use in the Tedds
Engineering Library Calculations.

• Try creating Messages using the Value of Variable option to show the
values of the minimum area and radius of gyration in the Log before the
Data List is displayed.

Of course there's much more for you to discover. We wish you an enjoyable
and productive time in using the program in your day-to-day work, and
exploring its capabilities more fully.

If you would like to read up on further information about Tedds, then we
recommend the Tedds Help system, which you can access in the usual way.

Some Tedds dialogs have context sensitive help. To see this simply click the
Help button in the dialog.

We also run training courses in most locales, for further information on
availability contact the Tedds support team in your region, simply click the
Support icon in any of Tedds’ automated calculations.
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5 Introducing the Tedds
Application

Tedds allows you to automate your engineering calculations. Tedds has been
written by structural engineers for structural engineers, and therefore, it
should meet the requirements of your everyday engineering tasks.

To perform calculations in Tedds, you simply need to select the calculation
that you need in the Tedds calculation library. Tedds automatically runs the
calculation, and prompts you for any additional information that is needed.

If the calculation requires information that you would traditionally obtain from
a printed source (such as a book of section properties, safe load tables, or
code graphs), Tedds allows you to select the details in a data list, a data table,
or a data graph.

Once you have completed the input and made the appropriate selections,
Tedds completes the calculations and displays the results.

Once you have performed the calculation, you can save it to disc, send it to a
range of destinations, print it, or recalculate it.

See also

Select a calculation (page 237)

5.1 Components of the Tedds Application window
To efficiently use Tedds, see the main components of the the Tedds
Application window in the following image.
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1. The file menu: contains file management commands, such as Save, Close,
and Print.

2. The Tedds ribbon: contains the tabs that allow you to access all features
of Tedds.

TIP If you need more information on a command, rest the mouse
pointer over a command icon. A tooltip appears and describes the
action that you can perform by clicking the icon.

3. The Project Manager window: allows you to organize multiple
documents together into a single project.

4. A Tedds calculation: displays a calculation that you have performed in
Tedds.

This area in the the Tedds Application window remains empty before you
run a calculation.

5.2 Select a calculation
When you create a new document in Tedds, the Select Calculation dialog box
automatically appears. To select a calculation in the dialog box, see the
following instructions.
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NOTE The list in the Select Calculation dialog box depends on the locale
that Tedds currently uses. Typically, you can view the standard Tedds
calculations. Depending on the locale and your previous use of Tedds,
you may also have other options available. The other options can be,
for example, calculations that use a particular set of units, or
calculations that you have downloaded on the Tedds web site.

In order to switch to another locale, see Change the locale (page 243).

1. Click the folder for the type of calculation that you need. 

The folder opens and displays the calculations within it.

2. Double-click the name of the required calculation. 

Tedds performs the calculation, invoking any data lists, data tables, or
other features that the calculation requires.

5.3 Search calculations in the Select Calculation dialog
box
In the Select Calculation dialog box, you can use search text to quickly locate
specific calculations. If necessary, you can also adjust the search properties to
find better results.
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Find a calculation
1. Type the desired search text in the Find in list field. 

If your search text matches a calculation, Tedds opens the relevant group
and views the matching item.

2. If the displayed result is not correct, do one of the following:

• Click Next to see the next item that matches your search text.

• Click Previous to return to the previous item that matched your search
text.

• Adjust the search text.

Adjust search options
• Click the Options button on the right side of the Find in list field.

• If necessary, select one or more of the following options:

• Match case: If you select this option, the search only matches if both
the letters and their case are identical to your search texts.

• Find in item descriptions: If you select this option, the search looks for
the search text also in the calculation descriptions. If you do not select
this option, the search only looks for the search text in item name.
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5.4 Components of a calculation interface
Once you have started calculating, all of the Tedds calculations share a similar
style of interface. See important calculation interface details in the following
paragraphs.

1. Context-sensitive information box

displays additional information about the selected variable, if available.

2. NOTES

displays additional details on the calculation that you are performing.

3. SKETCHES

displays a sketch related to the calculation that you are performing.

4. VARIABLES

lists all the variables and their values in the current calculation document.
You can select variables and then enter them in the calculation, if
necessary.

5. FEEDBACK

allows you to send feedback to the Tedds development team.

6. SUPPORT

opens a new window that allows you to contact the Tedds support.
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7. Data fields

allow you to type in necessary information. In some cases, variables may
have validation, which prevents you from entering invalid information.

8. Buttons

allow you to enter more information or select a particular item that the
current calculation requires.

9. Navigation buttons (such as Finish and Cancel)

allow you to finish the calculation, cancel the calculation process, or go to
the next or previous page in the calculation interface.

5.5 After performing a calculation
Once Tedds has performed a calculation, you have several options to
continue. You can:

NOTE The following only applies to the Tedds Application.

TIP Tedds can have more than one document open at once. To view open
documents or to switch between them, click the appropriate document tab
directly above the window that contains the calculation.

Re-calculate the document
Re-calculating the document allows you to change any data in the calculation
interface. Tedds remembers all variables and settings for the calculation.

To re-calculate the document:

1. On the Home tab, click Calculate. 

The calculation interface opens.

2. Adjust the data according to your needs.

3. Click Finish. 

Tedds re-calculates the document.

Change the header details
1. On the Home tab, click Header. 

For more information, see Adjust calculation sheet details (page 249).
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Copy the current document
1. On the Home tab, click Duplicate. 

Tedds copies the current document. If necessary, you can now re-
calculate the document and change the calculation data.

Create a new calculation document
1. On the Home tab, click New. 

The Select Calculation dialog box opens, allowing you to select the
appropriate calculation.

Send the contents of the document to another application
1. Click to open the file menu.

2. Hover the mouse pointer over Send To.

3. Select where you want to send the document. 

NOTE There is a difference between sending the calculation to Microsoft
Word or Tedds for Word:

• Sending the calculation to Microsoft Word will copy only the
text into a Word document.

• Sending the calculation to Tedds for Word copies the
calculation and all the variables into Tedds for Word, so that
they can be re-calculated.

If you regularly send calculations to the same destinations, we
recommend that you select the Wizard... option. This way, you can select
the destination you want to use each time you click Send To.

Open an existing document
1. On the Home tab, click Open.

2. Select the Tedds document (with a .ted file extension) that you want to
open.

Save the document
1. On the Home tab, click Save.
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2. Define the file name and location. 

Tedds saves the document as a .ted file, including all of the input, settings
and variables. You or anyone else with access to Tedds can open and re-
use the document.

Save the document as pdf
1. Click the file menu, then click the drop-down button adjacent to Save

As....

2. Click Save As PDF

3. Define the file name and location. 

Tedds saves the document as a .pdf file.

Save the project as pdf
1. Click the file menu, then click the drop-down button adjacent to Save

As....

2. Click Save Project As PDF 

The command will run the Save Project as PDF wizard which is a multi
page user interface for choosing how the project should be saved to PDF.

3. On Page 1 Documents, choose which documents in the project should be
included in the PDF file.

4. Click Next

5. On Page 2 Options, choose how the PDF file(s) are created.

Print the document
• In the file menu, click Print.

5.6 Change the locale
The locale that Tedds uses determines which calculations you can access and
which data you can use in your calculations. If you have purchased additional
regional libraries, you can switch to any of the available locales by using the
Locale list on the Home tab. To change the locale, do the following:

1. On the Home tab, click Locale.

2. In the list that appears, select the desired locale. 
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NOTE Re-calculating the document after changing the locale may lead to
incorrect results. Ensure that the new locale is compatible with
the existing calculations.

See also

Regional settings (page 348)

5.7 View hidden text, semicolons, or variables
Tedds automatically hides some elements in your calculations, such as
intermediate calculations, delimiters, and variables. However, if necessary, you
can decide to view the hidden elements. For more information, see the
following paragraphs.

NOTE The following only applies to the Tedds Application.

Show or hide hidden text

Tedds automatically views the important steps of a calculation in the
document. However, Tedds also needs to perform intermediate calculations in
order to obtain their results for subsequent use. If all the calculations were
visible, the complete set of calculations would be inordinately long and
convoluted. Tedds handles this by using hidden text. This means that the
calculations exist, but normally you neither see nor print them. However, if
necessary, you can view the intermediate calculations.

To review hidden calculations, do the following:

• On the View tab, select the Hidden Text option.

You can now see all the calculations in the document.

TIP To hide the intermediate calculations again, clear the Hidden Text
option.

Show or hide semicolons

Tedds can perform multiple calculations on the same line of the text. In these
situations, semicolons (;) separate calculations from one another. In order to
avoid any distraction to the flow of calculations, Tedds usually hides all
semicolons. However, if necessary, you can view them to determine the
different calculations.

To view the semicolons in your calculations, do the following:

• On the View tab, select the Semicolons option.

You can now see all the semicolons in the document.
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TIP To hide the semicolons again, clear the Semicolons option.

View variables

When Tedds performs calculations, it stores the results as variables. Generally,
you see the variables in the calculations, although some of them may be in
hidden text.

To quickly view the final result of a particular variable:

1. On the Home tab, click Variables.

The Variables dialog box opens.

The dialog box contains the following tabs:

• The Manage tab: allows you to delete variables in your calculation.

• The Document tab: allows you to view all the variables in the current
document.

• The System tab: allows you to view all the pre-defined variables that Tedds
recognizes.

Use the Variables dialog box
You can use the Variables dialog box to manage the different variables in your
calculation documents. The following paragraphs cover some useful features
of the Variables dialog box.

NOTE To adjust the Variables dialog box, do the following:

In the Tedds Application:

1. On the Home tab, click Options.

The Options - Default dialog box opens.

2. Go to Dialogs.

In Tedds for Word:

• In the Tools ribbon group, go to More --> Tedds options.

The Options - Default dialog box opens.

• Go to Dialogs.
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Dimensions and units

Variables are stored in system base units, rather than the units which you
specified in your calculation. Therefore, the Variables dialog box does not
store units. Instead the Variables dialog box replaces units with the
dimensions of the variable.

The following table illustrates the different dimensions of variables:

Variable dimensions
Symbol Meaning

M Mass
L Length
T Time
D Temperature

The dimension symbols can be combined in different ways.

For example, the dimensions of a variable in kN or kips are MLT-2.
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TIP In order to view the variable in its original units and have it converted
into all equivalent US and SI units, move and hold the cursor over the
variable.

Variable attributes

The following table illustrates the different variable attributes. You can see
them in the Attributes column.

Symbol Meaning
e The variable is stored as an

expression.
r The value cannot be overwritten.
m The variable has been modified since

the current calculation process
started.

Sort variables

Sorting variables makes it easier to locate variables and values, and allows you
to analyze variable data. You can, for example, verify that similar variables
share the same dimensions and units.

• To change the order in which the variables are displayed, click one of the
columns.

The first click arranges the variables in ascending order.

A second click arranges the variables in descending order.

TIP To modify the sorting of variables, in the Options - Default dialog box,
go to Dialogs --> Variables.
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Group variables

Grouping variables by column allows you to analyze variable data efficiently.
You can, for example, group variables by value to find variables with the exact
same values.

To group variables, see the following instructions.

1. Right-click anywhere in the variable list.

2. In the context menu that appears, select Group by.

3. Select the column by which you want to group the variables.

Copy and paste variables

You can use the Copy and Paste buttons to copy variables:

• From calc section to calc section

• From document to calc section

• From calc section to document

• From system to calc section or document

• FromTedds document to Tedds document

• From Tedds for Word document to Tedds for Word document

• From Tedds document to Tedds for Word document or vice versa

See also

Pre-defined system variables (page 562)

5.8 Adjust the zoom level
Generally, Tedds shows the results of a calculation as they would look if they
were printed. This means that some of the calculations may be too small to
review easily on screen. You may also sometimes want to see an overview of
several pages of a large calculation. Therefore, Tedds allows you to zoom the
display according to your needs. See the following instructions.

NOTE The following only applies to the Tedds Application.

1. On the View tab, click Zoom. 

The Zoom dialog box opens.

2. Type the desired zoom percentage.

3. Click OK. 

The zoom level changes to match the specified percentage.
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5.9 Adjust calculation sheet details
Tedds contains a series of different templates that you can use in your
calculations. In addition, you can include your company details and logo in the
header of calculation documents, and set header details that are only
applicable to an individual document.

NOTE The following only applies to the Tedds Application.

1. On the Home tab, click Header. 

The Header Properties dialog box opens.

2. Click to open the Document tab. 

3. Set the calculation sheet details. 

The fields that you see on the Document tab depend on the current
calculation template. If you change the calculation template, you may
have to set additional information.

TIP If necessary, you can copy the document details from one document
to another. Do the following:

a. Ensure that you have opened both the document whose details
you want to copy, and the document to which you want to copy
the details.

b. Go to the document whose details you want to copy and open
the Header Properties dialog box.

c. Click Copy All.

Introducing the Tedds Application 249 Adjust calculation sheet details



d. Go to the document where you want to past the header details
and open the Header Properties dialog box.

e. Click Paste All.

The header details are pasted to the current document.

4. Go to the Company tab. 

5. Adjust the company name and address according to your needs. 

TIP If you want Tedds to use the details which you have defined here as
default company details, select the Save these settings as the
default for new documents option.

6. Go to the Template tab. 
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7. In the Document Template section, click Select... to select the desired
document template.

8. If necessary, in the Header Logo section, click Browse... to add your
company logo to the header, and scale the logo appropriately. 

NOTE You have two options when adding the company logo. You can
either:

• Create a link to your logo file, so that any changes to the logo
are applied to the header as well.

• Embed the logo, so that the current logo is maintained even if
the source file changes.

9. Click OK. 

The changes are applied to the header.

Modify header labels
If you need to modify the labels of the various header property fields, you can
modify the labels to meet your needs. In order to do so, see the following
instructions.

1. In the Header Properties dialog box, click Edit labels... 
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The Edit Header Property Labels dialog box opens.

NOTE The fields in the Edit Header Property Labels dialog box depend
on the currently used calculation template. If you change to a
different template, some labels may no longer be appropriate, or
you may have to set new labels.

2. Modify the labels according to your needs.

3. Click OK. 

The Edit Header Property Labels dialog box closes.

4. In the Header Properties dialog box, click OK. 

The changes are applied to the document header.

5.10 Organize projects with the Project Manager
The Project Manager window in the Tedds Application allows you to adjust
and organize your projects. In this section, you will learn to create, open, and
close projects, add existing documents to projects, reorganize the documents
within projects by using folders, and modify project headers.

Create a new project
To create a new project, see the following instructions.

NOTE The following only applies to the Tedds Application.

1. Open the file menu.
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2. Hover the mouse pointer over the New... button.

3. In the list, select New Project. 

An empty project is created. The project appears in the Project Manager
window.

4. In the field next to the project, type a suitable name for the project.

Add documents into a project
In case you need to add new calculation documents into your current project,
see the following instructions.

NOTE The following only applies to the Tedds Application.

1. On the Project tab, do one of the following:

• To insert an existing document in the project, click Existing
Document.

• To insert a new calculation in the project, click New Document.

• To insert the currently active calculation document in the project, click
Active Document.

2. If necessary, repeat step 1 until you have added all necessary documents.

Reorganize documents within a project
When you create a new project, it initially has a flat structure. However, if you
want to organize the documents more hierarchically, you can add folders to
the currently open project. For more information, see the following
instructions.

NOTE The following only applies to the Tedds Application.

1. On the Project tab, click Folder. 

An empty folder appears within the current project in the Project
Manager window.

2. In the field next to the empty folder, type a name for the folder.

3. Move the desired documents into the folder either by dragging them into
the folder or by using the Move Up or Move Down commands on the
Project tab.

Modify document headers or project headers
Tedds contains two types of headers: document headers and project headers.
Document headers apply to an individual document, whereas project headers
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are common to all documents within a project. Modifying the header
information can be particularly useful when you add documents with existing
header information into a project. In order to modify the headers of a
document or a project, see the following instructions.

NOTE The following only applies to the Tedds Application.

Modify the header of an individual document
1. On the Home tab, click Header. 

The Header Properties dialog box opens.

The Header Properties dialog box contains the following tabs:

• Document tab: allows you to modify the header information regarding
the document.

• Company tab: allows you to modify the company information visible
in the header.

• Template tab: allows you to change the document template and select
a logo that is used in the header.

2. Modify the header properties according to your needs.

3. Click OK. 

The changes you made are applied to the current document.

Update all headers in a project
1. On the Project tab, click Project Header. 

The Header Properties dialog box opens.

The Header Properties dialog box contains the following tabs:

• Document tab: allows you to modify the header information regarding
the document.

• Company tab: allows you to modify the company information visible
in the header.

• Template tab: allows you to change the document template and select
a logo that is used in the header.

2. Modify the header properties according to your needs.

3. Click OK. 

If the project contains several documents, Tedds asks you whether you
want to apply the new header properties to all documents in the project.

4. Click Yes. 

Introducing the Tedds Application 254 Organize projects with the Project Manager



The changes are applied to the entire project.

NOTE Only the settings that you have modified in the Header
Properties dialog box are overwritten in each document.

Open or close existing projects
You can easily open or close existing projects using the file menu. For more
information, see the following instructions.

NOTE The following only applies to the Tedds Application.

• Do one of the following:

To Description
Open an existing project 1. On the file menu, click Open Project...

2. Browse to find and select the required
project.

Close an open project 1. On the file menu, click Close Project.
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6 Introducing Tedds for Word

Tedds for Word is a Microsoft Word add-in that allows you to automate your
engineering calculations and create professional-looking calculation
documents. The following paragraphs introduce Tedds for Word and its main
features.

With Tedds for Word, you can either select and execute an existing calculation
in the Tedds engineering library, or create and modify your own calculations.
You can also combine the two approaches.

In addition, Tedds for Word allows you to:

• Format your documents in the way that you want to arrange them.

• Customize the document headers and footers to match your company
style.

• Include multiple calculations in your document.

• Include output from other applications in your document.

• Access all the standard engineering data which the calculations in the
Tedds engineering library use.

• Link calculations together to copy input data or results from one
calculation to another.

• Save fragments of your document to your own engineering library, so that
you can reuse them later.

• Integrate your spreadsheets with Tedds.

• Share your calculations with other Tedds users.

NOTE These instructions have been written to reflect Microsoft Word 2016. If
you are using a different version of Microsoft Word, some features
may vary.
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6.1 Components of the Tedds for Word window
To efficiently use Tedds for Word, see the main components of the Tedds for
Word window in the following image.

1. Tedds tab

allows you to access all features of Tedds for Word.

2. Tedds ribbon

appears when you click the Tedds tab. The Tedds ribbon allows you to
quickly access the most common features of Tedds for Word.

3. Tedds ribbon groups

are toolbars that allow you to use the most common features of Tedds for
Word with a single click.

4. Library Access System

allows you to browse the predefined calculations in the Tedds engineering
library and your own calculations.

See also

Tedds ribbon groups (Tedds for Word only) (page 607)

Start the Library Access System (Tedds for Word only) (page 374)
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7 Introducing Tedds for Word
calculations

With Tedds for Word, you can either perform pre-defined structural
calculations, or write and use your own calculations. This section introduces
the basic Tedds for Word calculations and their components.

Using Tedds for Word, you can:

• Define and perform your own calculations in any Microsoft Word
document quickly and simply.

• Access standard calculations by using the Library Access System.

• Access component calculations by using the Library Access System.

• Include engineering data in your calculations by using data lists, data
tables, and data graphs.

• Calculate anything from a single calculation to an entire document.

• Automatically verify the dimensional accuracy of your calculations by
specifying the appropriate units for your variables.

• Define multiple calc sections in your document, so that the same variables
can have different values within your document.

7.1 Components of calculations
This presents the components of calculations which you can find in Tedds for
Word. When you are familiar with the components, you can easily proceed to
writing your own calculations.

NOTE The following only applies to Tedds for Word.

See also

Create and modify expressions (page 267)
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Define results (page 268)

Show or hide semicolons (page 272)

Use variables (page 276)

Use units in calculations (page 273)

Overview (SI Metric)

NOTE The first three components (1–3) are mandatory key components in all
Tedds calculations. The components 4–7 are optional.

1. An expression

that is the part of the calculation that needs to be evaluated.

2. An equal sign (=)

that tells Tedds for Word that this is a calculation which it should to
calculate.

3. A results field

that defines the location of the result. If necessary, you can set a format
and precision for the result.

4. An explanation

that helps the user of the calculations to understand a calculation.

5. One or more delimiters

that separate explanatory text from a calculation and calculations from
one another.

6. A variable

that assigns the result of the expression to a variable. You can use the
variable later in your calculations.
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7. Units

that you use both when you define calculations and when you define
results.

For further information about the components, see the following paragraphs.

Overview (US Imperial)

NOTE The first three components (1–3) are mandatory key components in all
Tedds calculations. The components 4–7 are optional.

1. An expression

that is the part of the calculation that needs to be evaluated.

2. An equal sign (=)

that tells Tedds for Word that this is a calculation which it should to
calculate.

3. A results field

that defines the location of the result. If necessary, you can set a format
and precision for the result.

4. An explanation

that helps the user of the calculations to understand a calculation.

5. One or more delimiters

that separate explanatory text from a calculation and calculations from
one another.

6. A variable

that assigns the result of the expression to a variable. You can use the
variable later in your calculations.
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7. Units

that you use both when you define calculations and when you define
results.

For further information about the components, see the following paragraphs.

Expressions

The expression is the part of a calculation that is evaluated during the
calculation process.

Tedds for Word recognizes an expression by the presence of an equal sign (=).

You can write expressions yourself, or use the expressions available in the
Tedds engineering library.

Examples

(45 x 23)

a + b

0.6 x Fy

Equal signs

Equal signs are a crucial component of calculation documents. They allow
Tedds for Word to find and evaluate the calculations in a document.

Equal signs separate the different parts of your calculation:

• An expression from the results field, to show a result:

a + b = ?

• A variable from an expression:

c = a + b

• A variable from an expression from a results field

Fa = 0.6 x Fy = ?
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If you type text and do not include an equal sign, Tedds for Word considers the
text an explanation.

TIP To insert an equal sign (=) that is not calculated, click the Equals not

calculated button ( ) in the Insert ribbon group.

Results fields

Results fields tell Tedds for Word where to place the result of an expression.

Tedds for Word calculated all results to a precision of 15 decimal places.

• # indicates that you want to view an intermediate result.

• ? indicates that you want to view a final result.

Explanations (SI Metric)

Explanations are optional elements that can make your calculations easier to
follow.

You do not need to mark explanations with any special characters. However, if
you want to add an explanation in the same paragraph as your calculations,
remember to separate the explanation and the calculation with a semicolon
delimiter ;.

Explanations (US Imperial)
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Explanations are optional elements that can make your calculations easier to
follow.

You do not need to mark explanations with any special characters. However, if
you want to add an explanation in the same paragraph as your calculations,
remember to separate the explanation and the calculation with a semicolon
delimiter ;.

Delimiters (SI Metric)

Delimiters are special characters which you can use to separate text from a
calculation, or calculations from one another.

Tedds for Word recognizes the following delimiters:

• Paragraph marks (¶)

If you write your calculations in separate paragraphs, you can press Enter
to separate the calculations from each other. When you do so, Word
automatically adds a paragraph mark (¶).

• Semicolons (;)

If you want to place explanatory text in the same paragraph as an
expression, or if you want to place several calculations in the same
paragraphs, use a delimiter to separate the items from each other.

NOTE Semicolon is the default delimiter within paragraphs. However,
certain locales allow you to use another delimiter within
paragraphs. For more information, see Regional settings
(page 348).

NOTE Line breaks (Shift + Enter) within an expression have no significance in Tedds
for Word. You can therefore use them to improve the layout of long
calculations on the page.

However, if you want to use line breaks and have several calculations within
the same paragraph, you still need to use semicolons to separate the
calculations.
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Delimiters (US Imperial)

Delimiters are special characters which you can use to separate text from a
calculation, or calculations from one another.

Tedds for Word recognizes the following delimiters:

• Paragraph marks (¶)

If you write your calculations in separate paragraphs, you can press Enter
to separate the calculations from each other. When you do so,
automatically adds a paragraph mark (¶).

• Semicolons (;)

If you want to place explanatory text in the same paragraph as an
expression, or if you want to place several calculations in the same
paragraphs, use a delimiter to separate the items from each other.

NOTE Semicolon is the default delimiter within paragraphs. However,
certain locales allow you to use another delimiter within
paragraphs. For more information, see Regional settings
(page 348).

NOTE Line breaks (Shift + Enter) within an expression have no significance in Tedds
for Word. You can therefore use them to improve the layout of long
calculations on the page.

However, if you want to use line breaks and have several calculations within
the same paragraph, you still need to use semicolons to separate the
calculations.

Variables (SI Metric)

Variables allow you to re-use a calculated value later in your calculations.

To recall the value, you can simply type the variable. Tedds for Word
automatically looks up the value that was assigned to the variable, and allows
you to use the value in the current calculation.
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Variables must follow some simple rules. Variables must:

• Only contain alphanumeric characters (A-Z, a-z, 0-9), Greek characters,
underscores (_), and full stops (.).

• Not be longer than 32 characters.

• Not start with a number.

• Not be the same as a Tedds function name (for example sin or median).

• Not contain superscript characters.

• Not contain any formatting other than subscripts.

NOTE When a part of a variable is in subscript, the part can contain
spaces and a list separator (, or ;).

NOTE • Variables are case-sensitive.

For example, Area and area are two separate variables.

• Variables take subscripts into account.

For example, Aeff and Aeff are two separate variables.

Variables (US Imperial)

Variables allow you to re-use a calculated value later in your calculations.

To recall the value, you can simply type the variable. Tedds for Word
automatically looks up the value that was assigned to the variable, and allows
you to use the value in the current calculation.

Variables must follow some simple rules. Variables must:

• Only contain alphanumeric characters (A-Z, a-z, 0-9), Greek characters,
underscores (_), and full stops (.).

• Not be longer than 32 characters.

• Not start with a number.

• Not be the same as a Tedds function name (for example sin or median).

• Not contain superscript characters.
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• Not contain any formatting other than subscripts.

NOTE When a part of a variable is in subscript, the part can contain
spaces and a list separator (, or ;).

NOTE • Variables are case-sensitive.

For example, Area and area are two separate variables.

• Variables take subscripts into account.

For example, Aeff and Aeff are two separate variables.

Units (SI Metric)

You can define units as you create your calculations. Tedds for Word allows
you to both use its internal system units, called base units, and add new units
into the system. In addition, Tedds for Word analyses whether the selected
units are dimensionally correct.

You can define the desired units for both the variables that you define, and
the results which you expect, by simply typing the units in your calculations.

The units which Tedds for Word uses as its base units depend on the locale
option that you selected during installation. Some locale options only allow a
single set of units, while others allow you to select the set which you prefer to
use: SI Units or US units. To change the locale, see Regional settings.

See the base units of each set in the following table.

Tedds for Word base units
Quantity SI Metric

Length m
Mass kg
Time s
Temperature °C
Angle °
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Units (US Imperial)

You can define units as you create your calculations. Tedds for Word allows
you to both use its internal system units, called base units, and add new units
into the system. In addition, Tedds for Word analyses whether the selected
units are dimensionally correct.

You can define the desired units for both the variables that you define, and
the results which you expect, by simply typing the units in your calculations.

The units which Tedds for Word uses as its base units depend on the locale
option that you selected during installation. Some locale options only allow a
single set of units, while others allow you to select the set which you prefer to
use: SI Units or US units. To change the locale, see Regional settings.

See the base units of each set in the following table.

Tedds for Word base units
Quantity US Imperial

Length ft
Mass slugs
Time s
Temperature °C
Angle °

7.2 Create and modify expressions
Expressions are calculations that need be evaluated. To create and modify
expressions, see the following instructions.

NOTE The following only applies to Tedds for Word.

Create expressions
1. Type the expressions that you want to calculate.

2. After each expression, type = and one of the following:

• A value

• The intermediate results symbol (#)
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• The final results symbol (?)

3. Calculate the expressions.

Modify expressions
1. Type over the parts that you want to change in your calculations.

2. Recalculate the changed calculations and any other calculations that are
affected by the changes.

7.3 Define results
To show the result of an expression, you must define the type of results that
you want. To define the type of results, see the following instructions.

NOTE The following only applies to Tedds for Word.

Tedds for Word includes two types of results. The types are:

• Intermediate results

that display the values used within a calculation.

You can use an intermediate result with or without using a specific format.

• Final results

that display the final value of an expression.

You can use a final result with or without using a specific format and with
or without units.

See also

Define result formats (page 269)

Define units for results (page 271)

Define intermediate results
1. Type your expressions.

2. After each expression, type = #

3. If necessary, type a format string to define the result format and
precision.
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Define final results
1. Type your expressions.

2. After each expression, type = ?

3. If necessary, type a format string to define the result format and
precision.

4. If necessary, type the unit that you want to display the results in.

Define result formats
Tedds for Word allows you to specify how a result appears in your document.
To do so, you can define the format and precision of your results. For more
information on defining result formats and precision, see the following
paragraphs.

NOTE The following only applies to Tedds for Word.

See also

Result formats (page 545)

Use a format other than the default for a particular results field
1. Type the appropriate results symbol (# or ?).

2. Type a format string that contains the following components:

• A format letter to define the format

• A precision number to define the precision

NOTE If no format string is specified, Tedds for Word uses the default
format.

To define the default format of results:

a. In the Tools ribbon group, click More --> Tedds options.

b. Go to Calculating --> Results.

Format letters and precision numbers

Valid format letters for results

See the valid format letters to define the format in the table below:

Letters Meaning
F Fixed format
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Letters Meaning
S Scientific format
G General format
E Engineering format
O Output format

Valid precision numbers

The precision number indicates the precision of the required results, and
should be in the range of 15 and -15.

• A positive number indicates the required number of decimal places or
significant figures.

• A negative number indicates that the result will be rounded to a nearest
value which depends on the magnitude of the negative number.

NOTE Tedds for Word returns all results in a results field. Each results field
has two parts:

1. The result part

which contains the formatted result of a calculation. The result
part is automatically shown when the result has been calculated.

2. The field code part

which contains the format string of the results field.

To view the field code part, in the Show/Hide ribbon group, select
Field Codes.

Example:

a = 50.5 mm

b = 60.75 mm

c = a * b = #E3 = ?F2 cm²

With the Field Codes option unselected, Tedds for Word views:

c = a * b = (3.07 * 10 – 3) = 30.68cm²

With the Field Codes selected, Tedds for Word views:

c = a * b = {=CSC|#E3} = {=CSC|?F2} cm²

Define formats for intermediate results
The default intermediate result format is initially set to engineering format and
3 significant figures.

To define the format of an intermediate result:

• Type # and the desired format string.
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Define formats for final results
The default final result format is initially set to fixed format and 3 decimal
places.

You can either define the format for a final result, or specify both its format
and precision. However, you can not specify only the precision of a final result.

To define the format of a final result:

• Type ? and the desired format string.

Define units for results
If necessary, you can define the units that you want to use in the final results
of your calculations. See the following instructions.

• After each question mark and format string, type the desired unit for the
results. 

For example:

= ?F1 N/mm2

TIP To create clear calculation documents and minimize any calculation
problems, we recommend that you place a space between a value
and its unit.

NOTE If the Perform dimensional checks option is switched on, the
dimensions of the units must be equivalent to the dimensions
calculated by dimensional analysis. For more information, see
Dimensional analysis (page 541).

Example

With the format and precision settings shown, the following equations

a = 150 mm; b = 60 cm; c = 2.5m

a * b = ? F0 cm 2

a * b * c = ? F3 m 3

calculate to give

a = 150 mm; b = 60 cm; c = 2.5m

a * b = 900 cm 2

a * b * c = 0.225m 3
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See also

Use units in calculations (page 273)

Define result formats (page 269)

Change the units of results
If necessary, you can modify the units used in final results. To change the units
of results, see the following instructions.

1. Type new units over the existing ones.

2. Recalculate the modified expressions.

Example

The following expressions have already been calculated as shown:

a = 150 mm; b = 60 cm; c = 2.5m

a * b = 900 cm 2

a * b * c = 2.250 * 10 -1 m 3

We can now replace the units of the second and third results with new ones:

a = 150 mm; b = 60 cm; c = 2.5m

a * b = 900 m 2

a * b * c = 2.250 * 10 -1 cm3

After that, we must recalculate the modified expressions. The updated results
are:

a * b = 90.0 * 10-3 m2

a * b * c = 2.250 * 105 cm3

7.4 Show or hide semicolons
Semicolons (;) are delimiters which separate calculations from one another,
and calculations from explanatory text. To define whether Tedds for Word
shows or hides semicolons, see the following instructions.

NOTE The following only applies to Tedds for Word.

NOTE When you show or hide semicolons, all of them will be shown or
hidden, whether they are in explanatory text or in calculations.

• In the Show/Hide ribbon group, select or clear the Semicolons check box. 
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All semicolons in the document will become visible when you select the
check box, and disappear when you clear the check box.

NOTE If nothing happens when you try to hide semicolons, ensure that
you do not have the Show hidden text option enabled in Word
options.

7.5 Use units in calculations
Tedds for Word allows you to use units in various ways. You can, for example,
define, use and modify new units, or use predefined system units. If
necessary, Tedds for Word can also perform a full dimensional analysis on
your units. To use units in your calculations, see the following instructions.

NOTE The following only applies to Tedds for Word.

Use units in input
• Type the desired unit after a value. 

For example:

x = 234 N/mm 2

Use units in results
• Type the desired unit after the question mark and, if necessary, the format

string. 

For example:

Py = ?F0 N/mm 2

See also

Define result formats (page 269)
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Define units for results (page 271)

Using Tedds Trig functions in equations involving radians (support article)

Change units in calculations
You can change the units of a value or a result at any time. To change units in
your calculations, see the following instructions.

NOTE The following only applies to Tedds for Word.

1. Erase the current units in the expression.

2. Type the new units in the expression.

3. Recalculate the expression, and any other parts of the document that the
modified expression affects.

See also

Use units in calculations (page 273)

Use constants with units
If you need to use constants with units in an expression, do the following:

NOTE The following only applies to Tedds for Word.

• Type the constant value and its unit in the document. 

NOTE In some cases, in order to remove ambiguity, we recommend
placing the constant and its unit within brackets.

Example:

The beam x has a fixed length 14.5 m, and is subdivided into a
variable number of equal spacings, s.

Do not write the calculation as follows:

s = 10

x = 14.5 m/s = ? *

* In the above expression, Tedds for Word considers m/s as the
unit meters per second, and not the intended calculation (14.5 m
divided by 10 spacings).

To ensure that Tedds for Word performs the calculations as you
intend, place the constant and its unit within brackets as follows:

s = 10
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x = (14.5 m) / s = 1.45 m = ?

When the revised expression is calculated, it gives the correct
answer:

x = (14.5 m) / s = 1,45 m

See also

Use units in calculations (page 273)

Dimensional analysis (page 541)

Introducing calculation errors (page 293)

Use system units
Tedds for Word contains a number of pre-defined system units that you can
use in all of your calculations. The following paragraphs teach you how to use,
view, add, and remove system units.

NOTE The following only applies to Tedds for Word.

See also

Units (page 548)

Use system units in calculations
• Do one of the following:

• Type the unit after a value or a results field.

• In the Insert ribbon group, click Units, and in either the SI Units or US
Units list, select the desired unit.

The selected unit appears in your document.

View all system units
1. In a Tedds for Word document, type ListAllUnits() = ?
2. Calculate the document. 

Tedds for Word lists all available system units in your document.

Add system units

NOTE • If you have the right to access the units database file, the new unit
will be permanently added into system units.
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• If you do not have the right to access the units database file, the
new unit will only be available in the current calculation process.

1. In a Tedds for Word document, type AddUnit($x$, #a#, #b#, #c#,
#d#, #f#) = ? 

where

• $x$ is the name of the unit which you want to add

• #a# is the power of the unit dimension Ma

• #b# is the power of the unit dimension Lb

• #c# is the power of the unit dimension Tc

• #d# is the power of the unit dimension θd

• #f# is the multiplication factor that you need to apply to the Tedds
base units to change the base units to the unit symbols (such as h for
hour) of the unit that you are adding.

2. Calculate the document. 

Tedds for Word adds the unit to the unit database.

Delete system units

WARNING Before you delete a system unit, note that:

• The unit will no longer be available for you to use.

• Any calculations that use the deleted unit will no longer
calculate correctly.

• If you have the right to access the units database file, the unit
will be permanently deleted from system units.

• If you do not have the right to access the units database file,
the deleted unit will no longer be available in the current
calculation process.

1. In your document, type RemoveUnit($x$) 

where

• $x$ is the name of the unit which you want to remove

2. Calculate the document. 

Tedds for Word deletes the unit from the unit database.
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7.6 Use variables
Using variables allows you to use the results of previous calculations in later
calculations. For further information on variables and variable levels, see the
following paragraphs.

NOTE The following only applies to Tedds for Word.

Variable definitions

All variable definitions take a similar form. The minimal variable definition
must include:

• A variable name

• An equal sign

• An expression or a constant value

In addition, most variable definitions include:

• An explanation

• A delimiter

• A unit

The components of a variable definition are very similar to the component of
calculations. For more information on each component, see The components
of calculations (page 258).

Variable levels

Tedds for Word recognizes three different levels of variables:

1. Calc section variables

2. Document variables

3. System variables

This is also the order in which Tedds for Word searches values for each
variable that you place in your document. If Tedds for Word cannot find the
value in one of the variable levels, a variable definition error occurs.

NOTE You must define each variable before you recall it later in your
calculation.

See also

Use calc section variables (page 281)

Use document variables (page 285)

Use system variables (page 287)

Modify variables (page 280)

Pre-defined system variables (page 562)

Introducing Tedds for Word calculations 277 Use variables



Calc section variables
You can use calc sections to separate the variables in your document from one
another. Each calc section stores its own variables independently. This way,
you can repeat similar calculations which use the same named variables
without the calculations affecting each others' results.

Any variable that you define between the start of one calc section and the start
of the next calc section is considered a calc section variable.

NOTE • If you define variables within one calc section and want to use the
variables elsewhere in your document, you can select the variables in a
calc section and promote them to document variables.

• If you define a calc section variable with the same name as a document or
system variable, Tedds for Word uses the value that you defined in the
current calc section.

• If you define a variable twice in the same calc section, Tedds for Word
uses the initial value up to the point at which the value is redefined. After
this point, Tedds for Word uses the new value.

Document variables
Any variable that you define in the document but outside of a calc section is
considered a document variable. Usually, you would define document
variables before the first calc section of the document.

After you have defined document variables, they are available throughout the
document and across all calc sections.

TIP To avoid the variables of one set of calculations affecting a different set
of calculations, we recommend using calc sections in all calculation
documents.

System variables
System variables are provided with Tedds for Word, and you can use them
anywhere in your calculations. As system variables are pre-defined, you do not
need to define system variables before you use them in your calculations.

To use a system variable, you can simply type the name of the variable in your
document.

TIP If you want to use a system variable name with a different value, you can
redefine the variable, and the modified value will be used in document
variables or calc section variables.
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Define variables
You define all variables in the same way whether you are defining variables for
a calc section or for a document. After you have created a variable and
assigned a value to the variable, you can use it throughout your calculations in
the same calc section or document. To create variables, see the following
instructions.

NOTE The following only applies to Tedds for Word.

Variables can be equal to:

• A value

For example x = 45 or Z = 245 N/mm2

• A string

For example text = "This is a string of text."

• The result of an expression

For example C = A + B

For more information about the rules for variable names, see Components of
calculations (page 258).

Assign a value to a variable
1. Type the variable name and an equal sign.

2. After the equal sign, type the desired value, expression, or string. 

For example:

a = 45

3. Calculate the expression. 

The variable is now stored in the variable list, and you can use it in later
calculations.

Assign a unit to a variable
1. After the variable and its value, place a space. Then, type the desired unit. 

For example:

a = 45 m

2. Calculate the expression. 

The variable is now stored in the variable list with its unit, and you can use
it in later calculations.
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Modify variables
You may sometimes need to modify the values or units of variables that you
have defined. To modify variables, see the following instructions.

NOTE The following only applies to Tedds for Word.

Modify the value of a variable
1. Type a new value over the current value of the variable.

2. Calculate the expression.

Modify the units of a variable
1. Type new units over the current units of the variable.

2. Calculate the expression.

Store variables as expressions
By default, Tedds for Word stores all variables as values. However, it may
sometimes be useful to store variables as expressions instead. This is
particularly useful when the value of a term in an expression changes during
calculations. To store variables as expressions, see the following instructions.

NOTE The following only applies to Tedds for Word.

Example

To understand the difference between storing variables as values and
expressions, consider the following calculation:

r = 10 mm

A = pi * r 2 = ? mm 2

The calculation is calculated to give:

r = 10 mm A = pi * r 2 = 314.2 mm 2

When calculated, the variable A above can be stored in two different ways:

• As the value resulting from the calculation:

A = 314.2 mm 2

• As the expression that is used to define the variable:

A = pi * r 2
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If you store A as an expression value, each time you reference A in later
calculations, the value returned is re-calculated.

Therefore, if the value of r changes, the result of A changes as well.

Store variables as expressions

1. Before the variable name, type $.

2. Type the expression that you want to store.

3. Calculate the expression. 

The value of the variable is now stored as an expression.

See also

Modify variables (page 280)

Components of calculations (page 258)

Use calc section variables
You can use calc sections to separate the variables in your document from one
another, as each calc section stores its own variables independently. This way,
you can repeat similar calculations that use the same named variables without
the calculations affecting each others' results. To use calc section variables,
see the following instructions.

NOTE The following only applies to Tedds for Word.

See also

Use the Variables dialog box (page 245)

Calc sections (page 289)

Use document variables (page 285)

Define calc section variables
1. Create a calc section.

2. In the calc section, write the variable name, an equal sign, and the value of
the variable.

3. Calculate the expression.

View calc section variables
1. Place the insertion point inside the calc section whose variables you want

to view.
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2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

3. Click the Calc Section tab to view calc section variables. 

NOTE To see the Calc Section tab, the insertion point must be inside a
calc section.

Write out calc section variables into a document

NOTE You can only insert calc section variables within the calc section in
which they are defined.

If you want to use the variables in another calc section, you have to
copy and paste the variables to the other section, or promote the
variables into document variables.

1. Place the insertion point inside the calc section whose variables you wish
to insert in the document.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

3. Click the Calc Section tab to view calc section variables. 

NOTE To see the Calc Section tab, the insertion point must be inside a
calc section.
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4. Select the variables that you want to insert in your document.

5. At the bottom left corner of the Variables dialog box, select the variable
details that you want to insert in your document.

6. Click Write Out. 

The selected variables appear in your document.

Promote calc section variables into document variables
1. Place the insertion point inside the calc section whose variables you want

to promote.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

3. Click the Manage tab. 
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4. In the Calc section variables list, select the variables that you want to
promote.

5. Click <-- Add to promote the selected variables. 

The selected variables appear in the Document variables list, and can
now be used throughout the calculation document.

NOTE If you make changes that cause the value of a promoted variable
to change, the value of the promoted variable automatically
changes to the new value.

Delete calc section variables
1. Place the insertion point inside the calc section whose variables you want

to delete.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

3. Click the Manage tab.

4. Select the variables that you want to delete.

5. Click Delete. 
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NOTE If you do not plan to recreate the deleted variables, erase the
calculations that define or use the deleted variables.

Use document variables
To use a document variable, you must first define the variable. The following
paragraphs teach you to define document variables, add document variables
below calc sections, insert document variables in a calculation document, and
delete document variables.

NOTE The following only applies to Tedds for Word.

See also

Use the Variables dialog box (page 245)

Define document variables
1. At the beginning of your document, type the variable name, an equal sign,

and the value of the variable.

2. Select the variable, and calculate the selection. 

The variable is now stored in the Document variables list.

View document variables
1. Place the insertion point anywhere in the document.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

3. If the Document tab is not already open, click it to view document
variables.

Add document variables below existing calc sections
1. In the Calc Section ribbon group, click Insert. 

The Add Calc Section dialog box appears.

2. Change the type to Revert to document section. 
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3. In the Title field, type a title for the document section.

4. If you want the calc section to start on a new page, select the Insert page
break option.

5. Click OK to create the new calc section.

Write out document variables into a document
1. Place the insertion point where you want to insert document variables.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.
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3. Click the Document tab to view document variables.

4. Select the variables that you want to insert in your document.

5. At the bottom left corner of the Variables dialog box, select the variable
details that you want to insert in the calculation document.

6. Click Write Out.

Delete document variables
1. In the Tools ribbon group, click Variables. 

The Variables dialog box appears.

2. Go to the Manage tab.

3. In the Document variables list, select the variables that you want to
delete.

4. Click the Delete button. 

NOTE If you do not plan to recreate the deleted document variables,
remember to erase the calculations that define or use the deleted
variables.

Use system variables
System variables are pre-defined variables for common constants, such as pi.
You can use system variables in all your calculations. To use or view system
variables, or to insert system variables in your documents, see the following
instructions.

NOTE The following only applies to Tedds for Word.

See also

Pre-defined system variables (page 562)

Use the Variables dialog box (page 245)

Use system variables in your calculations
1. Type the variable name into an expression in your document.

2. Calculate the expression.
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View all system variables
1. In the Tools ribbon group, click Variables. 

The Variables dialog box opens.

2. Click the System tab. 

The Variables dialog box displays the system variables.

Insert system variables in your document
1. Place the insertion point where you want to place the system values.

2. In the Tools ribbon group, click Variables. 

The Variables dialog box opens.

3. Click the System tab. 
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The Variables dialog box displays system variables.

4. Select the variables that you want to insert in your document.

5. In the Write Out options, select the variable details that you want to
insert in your document.

6. Click Write Out. 

The selected system variables appear in your document.

7.7 Calc sections
You can use calc sections to separate the variables in your document from one
another. Each calc section stores its own variables independently. This way,
you can repeat similar calculations which use the same named variables
without the calculations affecting each others' results.

NOTE The following only applies to Tedds for Word.

See also

Use calc section variables (page 281)

Add new calc sections
1. In the Calc Section ribbon group, click Insert. 
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The Add Calc Section dialog box appears.

2. In the Title field, type the title of the new calc section.

3. If necessary, select the Insert page break option.

4. Click OK.

Change the title of a calc section
1. Place the insertion point inside the calc section whose title you want to

change.

2. In the Calc Section ribbon group, click Edit. 

The Edit Calc Sectiondialog appears.

3. Modify the title according to your needs.

4. Click OK.

Cut, copy and paste calc sections
1. In the Calc Section ribbon group, do one of the following according to

your needs.
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a. To cut the current calc section, inside the current calc section, click
Cut.

b. To copy the current calc section, click Copy.

c. To paste a calc section where the insertion point is, click Paste.

Delete calc sections
1. Place the insertion point inside the calc section which you want to delete.

2. In the Calc Section ribbon group, click Delete. 

A confirmation message appears.

3. If you are sure that you want to delete the calc section, click Yes. 

All variables and calculations in the calc section are now deleted.

Delete calc section fields
If you want to delete the title and variables associated with a calc section, but
keep the calculation in your document, you can delete the Word field that
defines the start of the section.

1. In the Show/Hide ribbon group, select the Field Codes box.

2. Highlight the calc section field that you want to delete.

3. To delete the highlighted part of your document, press the Delete key.

Find the next or previous calc section
• In the Calc Section ribbon group, click the arrow next to the Go To button.

• To find the next calc section, select Next.

• To find the previous calc section, select Previous.

7.8 Calculate results
To calculate different parts of your document, see the following instructions.

NOTE The following only applies to Tedds for Word.
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Calculate an expression
An expression consists of all calculations in the same paragraph, and it is the
smallest unit that Tedds for Word can automatically calculate. To calculate an
expression, follow the instructions below.

1. Place the insertion point in the expression that you want to calculate.

2. In the Calculate ribbon group, click Expression. Tedds for Word
calculates the expression.

Calculate a selected area
1. Highlight the area of the document which you want to calculate.

2. In the Calculate ribbon group, click Selection. 

Tedds for Word calculates the selection.

Recalculate a previously selected area

TIP Tedds for Word remembers the start and end of the highlighted area
which it has last calculated. Therefore, you do not need to highlight the
area again in order to re-calculate it.

• In the Calculate ribbon group, click Recalc Selection. 

Tedds for Word calculates the previous selection.

Calculate a calc section
If you have defined calc sections within your document, you can choose to
calculate a single calc section.

1. Place the insertion point in the calc section you want to calculate.

2. In the Calculate ribbon group, click Calc Section. 

Tedds for Word calculates the calc section.

Calculate from the beginning of a document to a selected
expression
1. Place the insertion point in the expression which you want to calculate up

to.

2. In the Calculate ribbon group, click Start to Here. Tedds for Word
calculates the document from the start to the end of the selected
expression.
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Calculate from a selected expression to the end of a
document
1. Place the insertion point in the expression from which you want to begin

calculating.

2. In the Calculate ribbon group, click Here to End. Tedds for Word
calculates the document from the start of the selected expression to the
end.

Calculate an entire document
1. Place the insertion point anywhere in the document.

2. In the Calculate ribbon group, click All. Tedds for Word calculates the
entire document.

7.9 Introducing calculation errors
While evaluating calculations, you will most probably encounter some sort of
calculation errors. The following paragraphs focus on introducing calculation
errors, error alerts, and error categories used in Tedds for Word.

NOTE The following only applies to Tedds for Word.

See also

Error messages (page 576)

React to errors (page 296)

Find errors (page 297)

Error alerts
The method in which Tedds for Word informs you about calculation errors
depends on whether you have selected the Prompt on calculation error
option in Tedds options.

Depending on whether the Prompt on calculation error option is selected,
Tedds for Word either:

Introducing Tedds for Word calculations 293 Introducing calculation errors



• Places an error field in your document directly after the erroneous
expression.

TIP To make the error fields easy to locate, you can set a specific font and
color for them. To modify the look of error messages, go to More -->
Tedds options --> Calculating --> Errors.

• Pauses calculations and alerts you with a dialog.

• If you click Continue, Tedds for Word continues calculating until the
calculation process has finished, or until it finds the next calculation
error.

• If you click Abort, the document will be returned to the state where it
was before you started the calculation process.

Error categories
Tedds for Word contains four different error categories:

• Variable definition errors
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• Dimensional errors

• Non-fatal errors

• Fatal errors

In the table below, see the meaning and typical examples of each error
category.

Category Description Examples Further
information

Variable
definition
errors

Errors related to
missing or
erroneous variables.

• Undefined
variables

• Capitalization
errors in
variables

• Illegal formatting
of variables

You can select
whether you want
Tedds for Word to
consider undefined
variables as errors.

1. Go to More -->
Tedds options
--> Calculating.

2. If you want an
undefined
variable to be
treated as an
error, select the
Error on
undefined
variable box.

If you do not
want an
undefined
variable to be
treated as an
error, clear the
Error on
undefined
variable box. In
this case, Tedds
for Word asks
you to enter the
variable's details
directly.

Dimensio
nal errors

Errors which occur
when dimensional
analysis is switched
on, and the units in
the expression do
not match.

• Two variables
which should be
added have
different
dimensions

None
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Category Description Examples Further
information

Non-fatal
errors

Syntax errors or
other errors, which
do not allow Tedds
for Word to finish a
calculation.

• Missing brackets
within an
expression

• Division by zero

• Unrecognized
units

Fatal
errors

Major system errors,
which automatically
abort your
calculations.

• System is out of
memory

• System is out of
disk space

React to errors
The method with which you should react to errors depends on both the error
category and the settings that you have specified for calculations in Tedds
options. The following paragraphs cover reacting to different types of errors,
which may occur while using Tedds for Word.

NOTE The following only applies to Tedds for Word.

See also

Introducing calculation errors (page 293)

Error messages (page 576)

Fix variable definition errors
Variable definition errors occur when you try to use a variable that has not
been defined, is not one of the standard system variables, or is formatted
incorrectly. Tedds for Word only alerts you about variable definition errors if
you have selected the Error on undefined variable option in Tedds options.

1. Do one of the following.

a. Define the variable by typing the value of an undefined variable, or an
expression from which the value can be determined, and the
eventual units of the variable.

b. Use another variable by typing another variable name, or by clicking
Tools --> Variables and selecting an item from the variable list.

2. Click Continue to proceed with the calculations.
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React to dimensional or non-fatal errors
Dimensional and non-fatal errors occur when Tedds for Word cannot
complete the calculation for some reason.

Do one of the following.

• Ignore the error that has occurred, and click Continue to proceed with the
calculations.

• Click Abort to return to your document leaving it as it was before the
calculation commenced, and correct the error.

React to fatal errors
Fatal errors occur when Tedds for Word cannot run correctly due to a system
error, which may mean, for example, lack of memory or disk space.

In these situations, the System error dialog appears and informs you about
the error that has occurred.

• Click Abort and return to your document, leaving it as it was before
starting the calculation.

Find errors
In a large calculation document, you can find errors easily by using the Go to
Next/Previous Error button.

NOTE The following only applies to Tedds for Word.

1. Depending on whether you want to locate the next or the previous error,
do one of the following.

a. To locate the next error: in the Tools ribbon bar, click Next error.

b. To locate the previous error: in the Tools ribbon bar, click the arrow
on the right side of the Next error button, and select Previous error.

NOTE If an errors occur in hidden lines of the calculations, finding them
with the Go to Next/Previous Error button is not possible. To
view the error, do one of the following actions.

• In the Show/Hide toolbar, select the Hidden Calcs box.

• Go to File --> Options, and in the Display settings, ensure that
the Hidden text option is selected.
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NOTE Some errors may seem impossible to find. In most cases, these
kinds of invisible errors occur because of multiple accidental
clicks on the subscript or superscript buttons.

If you simply cannot find the error, try deleting and re-typing the
erroneous expression in the calculation document.

See also

Introducing calculation errors (page 293)

7.10 Automated calculations
Tedds for Word includes a great number of automated calculations, each of
which consists of a user interface. The interface allows you to define the
details and options for your design.

NOTE The following only applies to Tedds for Word.

When you insert an automated calculation in your document, you can only see
the title of the calculation in your document. To perform the automated
calculation, you need to select and calculate the title.

When you perform the automated calculation, the details that you have
defined and the results are stored as variables.

See also

Start the Library Access System (Tedds for Word only) (page 374)

7.11 The Progress Log
When you are writing your own calculations, enabling the Progress Log may
be helpful. The Progress Log provides additional information about the
progress of the calculation process. This information may help you find
eventual problems in your calculations.
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If you enable the Progress Log, you can define which information you want
the Progress Log to display. For more information, see Progress options
(page 347).

Select the items displayed in the Progress Log
You can select the items which you want to view in the Progress Log. To select
the items displayed in the Progress Log, see the following instructions.

1. Right-click the anywhere in the Progress Log. 

A context menu appears.

2. Click Options. 

The Log type options dialog box appears.

3. In the Log item types list, select the type of item that you want to adjust.

4. To not display a type of item, clear the Log [Item type] items option.

5. If necessary, adjust the colors that are used to show each type of item in
the log. 
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• Log type

controls the colors in the left column of the Progress Log window,
where the type of item is displayed.

• Log item

controls the colors in the right column of the Progress Log window,
where the details of an item are shown.

6. Click OK. 

The settings are saved, and you return to the Progress Log window.

See also

Filter the items displayed in the Progress Log (page 300)

Roll up the Progress Log (page 301)

Filter the items displayed in the Progress Log
If necessary, you can filter the items that are displayed in the Progress Log. To
do so, see the following instructions.

1. Right-click the anywhere in the Progress Log. 

A context menu appears.

2. In the context menu, click Filter.

3. In the list that appears, select the elements that you want to display in the
Progress Log. 
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See also

Select the items displayed in the Progress Log (page 299)

Roll up the Progress Log (page 301)

Roll up the Progress Log
You may sometimes want to reduce the size of the Progress Log, so that it
does not take up so much space on your screen. To roll up or unroll the
Progress Log, see the following instructions.

• To roll up the Progress Log, click the upwards arrows in the upper right
corner of the Progress Log.

• To unroll the Progress Log, click the downwards arrows in the upper right
corner of the Progress Log.
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8 Enhancing Tedds for Word
calculations with Tedds fields

Tedds fields are Tedds features that help you create different messages and
dialogs in your calculation document. Therefore, they can aid you in making
your calculations clear and easy to use.

NOTE The following only applies to Tedds for Word.

Tedds for Word provides the following major Tedds fields:

• fields (page 303), which display a dialog asking for the value of a particular
variable.

• fields (page 305), which display information about the current calculation.

• fields (page 311), which display a message box giving the user information
on how to use the calculations.

• fields (page 317), which display information, such as details about the
progress of the calculation, in the Progress Log.

• fields (page 322), which allow you to combine the strength of Tedds for
Word and Excel.

• fields (page 325), which allow you to access data lists and select items from
them to be used as variables.

• fields (page 327), which allow you to access data tables and select items
from them to be used as variables.

• fields (page 328), which allow you to access data graphs and select items
from them to be used as variables.

• fields (page 329), which allow you to calculate an item stored in a
calculation library.

In addition to major Tedds fields, Tedds for Word contains several additional
fields. For further information on other Tedds fields, see Other Tedds fields.

To modify (page 331) some of the major Tedds fields, Tedds for Word
contains special functions. The special functions are primarily intended to be
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used with Input fields, Show fields, Message fields and Log fields. The
functions are:

• The string function (page 334), which allows you to format a numerical
value as a string to be used in Tedds fields that require a string value.

• Conditions (page 335), which allow you to select a value based on one or
more conditions than can be used with Tedds fields.

Advanced Tedds fields allow you to use multiple conditions and other
components to enhance your calculations.

NOTE We recommend that you experiment with advanced Tedds fields before
actually using them in your actual calculations, as using advanced Tedds
fields may require some practice. Experimenting also helps you discover
exactly what each field type can offer you.

See also

Major Tedds field syntax (page 511)

8.1 Input fields
An Input field allows you to create a dialog that asks the user for a value of a
variable that is required in the calculations. To create Input fields, see the
following instructions.

NOTE The following only applies to Tedds for Word.

Create Input fields
1. In the Insert ribbon group, click Tedds field. 
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The Insert Tedds field dialog box appears, displaying the Input tab.

2. Specify the parts of the input.

a. In the Prompt field, type text that specifies what information the user
should enter in the dialog. 

You can use the string function to add previously calculated values
into the prompt text.

b. In the Name field, type the name of variable.

c. In the Units field, type the units for the variable.

d. In the Default value field, type the default value of the variable.

3. Select Write out standard input line to add text and the final result of
the field calculation to your calculation document.

• In the Format list, select the format in which the variable value should
be displayed, if necessary.

• In the Decimal places box, specify the number of decimal places to
which the variable value should be displayed.

4. In the Show input dialog box list, select how you want the input dialog to
be displayed, and what the initial variable value in the input box should
be.

• Only if variable not defined

The dialog is only displayed if the variable has not been defined.

The initial value is the default value that you have determined for the
field.
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• Always (with current value)

The dialog is always displayed.

If the variable is defined, the initial variable value is the current
variable value.

If the variable is not defined, the initial value is the default value that
you have determined for the field.

• Always (with default value)

The dialog is always displayed.

The initial value is the default value that you have determined for the
field.

• Use system option

The dialog is displayed according to the setting made in Tedds options
--> Calculating.

5. Click OK.

See also

Major Tedds field syntax (page 511)

Modify Tedds fields (page 331)

Use the string function (page 334)

Use conditions (page 335)

8.2 Show fields
Show fields allow you to summarize the information resulting from several
calculations within the document. To create different types of Show fields,
follow the instructions below.

NOTE The following only applies to Tedds for Word.

See also

Major Tedds field syntax (page 511)

Tedds fields and functions (page 510)

Use the string function (page 334)

Use conditions (page 335)
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Create Show fields
1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears, displaying the Input tab.

2. Click the Show tab. 

The following view appears.

3. In the Type list, select the type of field which you want to create. 

• Select Simple to add fixed text into your calculation.

• Select Value of variable to add text indicating the value of a variable
into your calculation.

• Select Condition to add a different piece of text into your calculation,
depending on whether a condition is met.

• Select Advanced to add a different piece of text into your calculation
depending on whether one or more conditions are met.
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Create Simple Show fields

1. In the Text field, type the text and the calculation that you want to be
displayed in the field.

2. Select the style in which you want the field to be displayed.

• If you want the text of the field to be identical with the rest of the
paragraph, select Use paragraph style.

• If you want the text to use the format which is defined for a result,
select Use Tedds result style.

3. Click OK.
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Create Value of variable Show fields

1. Specify the details of the field.

a. In the Prefix field, type the text that you want insert before the value
of the variable, if necessary.

b. In the Name or expression field, type the name of the variable, or
the expression that defines the value.

c. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• If the variable is stored as a string, select String.

d. In the Units field, type the units for the variable.

e. In the Format list, select the format in which the variable value
should be displayed, if necessary.

f. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

g. In the Postfix field, type the text that you want to insert after the
value of the variable, if necessary.

2. Select the style in which you want the field to be displayed.

• If you want the text of the field to be identical with the rest of the
paragraph, select Use paragraph style.

• If you want the text to use the format which is defined for a result,
select Use Tedds result style.

3. Click OK.
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Create conditional Show fields
Conditional Show fields allow you to define:

• a condition to be tested,

• the text that is to be returned to your document if the condition is true,

• the text that is to be returned to your document if the condition is false.

1. Specify the details of the field.

a. In the Condition field, specify the condition that you want to test in
the field. 

You can specify any of the Tedds for Word logical functions as
conditions.

b. In the Yes field, type the text that will be placed in your calculation if
the value of the condition is True.

c. In the No field, type the text that will be placed in your calculation if
the value of the condition is False.

2. Select the style in which you want the field to be displayed.

• If you want the text of the field to be identical with the rest of the
paragraph, select Use paragraph style.

• If you want the text to use the format which is defined for a result,
select Use Tedds result style.

3. Click OK.
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Create Advanced Show fields
You can assemble Advanced fields using two methods. You can type directly
in the Statement field, or use Insert buttons to add variable and condition
details in the Statement field. Tedds for Word then evaluates the Statement
field to create the Advanced field.

NOTE When you create an Advanced Show field, ensure that:

• All text is surrounded by quotation marks

• All parts that you want to include in the Show field are in the
Statement field.

1. Specify the variable details, and click Insert.

a. In the Name or expression field, type the name of the variable, or
the expression that defines the value.

b. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• If the variable is stored as a string, select String.

c. In the Units field, type the units for the variable.

d. In the Format list, select the format in which the variable value
should be displayed, if necessary.

e. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

2. Click the Insert button next to the No. of decimal places box.
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3. Specify the condition details.

a. In the Condition field, specify the condition that you want to test in
the field. 

You can specify any of the Tedds for Word logical functions as
conditions.

b. In the Yes field, type the text that will be placed in your calculation if
the value of the condition is True.

c. In the No field, type the text that will be placed in your calculation if
the value of the condition is False.

4. Click the Insert button next to the No field.

5. Select the style in which you want the field to be displayed.

• If you want the text of the field to be identical with the rest of the
paragraph, select Use paragraph style.

• If you want the text to use the format which is defined for a result,
select Use Tedds result style.

6. Click OK.

8.3 Message fields
Message fields display a message box that gives the user information as the
calculations are performed. To create different types of Message fields, see
the following instructions.

NOTE The following only applies to Tedds for Word.

Example Message field

See also

Major Tedds field syntax (page 511)

Tedds fields and functions (page 510)

Modify Tedds fields (page 331)

Use the string function (page 334)
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Use conditions (page 335)

Create Message fields
1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears, displaying the Input tab.

2. Click the Message tab. 

The following view appears.

3. In the Type list, select the type of field which you want to create. 

• Select Simple to add a fixed message into your calculations.

• Select Value of variable to add a message indicating the value of a
variable into your calculations.

• Select Condition to add a different message into your calculations
depending on whether a condition is met.

• Select Advanced to add a different message into your calculations
depending on whether one or more conditions are met.
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Create Simple Message fields

1. In the Title field, type the title of the message box.

2. In the Text field, type the text that you want the message box to display.

3. Click OK.
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Create Value of variable Message fields

1. Specify the details of the field.

a. In the Title field, type the title of the message box.

b. In the Prefix field, type the text that you want insert before the value
of the variable, if necessary.

c. In the Postfix field, type the text that you want to insert after the
value of the variable, if necessary.

2. Specify the details of the variable.

a. In the Name or expression field, type the name of the variable or the
expression that defines the value.

b. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• If the variable is stored as a string, select String.

c. In the Units field, type the units for the variable.

d. In the Format list, select the format in which the variable value
should be displayed, if necessary.

e. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

3. Click OK.

Enhancing Tedds for Word calculations with
Tedds fields

314 Message fields



Create conditional Message fields

1. Specify the details of the field.

a. In the Title field, type the title of the message box.

b. In the Condition field, specify the condition that you want to test in
the message box. 

You can specify any of the Tedds for Word logical functions as
conditions.

c. In the Yes field, type the text that will be placed in the message box if
the value of the condition is True.

d. In the No field, type the text that will be placed in the message box if
the value of the condition is False.

2. Click OK.

Create Advanced Message fields
You can create Advanced fields using two different approaches. You can
either type directly in the Statement field or use Insert buttons to add
variable and condition details in the Statement field. Tedds for Word then
evaluates the Statement field to create the Advanced field.

NOTE When you create an Advanced Message field, ensure that:

• All text is surrounded by quotation marks
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• All parts that you want to include in the message box are in the
Statement field.

1. In the Title field, type the title of the message box.

2. Specify the variable details.

a. In the Name or expression field, type the name of the variable, or
the expression that defines the value of the variable.

b. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• if the variable is stored as a string, select String.

c. In the Units field, type the units for the variable.

d. In the Format list, select the format in which the variable value
should be displayed, if necessary.

e. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

3. Click the Insert button next to the No. of decimal places box.

4. Specify the condition details.

a. In the Condition field, specify the condition that you want to test in
the message box. 

You can specify any of the Tedds for Word logical functions as
conditions.
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b. In the Yes field, type the text that will be placed in your calculation if
the value of the condition is true.

c. In the No field, type the text that will be placed in your calculation if
the value of the condition is false.

5. Click the Insert button next to the No field.

6. Click OK.

8.4 Log fields
Log fields allow you to create a summary of your calculations and display it in
the Progress Log. To create Log fields, see the following instructions.

NOTE The following only applies to Tedds for Word.

See also

Major Tedds field syntax (page 511)

Tedds fields and functions (page 510)

Modify Tedds fields (page 331)

Use the string function (page 334)

Use conditions (page 335)

Create Log fields
1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears, displaying the Input tab.

2. Click the Log tab. 
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The following view appears.

3. In the Type list, select the type of field which you want to create. 

• Select Simple to add fixed text into the Progress Log.

• Select Value of variable to add text indicating the value of a variable
into the Progress Log.

• Select Condition to add a different piece of text into the Progress Log
depending on whether a condition is met.

• Select Advanced to add a different piece of text into the Progress Log
depending on whether one or more conditions are met.
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Create Simple Log fields

1. In the Text field, type the text that you want to display in the Progress
Log.

2. Click OK.

Create Value of variable Log fields
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1. In the Prefix field, type the text that you want to insert before the value of
the variable, if necessary.

2. Specify the details of the variable.

a. In the Name or expression field, type the name of the variable, or
the expression that defines the value.

b. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• If the variable is stored as a string, select String.

c. In the Units field, type the units for the variable.

d. In the Format list, select the format in which the variable value
should be displayed, if necessary.

e. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

3. In the Postfix field, type the text that you want to insert after the value of
the variable, if necessary.

4. Click OK.

Create conditional Log fields

1. Specify the details of the field.
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a. In the Condition field, specify the condition that you want to test. 

You can specify any of the Tedds for Word logical functions as
conditions.

b. In the Yes field, type the text that will be placed in the Progress Log if
the value of the condition is true.

c. In the No field, type the text that will be placed in the Progress Log if
the value of the condition is false.

2. Click OK.

Create Advanced Log fields
You can assemble Advanced fields using two different approaches. You can
either type directly in the Statement field or use Insert buttons to add
variable and condition details in the Statement field. Tedds for Word then
evaluates the Statement field to create the Advanced field.

NOTE When you create an Advanced Log field, ensure that:

• All text is surrounded by quotation marks

• All parts that you want to include in Progress Log are in the
Statement field.

1. Specify the variable details.

a. In the Name or expression field, type the name of the variable, or
the expression that defines the value.
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b. In the Value type list, select the type of the value. 

• If the variable is a number, select Number.

• If the variable is stored as a string, select String.

c. In the Units field, type the units for the variable.

d. In the Format list, select the format in which the variable value
should be displayed, if necessary.

e. In the No. of decimal places box, specify the number of decimal
places to which the variable value should be displayed.

2. To add the variable details into the Log field, click the Insert button next
to the No. of decimal places box.

3. Specify the condition details.

a. In the Condition field, specify the condition that you want to test. 

You can specify any of the Tedds for Word logical functions as
conditions.

b. In the Yes field, type the text that will be placed in Progress Log if the
value of the condition is true.

c. In the No field, type the text that will be placed in Progress Log if the
value of the condition is false.

4. To add the condition details into the Log field, click the Insert button next
to the No field.

5. Click OK.

8.5 Excel link fields
Excel Link fields link Tedds for Word and Excel together, so that your Excel
calculations can be sent to Tedds for Word, or the other way around. To create
Excel Link fields and create a Tedds compatible Excel worksheet, follow the
instructions below.

NOTE The following only applies to Tedds for Word.

See also

Modify Tedds fields (page 331)

Major Tedds field syntax (page 511)
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Create Excel Link fields
1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears, displaying the Input tab.

2. Click the Excel tab. 

The following view appears.

3. Specify the details of the field.

a. In the Filename field, full path and filename of the Excel document to
which you want to link.

b. In the Link Sheet field, type the name of the linking worksheet in the
Excel document you set above. 

NOTE An Excel file may have several worksheets involved in the
calculations, but there can only be one worksheet that you
use as the link between Tedds for Word and Excel. The
selected worksheet receives the variables from Tedds for
Word and contains the resultant variables to return to Tedds
for Word.

The linking worksheet must conform to a particular layout.
You can find a worksheet with this layout in ProgramData
\Tekla\Structural\Tedds\Excel\TEDDS2XL.xls. You can use the file
by copying the path into the Link Sheet field, or create and
use your own worksheet.
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4. In the Output Picture list, select whether you want to return a chart or a
picture of selected table cells from Excel to Tedds for Word.

• If you do not want to include a picture, select None.

• If you want to include a picture of a chart, select Chart.

After that, type the name of the sheet and, if there are more than one
charts in the sheet, the chart name.

• If you want to include a picture of a selected range of cells, select
Table Range.

After that, type the name of the sheet and the range of cells which you
want to include from the selected sheet.

5. In the Options list, adjust the link options according to your needs.

a. If you want to transfer variables from Tedds for Word to Excel, select
Link variables from Tedds to Excel.

b. If you want to transfer variables from Excel to Tedds for Word, select
Link variables from Excel to Tedds. 

NOTE If you check both of the link options above, then the order in
which the data is transferred is:

1. From Tedds for Word to Excel

2. From Excel back to Tedds for Word.

If you wish to transfer data in the reverse order, create two
Excel Link fields. In the first link, only select the Link
variables from Excel to Tedds option. In the second link,
only select the Link variables from Excel to Tedds option.

c. If you want to have Excel open when the calculations are performed,
select Show Excel.

d. If you select the Show Excel option, you can also select Wait for
workbook to be closed before linking in finished. If you select the
Wait for workbook to be closed before linking in finished option,
the linking process will pause until you close the Excel worksheet.

e. If you want to save the workbook after performing the calculations,
select Save workbook when linking is finished.

6. If necessary, you can make Excel run up to three macros during the linking
process. Select the macros in the Excel macros to run whilst linking
section. 

• If you want to run a macro before the variables are passed to Excel
from Tedds for Word, type its name in the leftmost field.

• If you want to run a macro after the variables have been passed but
before they are returned to Tedds for Word, type its name in the
middle field.
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• If you want to run a macro after performing the linking, type its name
in the rightmost field.

7. Click OK.

Create a compatible Excel worksheet
You can find a compatible Excel worksheet on your computer in ProgramData
\Tekla\Structural\Tedds\Excel\TEDDS2XL.xls. You can use the file by copying the
path into the Link Sheet field, or create and use your own worksheet. To
create your own worksheet, see the following instructions.

1. In your Excel worksheet, create two sets of three columns. Leave one
empty column between the sets.

2. In the central cell above the first three columns, type the title Variables
from Tedds.

3. In the central cell above the second three columns, type the title
Variables back to Tedds.

4. In the cells below the titles, type the following subtitles: 

• Variable
• Value
• Unit
The following image illustrates how the worksheet should look.

NOTE Although you can do calculations within the Variables back to
Tedds cells, we do not recommend this.

You do not need to fill in any values in either of the Value
columns. Tedds for Word automatically enters values to the
Value cells during the calculation.

8.6 Data list fields
Data lists contain engineering data, and using Data List fields allows you to
display the data in the the Data List dialog box. The easiest way to create
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Data List fields is to find the appropriate data list using Library Access
System. To do that, see the following instructions.

NOTE The following only applies to Tedds for Word.

Example data list

1. In the Library ribbon group, click the arrow below the  Launch the
Tedds Library Access System button.

2. In the list, select Engineering Data. 

The Library Access System window opens.

3. Find and select the data list that you want to insert in your calculations.

4. Perform your calculations. 

When Tedds for Word proceeds to calculating the Data List field, the 
Data List dialog box opens.

NOTE You can also create a Data List field using the Insert Tedds field
dialog. For further information on the syntax of Data List fields,
see Major Tedds field syntax (page 511).
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See also

Modify Tedds fields (page 331)

Data lists (page 398)

Components of the Data List dialog box (page 398)

8.7 Data Table fields
Data tables contain standard engineering data, and using Data Table fields
allows you to display the data as tables in your calculations. To create Data
Table fields, see the following instructions.

NOTE The following only applies to Tedds for Word.

Example data table

1. In the Library ribbon group, click the arrow below the  Launch the
Tedds Library Access System button.

2. In the list, select Engineering Data. 

The Library Access System window opens.

3. Find and select the data table that you want to insert in your calculations.

4. Perform your calculations. 

When Tedds for Word proceeds to calculating the Data Table field, the 
Data Tables window opens.

NOTE You can also create Data Table fields using the Insert Tedds
field dialog. For further information on the syntax of Data Table
fields, see Major Tedds field syntax.

See also

Modify Tedds fields (page 331)

Data tables (page 404)

Components of the Data Tables window (page 404)
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8.8 Data graph fields
Using Data Graph fields in your calculations allows you to display engineering
data as graphs in your calculations. To create Data Graph fields, see the
following instructions.

NOTE The following only applies to Tedds for Word.

Example of a Data Graph

1. In the Library ribbon group, click the arrow below the  Launch the
Tedds Library Access System button.

2. In the list, select Engineering Data. 

The Library Access System window opens.

3. Find and select the data graph that you want to insert in your calculations.

4. Perform your calculations. 

When Tedds for Word proceeds to calculating the Data Graph field, the 
Data Graph window opens.

NOTE You can also create a Data Graph field using the Insert Tedds
field dialog. For further information on the syntax of Data Graph
fields, see Major Tedds field syntax.
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See also

Modify Tedds fields (page 331)

Data graphs (page 414)

Components of the Data Graph window (page 414)

8.9 Calc item fields
Calc Item fields allow you to calculate an item stored in a calculation library
and select whether or not the results are returned in the calculation
document. To create Calc Item fields, see the following instructions.

NOTE The following only applies to Tedds for Word.

See also

Major Tedds field syntax (page 511)

Modify Tedds fields (page 331)

Create Calc Item fields
1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears, displaying the Input tab.

2. Click the Calc Item tab. 

The following view appears.

3. In the Type list, select the type of field that you want to create.

• Select Simple to insert and calculate any library item in your
calculations.

• Select Condition to insert one of two possible library items in your
calculations, depending on whether a condition is met.
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Create Simple Calc Item fields

1. Specify the details of the field.

a. In the Calc library field, find the correct library by clicking the ...
button, or type the full path and filename of the library.

b. In the Calc item field, find the correct calculation item by clicking ...
button, or type the short name of the item that you want to calculate.

2. In the Output list, select whether you want to insert the item results in
your calculations.

• To insert the item results in your calculations, select Append.

• Otherwise, select Discard.

3. Click OK.
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Create conditional Calc Item fields

1. Specify the details of the condition.

a. In the Condition field, specify the condition that you want to test.

b. In the Calc library field, find the correct library by clicking the ...
button, or type the full path and filename of the library.

c. In the Yes Calc item field, type the calc item that will be placed in the
calculations if the value of the condition is true.

d. In the No Calc item field, type the calc item that will be placed in the
calculations if the value of the condition is false.

2. In the Output list, select whether you want to insert the item results in
your calculations.

• To insert the item results in your calculations, select Append.

• Otherwise, select Discard.

3. Click OK.

8.10 Modify Tedds fields
This section covers modifying Tedds fields in different ways, such as
modifying Tedds field syntax, correcting Tedds field errors, and entering
formatted text in Tedds fields.

NOTE The following only applies to Tedds for Word.
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See also

Major Tedds field syntax (page 511)

Expression text format (page 538)

Units (page 548)

Modify the content of Tedds fields
All Tedds fields have their own particular syntax.

You can modify Tedds fields by modifying the elements in their syntax. For
more information, see the syntax of each Tedds field.

Fix Tedds field errors
If your Tedds fields contain mismatched quotation marks, Tedds for Word
displays a fatal error message while calculating the field.

If this occurs, do the following:

1. Click Interrupt to stop the calculation. 

An error field is placed in your document. The error field allows you to
identify the invalid Tedds field.

2. Make the necessary corrections to the Tedds field.

3. Recalculate the calculations from the corrected Tedds field to the end of
the document.

Enter formatted text in Tedds fields
You may need to enter formatted text in your Tedds fields. In many cases, the
Insert Tedds field dialog box allows you to access the most common
formatting options with the buttons on the right side of each field.

1. In the Insert ribbon group, click Tedds field. 

The Insert Tedds field dialog box appears.

2. Do one of the following.

a. Use one of the suggested formatting options, presented as buttons
next to each field in the Insert Tedds field dialog box.

b. Right-click a field that allows formatted text to access the full range of
formatting options. 
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A context menu containing all of the formatting options appears.

See the description of each option in the table below.

Option Description
Select all Selects all text in the field.

Superscript If no text is selected in the field, switches to
typing in superscript characters.

If text is selected, switches the selected text
between normal and superscript characters.

Subscript If no text is selected in the field, switches to
typing in subscript characters.

If text is selected, switches the selected text
between normal and subscript characters.

Greek If no text is selected in the field, switches to
typing in Greek characters.

If text is selected, switches the selected text
between normal and Greek characters.

Lowercase Displays a list of lowercase Greek characters,
from which you can select one to add it to the
formatted text field.

If text is selected in the field, the selected text is
replaced by the selected Greek character.

Uppercase Displays a list of uppercase Greek characters,
from which you can select one to add it to the
formatted text field.

If text is selected in the field, the selected text is
replaced by the selected Greek character.

SI Units Shows a list of metric unit types, in which you can
select a unit and add it to the formatted text
field.

If text is selected in the field, the selected text is
replaced by the selected unit.
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US Units Shows a list of US unit types, in which you can
and select a unit and add it to the formatted text
field.

If text is selected in the formatted text field, the
selected text is replaced by the selected unit.

Expression text / Formatted text If the formatted text field currently shows
formatted information, then switches the text to
expression text format.

If the field currently shows expression text
format, then switches the text to formatted text.

8.11 Use the string function
The string function converts a variable value into text, so you can use it in a
Tedds field that only accepts string arguments. You can use the string
function with Input fields, Show fields, Message fields and Log fields.

NOTE The following only applies to Tedds for Word.

The particular syntax of a string function is:

string($variable name$, $format$, $unit$)

Parameters:

$variable name$ is the name of the variable that you want to include in the
string, or a calculation that gives you the variable value.

$format$ is the format that you want to apply to the calculated value.

$unit$ is the unit in which the variable is to be displayed. Units are optional.

Examples of the string function

Message field

Message("The minimum Area of steel required is "+string(A_{s},"F0","mm^(2)")+"
mm^2 ","Note")

In the example, the string function ((A_{s},"F0","mm^(2)")) is used for adding
values within text.

The + signs tell Tedds for Word to add the parts together to create the text
that goes into the dialog.

Input field

Input("Input the bar diameter - minimum "+string(D_{min},"F0","mm")+"
mm","Dia","mm", string(D_{min},"F0","mm"),2)

In the example, the first string function is used for adding values within the
text. The second string function is used on its own without other text, and it
calculates a default value that is set in the input dialog.
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See also

Syntax conventions (page 510)

Major Tedds field syntax (page 511)

8.12 Use conditions
The condition function allows you to give alternative results based on whether
the value of a particular condition is True or False. You can use the condition
function with Input, Show, Message, and Log fields.

NOTE The following only applies to Tedds for Word.

Condition syntax

The condition syntax for each of the eventual conditional fields is:

• Input($prompt$, $variable name$, $units$, #default value# or $default value$ ,
[#control flag#], (if¡condition¡, $true text$, $false text$))

• Show(if¡condition¡,$true text$, $false text$, ¡control flag¡, ¡format flag¡, #control
flag#)

• Message(if(¡condition¡, $true text$, $false text$), $message title$, [¡control flag¡])

• LogText(if(¡condition¡,$true text$,$false text$))

The parameters are:

• ¡condition¡ is the condition which controls the field and determines whether
the true text or the false text will appear in your document.

• $true text$ is the text which is displayed if the value of the condition is True.
You can use the string function to add values of variables into the text.

• $false text$ is the text which is displayed if the value of the condition is
False. You can use the string function to add values of variables into the
text.

Condition function example

Consider the Input field syntax below:

Input("Input the bar diameter - minimum "+String(D_{min},"F0","mm")+"
mm","Dia","mm", if(D_{min}>Dia, string(D_{min},"F0","mm"),
string(Dia,"F0","mm")),2)

In this case, the default value for the variable Dia depends on whether the
minimum bar diameter is greater than the actual diameter.

You can see this more clearly if we isolate the condition from the rest of the
field:

if(D_{min}>Dia, string(D_{min},"F0","mm"), string(Dia,"F0","mm"))
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If we further remove the string expressions, replacing them with D_{min} and
Dia we get

if(D_{min}>Dia, D_{min}, Dia) .

Now the condition is much easier to see: if D_{min} is greater than Dia, the
input dialog has its default value set to D_{min}.

If D_min is less than or equal to Dia, then its default value will be set to Dia.

NOTE If you want to use complex conditions in your calculations, you may find it
useful to create the overall structure of the field, and then divide the field
syntax into pieces.

You must use expression text format for non alphanumeric characters.

See also

Syntax conventions (page 510)

Major Tedds field syntax (page 511)
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9 Configuring settings

This section covers a series of options that you can set to configure Tedds
according to your needs. The options are available in the Options - Default
dialog box.

To access the Options - Default dialog box, do one of the following:

In the Tedds Application:

• On the Home tab, click Options.

In Tedds for Word:

• In the Tools ribbon group, click More --> Tedds options .

9.1 Startup options
Startup options allow you to determine how Tedds starts. For more
information, see the following paragraphs.

Automatically start the most recently selected application

If you select this option, when you start Tedds, either Tedds or Tedds for Word
starts automatically, depending on which version you have last used.

When Tedds starts

The When Tedds starts option allows you to select how you want Tedds to
start. The option does not apply to Tedds for Word.

• Select Open Start page to automatically display the Tedds Start Page.

• Select Select a new calculation to automatically display the Select
calculation dialog box.

• Select Do nothing to simply open Tedds without displaying the Tedds
Start Page or the Select calculation dialog box.
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Load method

NOTE To avoid any damage, do not modify the Load method option unless
you are advised otherwise by the Tedds technical support team.

The Load method option allows you to change the method which is used to
load the Tedds for Word add-in.

Always load the Tedds loader in Word

WARNING To avoid any damage, do not modify the Always load the Tedds
loader in Word option unless you are advised otherwise by the
Tekla technical support team.

The Always load the Tedds loader in Word option allows you to use all
Tedds commands when you open a Tedds for Word document in Microsoft
Word, even when you do not start Tedds for Word separately.

Always show the Tedds tab on the ribbon in Word

If you select the Always show the Tedds tab on the ribbon in Word option,
Microsoft Word always displays the Tedds tab, even when you do not start
Tedds for Word separately.

9.2 Environment options
The environment options allow you to, for example, specify the default file
location (in the Tedds Application), or view both SI and US units on the Tedds
ribbon (Tedds for Word).

Environment options (the Tedds Application)

Default file location

The option sets the default location to which calculations will be saved.

Recent Files

The option allows you to adjust the number of recent files displayed on the
Tedds Start Page.

Recent Calculations

The option allows you to adjust the number of recent calculations displayed
on the Tedds Start Page.
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Environment options (Tedds for Word)

Show Tedds Developer tab

If you select the Show Tedds Developer tab option, you get access to the
advanced applications and utilities that the Tedds development team uses.

WARNING Many Tedds developer tools require an extensive knowledge of
writing Tedds calculations.

To avoid any damage, the Tedds developer tools should not be
used by an unaccustomed user.

Show Tedds Template designer tab

If you select the Show Tedds Template designer tab option, you get access
to tools that enable creating and modifying calculation templates.

Show both SI and US units on ribbon

The Show both SI and US units on ribbon allows you to display both SI and
US units on the Tedds ribbon, so that you can easily insert both units into your
calculations.

See also

Calculation templates (page 364)

Create new calculation templates (page 370)

Modify the header or footer of a calculation template (page 367)

9.3 Document options
Document options allow you to change the default document template, the
default header logo, default company details, and the default date format. For
further information on document options, see the following paragraphs.

Template options

In Template options, you can change the default template and header logo of
a document.

Default Document Template

The Default Document Template option allows you to change the default
template that you use for your calculation documents.

• Click Select... to browse the calculation template that you want to use as
the default template.

• Click Use Current (Tedds for Word only) to use the current calculation
template as the default template.
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• Click Edit... to modify the selected default document template.

Default Document Header Logo

The Default Document Header Logo option allows you to change the default
logo of your documents, which is located in the document header.

In the Tedds Application, you must also select between the two following logo
options (the Tedds Application only):

• Link to logo file: creates a link to your logo file, so that any changes to the
logo are applied to the header as well.

• Embed logo in document: embeds the logo in the document, so that the
current logo is maintained even if the source file changes.

The Scale option (the Tedds Application only) allows you to scale the logo to fit
the template.

Header options

In Header options, you can change the default company details and the
default date format of your calculation documents.

Default Header Properties

The fields under Default Header Properties allow you to type and change the
default company details in your document header.

Date Format

The Date Format option allows you to change the date format that is used in
your calculation documents.

9.4 View options (the Tedds Application only)
The view options in the Tedds Application settings allow you to adjust the way
your calculations are displayed by default.

Default to show

Select the options that you want to view in your calculation documents by
default. The available options are:

• Hidden text

• Semicolons

For more information, see View hidden text, semicolons, or variables
(page 244).
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Default zoom

This option allows you to adjust the default zoom level of calculation
documents.

For more information, see Adjust the zoom level (page 248).

9.5 Send To options (the Tedds Application only)
The send to options in the Tedds Application allow you to adjust the transfer
of your Tedds calculations to Microsoft Word or Tedds for Word, or via email.

Word page

Select how you want to send your calculations to Microsoft Word. The options
are:

• New document: to create a new document for the calculation,

• Append to active document: the calculation is added to the end of the
current document,

• Insert in active document: the calculation is placed within your current
document at the position of the mouse pointer.

NOTE If you select Append to active document or Insert in active
document, but have no document open, a new document will be
created.

If a new document is required use the following Word template

If the send to process needs to create a new document for the results of your
calculations, you can specify the Word template that you want it to use. If you
don not select a specific template, the use the Normal template .

NOTE Do not select a Tedds for Word template here, or the sent file will also
require Tedds for Word to run.

If you do want to send a calculation from the Tedds Application to
Tedds for Word, then use the Send To --> Tedds for Word command
instead.

TEDDS for Word page

Select which Tedds for Word template to use when you send your Tedds
calculations to Tedds for Word.

Use the following Tedds for Word template

Ensure that you select a Tedds for Word template here. If you do not select a
Tedds for Word template, the Tedds for Worddocument will not contain the
settings that are needed to correctly calculate your Tedds calculations.
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Email page

Embed header logo in document

NOTE The option is only effective if you have selected the Link to logo file
option in the Document options (page 339).

If you select Embed logo in document, Tedds embeds the logo in the
calculation document before it sends the email.

If you do not select this option, Tedds maintains the current link details. In this
case, the recipient of the email will only see the logo if the logo file already
exists in the same directory location on their computer as on yours.

9.6 Save options
These determine the options used when saving PDF files (Tedds, Tedds for
Word, batch design).

Convert Enhanced Metafile Plus (vector images) to Bitmaps

Drawings created in Tedds calculations use the vector format Enhanced
Metafile Plus (EMF+) which provides the richest feature set and quality.
However when documents are saved in PDF format not all of the vector
information which is supported by an EMF+ image can be converted accurately
to PDF format. To ensure that the integrity of the image is maintained this
option can be enabled which will convert the image to a raster bitmap at a
fixed resolution. The disadvantage of enabling this option is that the original
vector images will not be scaled according to the final print quality and
therefore may in some circumstances appear pixelated.

Bitmap quality

When Convert Enhanced Metafile Plus (vector images) to Bitmaps is
enabled this option will determine the size of the bitmap image which is
generated. The Low setting will create a drawing which is equivalent to 96 dpi.
Good will increase the scale of images by 100%, High will increase the scale of
images by 200%. When images are scaled the improved resolution comes at
the expense of a larger PDF file.

9.7 Calculating options
Calculating options allow you to control how Tedds performs calculations.
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General calculating options
General calculating options allow you to adjust the way in which Tedds
performs certain calculations.

See also

Dimensional analysis (page 541)

Use variables (page 276)

Input fields (page 303)

Data lists (page 398)

Data tables (page 404)

Data graphs (page 414)

General
General options allow you to select whether Tedds performs dimensional
checks and how Tedds reacts to different variable errors, calculation errors,
and cancelling a calculation process.

Perform dimensional checks

The Perform dimensional checks option allows you to select whether you
want Tedds to perform dimensional analysis on your variables to ensure that
they have the right dimensions.

Prompt on calculation error

The Prompt on calculation error option allows you to select whether you
want Tedds to display a dialog box notifying you about a calculation error
whenever it encounters one.

Error on undefined variable

The Error on undefined variable option allows you to select whether you
want Tedds to consider an undefined variable an error, or proceed with the
calculations despite the undefined variable.

If calculating is cancelled

The If calculating is cancelled option allows you to select how you want to
proceed when calculating is cancelled.

Tedds Input fields
Tedds Input fields options allow you to determine whether Tedds displays
Input dialog boxes in your calculations or not.
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Default

The Default option allows you to select the default action that is executed to
Input dialog boxes unless you determine otherwise while creating a particular
Input field.

Replace 'Display always' and 'Display only if variable not defined' with
this default option

The Replace 'Display always' and 'Display only if variable not defined'
with this default option option allows you to remove the opportunity to use
some of the other display options, and replace the options with the Default
option determined above.

Engineering data tools
Engineering data tools options allow you to determine which engineering
data tools are displayed in your calculations.

Select the boxes of the data tools that you want to view in your calculations.
The options are:

• Show Data lists

• Show Data tables

• Show Data graphs

Sketch options
Sketch options allow you to adjust the settings that are connected to viewing
and adding sketches in your calculations.

See also

Start the Sketch Viewer (page 468)

Copy a sketch to your calculations (page 473)

Sketches
The options under Sketches allow you to change the alignment of sketches,
and determine whether transparent fills are allowed in sketches.

Alignment

The Alignment option allows you to select how sketches in Enhanced Metafile
format should be aligned in your calculation documents.

Transparent fills

Some printer drivers and PDF export tools may have difficulties handling
transparent items, which may lead to poor quality sketches being output. The
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Transparent fills option allows you to determine whether Tedds should use
transparent fills in sketches.

The options are:

• Allow

which is the default option, allowing transparent fills.

• Substitute solid transparent fills with hatch patterns

which replaces transparent fills with a hatch pattern. This option may
resolve the problems of using transparent fills.

• Draw shape outline only

which ignores transparent fills, so only the outline of the shape is drawn.

Maximum output size
The Maximum output size option allows you to determine when and how
much Tedds should scale a sketch or a calc library item, so that it fits in your
calculation document. The Maximum output size indicates how many
percent of the page the sketch or library item can occupy.

You can adjust the maximum output size by typing the appropriate
percentages in the of page width and of page height boxes or by using the
arrows on the right side of each box.

Result options
Result options allow you to change the formatting of both intermediate and
final results.

See also

Result formats and precision (page 545)

Define results (page 268)

Results
In the Results section, you can select how Tedds views your results.

Use paragraph style

Select the Use paragraph style option if you want results to look like the
other text in the same paragraph of your calculations.
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Use following style

Select the Use paragraph style option if you want to define a distinctive style
for the results in your calculations.

Using a distinctive style may be helpful in seeing exactly which parts of your
calculations have been previously defined and which parts have been
generated as a part of a calculation. To define a distinctive style for results,
click Font.

Intermediate results (=#)
In the Intermediate results (=#) section, you can adjust the format, precision,
and levels of intermediate results.

Default format

The Default format option allows you to select the default format in which
you want Tedds to display the intermediate results of your calculations. For
more information on result formats, see Result formats and precision
(page 545).

Default precision

The Default precision option allows you to select the default precision which
you want Tedds to use for your intermediate results. For more information on
result precision, see Result formats and precision (page 545).

Show results up to [N] levels deep

The Show results up to [N] levels deep option allows you to determine how
many levels of intermediate results you want to see in your calculations,
providing that the calculations have multiple levels of intermediate results.

Final results (=?)
In the Final results (=?) section, you can adjust the format and precision of
final results, and determine whether final results are underlined in your
documents.

Default format

The Default format option allows you to select the default format in which
you want Tedds to view the final results of your calculations.

For more information on result formats, see Result formats and precision
(page 545).

Default precision

The Default precision option allows you to select the default precision which
you want Tedds to use in your final results.

For more information on result precision, see Result formats and precision
(page 545).
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Underline result

Select the Underline result option if you want Tedds to underline all final
results in your calculation documents.

Progress options
Progress options allow you to determine how Tedds views the progress of
calculations. See the possible options in the following paragraphs.

None

If you select the None option, Tedds does not view any information on the
progress of your calculations.

Simple progress window

If you select the Simple progress window option, Tedds views a simple
progress bar that indicates how far through the calculations you are.

Detailed progress log window

If you select the Detailed progress log window, Tedds will view the Progress
Log. The Progress Log gives you brief details on the calculations during the
calculation process.

• Clear when starting calculations

If you select this option, Tedds clears the Progress Log when it starts a new
calculation process.

Otherwise, the Progress Log adds the details for new calculations to the
end of the log.
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• Hide when calculations have finished

If you select this option, Tedds only shows the Progress Log while
calculations are running, and closes the Progress Log when the calculation
process ends.

See also

The Progress Log (page 298)

Regional settings
Regional settings allow you to control the locale whose calculation settings,
units, and number and expression formats you want to use.

See also

Units (page 548)

Use units in calculations (page 273)

Locale

The Locale list allows you to select the locale whose calculations and data you
want to use.

Default calculation settings

The Default calculation settings allows you to select a country, so that Tedds
can set the most appropriate defaults for particular calculations.

For example, if you select Ireland, Eurocode calculations will default to the Irish
National Annex where appropriate.

Base units

Depending on the locale that you have selected, the Base units option may
allow you to select whether you want to use SI units or US units. The selected
units are used in storing your variable values, and as default units for variable
values.

NOTE You can use both SI units and US units in your calculations,
regardless of which units you have selected as base units.
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Number and expression format

The Number and expression format option controls the characters that
Tedds uses for the decimal symbol, the list separator, and the expression
terminator.

WARNING If you change the Number and expression format option
manually in the list, any existing calculations will most probably
stop working. Instead, we recommend that you select the correct
area in the Locale list.

Error options
Error options allow you to determine how Tedds views errors in your
calculations.

Use paragraph style

Select the Use paragraph style option if you want calculation errors to look
like the other text in the same paragraph of your calculations.

Use following style

Using a distinctive style for your results helps you locate an error that has
occurred in your calculations.

If you want to define a distinctive style for the errors in your calculations,
select the Use following style option.

To define a style for errors, click Font.

See also

Introducing calculation errors (page 293)

Find errors (page 297)

Beam analysis options
Beam analysis options allow you to select how the positive moment in bending
moment diagrams in indicated.

Draw bending moment diagrams showing positive bending

This option allows you to select how you want Tedds to indicate positive
bending in bending moment diagrams.

According to your needs, select downwards or upwards.

See also

2D analysis (page 421)
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Calc item options
Calc item options allow you to determine which properties of library calc items
that Tedds inserts in your calculations.

The When calculating a library calc item a reference will usually be
included at the end of the item's output which includes the following
properties for that item option allows you to determine which properties
Tedds inserts in your calculations.

The options are:

• None

• All

• Default

• Custom

The fields below the option illustrate which details of an item are displayed
when you select an option.

See also

Start the Library Access System (Tedds for Word only) (page 374)

Debugging options
These tools may be used by our support teams when resolving specific
calculation issues.

Debugging

Debug mode

Debug mode changes how some functions and calculations behave in order
to assist the diagnosis of errors (bugs) when writing custom calculations. Some
calculations may alter their behaviour when debug mode is enabled, therefore
debug mode should always be disabled when producing final output
calculations.

Log all expressions

When calculating is in progress, tracing will log messages that help you to
monitor the execution sequence of your calculations, to detect malfunctions.
The messages that tracing produces appear in the Progress Log window
therefore the Progress Log must be enabled to read the messages.
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Delete temporary variables when finished calculating

Normally when the calculation process has finished all variables which have
the temporary attribute enabled will be automatically deleted, enableing this
options prevents them from being deleted.

Cache Calc Libraries

Normally during the calculation process when a Calc Library is opened it will
remain open until the calculation process has finished in order to improve the
speed of calculating. When a library is open in the cache it cannot be modified
therefore if you want to to modify calculations whilst they are running you can
disable this setting.

Calculation User Interfaces

Enable progress log when calculating preview items

In calculation user interfaces which include a preview window for showing
results the progress log is normally disabled whilst the preview window is
updated, if you need to debug the calculations used to update the preview
results then you can disable this setting.

Show calculation options

When enabled a button is added to the toolbar in calculation user interfaces
which allows you to access the calculation options dialog.

Show QuickCalc

When enabled a button is added to the toolbar in calculation user interfaces
which allows you to show the QuickCalc window. The QuickCalc window can
be used to execute expressions whilst the calculations user interface is
running in order to query or modify the processing of the calculation.

9.8 Dialog options
Dialog options allow you to adjust the Variables dialog box. You can
determine which variable details you want to view, how the values of variables
should be expressed, and how the variables should be sorted.

Variables
The Variables options allow you to select which properties of variables you
want to view.
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Show value type column

Select the Show value type column option if you want to include a column
identifying the value type (number, string, or column) in the Variables dialog
box.

Show attributes column

Select the Show value type column option if you want to include a column
identifying the attributes (temporary, hidden, or promoted) of the variable in
the Variables dialog box.

TIP Having the Show attributes column option selected can be helpful
when you try to find out why a particular calculation is not working
correctly.

Values
The Values options allow you to define the format and decimal places which
you want to use when defining the values of variables.

Format

The Format option allows you to select the format in which the values are
viewed. For more information on result formats, see Result formats
(page 545).

Decimal places

The Decimal places option allows you to determine to how many decimal
places the values are viewed.

Sorting
The Sorting options allow you to determine whether Tedds takes into account
the case and formatting of variable names in the Variables dialog box.

Ignore case

The Ignore case option allows you to determine that Tedds considers variable
names such as B and b the same variable.

Ignore formatting (Greek/superscript/subscript)

The Ignore formatting (Greek/superscript/subscript) option allows you to
determine that Tedds considers variable names such as B1 and B1 the same
variable.
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9.9 Setup options
Setup options allow you to control various settings, such as where calc
indexes and calc libraries are located and whether you want to download and
install updates to Tedds.

Application data options
Application Data options allow you to control the default location where
System and User data is stored (settings files that affect the behavior of
Tedds).

Application Data options contain two tabs, User and System. The System
location is not editable and is only included for reference. Currently the only
files stored in the User location are user defined system variable files which
can be used to override the system defined system variables.

Calc index options
Calc Index options allow you to control user indexes and view system indexes.

Calc Index options contain two tabs, User and System. Although both tabs
contain the same options, you can only change the options on the User tab.

See more

Library Access System settings (Tedds for Word only) (page 357)

System and user libraries (page 564)

Index directories

The Index directories option allows you to add or delete calc indexes.

Name

The Name field allows you to change the name of the selected calc index.

Directory

The Directory field allows you to determine where Tedds saves the user
indexes that you want to use.

To change the directory, type the new directory in the box, or click Browse...
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Priority

The Priority option allows you to determine in which order the indexes
appear in the Index directories list. The indexes whose priority is 1 appear
the highest, the indexes whose priority is 2 appear the second highest, and so
on.

Merge all filed into a single set

Select the Merge all files in directory into a single set option if you want all
of the items of the index to be in the same set.

Calc library options
Calc library options allow you to change the location of user and system
libraries.

User

In the User field, you can specify the location of your user libraries. You can
either type the new location in the field, or click Browse... to select the correct
directory.

NOTE By having system and user libraries in different locations, you can
easily avoid confusing the two library types. We do not recommend
using the same location for your system and user libraries.

System

To change the location of system libraries, see Frequently used procedures in
creating system libraries (page 568).

See also

Start the Library Access System (Tedds for Word only) (page 374)

System and user libraries (page 564)

Library Access System settings (Tedds for Word only) (page 357)

Calc project options

The Calc Projects options allow you to view and adjust the location where
Calc Projects are stored (source files for writing calculations, e.g. Calc
designer .cdd flow chart files and Interface Designer .tid files), this setting is
used by the Calc Designer, Interface Designer and the Library Access System.
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Calc document options
The calc document options allow you to view and adjust the location where
Tedds saves your calculations documents.

Calc Document Directory

In the Calc Document Directory field, you can determine where Tedds saves
the calculation documents that you create.

You can either type the location in the field, or click Browse... to select the
correct directory.

Excel workbook options
Excel workbook options allow you to access Excel workbooks if you need them
in your calculations in Tedds. In addition, Excel workbook options allow you to
control the locations of the system and user Excel workbooks.

User

In the User field, you can define the location of your user workbooks. You can
either type the location directly in the User field, or click Browse... to select
the correct directory.

NOTE We do not recommend using the same location for system and user
workbooks.

System

The System field displays the current location of the system workbook
directory, which has been set automatically when installing Tedds.

See also

Excel link fields (page 322)

Update service options
Update service options allow you to define whether you want to download
and install updates for Tedds, and how often Tedds checks for new updates.

Enable update service

The Enable update service option defines whether you can update Tedds.

If you only check the Enable update service option, you will have to update
Tedds manually. To update Tedds manually, go to Help --> Check for
updates.
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Check for updates when starting Tedds

If you select the Check for updates when starting Tedds option, Tedds will
automatically check for critical updates every time you start the software.

If critical updates are available, Tedds will notify you, and you can select
whether you want to install the updates.

Only check once each day

If you select the Only check once each day option, Tedds will only check for
critical updates once each day that you use the software.

Check for non critical updates every [N] day(s)

The Check for non critical updates every [N] day(s) option allows you to
define how often Tedds checks for non-critical updates. To define the number
of days between each check, type the desired number in the field.

Feedback options
Feedback options allow you to define whether you want to participate in
improving Tedds. You can either give us direct feedback or allow us to collect
data on your use of Tedds.

Tedds Customer Experience Improvement Program

The Tedds Customer Experience Improvement Program option lets you
define whether you want to allow us to collect information about your
hardware and software configuration and how you use Tedds. The data is
collected monthly, and used only to improve the quality, reliability, and
performance of Tedds.

NOTE The Update service option must be enabled so that you can
participate in the Tedds Customer Experience Improvement
Program.

Feedback Survey

The Feedback Survey option allows you to determine whether you want to
receive feedback surveys about Tedds or not. By default, we will automatically
send you a feedback survey from time to time.

If you do not wish to receive feedback surveys, you can clear the Don't ask me
again option.

If you have any concerns or suggestions in your mind, you can still click Start
the Tedds feedback survey to give us feedback whenever you want to.
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9.10 Profile options
Profile options allow you to select whether you want to always use the same
profile, or select a profile each time you start Tedds.

Remember profile

The Remember profile option allows you to select whether Tedds remembers
your user profile, or asks you to select a profile when you start Tedds.

• Select the Remember profile option to always use the same profile when
you start Tedds.

• Clear the Remember profile to select a profile when you start Tedds.

9.11 Library Access System settings (Tedds for Word only)
You can adjust Library Access System settings according to your needs. For
more detailed information on Library Access System settings, see the
following paragraphs.

NOTE The following only applies to Tedds for Word.

Environment --> General settings
Setting Effect in Simple

mode
Effect in Advanced mode

Remember open
sets

None When selected, Library Access
System opens the sets that you
leave open the next time you
start Library Access System.

Enable drag and
drop

When selected,
allows you to drag
items from Library
Access System and
drop them into your
documents.

When selected:

• Allows you to drag items
from Library Access System
and drop them into your
documents.

• Allows you to use drag and
drop when you create new
sets, or modify existing ones.

Enable inplace
editing of item
names

None When selected, allows you to
rename a user library or a user
set by double-clicking its name.

Confirm how to add
solution and
example items

When selected, adding a solution item ( ) or an
example item ( ) displays the Insert Calc Item dialog
box.
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Environment --> General settings
Setting Effect in Simple

mode
Effect in Advanced mode

• New document

Inserts the item into a new Tedds for Word
document.

• Append to active document

Inserts the item at the end of the current Tedds for
Word document.

• Insert in active document

Inserts the item in the current Tedds for Word
document at the position of the insertion point.

• Add new Calc Section

Adds a new calc section where Tedds for Word
inserts the item.

• Insert page break

Adds a page break into your Tedds for Word
document immediately before the new calc section.

Add items in a new
paragraph

When selected, Tedds for Word inserts a paragraph
break before and after an item that it copies into your
calculation sheet.

Confirm selection
in Word

None When selected, Tedds for Word
asks you to confirm that you
have highlighted the correct
part of your document when
you are adding items into a
library.
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Environment --> General settings
Setting Effect in Simple

mode
Effect in Advanced mode

Remove field
results in Word
before saving item
contents

None When selected, adding your
own calculations to a library
clears any calculation results.
Instead, Tedds for Word only
displays the format settings.

Select format and
category of item
contents

None When selected, adding your
own calculations to a library
displays the Paste special
dialog box. In the dialog box,
you can select which format you
want to paste the text in.

Update item
version from calc
set version

When selected, Tedds for Word updates the version of
an item to the same version as the calculation set that
it belongs to.

Environment --> Messages settings
Setting Effect in Simple mode Effect in Advanced

mode
Delete item from
set

None When selected,
Tedds for Word asks
you to confirm that
you want to delete
the item from the
set.

Delete item from
library

None When selected,
Tedds for Word asks
you to confirm that
you want to delete
an item from the
library.

Environment --> View settings
Setting Effect in Simple mode Effect in Advanced

mode
Font Allows you to change the font used in the names of the

groups, items in your sets, or indexes.

NOTE If you select a font that does not contain all
the characters that a particular set / index
uses, any characters that are not in the font
are displayed as hollow boxes.
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Environment --> View settings
Setting Effect in Simple mode Effect in Advanced

mode
Information Tips Allows you to select whether you want to see tips for

the icons used for calculation items, or further
information for a particular item.

Tedds for Word displays information tips when you
hover the mouse pointer over an icon or an item
name.

The setting also allows you to select the item tips that
you want to see.

Colours Allows you to select colors for a specific elements in
the Library Access System window.

The elements are text, background, highlight text, and
highlight. The button on the right of each element
allows you to change the color.

Setup --> Calc index settings
Setting Effect in Simple mode Effect in Advanced

mode
Index directories Displays a list of existing indexes.

When you click an entry in the Index directories list,
the dialog box displays its name, directory, and
priority.

Name Displays the name of the selected index directory.
Directory Displays the path of the directory that contains the

sets to be indexed.
Priority Allows you to select the order in which items appear in

the list of indexes.

For instance, an item whose priority is 1 is higher in
the list of indexes than an item whose priority is 3.

Merge all files in
directory into a
single set

When selected, Library Access System creates a
single list of all the sets in the directory, showing the
root item in each set.

Setup --> Calculation libraries settings
Setting Effect in Simple mode Effect in Advanced

mode
User library
directory

The directory where Tedds for Word saves your user
libraries.

To change the location of user libraries, type the new
directory in the field, or click Browse....
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Setup --> Calculation libraries settings
Setting Effect in Simple mode Effect in Advanced

mode
System library
directory

The location of the system libraries, that was set when
Tedds for Word was installed.

To change the location of system libraries, see Change
the location of the System libraries directory
(page 570).

Setup --> Calc sets settings
Setting Effect in Simple mode Effect in Advanced

mode
User set directory The directory where Tedds for Word saves your user

sets.

To change the directory, type the new directory in the
field, or click Browse... .

System set
directory

The location of the system libraries, which was set
when Tedds for Word was installed.

To change the directory, hold down Ctrl key and right-
click the dialog box twice. Then, type the new directory
in the field, or click Browse....

Setup --> Update service settings
Setting Effect in Simple mode Effect in Advanced

mode
Enable update
service

When selected, Library Access System automatically
searches new updates to its libraries.

Check for updates
when starting
Tedds

When selected, Library Access System searches new
updates to the libraries each time you start Tedds or
Tedds for Word.

Only check once
each day

When selected, Library Access System searches new
updates once each day when you start Tedds or Tedds
for Word.

Check for non
critical updates
every [N] days

Allows you to set the frequency with which Library
Access System searches non critical updates to its
libraries.
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9.12 Microsoft Word settings (Tedds for Word only)
To simplify creating your own calculations, we recommend that you adjust
some Microsoft Word settings. See the detailed instructions for adjusting
Microsoft Word settings in the following paragraphs.

NOTE The following only applies to Tedds for Word.

Stop automatic capitalization
By default, Word capitalizes the first character of the first word of a paragraph
or sentence. For calculations, this setting can be counter-productive. To stop
automatic capitalization, follow the instructions below.

1. Go to File --> Options --> Proofing --> AutoCorrect options.

2. Ensure that the Capitalize first letter of sentences option is not
selected.

3. Ensure that the Correct TWo INitial CApitals option is not selected.

4. Click OK.

Set up AutoText
The AutoText feature of Word allows you to store and reuse formatted text
(and graphics), accessing them through a few simple keystrokes. Therefore,
AutoText may be useful when defining variable names and units.

1. Type the text that you want to save, and format it correctly. For example,
N/mm2

2. Highlight the formatted text.

3. Go to Insert --> Text --> Quick parts --> AutoText --> Save selection to
AutoText gallery. 

4. In the Name field, type the characters that you want to use to access the
item.
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5. Click Add. 

To use the item, type the item name and press the F3 key.

Use hidden text
Normally, the calculations that you type in your document are always visible.
However, this may result in lengthy documents, since all intermediate
calculations must be included for the calculations to work correctly. One
solution to this problem is using hidden text in very simple calculations and
commonly available items, such as section properties. Using hidden text may
be challenging, and therefore, we recommend that you only hide calculations
once you have tested them and are sure that they work correctly.

If you want to hide some of your calculations, you can use one of the pre-
defined hidden paragraph styles such as Calc Script (Hidden) or Calc Script
Heading (Hidden).

We recommend using the hidden paragraph styles to manage hidden text,
because the Show/Hide --> Hidden Calcs does not effect any characters
which you format individually.

To make any calculations using paragraph styles which end in the word Hidden
visible, do the following:

• On the Tedds ribbon, click Show/Hide --> Hidden Calcs.

NOTE For the hidden text paragraphs to function as described, ensure that
the following Word Options settings apply:

• The Display --> Hidden text option is not selected.

• The Display --> Print hidden text option is unselected.

If, at any point, you want to quickly identify all the text with the hidden text
attribute applied:

• In Word Options, click Display and select the Hidden text option.

All hidden text will be displayed, with a dotted underline when the Hidden
Calcs option is selected, and without underline when the Hidden Calcs
option is not selected.

NOTE When you perform your calculations and they contain errors in a line
of calculations that is hidden, you will not be able to find the
erroneous calculations if the Hidden Calcs option is not selected.

If you need so to see hidden calculations, click Show/Hide --> Hidden Calcs,
correct the error, and hide the calculations again.
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10 Calculation templates

Calculation templates offer a convenient way of standardizing the appearance
of your calculation documents. Tedds for Word contains a number of
calculation templates, which can easily give your calculations a professional
look.

NOTE The following only applies to Tedds for Word.

Like other Word templates, the Tedds for Word calculation templates contain
elements connected to:

• Page appearance, such as page size, orientation, and margins

• Paragraph formats, such as font size and line spacing

• Character formats, such as font type

In addition to helping you create professional-looking documents, calculation
templates simplify modifying the information in the header and footer of a
calculation sheet.

NOTE You can also use standard Word templates to adjust the appearance
of your document.

If you use a Word template, Tedds for Word adds the macros that it needs to
function.

If you attempt a calculation in a document that does not have the necessary
macros, Tedds for Word will offer to add them, and convert the Word template
into a Tedds for Word template.

Before converting a Word template into a Tedds for Word template, note that:

• Once you have added the Tedds for Word macros into a template, you can
only use that template if you have Tedds for Word installed. Do not convert
your Word templates into Tedds for Word templates, if you want to use the
template later without Tedds for Word.

• Converting a Word template into a Tedds for Word template only adds the
macros that Tedds for Word needs to function. Therefore, you will need to
create the paragraph styles yourself to format the document correctly.
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• You cannot add Tedds for Word macros to the Normal.dot template, which
is automatically used for all documents that you open in Word.

10.1 Select a calculation template
When you select a calculation template, you have three options. You can either
use the default template of Tedds for Word, select some other Tedds for Word
calculation template, or use a special Tedds for Word calculation template in
order to create your own calculation templates.

NOTE The following only applies to Tedds for Word.

In addition to using Tedds for Word calculation templates, you can use a
standard Word template.

If you choose to use a Word template, Tedds for Word automatically adds the
macros which it requires in order to work correctly. However, in that case,
Tedds for Word does not add any page layout, paragraph or character styles.

TIP To avoid untidy results and having to define specific paragraph styles for your
calculations, we strongly recommend using calculation templates in your
calculations.

See also

Create new calculation templates (page 370)

Use the default template
1. Click the File menu.

2. In the left side pane, click New Tedds document. 

A new document opens based on the default calculation template.

Use a specific calculation template
1. Click the File menu.

2. In the left side pane, click New. 
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3. Click the PERSONAL tab. 

The Tedds for Word calculation templates are located in the Calcs A4 and
Calcs letter folders.

4. Click to open the desired folder.

5. Click the calculation template which you want to use. 

A new document opens based on the chosen template.

Use a special calculation template
Tedds for Word contains special calculation templates, designed to function as
the basis of your own calculation templates. These calculation templates are
called Tedds normal (Arial) and Tedds blank (Arial). The difference between the
special calculation templates is that the blank template includes a border
around the calculations area of the page, whereas the normal template does
not.
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1. Click the File menu.

2. In the left side pane, click New. 

3. Click the PERSONAL tab. 

The Tedds for Word calculation templates are located in the Calcs A4 and
Calcs letter folders.

4. Click to open the desired folder.

5. Click the special calculation template which you want to use. 

A new document opens based on the chosen template.

10.2 Modify the header or footer of a calculation template
When you use a Tedds for Word calculation template, you can insert
document details or company information in the header or footer, or modify
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the property labels in the header or footer according to your needs. To modify
the header or footer using the Header properties dialog box. To modify the
header or footer, see the following instructions.

NOTE The following only applies to Tedds for Word.

See also

Document options (page 339)

Open the header
• In the Header ribbon group, click the Edit button.

The Header properties dialog box appears.

Add document details
1. Open the header. 

The Header properties dialog box appears.

2. Ensure that the Document tab is open.

3. Type document details in the fields.

4. To save the details, click OK. 

TIP You can easily copy the document details from one document to
another by using the Copy all and Paste all buttons in the Header
properties dialog box.

Add company details
1. Open the header. 

The Header properties dialog box appears.

2. Go to the Company tab. 
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3. Type your company details in the fields.

4. To save the company information for all future Tedds for Word
documents, select the Save these settings as the default for new
documents option.

5. To save the details, click OK.

Change the header logo
1. Open the header. 

The Header properties dialog box appears.

2. Go to the Template tab. 
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3. Click Browse... to select the file which you want to use as the logo.

4. To use the logo in all future Tedds for Word documents, select the Save
these settings as the default for new documents option.

5. To save the logo, click OK.

Modify header labels
Property labels explain the input which is required in a particular table cell. In
case the property labels in the header do not meet your needs, you can
modify them.

1. Open the header. 

The Header properties dialog box appears.

2. In the lower left corner of the dialog box, click Edit labels 

The Edit header property labels dialog box opens.

NOTE The Edit header property labels dialog box may look different
depending on the template that you are using.

3. Make the desired changes to the labels.

4. To save the changes, click OK.

10.3 Create new calculation templates
The standard Tedds for Word calculation templates give you a wide range of
layout options. However, if you wish, you can also create your own calculation
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templates with the Tedds Template designer. To do so, see the following
instructions.

NOTE The following only applies to Tedds for Word.

See also

Document options (page 339)

Open the Tedds Template Designer
1. Go to Tools --> More --> Tedds options.

2. Under Environment, select the Show Tedds Template designer tab
option. The Tedds Template designer tab opens.

Open a new template
1. On the Tedds Template designer tab, click Tedds for Word.

2. In the list that appears, select the desired calculation template. The
selected calculation template opens.

Edit the header and footer of the template
1. To edit the header and footer of a template, do one of the following:

• Double-click the header or footer area of the document.

• On the Tedds Template designer tab, in the click Header --> Edit or
Edit footer.

2. Modify the existing table in the header or footer, or insert a new one.

3. To enter fixed text in the cells, on the Tedds Template designer tab, click
Insert --> Property label.

4. From the list that appears, select a suitable label. 

NOTE If you want to modify the property labels, click Header --> Edit.

In the Header properties dialog box that appears, click Edit
labels and modify the labels according to your needs. For more
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information, see Modify the header or footer of a template
(page 367).

5. To add variable text in the table, insert Property value cells by clicking
Insert --> Property value, and in the list that appears, select a suitable
value.

Insert a logo in the template
1. Click Insert --> Property value.

2. From the list that appears, select Logo.

3. Click Header --> Edit. The Header properties dialog box appears.

4. Go to the Template tab. 

5. Click Browse... to select the file which you want to use as the logo.

6. To use the logo in all future Tedds for Word documents, select the Save
these settings as the default for new documents option.

7. To save the logo, click OK.

Save a calculation template as the default Tedds for Word
template
1. To save the file, click File --> Save as.

2. Click Tools --> More --> Tedds options.

3. In the Options - Default dialog, click Documents.
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4. To set the template as default document template, do one of the
following.

• If the template is open, click Use current.

• Click Select and select the new default template.

Save a calculation template as the default Tedds template
1. To save the file as a word template, click File --> Save as and save the

item in the.dotx form.

2. Go to the Tedds Template designer tab.

3. Click File --> Save .Tet.

4. Open Tedds.

5. On the Tedds ribbon, click Options.

6. Under Documents, click Select and in the Company folder, select the
new default template.
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11 Start the Library Access System
(Tedds for Word only)

When you use Tedds for Word, you can access the calculations and
engineering data in the Tedds engineering library by using the Library Access
System. The following paragraphs cover the basic components, library types,
and modes of the Library Access System and launching the Library Access
System.

NOTE The Library Access System is only available in Tedds for Word.

Components of libraries and sets

Libraries include two types of components: entries and items. See the
components and their functions in the table below.

Name Description
Entries Actual calculations, sketches, tables,

or other pieces of data that the library
contains, and that you can copy to
your calculations.

Properties Reference information that describes
a particular entry, such as Short Name,
Long Name, or Item Details.

Sets include two types of components: groups and items. See the components
and their functions in the table below.

Name Description
Groups Organize the items in a set into a

logical order to help you find the
items easily.

Groups may contain other groups,
items, or both.
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Name Description
Items Point to an entry in a library, which

you can execute by executing the
item.

When you execute an item, the entry
that the item refers to is copied to
your document.

Library types

The Library Access System uses two types of libraries: system libraries and
user libraries.

• System libraries are intended to hold company standard information,
which will not change frequently and which you normally cannot change.

All libraries installed with Tedds for Word are system libraries.

• User libraries contain your own data, and you can modify them.

At installation, Tedds for Word creates a My Libraries directory that contains
an empty MyCalcs.lbr user library file. The MyCalcs.lbr file is the default
saving location of the data that you want to save to the Tedds engineering
library.

Modes

• The simple mode allows you to find, preview and execute groups and
items. In addition, you can adjust the Library Access System settings.

• The advanced mode allows you to use more advanced features of the
Library Access System. The features include creating and modifying your
own sets, and sharing your calculations.

Launch the Library Access System

• On the Tedds tab, click Launch the Tedds Library Access System.

The Library Access System window opens.

See also

Library Access System icons (page 565)

Library Access System toolbars (page 616)

Library Access System settings (Tedds for Word only) (page 357)

Use the Library Access System: Advanced mode (page 379)

Use the Library Access System: Simple mode (page 376)

Basic Library Access System procedures: Advanced mode (page 380)

Basic Library Access System procedures: Simple mode (page 376)
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11.1 Use the Library Access System: Simple mode
The Simple mode of the Library Access System allows you to access the key
functionality of the Library Access System with the help of simple toolbars.
The Simple mode allows you to have one set open at a time.

NOTE The following only applies to Tedds for Word.

The following image displays the Library Access System in Simple mode:

See also

Library Access System toolbars (page 616)

Library Access System icons (page 565)

Basic Library Access System procedures: Simple mode (page 376)

Basic Library Access System procedures: Simple mode
The following paragraphs cover the basic procedures of the Library Access
System window, such as manipulating the view of a set, executing an item,
finding sets, and configuring settings.

NOTE The following only applies to Tedds for Word.
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See also

Library Access System settings (Tedds for Word only) (page 357)

Open the index
• Click the Index button.

Open a set
1. Double-click the set that you want to open.

Manipulate the view of a set
• To expand a set, select the set and press the * key on the numeric keypad.

• To collapse a set, select the set and press the - key on the numeric keypad.

Preview an item
1. Select the item.

2. Click View --> Preview. 

A preview of the item opens.

Execute an item
1. Double-click the item which you want to execute. 

If you select a solution item (marked with ) or an example item (marked
with ), the Insert Calc Item dialog box appears.
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a. Select where and how you want to insert the item. 

• To insert the calc item in a new document, select New document.

• To append the calc item in the end of the current document,
select Append to active document.

• To insert the calc item at the location of your insert point in the
current document, select Insert in active document.

• To insert the calc item in a new calc section, select Add new Calc
Section.

• To insert a page break before the new calc section, select
Insert page break.

b. Click OK.

NOTE You have to calculate the executed item in order to receive
results.

Search a set
1. Click Find.

2. In the Find field, type the search entry.

3. Use the buttons on the right side of the Find field to browse the results of
the search. 

Start the Library Access System (Tedds for Word
only)

378 Use the Library Access System: Simple mode



NOTE To modify the Find options, click the rightmost button next to the
Find text box.

The list below appears.

If you select Match case, the search will only find a match if both
the letters and their case are identical to your search entry.

If you select Find in item descriptions, the search will search
item descriptions in addition to item names.

Display item or group properties
1. Select the item or group whose properties you want to view.

2. To see the properties, do one of the following:

• Right-click the item and in the context menu that appears, click View
properties.

• Click View --> Properties.

Adjust settings
• Click Tools --> Options.

The Options - Default dialog box appears.

Change the Library Access System mode
• Click View --> Advanced Menus.

11.2 Use the Library Access System: Advanced mode
Using the Advanced mode allows you to manage libraries and further adjust
the Library Access System window. You can create your own sets and modify
them by adding, modifying and deleting groups and items.
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NOTE The following only applies to Tedds for Word.

NOTE The sets installed with Tedds for Word are protected, and therefore, they
cannot be modified. If you want to modify one of the installed sets, we
recommend saving the set with a new name and modifying the renamed set.

The following image displays Library Access System in the Advanced mode.

See also

Basic Library Access System procedures: Advanced mode (page 380)

Library Access System toolbars (page 616)

Library Access System icons (page 565)

Basic Library Access System procedures: Advanced mode
In the following paragraphs, we cover the basic procedures of the Library
Access System window, such as manipulating the view of a set, executing an
item, finding sets, and configuring settings.

NOTE The following only applies to Tedds for Word.

See also

Create new sets (page 385)

Add new items into a set (page 388)
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Add new groups into a set (page 387)

Build new sets based on existing sets (page 390)

Modify groups and items (page 391)

Open the index

• Click the  Index button.

Open a set
• Double-click the set that you want to open.

Email a set and referenced libraries

RESTRICTION To email a file, you must have a Microsoft Outlook profile.

1. Select and open the set that you want to send.

2. Click File --> Send.... 

Tedds for Word adds the set and the libraries that reference to it as
attachments to a new email.

Import a library
1. Click File --> Import....

2. In your user libraries directory, select the library that you want to import.

3. Click Open. 

The imported user library opens.

Export a set
1. Click File --> Export...

2. Name the set and select the file type you want to save the set in. You can
select:

• Text file

• XML file

3. Click Save. 

If you selected text file as the file type, the Export Options dialog box
appears.

a. Adjust the export options and the properties to be included in the
text file. 
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NOTE If you select the Indent groups option, the text file will
appear to have the same structure as your set.

b. Click OK.

Manipulate the view of a set
To manipulate the view of the set, you have the following options:

• To expand a group, select the group and press the * key on the numeric
keypad.

• To expand a group one level, select the group and press the + key on the
numeric keypad or double-click the group.

• To collapse a group, select the group and press the - key on the numeric
keypad.

• To change the level of detail displayed on the screen, select the group and
click View --> Long names . 

If the Long names option appears to be selected, you are viewing the long
names of items. If the Long names option does not appear to be selected,
you are viewing the short names of items.

Preview an item
• Do one of the following:

• Select the item and click View --> Preview.

• Click  Preview.
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Undo an action
• Click Edit --> Undo.

Execute an item
1. Do one of the following:

• Double-click the item that you want to execute.

• Select the item that you want to execute and click  Execute.

If you select a solution item (marked with ) or an example item (marked
with ), the Insert Calc Item dialog appears.

a. Select where and how you want to insert the item. 

• To insert the calc item in a new document, select New document.

• To append the calc item in the end of the current document,
select Append to active document.

• To insert the calc item at the location of your insert point in the
current document, select Insert in active document.

• To insert the calc item in a new calc section, select Add new Calc
Section.

• To insert a page break before the new calc section, select
Insert page break.

b. Click OK.
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NOTE You have to calculate the executed item in order to receive
results.

Search a set

1. Click  Find.

2. Type the search entry.

3. Use the buttons on the right side of the Find field to browse the results of
the search. 

TIP To modify the Find options, click the rightmost button next to the
Find field.

The following list appears:

If you select Match case, the search will only find a match if both
the letters and their case are identical to your search entry.

If you select Find in item descriptions, the search will search item
descriptions in addition to item names.

Display item properties
1. Select the item whose properties you want to see.

2. To see the properties, do one of the following:

• Right-click the item and in the menu which appears, click View
properties.

• Click View --> Properties.

Adjust settings
• Click Tools --> Options.

• Click Tools --> Options. 

The Options - Default dialog box appears. For more information on
adjusting Library Access System settings, see Library Access System
settings (page 357).
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Change the Library Access System mode
• Click View --> Simple Menus.

Create new sets
You can create new sets to store items according to your needs, creating new
items and groups or copying items from other sets. For detailed instructions,
see the following paragraphs.

NOTE The following only applies to Tedds for Word.

1. Do one of the following:

• Click File --> New.

• Click  New Calc Set Wizard.

The New Calc Set Wizard appears.

2. To proceed, click Next. The following view appears.
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3. Type the name of the set in the Name field.

4. If necessary, modify the automatically generated short name and file
name.

5. Click Next. The following view appears.
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6. Set the default information that Tedds for Word proposes for new items.
You can modify the default information each time you create a new set.

7. Click Next. 

8. To finish creating the set, click Finish. 

TIP To create a new, empty and untitled set, you can also click File -->
New blank set.

See also

Build new sets based on existing sets (page 390)

Modify sets (page 393)

Add new groups into a set (page 387)

Add new items into a set (page 388)

Add new groups into a set
Groups are useful in organizing sets and calculation items into collections that
are linked by a particular theme. This way, you can easily access the
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calculations that you need in a certain project or situation. To add new groups
into a set, see the following instructions.

NOTE The following only applies to Tedds for Word.

1. Select the item or group above the position where you want to place the
new group.

2. Do one of the following:

• Click Edit --> New Group.

• Click  New Group.

The New Group dialog box appears.

3. Type a short name and, if necessary, a long name for the group.

4. Click OK. If you have selected an empty group as the place where you
want to add the new group, Tedds asks you whether you want to create
the new group inside the selected group.

a. Click Yes to add the group inside the selected group, or No to add the
group below the selected group.

Tedds adds the group into the location that you selected.

See also

Add new items into a set (page 388)

Create new sets (page 385)

Delete groups and items (page 394)

Modify sets (page 393)

Modify groups and items (page 391)

Library Access System settings (Tedds for Word only) (page 357)

Add new items into a set
The Library Access System allows you to save your own calculation items into
sets. That way, you can easily reuse your calculations later. To add new items
into a set, see the following instructions.

NOTE The following only applies to Tedds for Word.

1. Open the set you want to add the item in to. 

NOTE This must be a set that you have created. The sets installed with
Tedds for Word are protected, and therefore, they cannot be
modified.
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2. Click Edit --> New Item. 

If you have the Confirm selection in Word option selected, follow the
instructions below.

a. The Library Access System asks you to highlight the item in your
Tedds for Word document.

b. Highlight the item and click OK.

If you have the Select format and category of item contents option
selected, follow the instructions below.

a. In the Paste special dialog, select the format in which you want the
information be stored in the library.

3. In the New item properties dialog, type the name of the new item, and
select the library where the item is saved. 

NOTE To enter optional item properties, click More.

4. Click OK. 

If you have selected an empty group as the place where you want to add
the new item, the Library Access System asks you whether you want to
create the new group inside the selected group.

a. Click Yes to add the item inside the selected group, or No to add the
item below the selected group.

The Library Access System adds the item into the location which you
selected.

See also

Add new groups into a set (page 387)

Create new sets (page 385)

Delete groups and items (page 394)

Modify groups and items (page 391)

Modify sets (page 393)

Library Access System settings (Tedds for Word only) (page 357)
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Build new sets based on existing sets
Sometimes, you may want to create a calculation set that contains many items
from another set. In this case, we recommend that you build a new set based
on the existing set, instead of creating a new set and adding the desired items
manually. For detailed instructions, see the following paragraphs.

NOTE The following only applies to Tedds for Word.

See also

Create new sets (page 385)

Build new sets based on existing sets
1. Click Tools --> Set Builder... 

The Build New Calculation Set dialog box opens.

2. Type the search text and select an appropriate search type in the Search
type list and, if necessary, click Select...

3. According to your needs, click Search and Add or Search and Replace. 

The search results appear.

4. To remove an item from the set, select the result and click Remove.

5. Repeat steps 2–4 as needed.
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6. When the result list only displays the items that you want to include in the
set, click Build. 

Tedds creates a new untitled set that contains the items on the results list.

Search tips
See some tips for searching items in the following list:

• To search with the exact search text, select Match whole word only.

• To search with the exact search text and the case of the letters that you
type, select Match case.

• To clear the result list, click Remove All.

• To search the set again and add the results to the result list, click Search
and Add.

• To search the source set again and replace the items in the result list, click
Search and Replace.

• To narrow the search results, you can build intermediate sets that match
the current search criteria. Then, you can search the intermediate sets with
new search criteria as many times as necessary, until the set only contains
the items that you need. Once you are finished, remember to delete the
intermediate sets.

Modify groups and items
In order to achieve the set layout that you require, you may need to modify
groups and items within your set. To modify a group or an item, see the
following instructions.

NOTE The following only applies to Tedds for Word.

See also

Modify sets (page 393)

Add new groups into a set (page 387)

Add new items into a set (page 388)

Delete groups and items (page 394)

Modify group properties
1. Right-click the group that you want to modify. 

A context menu appears.

2. In the context menu, click Edit --> Group.... The Edit Group dialog box
appears.
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3. Modify the long and short name of the group according to your needs. 

NOTE Name, or the short name, is mandatory information.

4. Click OK.

Modify item properties
You may sometimes need to change the properties of an item without
changing its library content. You may, for example, need to add a new item
similar to an existing one, and thus need to modify the properties of the
existing item to clarify the difference between the two.

1. Select the item that you want to modify.

2. Click Edit --> Edit Item Properties...

a. If the item is password protected, type the correct password to
modify the item properties.

The Edit Item Properties dialog box appears.

3. Modify the item properties according to your needs. 

NOTE Name and library file are mandatory information.

To add optional information, click More.

4. Click OK.

Modify item contents
1. Double-click the item to execute it in the current Tedds for Word

document.

2. In the document, make changes to the calculations according to your
needs.

3. Verify that the modified calculations work correctly.

4. Open the Library Access System and select the item that you modified.

5. Depending on your settings, do one of the following:
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a. If you have not selected the Confirm selection in Word option,
highlight the calculations that you want to save for the current item.

b. If you have selected Confirm selection in Word option, Library
Access System allows you to select the calculations while modifying
the item.

6. Click Edit --> Edit Item Contents....

a. If you have selected the Paste special option in the Library Access
System settings, select the type in which you want to save the item
and click OK. 

b. If the item is password protected, type the correct password.

When Tedds has saved the changes to the item, a confirmation message
appears on the screen.

Modify sets
You can modify your sets using two main approaches: drag and drop and the
clipboard. Drag and drop allows you to simply select a group or an item within
the current set, drag it into a second set, and copy the item there by releasing
it. You can also change the location of the item inside a set by dragging and
dropping it. For more information on modifying sets, see the following
instructions.
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NOTE The following only applies to Tedds for Word.

TIP To simplify dragging and dropping groups or items from one set to another, you
can arrange the sets side by side. To do that, click Window --> Tile horizontally.

Enable drag and drop
If you want to use drag and drop while modifying sets, ensure that you have
enabled dragging and dropping in Library Access System settings. For more
information, see Library Access System settings (page 357).

Copy an item within the same set using drag and drop
• Hold down the Ctrl key while doing the drag and drop.

Cut an item
• Click Edit --> Cut.

Copy an item
• Click Edit --> Copy.

Paste an item
• Click Edit --> Paste.

If you drag and drop or paste a group or an item into an empty group, Library
Access System asks you whether you want the item to be pasted within or
below the selected group.

• To copy the group or item inside the group, click Yes.

• To copy the group or item below the group, click No.

Delete groups and items
Sometimes, you may need to delete groups and items from a set or from your
user libraries. Deleting an item from a set simply removes the item from the
selected set, whereas deleting a group from a library permanently removes
the group and all of its contents from the library.

NOTE The following only applies to Tedds for Word.

Start the Library Access System (Tedds for Word
only)

394 Use the Library Access System: Advanced mode



See also

Library Access System settings (Tedds for Word only) (page 357)

Modify groups and items (page 391)

Modify sets (page 393)

Delete groups and items from a set
1. Select the group or item that you want to delete.

2. Click Edit --> Delete From Set. 

If you have selected the Delete item from set option in the Library
Access System message settings, Tedds asks you to confirm deleting the
group or item.

a. Click Yes.

Delete groups and items from a library

WARNING Deleting a group or an item following these instructions will
delete the permanently from Library Access System. Therefore,
any set that points to the deleted item or group can no longer
display the item or group. Deleting a group or an item from a
library is irreversible.

1. Select the group or item that you want to delete.

2. Click Edit --> Delete From Set & Library.

a. If the group is password protected, type the password.

b. If you have selected the Delete item from library option in the
Library Access System message settings, Tedds asks you to confirm
deleting the group or item. Click Yes.

Share calculations to other Tedds users
At some point, you may need to share your calculations to other Tedds users.
For this purpose, you can use the Calc Publishing Wizard. With Calc
Publishing Wizard, you can create installation packages, which automatically
install the calc set to the other user's computer. In addition to the set itself,
installation packages contain all the libraries associated with the set.
Installation packages can also contain data lists, data tables, and data graphs.

NOTE The following only applies to Tedds for Word.
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Create calculation packages
1. Click Tools --> Calc Publishing Wizard. 

The Tedds Calc Publishing Wizard opens.

2. To select the appropriate type in the Package Type list, see the options
below.

• If your calculations only use data lists, data tables, and data graphs
provided with Tedds, select Tedds System Calculation.

• If your calculations use your own customized data lists, data tables,
and data graphs, select Tedds System & User Calculation.

3. In the side pane, click the Sets folder.

4. Click Add file.

5. Select the items that you want to add to your project.

6. To prevent other users from overwriting the file, you can select the file
and ensure that the ReadOnly value is set to True. 

7. Go to the Properties tab.
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8. Define properties for the installation package. 

Title, Author, and Output installation package (the location where the
installation package will be created) are mandatory information.

9. Click Build. 

Tedds creates an .MSI file in the location that you defined in Output
installation package.

TIP Consider saving the publishing project, so that you can easily re-
build the package if you have updated the calculations and want to
share the new versions.

Install calculation packages
• Double-click the desired .MSI file and follow the on-screen prompts. 

The calculation is now available in the index in both Tedds and Tedds for
Word.

TIP You can copy the installation package to an USB flash drive, email it,
or publish it online.
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12Data lists

Data lists are lists that contain and allow you to access engineering data.
Tedds allows you to use these lists with the help of the the Data List dialog
box. For more information on the benefits of data lists, see the following
paragraphs.

You do not need to open the Data List dialog box separately, since it
automatically opens if the calculation requires any data from it.

The the Data List dialog box allows you to:

• Access data for a wide range of items with the help of a simple interface.

You can access such data as section properties, grade stresses, and design
strengths.

• Select a specific item in a data list and view its properties on the screen.

• Return and use the properties for a selected item to your calculations.

See also

Data list fields (page 325)

12.1 Components of the Data List dialog box
A data list displays information related by a common theme. In the following
paragraphs, we present the main components of the Data List dialog box.
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1. Page pane

displays all pages of information related to the selected theme, such as
Steel Sections.

2. Item pane

displays all items of the selected page.

3. Page divider

is the area between the Page pane and the Item pane.

The page divider allows you to modify the width of each pane.

4. Selected item

is the item which will be inserted in your calculations when you click
Select.

The selected item is always highlighted with blue.

5. Details button

allows you to see the variables of the selected item.

See also

Return an item to your calculations (page 401)

Adjust the view of the Data List dialog box (page 399)

View the details of a selected item (page 400)
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12.2 Adjust the view of the Data List dialog box
You can adjust the proportions of the Data List dialog box according to your
needs. For more details on how to adjust the view of the Data List dialog box,
see the following paragraphs.

By default, the Data List dialog box remembers the size and position which
you have defined the last time that you used it.

However, Tedds resets the relative proportions of the Page pane and the Item
pane each time that you close the Data List dialog box.

Adjust the view

• Drag the page divider to alter the relative proportions of the Page pane and
the Item pane.

12.3 View the details of a selected item
With an item selected in the Data List dialog box, you can see all the details
that the data list has stored for the item.

1. Select the item whose details you wish to view.

2. Click the Details button. 
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The Details sheet opens.

NOTE If you select different items with the Details sheet open, the
dialog box always displays the information for the currently
selected item.

To close the Details sheet, click X at the top right corner of the
Details sheet.

See also

Return an item to your calculations (page 401)

12.4 Return an item to your calculations
Using the Data List dialog box, you can return items and their properties to
your calculations. To select the item to return, see the following instructions.
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Return an item to your calculations
The basic process of selecting an item which you want to return to your
calculations is described in the following instructions.

1. In the Page pane, select the correct type of the item.

2. In the Item pane, select the correct item.

3. To insert the properties of the selected item in your calculations, click
Select.

For detailed instructions on how to select the correct page and item, see the
following paragraphs.

Select the page containing the correct item type
1. Scroll the Page pane to find the correct page.

2. Click the page icon or page text to select the page. 

The page title bar displays the selected page.

Select the correct item
1. Do one of the following:

• Scroll the Item pane until you can see the correct item.
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• Click anywhere in the first column of the Item pane and type the first
character of the correct item.

Tedds views the first item beginning with the character which you
typed.

To see other results, repeat the first character as many times as
necessary.

2. Click the rightmost column to pick the particular item you require. 

The page title bar displays the selected item.

3. To insert the properties of the selected item in your calculations, click
Select.
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13Data tables

Data tables are tables that contain and allow you to access engineering data.
Using the Data Tables tool, you can return a piece of the engineering data to
your calculations. For more information on the use and benefits of the Data
Tables tool, see the following paragraphs.

You do not need to open the Data Tables tool separately, since it
automatically opens if the calculation requires any data from it.

Using the Data Tables tool, you can:

• Access a wide range of data including such information as design tables
and proprietary manufacturers data.

• Search any table using comprehensive criteria.

• Interpolate data tables to see the exact values that you need in your
calculations.

• Select specific items simultaneously in all open data tables.

• Return details from some or all tables to your calculations.

The Data Tables tool consists of an application window that contains one or
more subsidiary windows, each of which contains the information for a
particular table.

When you select a single item, the Data Tables tool selects the same item in
all open tables. You can then either:

• Return the information from all the open data tables to your calculations.

• Select the tables whose information you want to return to your
calculations.

See also

Data Table fields (page 327)
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13.1 Components of the Data Tables window
When you calculate a data table, the Data Tables window automatically opens
and allows you to select the data that you need in your calculations. To
efficiently use data tables, see the main components of the Data Tables
window in the following paragraphs.

1. Table tabs

allow you to view different details of the data table.

a. Table tab

displays a graphical representation of the data table.

b. Variables tab

displays the current variables of a selected item in the data table.

c. Notes tab

displays any notes that apply to the data table.

d. Sketches tab

displays any sketches that relate to the data table.

NOTE

All data tables do not contain all of the previously mentioned details. That
is why the Notes tab and the Sketches tab may not always be available.

2. Home button

returns the table display to the top left corner of the table.
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3. Toolbar

allows you to access the different functions of data tables.

See also

Select an item in a data table (page 406)

View the different details of a data table (page 411)

13.2 Linked data tables
The Data Tables tool can open several linked data tables at once. This allows
you to select items in several tables with one click.

For example, designing a strut may require opening one data table on section
properties, and another one on safe loads. Although each data table contains
different information, the items in all tables are similar.

When you select an item in one table, the same item is also selected in the
linked data tables, as long as the selection meets the search criteria that you
have set for the linked data tables. This means that by selecting one item, you
can return information to your calculations from several different data tables.

See also

Select an item in a data table (page 406)

13.3 Select an item in a data table
In the Data Tables window, you can select an item whose information you
want to return to your calculations. To select an item in a data table, see the
following instructions.

• Click the cell at the intersection of the correct row and column, containing
the information that you want to return to your calculations. 
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Tedds indicates the selected item by highlighting it with the color
determined in Data Tables settings.

NOTE If your selection is not sufficient to identify a unique item, the
Variables tab states Needs selecting.

See also

Linked data tables (page 406)

Search specific information in a data table (page 409)

Interpolate data within a data table (page 407)

View the different details of a data table (page 411)

Return data table information to your calculations (page 410)

Adjust data table settings (page 411)
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13.4 Interpolate data within a data table
If a data table contains data that allows interpolating, you can interpolate the
table linearly. To interpolate data within a data table, see the following
instructions.

1. In the toolbar, click Interpolate. 

The Interpolate dialog box appears.

2. In the Range Item list, select the item that you want to interpolate.

3. Type the desired value in the Value to be added field. 

NOTE The value that you add must be greater than the smallest value
and smaller than the greatest value in the Range Values list.

4. Click Interpolate. 

Tedds performs the interpolation and updates the table to include the
new value.

5. If necessary, repeat steps 1–4 to receive the desired result. 

NOTE If you make selections within a table, the Data Tables window
automatically transfers the existing selection to the interpolated
value.

See also

Clear an interpolation (page 408)

Clear an interpolation
Sometimes, you may want to clear the interpolation that you have made in
order to return a data table to its original condition. To clear an interpolation,
see the following instructions.

• Click Edit --> Clear interpolation. 

The last interpolation that you made is cleared.
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See also

Interpolate data within a data table (page 407)

13.5 Search specific information in a data table
You can easily search a data table for information that matches specific search
criteria. The matching cells are identified using a color of your choice, so that
you can easily identify the items which match your search criteria. For more
information on how to search specific information in a data table, see the
following instructions.

See also

Select an item in a data table (page 406)

View the different details of a data table (page 411)

Return data table information to your calculations (page 410)

Search specific information in a data table
1. Click Search. 

The Search criteria dialog box appears.

2. In the Search for list, select the item that you want to search for.

3. In Criterion 1, set the condition which you want to use in your search.

4. If necessary, in Criterion 2, set another condition to limit your search
further.

5. If you have defined Criterion 2, select whether Criterion 2 is additional or
alternative to Criterion 1 by selecting either And or Or.

6. If you want to apply search conditions for other items, repeat steps 2–5
for each item.

7. To search the data table, click OK. 

The data table re-displays, and highlights the items that match your
search criteria.

To view the details of the matching items, click the Variables tab.

Change the search criteria for a data table
1. Click Search. 

The Search criteria dialog box appears.

2. Select the item whose criteria you want to change.
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3. Change the search criteria according to your needs.

• If you want to remove all search criteria, set Criterion 1 to None.

4. Click OK.

Clear a search
• To clear your search, click Edit --> Clear search. 

Your search is cleared.

13.6 Return data table information to your calculations
Once you have made your selections in the group of data tables you have
open, you can return the appropriate information from one or more of these
tables to your calculation sheet. That way, you can use the information in your
calculations. To return data table information to your calculations, see the
following instructions.

See also

Close the Data Tables window (page 412)

Return data table information to your document
1. Do one of the following:

• Double-click the selected item.

• Select the item and click Copy to calcs.

If you have more than one table open, you can select from which tables
you want to return information.

NOTE You cannot return information to your calculations from a table if
you have not made a proper selection. To return to make a
selection in a data table, click Cancel.
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2. Click OK. 

The information of the selected item is returned to your calculations.

13.7 View the different details of a data table
Data tables do not only consist of the graphical representation of the table,
but also variables. In addition, data tables may contain associated notes and
sketches. To view the different details of a data table, see the following
instructions.

You can view different details by clicking the different table tabs, located at the
bottom of the Data Tables window.

• Based on which details of the data table you want to display, do one of the
following.

• To view the graphical representation of the table, click the Table tab.

NOTE The Table tab is the initial view when you open the Data
Tables window.

• To view the variables associated with the table, click the Variables tab.

• To view the notes associated with the table, click the Notes tab.

• To view the sketches associated with the table, click the Sketches tab.

See also

Components of the Data Tables window (page 404)

13.8 Adjust data table settings
To alter the appearance of the Data Tables window, you can adjust data table
settings yourself. To adjust the settings, follow the instructions below.

1. In the Data Tables window, click File --> User Options. 
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The Options dialog box appears.

2. Modify the colors that you want to use for the different parts of the Data
Tables window.

a. To change the background color of the Data Tables window, modify
the Page color.

b. To change the color of entries that match your search criteria, modify
the Qualifying value text color.

c. To change the color of selections that you have made on the screen,
modify the Cell selection color.

d. To change the color of entries that do not match you search criteria,
modify the Excluded value text color.

3. Select the zoom level for the table.

4. Click OK.

See also

Components of the Data Tables window (page 404)

Search specific information in a data table (page 409)

13.9 Close the Data Tables window
You can close the Data Tables window in two ways: you can either return
variables to your calculations, or close the Data Tables window without
returning any information to your calculations.
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Close the Data Tables window and return variables
• Do one of the following:

• Double-click the desired item.

• In the toolbar, click the  Copy to calcs button.

Close the Data Tables window without returning variables

WARNING If you close the Data Tables window without returning variables,
any remaining calculations that use details from the data tables
will not calculate correctly.

• Do one of the following:

• Click File --> Exit Without Copy.

• Click X at the top right corner of the Data Tables window, and in the
confirmation message that appears, click Yes.
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14Data graphs

Data graphs are graphs that contain and allow you to access engineering data.
You can then use the engineering data in your calculations.

You do not need to open the Data Graph window separately, since it
automatically opens if the calculation requires any data from a data graph.

The the Data Graph window allows you to:

• Access a wide range of data, including design curves and proprietary
manufacturers data.

• Interpolate graphs to see the exact values that you require.

• Return details from graphs to your calculations.

See also

Data graph fields (page 328)

14.1 Components of the Data Graph window
To help you work with data graphs quickly and efficiently, see the components
of the Data Graph window in the following paragraphs.
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1. Interpolate bar

allows you to access the main data graph functions with one click.

2. Data graph tabs

allow you to display different details of the data graph.

a. Graph tab

displays a graphical representation of the graph.

The Graph tab is the initial view of a data graph.

b. Variables tab

displays the current values of all variables related to the selected
point of the graph.

c. Notes tab

displays any notes that apply to the graph.

d. Sketches tab

displays a diagram that relates to the graph.

NOTE All data graphs do not contain all of the previously mentioned details.
If that is the case, the Notes tab and the Sketches tab may not be
selectable.

See also

Select a point in a data graph (page 415)

Interpolate data within a data graph (page 417)

Return data graph information to your calculations (page 418)
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14.2 Select a point in a data graph
Using the Data Graph window allows you to select a point in a graph and
return its data to your calculations. To select an item in a data graph, see the
following instructions.

1. Click a point of a curve. 

TIP To see the value of the selected point, rest the mouse pointer over
the point.

To see the properties of the selected point, click the Variables tab.

A pair of cross hairs appears around the selected point.

2. If necessary, do one of the following to further specify the desired point:

• Drag the cross hairs to a specific point of the curve.

• At the top of the graph, type the details of the desired point in the X
axis and Y axis fields.

See also

Components of the Data Graph window (page 414)

Interpolate data within a data graph (page 417)

Return data graph information to your calculations (page 418)
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14.3 Interpolate data within a data graph
Data graphs allow you to interpolate new values within them, if necessary. To
interpolate data within a data graph or clear interpolations, see the following
instructions.

See also

Select a point in a data graph (page 415)

Interpolate within a data graph
1. In the Interpolate bar, click Interpolate. 

The Interpolate dialog box appears.

2. Type the new value that you want to insert in the data graph. 

The new value must be greater than the smallest existing value and
smaller than the greatest existing value.

3. Click OK. 

The new value that you entered appears in the data graph.

Only the values that are relevant to the selected point are stored when
you insert information in your calculations.

Clear an interpolation
1. Click Curve --> Clear Interpolation. 

Your latest interpolation is cleared.
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14.4 Return data graph information to your calculations
Once you have made your selection in a data graph, you can return the
information of the selected point to your calculations. You can then use the
information in further calculations. To return data graph information to your
calculations, see the following instructions.

Return point information to your calculation

• In the Interpolate bar, click  Copy to calcs. 

The information of the selected point is returned to your calculations and
the the Data Graph window closes.

See also

Select a point in a data graph (page 415)

Close the Data Graph window (page 419)

14.5 Adjust data graph settings
To adjust the appearance of the Data Graph window, see the following
instructions.

1. In the Data Graph window, click File --> User Options. 

The User Options dialog box appears.

2. Select the components that you want to view in the Data Graph window.

• To view the grid lines for the X axis, select the X grid lines option.

• To view the grid lines for the Y axis, select the Y grid lines option.
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• To view the point of the curve for which primary data has been
defined, select the Curve points option.

The other values are determined by linear interpolation between curve
points.

3. Select the color and style with which you want the selected curve to be
highlighted.

4. Select the precision with which data graphs work by using the up and
down arrows.

• If you select 1000, the data graph works with numbers that are
multiples of one thousand.

• If you select 1200, the data graph works with numbers that are
multiples of one hundred.

• If you select 1230, the data graph works with numbers that are
multiples of ten.

• If you select 1234, the data graph works with numbers that are
multiples of one, or integers.

• If you select 1234.0, the data graph works with numbers that are
multiples of one tenth.

• If you select 1234.00, the data graph works with numbers that are
multiples of one hundredth.

• If you select 1234.000, the data graph works with numbers that are
multiples of one thousandth.

5. Click OK. 

The settings are now saved.

14.6 Close the Data Graph window
You can close the Data Graph window in two ways. You can either decide to
return data graph information to your calculations, or close the Data Graph
window without returning any information to your calculations.

Close the Data Graph window and return variables
1. Do one of the following:

• In the toolbar, click Copy to calcs.

• Click File --> Copy To Calcs and Exit.
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Close the Data Graph window without returning variables

WARNING If you close the Data Graph window without returning variables,
any remaining calculations that use details from the data graph
will not calculate correctly.

1. Do one of the following:

• Click File --> Exit Without Copy.

• Click X at the top right corner of the Data Graph window, and in the
confirmation dialog box that appears, click Yes.
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15 2D analysis

Tedds includes a fully integrated 2D analysis tool that allows you to define a
frame in 2D, analyze the frame, and insert the results in your calculation
document. In the following paragraphs, see the benefits of using the 2D
analysis tool.

The 2D analysis tool allows you to:

• Model frames with unlimited nodes and elements.

• Use a spreadsheet for inputting data.

• View model geometry, loading and results for shear, moment, deflection,
axial deflection, and axial force.

• Output results for node reactions, node deflections, shear, moment,
deflection, axial deflection and axial force.

• Output drawings for geometry, loading, shear, moment, deflection, axial
deflection and axial force.

15.1 Start 2D analysis
To start the 2D analysis tool and model your own frames, see the following
instructions.

See also

Components of the 2D Analysis dialog box (page 422)

Create a 2D analysis model (page 424)

Modify a 2D analysis model (page 428)

Start 2D analysis (the Tedds Application)
1. Create a new document. 

The Select Calculation dialog box opens.
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2. In the Analysis folder, click the 2D analysis subfolder.

3. Double-click the 2D analysis item. 

The 2D analysis dialog box opens.

Start 2D analysis (Tedds for Word)

1. On the Tedds tab, click Library Access System. 

The Library Access System window opens.

2. Click the Analysis folder and the 2D analysis subfolder.

3. Double-click the 2D analysis item. 

The 2D analysis item appears in your document.

4. Calculate the 2D analysis item. 

The 2D analysis dialog box opens.

15.2 Components of the 2D Analysis dialog box
The 2D analysis tool allows you to create and define several different
properties for your components. In the paragraphs below, see the main
components of the 2D analysis dialog box.
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1. Context-sensitive help box

guides you in creating your model.

2. Preview window

displays a preview of the model that you are defining.

3. 2D analysis tabs

allow you to define the different components of your model.

a. Nodes tab

allows you to define an unlimited number of nodes.

b. Materials tab

allows you to select pre-defined materials used in your model or
define the properties of a custom material manually.

c. Sections tab

allows you to select pre-defined sections used in your model or
define custom section properties manually.

d. Elements tab

allows you to create analysis elements by connecting two nodes and
assigning the material and section for the elements.

e. Design Members tab

allows you to join elements to form design members. Using design
members enables applying loads to design members, and outputting
results so that they suit your design purposes.
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f. Loading tab

allows you to create load cases, which enable entering loads.

g. Load Combinations tab

allows you to define load combinations with an appropriate load
factor for each load case.

h. Results tab

allows you to view the results of your analysis and define how you
want the results to be displayed.

i. Output tab

allows you to determine which details of the analysis are included
when you insert the analysis in your calculation document.

4. Property spreadsheet

allows you to define the properties of the components that you are
creating.

5. Quick-access buttons

allow you to access the notes related to the 2D analysis tool and the
variables of your model, and send feedback or a support request to the
Tedds help desk.

See also

Start 2D analysis (page 421)

Create a 2D analysis model (page 424)

15.3 Create a 2D analysis model
Creating a 2D analysis model is a process with multiple phases. To create your
own 2D analysis model, see the following instructions.

NOTE When you have entered or modified values for a row, remember to
save the data by pressing Enter, clicking another row, or switching to
another tab.

TIP When you define the components and properties for your model in the
property spreadsheet, some labels specify the units in which they expect
the values to be entered. To use other units, simply type the unit in the
field after the value.

See also

Start 2D analysis (page 421)
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Components of the 2D Analysis dialog box (page 422)

Modify a 2D analysis model (page 428)

Example 2D analysis model (page 429)

1. Define geometry for the model
1. On the Nodes tab, type the node coordinates and define their properties. 

NOTE Before creating additional nodes, ensure that the existing node is
valid.

2. Go to the Materials tab. 

3. Do one of the following:

• In the Name column, click the arrow on the right side of cells, and
select the correct material in the list that appears. You can then modify
the material properties according to your needs.

• Type the name of the material and the material properties in the fields
manually.

4. Go to the Sections tab. 

5. Do one of the following:

• Click Select... and select the desired pre-defined sections which you
use in your model. If necessary, you can then modify the design
properties by clicking Custom...

• Type the properties of your sections in the fields manually.
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6. Click the Elements tab to open it.

7. Define the elements that you want to use in your model. 

NOTE The local x-axis of each element runs from the start node to the
end node. By default, the local major axis is perpendicular to the
local x-axis in the 2D plane of the model with positive values, in
the same sense as the global z-axis. For elements parallel to the
global z-axis, the major axis is rotated anti-clockwise to the local
x-axis.

To use the minor axis section properties instead of major axis,
select the Rotated option.

a. Connect two nodes by defining the start and end nodes for each
element.

b. Select a material for the element.

c. Select a section for the element.

d. Define the releases and rotation of the element according to your
needs.

2. Define design members for the model
1. Go to the Design Members tab.

2. Name the design members that you want to use in your calculations.

3. Click the ... button in the Edit column and specify a start and end element
for each design member. 

4. Modify the properties of the design members according to your needs.
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3. Define loading for the model
1. Go to the Loading tab.

2. Do one of the following:

• Use the existing load cases that are visible in the left property
spreadsheet (labeled Loading).

• In the Loading property spreadsheet, define new load cases according
to your needs.

3. In the list above the right property spreadsheet, Select the types of loads
that you want to use in your model. 

4. Define the loads for the different types of loads. 

TIP You can enter load positions in the following ways:

• as absolute values

• as ratios from 0 to 1, where 0 is the start of the element or
member, and 1 is the end of the element or member

5. Go to the Load Combinations tab.

6. Define the properties of the load combinations which you want to use in
your model. 

4. View and examine results
1. Go to the Results tab.

2. Select result options according to your needs using the available check
boxes and lists. 
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TIP By default, results view the results for the entire model. However, if
you enable the Only show current selection option, the results
only view the currently selected elements or members.

5. Specify output details
1. Go to the Output tab.

2. Select output options according to your needs using the available check
boxes and lists.

3. To preview the output created with the options you selected, click
Preview output...

4. To insert the output in your calculation document, click OK 

TIP To modify the 2D analysis model later, you can recalculate it.

15.4 Modify a 2D analysis model
Tedds allows you to make changes to an existing 2D analysis model, if
necessary. To modify a 2D analysis model, you must have the 2D analysis
dialog box open. For more information, see the following instructions.

See also

Create a 2D analysis model (page 424)

Example 2D analysis model (page 429)

Modify a group of cells

NOTE You can modify both cells that have a numeric value and cells that
have some other sort of content. This may mean cells with text, or
cells for which you select the desired option in a list.

1. Hold down the Ctrl key, and select the cells that you want to modify.

2. Still holding down the Ctrl key, change the value in one of the selected
cells.

3. Press Enter to update all cells to the new value.

4. Release the Ctrl key.
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Modify expressions
In addition to numerical values, you can type mathematical expressions in the
cells of the 2D analysis dialog box.

If the expression starts with an operator, the current value of the cell will
automatically be prefixed to the expression.

For example:

=+1 adds 1 to the current value.

=+500 mm' adds 500 mm to the current value.

=*2' multiplies the current value by 2.

= L assigns the value of the variable L.

To modify expressions, see the following instructions.

1. Select the cells that you want to modify.

2. Type = and the expression. For example, = +1.

3. Press Enter to update the selection.

Sort data
You can easily sort data in any column of the 2D analysis dialog box by
clicking the column header.

• To sort the data in a column in ascending order, click the column header
once.

• To sort the data in a column in descending order, click the column header
twice.

NOTE If you modify the value of a cell in a currently sorted column, the
modified cell may move in the list because its value changes the sort
order.

15.5 Example 2D analysis model
This example demonstrates the use of the 2D analysis tool and highlights
techniques that can be used for efficiently entering data and modifying the
model.

See also

Creating the example 2D analysis model (page 432)
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Example 2D analysis model (SI Metric)

Geometry and Loading

The truss shown below is to be input:

• Top and bottom chords: UC 203x203x46

• Diagonals: CHS 168.3x6.3

Load case 1: Self weight

Calculated automatically.

Load case 2: Dead

Load case 3: Live
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Load Combination:

1.35 * Self weight + 1.35 * Dead + 1.50 * Live

Example 2D analysis model (US Imperial)

Geometry and Loading

The truss shown below is to be input:

• Top and bottom chords: W 8x40

• Diagonals: HSS 6.625x0.250

Load case 1: Self weight

Calculated automatically.

Load case 2: Dead

Load case 3: Live
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Load Combination:

1.2 * Self weight + 1.2 * Dead + 1.6 * Live

Creating the example 2D analysis model
To create the example 2D analysis model, see the following instructions.

See also

Example 2D analysis model (page 429)

Create a 2D analysis model (page 424)

Open the 2D analysis dialog box
See: Start 2D analysis (page 421)

Define the geometry (SI Metric)
1. On the Nodes tab, enter the nodal coordinates.

2. Indicate that the frame is supported at nodes 1 and 4, as shown below. 

TIP To generate additional rows for new nodes, ensure the existing row
is valid. Then, click anywhere in the empty row below, marked with
* .

Node X(m) Z(m) DOF X DOF Z DOF
rotation

1 0 0 Fixed Fixed Free
2 2 0 Free Free Free
3 4 0 Free Free Free
4 6 0 Free Fixed Free
5 1 1.75 Free Free Free
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Node X(m) Z(m) DOF X DOF Z DOF
rotation

6 3 1.75 Free Free Free
7 5 1.75 Free Free Free

3. On the Materials tab, set the material to Steel (EC3). 

The material properties appear in the property spreadsheet.

Name Density

(kg/m^3)

Youngs
Modulus

(kN/mm^2)

Shear
Modulus

(kN/mm^2)

Thermal Co-
efficient

Steel (EC3) 7850 210 80.8 12

4. On the Sections tab, click Select..., and select the two sections shown
below in the European steel data list: 

Name Area

(cm^2)

Major
Inertia

(cm^4)

Minor
Inertia

(cm^4)

Shear
Area, y

(cm^2)

Shear
Area, z

(cm^2)
UC
203x203x6
0

76.373 6124.513 2064.598 52.602 19.702

CHS
168.3x6.3

32.063 1053.420 1053.420 16.0315 16.031

5. On the Elements tab, define the analysis elements as shown below. 

Element Start Node End Node Material Section
1 1 2 Steel UC

203x203x60
2 2 3 Steel UC

203x203x60
3 3 4 Steel UC

203x203x60
4 5 6 Steel UC

203x203x60
5 6 7 Steel UC

203x203x60
6 1 5 Steel CHS 168.3x6.3
7 5 2 Steel CHS 168.3x6.3
8 2 6 Steel CHS 168.3x6.3
9 6 3 Steel CHS 168.3x6.3
10 3 7 Steel CHS 168.3x6.3
11 7 4 Steel CHS 168.3x6.3
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6. Define the end releases for the elements as shown below. 

Element Start
Node

End Node Start
Moment

End
Moment

Axial

1 1 2 Fixed Fixed Fixed
2 2 3 Fixed Fixed Fixed
3 3 4 Fixed Fixed Fixed
4 5 6 Fixed Fixed Fixed
5 5 6 Fixed Fixed Fixed
6 1 5 Free Free Fixed
7 5 2 Free Free Fixed
8 2 6 Free Free Fixed
9 6 3 Free Free Fixed
10 3 7 Free Free Fixed
11 7 4 Free Free Fixed

The releases should now be displayed in the graphical display as shown
below.

Define the geometry (US Imperial)
1. On the Nodes tab, enter the nodal coordinates.

2. Indicate that the frame is supported at nodes 1 and 4, as shown below. 

TIP To generate additional rows for new nodes, ensure the existing row
is valid. Then, click anywhere in the empty row below, marked with
* .
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Node X(ft) Z(ft) DOF X DOF Z DOF
rotation

1 0 0 Fixed Fixed Free
2 7 0 Free Free Free
3 14 0 Free Free Free
4 21 0 Free Fixed Free
5 3.5 6 Free Free Free
6 10.5 6 Free Free Free
7 17.5 6 Free Free Free

3. On the Materials tab, select Steel (AISC). 

The material properties appear in the property spreadsheet.

Name Density

(lbm/ft^3)

Youngs
Modulus

(ksi)

Shear
Modulus

(ksi)

Thermal Co-
efficient

Steel (AISC) 490 29000 11200 12

4. On the Sections tab, click Select..., and select the two sections shown
below in the USA (US units) steel data list: 

Name Area

(in^2)

Major
Inertia

(in^4)

Minor
Inertia

(in^4)

Shear
Area, y

(in^2)

Shear
Area, z

(in^2)
W 8x40 1.7 146 49.1 8.13 2.97
HSS
6.625x0.25
0

4.68 23.9 23.9 2.34 2.34

5. On the Elements tab, define the analysis elements as shown below. 
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Element Start Node End Node Material Section
1 1 2 Steel (AISC) W 8x40
2 2 3 Steel (AISC) W 8x40
3 3 4 Steel (AISC) W 8x40
4 5 6 Steel (AISC) W 8x40
5 6 7 Steel (AISC) W 8x40
6 1 5 Steel (AISC) HSS

6.625x0.250
7 5 2 Steel (AISC) HSS

6.625x0.250
8 2 6 Steel (AISC) HSS

6.625x0.250
9 6 3 Steel (AISC) HSS

6.625x0.250
10 3 7 Steel (AISC) HSS

6.625x0.250
11 7 4 Steel (AISC) HSS

6.625x0.250

6. Define the end releases for the elements as shown below. 

Element Start
Node

End Node Start
Moment

End
Moment

Axial

1 1 2 Fixed Fixed Fixed
2 2 3 Fixed Fixed Fixed
3 3 4 Fixed Fixed Fixed
4 5 6 Fixed Fixed Fixed
5 5 6 Fixed Fixed Fixed
6 1 5 Free Free Fixed
7 5 2 Free Free Fixed
8 2 6 Free Free Fixed
9 6 3 Free Free Fixed
10 3 7 Free Free Fixed
11 7 4 Free Free Fixed
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The releases should now be displayed in the graphical display as shown
below.

Make the top and bottom chords continuous
1. On the Design Members tab, name the first member Top Chord.

2. Click the ... button in the Edit column and specify the properties of Top
Chord as shown below: 

• start node 4

• end node 5

• support at the two end nodes

3. Repeat the above process to create a second member, Bottom Chord,
with the properties shown below: 

• start node 1

• end node 3

• support at the two end nodes

Define the loading (SI Metric)
1. On the Loading tab, select Node loads as the type of load. 
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2. Define the three Z direction loads shown below, at the same time
ensuring that the load case for each one is set to Dead.

3. Add three more node loads as shown below, this time changing the load
case to Live.

4. On the Load Combinations tab, create a single combination whose type
is Strength.

5. Define the factors of the combination as follows: 

• Self weight: 1.35

• Dead: 1.35

• Live: 1.5

Define the loading (US Imperial)
1. On the Loading tab, select Node loads as the type of load. 
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2. Define the three Z direction loads shown below, at the same time
ensuring that the load case for each one is set to Dead.

3. Add three more node loads as shown below, this time changing the load
case to Live.

4. On the Load Combinations tab, create a single combination whose type
is Strength.

5. Define the factors of the combination as follows: 

• Self weight: 1.2

• Dead: 1.2

• Live: 1.6

Examine the results (SI Metric)
The Results tab displays both tabular and graphical results for the selected
load case, combination or envelope. You can control the graphical results with
the available lists and the check boxes.

1. In the list immediately to the left of the table, select Single load
combination, and highlight the previously defined combination. 
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2. Select the box to display the axial force diagram, and note the forces in
each of the members.

3. Try checking each of the result check boxes to view the different diagrams
that can be displayed.

4. On the Nodal tabular results spreadsheet, click the column header for
vertical global deflection. The deflections are sorted in ascending order,
click again to sort in descending order.

NOTE Minimum and maximum member forces can be located in a
similar way.

Examine the results (US Imperial)
The Results tab displays both tabular and graphical results for the selected
load case, combination or envelope. You can control the graphical results with
the available lists and the check boxes.

1. In the list immediately to the left of the table, select Single load
combination, and highlight the previously defined combination. 
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2. Select the box to display the axial force diagram, and note the forces in
each of the members.

3. Try checking each of the result check boxes to view the different diagrams
that can be displayed.

4. On the Nodal tabular results spreadsheet, click the column header for
vertical global deflection. The deflections are sorted in ascending order,
click again to sort in descending order.

NOTE Minimum and maximum member forces can be located in a
similar way.

Modify the geometry (SI Metric)
You can quickly modify the model by using expressions in spreadsheets. See
an example below.

1. Return to the Nodes tab and highlight all X coordinate cells.

2. Type =*2, as shown below. 
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3. Press Enter. 

The value in each highlighted cell is increased by the amount specified.

Click the Results tab to see that the analysis has been automatically
updated to reflect the increased span.
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Modify the geometry (US Imperial)
You can quickly modify the model by using expressions in spreadsheets. See
an example below.

1. Return to the Nodes tab and highlight all X coordinate cells.

2. Type =*2, as shown below. 

3. Press Enter. 

The value in each highlighted cell is increased by the amount specified.

Click the Results tab to see that the analysis has been automatically
updated to reflect the increased span.
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16 The Section Properties
calculator

The Section Properties Calculator allows you to create custom section
shapes by entering the dimensions of each component. For more information,
see the following paragraphs. The Section Properties Calculator also allows
you to recall any existing sections using the Data Lists tool, converting them
into primary shapes that the Section Properties Calculator can easily
process.

16.1 Start the Section Properties Calculator
You can start the Section Properties Calculator by selecting it in the
engineering library. To do so, see the following instructions.

See also

The Section Designer (page 447)

Create sections in the Section Designer (page 448)

Start the Section Properties Calculator (the Tedds
Application)
1. Open a new document. 

The Select Calculation dialog box opens.

2. Click the Section Properties folder and the Section Properties
Calculator subfolder.

3. To start the Section Properties Calculator, double-click the Section
Properties Calculator item. 
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The Section Properties Calculator calculation interface appears, allowing
you to define the properties for your section.

NOTE If you select Custom as the section type, the Section Designer
window will open, allowing you to create the desired section.

Start the Section Properties Calculator (Tedds for Word)

1. In the Library ribbon group, click the Launch the Tedds Library
Access System button. 

The Library Access System window opens.

2. Click the Section Properties folder and the Section Properties
Calculator subfolder.

3. To start the Section Properties Calculator, double-click the Section
Properties Calculator item. 

The Insert Calc Item dialog box appears.

4. Select how you want to insert the Section Properties Calculator in the
calculation document.

• To insert the calc item in a new document, select New document.

• To append the calc item in the end of the current document, select
Append to active document.

• To insert the calc item at the location of your insert point in the current
document, select Insert in active document.

• To insert the calc item in a new calc section, select Add new Calc
Section.
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• To insert a page break before the new calc section, select Insert
page break.

5. Click OK. 

The Section Properties Calculator item appears in your document.

6. Select and calculate the Section Properties Calculator item. 

The Section Properties Calculator calculation interface appears, allowing
you to define the properties for your section.

NOTE If you select Custom as the section type, the Section Designer
window will open, allowing you to create the desired section
yourself.

16.2 The Section Designer
The Section Properties Calculator allows to create custom section types by
assembling any number of primary shapes on a canvas tool. The tool for
creating the section types is called the Section Designer. For more
information, see the following paragraphs.

Using the Section Designer, you can:

• Combine primary shapes (rectangles, circles, and triangles) with each other
to generate new sections.

• Create holes within the primary shapes, if necessary.
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• Recall sections from the Data Lists tool.

• Combine the recalled sections with other primary shapes to generate new
sections.

• Modify the size and position of primary shapes in several ways.

• Calculate the properties of the overall section that you have created, and
insert its properties in your calculation document.

See also

Section Designer toolbars (page 622)

Create sections in the Section Designer
To create different sections, or shapes, in the Section Designer, follow the
instructions below.

To define the sections whose properties you want to calculate, you can:

• Build the sections by creating primary shapes (rectangles, circles, triangles
and holes).

• Recall standard sections using the Data Lists tool.

• Select a standard section shape and enter the appropriate details directly.

See also

Modify sections (page 453)

Structure sections (page 454)

Control the position of objects on the canvas (page 455)

Move objects on the canvas (page 456)

Rotate objects (page 458)

Snap objects with respect to each other (page 461)

View section properties (page 465)

Section Designer toolbars (page 622)

Create a rectangle
You can create rectangles either by drawing them on the canvas, or by typing
their properties manually.

Draw the shape on the canvas

1. In the toolbar, click the Rectangle button.

2. Place the mouse pointer where you want to place one corner of the
rectangle.
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3. Hold down the left mouse button and drag the pointer where you want to
place the opposite corner of the rectangle.

4. To create the rectangle, release the left mouse button.

Define shape properties manually

1. Right-click anywhere in the Section Designer window.

2. In the context menu that appears, click Insert --> Rectangular shape.

The Add Rectangle dialog box appears.

3. In the dialog box, type properties for the rectangle.

4. Click OK.

Create a circle
You can create circles either by drawing them on the canvas, or by typing their
properties manually.

Draw the shape on the canvas

1. In the toolbar, click the  Circle button.

2. Place the mouse pointer where you want the circle to start.

3. Hold down the left mouse button, and drag the mouse pointer where you
want the circle to end.

4. To create the circle, release the left mouse button.

Define shape properties manually

1. Right-click anywhere in the Section Designer window.

2. In the context menu that appears, click Insert --> Circular shape.

The Add Circle dialog box appears.

3. In the dialog box, type properties for the circle.

4. Click OK.

Create a triangle
You can create triangles either by drawing them on the canvas, or by typing
their properties manually.

Draw the shape on the canvas

1. In the toolbar, click the  Triangle button.

2. Place the mouse pointer where you want the triangle to start.

3. Hold down the left mouse button, and drag the mouse pointer where you
want the triangle to end.

4. To create the triangle, release the left mouse button.
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Define shape properties manually

1. Click Insert --> Triangular shape.

The Add Triangle dialog box appears.

2. In the dialog box, type properties for the triangle.

3. Click OK.

Create a hole

NOTE Before you create holes, note the following:

• Holes must lie completely within the shape to that they belong.

• Rectangular shapes can contain any number of holes.

The holes can be rectangular on elevation, circular on elevation, or
rectangular on section.

• Circular shapes can only contain a single hole.

The holes must be circular on section, and concentric within the
shape.

• You cannot create holes within triangular shapes.

1. Select the shape to that you want to add a hole.

2. Click Insert --> Hole. 

The Add Hole dialog box appears.

3. Select the type of hole that you want to define. 

The rest of the dialog box configures to show the details appropriate to
the selected hole type.

4. Enter properties for the hole.
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5. Click OK. 

NOTE In order for you to understand the way that holes are handled in
the Section Designer, read the following about containment:

• In order to prevent a hole and its parent shape being
separated, a property called containment is switched on for
the parent shape.

This means that any other shape or hole, or group that lies
completely within the shape, will be selected and moved
together with the parent shape. This also includes the
following cases:

• Shapes that you add within the shape that has
containment switched on.

• Shapes that lie within the shape that has containment
switched on.

• If you want containment to be switched off, delete the holes in
the parent shape. You can then select the shape by itself and
move it out of the way before reinstating the holes that you
deleted.

• If you place shapes (including holes) in a group, the
containment feature is switched off for the entire group.

Therefore, we recommend that when you have finished
creating a shape with holes, you select the shape together
with all its holes and place them in a group.

Create a predefined shape
The Tedds Data Lists tool includes details for many standard sections. The
Section Designer also allows you to insert these sections on your canvas to
create your own custom sections.

NOTE The Section Designer converts the pre-defined sections that you
insert into groups of primary shapes. The conversion process may
ignore some features of the section. Therefore, always check whether
using the Section Designer suits your needs.

1. Do one of the following:

• In the toolbar, click the  Predefined shape button.

• Right-click anywhere in the Section Designer window, and in the
context menu that appears, click Insert --> Predefined shape.

The Select Predefined Shape dialog box appears.

2. Do one of the following:
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• To recall a standard section using Data Lists, double-click an item in
the Standard shape from list.

a. In the Data List dialog box, select the desired item.

b. Click OK.

• To enter the details for a shape yourself, select the Custom library
shape option and click OK.

a. In the Add Custom Library Shape dialog box, select the type of
shape.

b. Click Next.

c. In the dialog box that appears, type properties for the section.

d. Click Finish.

e. To place the shape on the canvas, click the left mouse button
where you want to place the section.
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Modify sections
Once you have created shapes in the Section Designer, you may need to
modify their location, size, or other properties. To modify existing sections on
the canvas, see the following instructions.

1. Do one of the following:

• Click Edit --> Shape....

• Click the shape which you want to modify with the right mouse button,
and in the context menu which appears, select Edit Shape....

• Select a shape and drag the control handles around the shape to
adjust its size.

2. Modify the shape properties according to your needs.
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See also

Structure sections (page 454)

Control the position of objects on the canvas (page 455)

Move objects on the canvas (page 456)

Rotate objects (page 458)

Snap objects with respect to each other (page 461)

View section properties (page 465)

Section Designer toolbars (page 622)

Structure sections
As you create custom sections, you can define them in many ways. You can,
for example, move shapes back and forward on the canvas, and group shapes.

See also

Control the position of objects on the canvas (page 455)

Move objects on the canvas (page 456)

Rotate objects (page 458)

Snap objects with respect to each other (page 461)

View section properties (page 465)

Section Designer toolbars (page 622)

Select objects
• To select an object, click the shape which you want to select with the left

mouse button. 

Any other objects are automatically deselected.

• To add objects to your current selection, hold the Shift key down and click
the objects that you want to add.

• To remove objects from your current selection, hold the Shift key down
and click the objects that you want to remove.

Move objects forward or backward
1. Select the object that you want to move.

2. In the left side pane, do one of the following:

• To move an object to the front, in the toolbar, click the  Front
button.
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• To move an object to the back, in the toolbar, click the  Back button.

• To move an object forward, in the toolbar, click the  Forward
button.

• To move an object backward, click the  Backward button.

Create groups
Grouping objects allows you to move and rotate the shapes as a single entity.

If necessary, you can create a hierarchy of shapes by adding groups into other
groups.

1. Select the objects that you want to group.

2. Do one of the following:

• In the toolbar, click the  Group button.

• Click Structure --> Group.

The objects are now grouped.

NOTE When you insert the section in a calculation document, all
grouping details are lost.

Destroy groups
1. Select the group that you want to destroy.

2. Do one of the following:

• In the toolbar, click the  Ungroup button.

• Click Structure --> Ungroup.

The items in the selected group are no longer grouped. Any groups within
the selected group can also be destroyed as above.

Control the position of objects on the canvas
The Section Designer provides several different ways of positioning objects
on the canvas, such as snapping the objects to the grid. For more information,
see the following paragraphs.

See also

Structure sections (page 454)

Move objects on the canvas (page 456)
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Rotate objects (page 458)

Snap objects with respect to each other (page 461)

Adjust Section Designer settings (page 462)

Control snapping to the grid
The grid is displayed as a series of small dots on the canvas. By default, the
Section Designer views the grid when it starts.

Snapping items to grid allows you to create shapes that are at exactly the right
spot on your canvas.

• To control the current grid snap setting, click View --> Snap to grid on
drag.

Control angle snapping
When you rotate shapes, you can also limit the allowable rotations to
multiples of 15° by selecting the Angle snap option. By default, the Angle
snap option is selected when the Section Designer starts.

• To control the current angle snapping setting, click View --> Angle snap.

Move objects on the canvas
The Section Designer provides several different ways of positioning objects
on the canvas. You can drag and drop objects on the canvas, nudge objects, or
type the desired location of objects in a dialog box. For more information, see
the following instructions.

See also

Structure sections (page 454)

Control the position of objects on the canvas (page 455)

Rotate objects (page 458)

Snap objects with respect to each other (page 461)

Adjust Section Designer settings (page 462)

Section Designer toolbars (page 622)

Move objects by dragging and dropping
1. Select the objects that you want to move.

2. Click one of the object and hold down the left mouse button.

3. Drag the selected objects to the desired location. 
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NOTE If the Snap to grid on drag option is switched on, the top left
corner of the selected objects snaps to the nearest grid point.

4. Release the mouse button to drop the objects in their new location.

Move objects by nudging
1. Select the objects that you want to move.

2. Use the nudge buttons on the left side pane (see the image below) or the
arrow keys on the keyboard to move the selected objects in the
appropriate direction in steps that are equal to the current grid spacing in
that direction. 

NOTE If you hold down the Shift key and use the buttons from the
Nudge toolbar to move the selected objects, they move in the
selected direction by one unit.

The unit of movement depends on the size of canvas. For more
details, see the table below.

Canvas Size Unit
2 m x 1.5 m 0.1 mm
21 m x 15 m 1 mm
210 m x 150 m 10 mm
328 in x 234 in 1/64”
109 ft x 75 ft 1/16”
875 ft x 625 ft 1/2”

Define the position of objects in a dialog box

NOTE You can only move one object at a time by defining the position of
objects in a dialog box.

1. Select the object that you want to move.

2. Do one of the following:

• Click Edit --> Move Shape....
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• Right-click anywhere in the canvas, and in the context menu, select
Move Shape....

The Move shape by dialog box appears.

NOTE The appearance of the dialog box depends on the shape that you
have selected.

3. Type the distances by that you want to move the object. 

NOTE • Rectangles and triangles:

You can move the objects along either the global or the local
coordinate axis system, or along the two coordinate systems.

• Circles and groups:

You can only move the objects along the global axis.

4. Click OK.

Rotate objects
When you create a shape, you can specify its rotation from the global axis
system where appropriate. You can apply rotations to all shapes and groups
using the mouse.

NOTE To determine whether you want to limit the rotation of objects to
multiples of 15°, see Control angle snapping (page 455).

1. Select the objects that you want to rotate.

2. In the toolbar, click the  Rotate button.

3. Click one of the selected objects and hold down the left mouse button.

4. Drag the object until you achieve the desired rotation. 
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NOTE The way objects are rotated depends on their grouping.

If you rotate separate objects, each object is rotated around its
midpoint.

If you rotate groups, each group rotates around its midpoint.
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5. Once the rotation is correct, release the left mouse button. 

The shapes are rotated in the desired position.

See also

Structure sections (page 454)

Control the position of objects on the canvas (page 455)
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Move objects on the canvas (page 456)

Snap objects with respect to each other (page 461)

Section Designer toolbars (page 622)

Snap objects with respect to each other
The Section Designer allows you to position shapes on your canvas by
positioning two objects with respect to each other.

NOTE When you select multiple objects, the squares that surround the
object that you have last selected are gray.

The squares that surround previously selected objects are white.

The color is important for snapping the items. The object that you want to
move should be surrounded by grey squares, whereas the sqaures around the
other object should be white.

If you select the objects in the wrong order, then you can hold the Shift key
down and click over the object twice (to deselect it and then select it again).
You can also old the Ctrl key down and click the object.

1. Select the two objects that you want to snap to one another.

2. Ensure that the object that you want to move is surrounded by gray
squares, and that the object that should remain stationary is surrounded
by white squares.

3. Do one of the following:

• In the toolbar, click the Snap Shapes button.

• Click Edit --> Snap Shapes...
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The Snap Shapes dialog box appears.

4. Use the Snapping buttons determine the face of the moving object that
you want to snap to the stationary object.

5. To align the objects with each other, select the appropriate alignment
option.

6. To move the object once you have snapped it, type the distance for the
moving object in the fields of the Offset section. 

NOTE You can only move the object parallel to the face that been
snapped to the stationary objet. Therefore, the alternate field is
disabled.

7. To perform the snap, click OK.

See also

Structure sections (page 454)

Control the position of objects on the canvas (page 455)

Move objects on the canvas (page 456)

Section Designer toolbars (page 622)

Adjust Section Designer settings
You can adjust Section Designer settings to minimize the information that
you need to enter and define how the grid of the Section Designer works. For
more information, see the following paragraphs.
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See also

Control the position of objects on the canvas (page 455)

View section properties (page 465)

Return section properties to your calculations (page 467)

Adjust user options
1. To see the user options, in the Section Designer window , click File -->

User Options.... 

The User Options dialog box opens.

The User Options dialog box contains the following settings:

• Automatic calculation of properties

If you select the Automatic calculation of properties option, Section
Designer automatically calculates the properties of the section each
time you add, remove, move or modify a section shape in any way.

This means that you can view the properties of your section at any
time. However, if your section contains many shapes, it may take some
time for the properties to be calculated.

To view section properties, first open the Section Properties dialog
box. Then, as you modify your section, the current properties will be
displayed.

• Density

Besides the type and dimensions of each primary shape (rectangle,
circle, triangle, and hole), Section Designer needs to know the density
of each shape.
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The value that you type in the Density field is used as the default value
for all shapes that you define.

If necessary, you can change the density of a shape separately.

• Input label set

allows you to select which units you want to use while creating your
section.

• Output label set

allows you to select which units you want to use for output.

NOTE The Input label set and Output label set options are
completely independent. Therefore, you can select different
unit systems for input and output.

• Output sketch

The Output sketch options allow you to control the sketch of the
section. They do not affect returning section properties to Tedds.

• If you select No, no sketch is created.

• If you select To document, a sketch is inserted in your calculation
document.

• If you select To Sketch Viewer, the sketch is created and inserted
in Sketch Viewer. You can then manipulate the sketch and insert it
wherever you like in your document.

• Zoom to fit before copy to calcs

If you select the Zoom to fit before copy to calcs option, Section
Designer zooms the created sketch so that the section fills the sketch.

2. Once you have adjusted the settings according to your needs, click OK. 

The options are registered, and the User Options... dialog box closes.

Set and use the grid
The grid of the Section Designer window makes it easy to create accurately
sized and positioned shapes. You can set the spacing of the grid points to
meet your needs, modifying it as necessary while you define of the section.

• Click View --> Grid Properties.... 
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The Grid Properties dialog box appears.

The Grid Properties dialog box contains the following options:

• Grid Visible

The Grid Visible allows you to select whether you want to see the grid
in the Section Designer window. The grid is displayed as a series of
dots.

• Snap to grid on drag

allows you to determine whether you want shapes to automatically
snap to the nearest grid point when you move them. If the Snap to grid
on drag option is not selected, the creation and movement of shapes is
unrestrained.

• Angle snap

When you rotate objects with this option checked the rotation is limited
to 15° increments (15°, 30°, 45° and such like). With this option cleared,
any rotation is possible.

• Grid Color

allows you to determine the color of the grid points.

• Grid Spacing

allows you to specify the spacing between the grid points both
horizontally and vertically.

The units that are expected depend on the size of the canvas that you
have selected.

You can change the grid spacing at any time while creating a section to
allow more precise control for small shapes.
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View section properties
The Section Designer allows you to view the properties of your section at any
point. You can later insert the section properties in your calculations. To view
section properties, see the following instructions.

• Click View --> Section Properties. 

The Section Properties list appears.

See also

Adjust Section Designer settings (page 462)

Save a section to disk (page 466)

Return section properties to your calculations (page 467)

Save a section to disk
If you wish to save a section so that it maintains the groups that you may have
defined in the Section Designer, you can save the file to disk in .spt format. To
save a section to disk, see the following instructions.

1. In the Section Designer window , click File --> Save As....
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2. Save the file.

Return section properties to your calculations
Once you are finished creating your section in the Section Designer, you can
return the section properties to your calculation document. To do so, see the
following instructions.

• Do one of the following:

• In the toolbar, click the Copy to calcs button.

• Click File --> Copy to calcs and exit.

The section is copied to your calculation document and the Section
Designer window closes.

NOTE The groups that you may have defined in the Section Designer are
not included in the results that are copied to your calculation
document.

If you want to maintain the groups that you have defined, see Save
a section to disk (page 466).

See also

Adjust Section Designer settings (page 462)
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17 Start the Sketch Viewer

The Sketch Viewer tool in Tedds for Word allows you to easily modify your
sketches. The modified sketches can be pasted back into your calculation
documents. When you paste the sketches in your calculations, the size and
shape of the sketches are automatically maintained.

RESTRICTION The Sketch Viewer is only available in Tedds for Word.

Some calculations automatically produce sketches for you. The sketches of
these calculations will be appear in the Sketch Viewer. According to your
needs, you can either decide to insert the sketches in your calculations or
leave them out.

In addition to opening the sketches of existing calculations, the Sketch Viewer
allows you to create your own sketches and modify them.

You can start the Sketch Viewer in two different ways, depending on whether
you want to open it without a sketch, or modify an existing sketch. See the
following instructions:

17.1 Open the Sketch Viewer empty
If you do not have a sketch which you want to modify, follow the instructions
below.

• In the Tools ribbon group, click More --> Sketch Viewer. 

The Sketch Viewer window opens.

17.2 Open an existing sketch in the Sketch Viewer
1. In your calculation document, select the frame that contains the sketch.

2. In the Tools ribbon group, click More --> Sketch Viewer. Sketch Viewer
displays the selected sketch in a new sketch window.
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See also

Components of the Sketch Viewer window (page 469)

Adjust the view of a sketch (page 471)

Transfer a sketch to the Sketch Viewer (page 470)

Copy a sketch to your calculations (page 473)

Open a new sketch window (page 470)

Close sketch windows (page 473)

17.3 Components of the Sketch Viewer window
Knowing the main components of the Sketch Viewer window can help you
work with the tool more efficiently. See the main components of the Sketch
Viewer window in the following paragraphs.

NOTE The following only applies to Tedds for Word.

1. File menu

allows you to, among other things, create new sketches, open existing
sketches, and save sketches.
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2. Sketch Viewer toolbar

allows you to access the most common features of the Sketch Viewer
with a single click.

For more information, see Sketch viewer toolbar.

3. Sketch windows

are windows that contain separate sketches.

See also

Start the Sketch Viewer (page 468)

Adjust the view of a sketch (page 471)

Transfer a sketch to the Sketch Viewer (page 470)

Copy a sketch to your calculations (page 473)

Open a new sketch window (page 470)

Close sketch windows (page 473)

17.4 Open a new sketch window
You can open a new window that contains another sketch or another copy of a
currently open sketch. In the latter case, you can manipulate each sketch
independently. You can transfer each version of the sketch back to your
calculation document without it affecting the other version. In order to open a
new sketch window, see the following instructions.

NOTE The following only applies to Tedds for Word.

• Click Paste new. 

The Sketch Viewer opens a new window. The new window contains a copy
of the current sketch.

See also

Adjust the view of a sketch (page 471)

Transfer a sketch to the Sketch Viewer (page 470)

Close sketch windows (page 473)

17.5 Transfer a sketch to the Sketch Viewer
With the Sketch Viewer, you can transfer and manipulate a file in the
Windows Enhanced Metafile (EMF) format from either your document or a
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disc. In addition, you can transfer images from the clipboard to the Sketch
Viewer, provided that the images are placed on the clipboard in the correct
format.

NOTE The following only applies to Tedds for Word.

NOTE The transferred sketches must be in Windows Enhanced Metafile
(EMF) format, and are exported from the Sketch Viewer in the same
format.

Transfer a picture from your document
1. Ensure that the Sketch Viewer is open.

2. In your document, select the frame containing the sketch that you want to
transfer.

3. In the Tools ribbon group, click More --> Sketch Viewer. 

The Sketch Viewer displays the selected sketch in a new sketch window.

Transfer objects from your document
1. Ensure that the Sketch Viewer is open.

2. In your document, double-click the picture that you want to view.

3. Select the objects you want to place in the Sketch Viewer.

4. Right-click the objects and select Copy.

5. Click the Sketch Viewer window to activate it.

6. Do one of the following:

• To paste the objects to the currently open sketch, on the toolbar, click
Paste.

• To paste the objects to a new sketch window, on the toolbar, click
Paste new.

Tedds transfers the selected objects to the Sketch Viewer.

17.6 Adjust the view of a sketch
When the Sketch Viewer opens or a new file is transferred to Sketch Viewer,
the sketch is viewed completely filling the sketch window while maintaining
the sketch’s aspect ratio. However, you can adjust the view of a sketch
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according to your needs. For detailed instructions, see the following
paragraphs.

NOTE The following only applies to Tedds for Word.

Change the view option
• On the toolbar, select one of the following view options:

• Zoom to fit: returns the sketch window to its original display state, with
the sketch at the maximum size at which it fits the window

• Zoom in

• Zoom out

• Zoom previous: returns the sketch window to the previous display
state

Change the background color
1. Click Settings. 

The Options - Default dialog box opens.

2. Click Select...

3. Select the color that you want to use as the background color of sketches.

4. Click OK. 

The background color is saved.
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Move the sketch
1. On the toolbar, ensure that the Move button is selected.

2. Move the mouse pointer to the point of the sketch that you want to move.

3. Hold down the left mouse button and drag the selected point to the
desired location.

4. Release the left mouse button.

17.7 Copy a sketch to your calculations
You may want to insert a copy of your sketch to your calculation document. To
copy a sketch from the Sketch Viewer, see the following instructions.

NOTE The following only applies to Tedds for Word.

1. Adjust the view of the sketch according to your needs.

2. On the toolbar, click Copy. 

A bitmap representation of the current view of your sketch is copied to
the clipboard.

3. Paste the sketch to your calculation document.

See also

Transfer a sketch to the Sketch Viewer (page 470)

17.8 Close sketch windows
Once you are finished working with sketches, you can close the open sketch
windows. For detailed instructions on how to close sketch windows, see the
following paragraphs.

NOTE The following only applies to Tedds for Word.

Close a sketch window
1. Select the sketch that you want to close.

2. Click X at the top right corner of the sketch tab.
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Close all sketch windows
• Click X at the top right corner of the Sketch Viewer window.
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18 Start the Interface designer

The Interface Designer is a tool for creating customized dialogs, also known
as interfaces, that allow the user to enter data for multiple input fields in the
same place. Interfaces help you to make your calculations more user-friendly,
intelligent, and automated. To start the Interface Designer in Tedds for Word,
see the following instructions.

NOTE The Interface Designer is only available in Tedds for Word.

By using interfaces in your calculation, you can:

• Have all the input data visible and presented at the start of the calculation.

• Group related input together in a logical way.

• Enter data with the help of multiple control types, for example check boxes
and lists.

• Validate input when it is entered.

• Apply maximum and minimum values to input.

• Scroll through and revise input before continuing the calculation.

• Add buttons for making selections from data lists, data tables, and so on.

• Add sketches and notes to the interface to illustrate the calculation.

To start the Interface Designer, do the following:

1. In the Insert ribbon group, click User Interface. 
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The Manage User Interfaces dialog box appears.

2. Select where you want to insert the user interface and click New. 

The Tedds Interface Designer window opens, displaying an empty
interface template.

See also

Components of the Interface Designer (page 476)

Close the Interface Designer (page 502)

18.1 Components of the Interface Designer
To understand the structure and components of the Interface Designer, see
the following image and paragraphs.

NOTE The following only applies to Tedds for Word.
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Components of the Tedds Interface Designer window
In the following image, see the structure and some other components of the
Tedds Interface Designer window.

1. Interface Designer toolbar

allows you to access the most common features of Interface Designer
with a single click.

The Interface Designer toolbar allows you to:

• Close the Tedds Interface Designer window and insert the interface
in your calculations.

• Access the Tedds user guide for help.

• Undo or redo an action.

• Add pages, input controls, and output controls.

• Move a components up or down.

• Cut, copy, and paste interface components.

• Delete interface components.

2. Property pane

allows you to enter and modify the properties of the selected interface
component.

3. Empty rows

display where you can add new interface components.

4. Context-sensitive help box

guides you in entering the correct information for each entry in the
property pane.
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Components of an interface
You can use the following components to create an interface:

• Pages

• Controls

• Groups

• Page items

• Data views

Each of the interface components is explained individually in the
documentation.

When you create components in your interface, the Interface Designer views
exactly how the components will appear when a calculation is performed
using the interface.

See also

Pages (page 478)

Controls (page 482)

Groups (page 487)

Page items (page 489)

Data views (page 492)

Pages
Pages represent actual pages of the interface. The overall layout of your
interface is also set at page level. A page can contain multiple controls, groups,
page items and data views. In addition, if necessary, you can define
circumstances when a page is enabled and when it is not.

NOTE The following only applies to Tedds for Word.

See also

Controls (page 482)

Groups (page 487)

Page items (page 489)

Data views (page 492)

Add pages
1. Do one of the following:
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• On the Interface Designer toolbar, click Page.

• At the bottom of the window, click the  Add new page button.

A name field appears on the left side of the  Add new page button.

2. Type a page name in the field.

Page properties
The Page properties property pane allows you to define the page layout of
the selected page.

TIP To access the Page properties property pane, click the name of the
desired page at the bottom of the Interface Designer window.
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See the property fields of the Page properties property pane in the following
table:

Property name Description
Appearance

Name The name that you give to the page to identify it.

The name is not visible in the final interface.
Title The text that appears at the top of the interface for

the current page.
Buttons The buttons that appear at the bottom of the

interface.
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Property name Description
Undo on cancel Determines whether changes are automatically

cleared when the user clicks the Cancel button on
the page.

Library items
Notes library item A library item that is displayed when the user clicks

the Notes button in the interface.
Page library items Page library items that are included in the page,

provided that the page template accepts
calculation items.

Sketch library item A library item that is displayed when the user clicks
the Sketches button in the interface.

Template
Size Size of the page template.

NOTE The Size can only be defined and changed
on the first page of your interface.

Custom Determines whether the interface template is a
custom template that you can customize according
to your needs.

For more information, see Create a custom page
template.

Layout Allows you to select page template style from
several standard layouts.

Resizable Determines whether the user can resize the
interface.

Events
Creating A calculation that is performed before the page is

created.
Created A calculation that is performed once the page is

created.
Activated A calculation that is performed each time the user

activates the page.
Input changing A calculation that is performed just before the user

modifies input.
Input changed A calculation that is performed when user has

modified the value of an input control.
Input updated A calculation that is performed when the user has

modified the value of all input controls on the
page.
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Property name Description
Output updated A calculation that is performed when all output

controls have been updated after the user has
modified the value of input controls.

Validation failed A calculation that is performed when validation of
the input controls on the page fails.

Validation succeeded A calculation that is performed when validation of
the input controls on the page succeeds.

Deactivated A calculation that is performed when the page is
deactivated.

Information
Information Text that appears in the yellow context help

window on top of the page when the user does not
modify a specific input control.

Modify page order
• To move the current page backward or forward, click the arrow on the right

side of the page name, and select the desired option.

Delete pages
1. Do one of the following:

• In the Interface Designer toolbar, click Delete.

• At the bottom of the window, click the  Delete page button.

A confirmation dialog box appears and asks you whether you want to
delete the current page.

2. Click Yes.

Controls
Controls are the basic parts of an interface. The Interface Designer allows
you to create two types of controls: input controls, which allow the user to
enter information, and output controls, which display additional items in the
interface.

NOTE The following only applies to Tedds for Word.
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See also

Groups (page 487)

Pages (page 478)

Add controls
1. Do one of the following:

• On the Interface Designer toolbar, click the arrow on the right side of
theInput or Output button, depending on which type of control you
want to add.

a. In the list that appears, select the control that you want to add.

Control Description
Input controls

Button A button that allows the user to
perform an operation, such as open a
data list.

Check Box A box that the user can select to
perform an operation, such as include
a sketch with the output.

Drop List A list of standard values that only
allows the user to select values in the
initial list.

Edit An input field where the user can type
the desired value.

Edit Drop List A list of standard values that allows
the user to enter values that are not
in the initial list.

Edit Up Down An input box where the user can
enter a value, and adjust the value by
using up and down buttons.

Label A field that displays a line of text.
List Box A list box of standard values that only

allows the user to select values in the
in the initial list.

Output controls
Blank A blank line used for separating

controls.
Data view When using a custom page template,

the control allows you to show a
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Control Description
library item or a sketch within the
interface.

For more information, see Data views
(page 492).

Separator
Horizontal

A horizontal line that you can use for
separating areas of an interface page.

Separator
Vertical

A vertical line that you can use for
separating areas of an interface page.

Custom control Allows you to create a custom control.
List view Allows you to insert a list in your

interface.

• At the top of the page, click Add Control.

A new control appears on the template.

2. In the property pane, define the control properties according to your
needs.

Adjust control properties

NOTE The available properties may vary depending on the control type.

The property pane allows you to define and modify the properties of the
selected control. To adjust the control properties, do the following:

• Click the control and go to the property pane.
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• Adjust the control properties according to your needs.

In the following table, see the properties of controls in the property pane.

Property name Description
Appearance

Name The variable name for the input value
when the calculation is run.

Description Text that the interface views to clarify
what information is required in the
selected field.

Enable if Determines whether the control is
enabled or not.

TIP To always enable the control,
leave the field empty.

To disable the control, type 0 in
the field.

To define a control on which the
current control is dependent, in the
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Property name Description
Enable if field, type the name of the
control on which the current control
is dependent.

Hide if disabled Determines whether the control is
viewed in the interface when it is
disabled.

Info width Determines how wide the area for the

information icon ( ) is.
Description width Determines how wide the area for the

control description is.
Name width Determines how wide the area for the

control name is.
Value width Determines how wide the area for the

variable value is.
Unit width Determines how wide the area for the

variable unit is.
Type Allows you to select a type for the

control.
Data

Default value Determines the default value of the
variable, unless another value already
exists.

Disabled value A value that determines whether the
control is disabled.

Units Determines the units of the value.

TIP Units may require superscripts,
and many variables use Greek
characters or subscripts.

To format controls, you can use
the formatting buttons on the
right side of each property field.
In addition, you can click the ...
button on the right side of the
selected property field to format
controls.

Value type Determines the type of the value
(number or string).

Events
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Property name Description
Validation failed A calculation that is performed when

the validation of input controls on the
page fails.

Validation succeeded A calculation that is performed when
the validation of input controls on the
page succeeds.

Value changed A calculation that is performed when
the user has modified the input value.

Value changing A calculation that is performed just
before the variable is updated
because the user has modified the
input value.

Validation
Expression Allows you to create an expression

that determines whether the input
value is valid or not.

If the value of the expression in the
Expression field is True, the input
value is valid.

TIP To consider all variable values
as valid, leave the Expression
field empty.

Message Allows you to create a message that is
viewed if the validation of the
expression in the Expression field
fails.

Min value The minimum value of the variable.
Max value The maximum value of the variable.

Information
Information Text that appears in the yellow

context help window on top of the
page when the user does not modify
a specific input control.

Delete controls
1. Select the control that you want to delete.

2. On the Interface Designer toolbar, click Delete.
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Groups
Groups allow you to group controls together in a logical way. Using groups
provides two main benefits: related controls are located in the same area of
the interface with their own title, and you can set whether the controls are
enabled or not at the group level.

NOTE The following only applies to Tedds for Word.

See also

Controls (page 482)

Pages (page 478)

Add groups
1. At the top of the page, click Add Group. 

A new row appears at the top of the current page.

2. Name the group.

3. Define the group properties in the property pane according to your
needs.

4. Add controls into the group according to your needs.

Adjust group properties
The property pane allows you to modify the selected group.

1. Click the group, and go to the property pane.

2. Adjust the properties according to your needs.

The group properties consist of the following components:

Property name Description
Appearance

Title The title of the group.
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Property name Description
Enable if Determines whether the group is

enabled or not.

TIP To always enable the group,
leave the field empty.

To disable the group, type 0 in
the field.

To define a group or control on which
the current group is dependent, type
the name of the control or group in
the Enable if field.

Hide if disabled Determines whether the group is
viewed in the interface when it is
disabled.

Single page Determines whether the entire group
is placed on the same page of the
interface.

Delete groups
1. Select the group that you want to delete.

2. In the Interface Designer toolbar, click Delete.

Page items
Page items, or page library items, display a calculation library item to assist the
user during the calculation. Page items can be sketches, notes, or even
calculations.

NOTE The following only applies to Tedds for Word.

See also

Pages (page 478)

Data views (page 492)

Add page items
1. In the Page properties property pane, go to Layout.

2. Click the ... button on the right side of the property field. 

Start the Interface designer 489 Components of the Interface Designer



The Select Page Layout dialog box appears.

3. Select a page layout that allows page items. 

For example, layout 10 includes an area for page items.

4. On the page, double-click the area labeled Click to select page item. 

The Select Calc Library dialog box appears.

5. Select the item that you want to display in the interface.

6. Click OK.

View page item properties
To modify a page item and view its properties, see the following instructions.

1. Select the page item.

2. In the Page properties, click the arrow on the left side of the Page library
items property. 
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3. Double-click the desired page item. 

The properties of the page item appear.

See the different page item properties in the following table:

Property name Description
Display Determines whether the item is a sketch, a beam analysis

sketch, a calculated library item, or a non-calculated
library item.

Library Views and allows you to modify the library where the page
item is stored.

Library item Views and allows you to modify the page item.
Calculate as
expression

Determines whether the value in the Display, Library, or
Library item field should be calculated as an expression.

TIP To indicate that the property should be calculated as
an expression, you can type = in the field of the
property.
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Property name Description
Update if Allows you to create an expression that determines

whether the page item view is updated when the user
modifies the values of input controls.

If the value of the expression in the Update if field is True,
the page item view is updated.

TIP To always update the preview, leave the Update if
field empty.

Delete page items
1. Select the page item that you want to delete.

2. Click the arrow on the left side of Page library items property to view
page item properties.

3. Clear the Library and Library item fields.

Data views
Data views display a library item that assists the user during a calculation.
Data views differ from page library items only in that data views can be
displayed on custom templates, whereas page library items can only be
displayed on standard template layouts. For more information on data views,
see the following paragraphs.

NOTE The following only applies to Tedds for Word.

See also

Pages (page 478)

Page items (page 489)

Add data views
1. In the Interface Designer toolbar, click the arrow on the right side of the

Output button.

2. In the list that appears, select Data view.
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Adjust data view properties
• Use the property pane to define and modify a data view.

See the properties of the Data view properties property pane in the
following table:

Property name Description
Appearance

Name The name that you assign to the data
view.

Display Determines whether the item is a
sketch, a beam analysis sketch, a
calculated library item, or a non-
calculated library item.

Update if Allows you to create an expression
that determines whether the data
view is updated when the user
modifies the values of input controls.

If the value of the expression in the
Update if field is True, the data view
is updated.

TIP To always update the preview,
leave the Update if field empty.

Update order Determines whether the preview of
the data view is updated with input
controls or output controls.

Library items
Library Allows you to select the calculation

library where the item is stored.
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Property name Description
Library item Allows you to select the library item

that is viewed in the data view area.

Delete data views
1. Select the data view that you want to delete.

2. On the Interface Designer toolbar, click Delete.

18.2 Create a custom page template
If none of the standard page templates suits your needs, you can create a
custom page template for your interface. In order to do so, see the following
instructions.

NOTE The following only applies to Tedds for Word.

See also

Pages (page 478)

Open the Template Designer
1. In the interface, select the page for which you want to create a custom

template.

2. In the Page properties property pane, set the value of Custom to True.

3. Go to the Layout.

4. Click the ... button on the right side of Layout. 

The Template Designer dialog box opens.
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Modify page layout

NOTE The cells of the Template Designer dialog box represent and are
referred to as control locations.

• Use the Tab order option to define the order in which the Tab key moves
between the controls of the interface.

1. Click Tab order.

2. Click the control locations in the order which the Tab key should move
between the controls. 

A number indicating the ordinal number of the control appears on the
right side of the row number.

TIP To change the ordinal number of a control, type the desired
ordinal number in the box on the right side of Tab order.

• In the Columns box, define the number of columns in the layout according
to your needs.

Modify control locations
• To resize a control location, click the edge of the desired control location

and drag it according to your needs. 
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• To move a control location, select the control location and drag it to the
desired blank space. 

NOTE The blank space must be at least as many columns wide as the
control location that you want to move.

• To delete a control location, select the control location and press Delete.

18.3 Create an example interface
The following images and instructions illustrate how you can create user
interfaces in Tedds.

NOTE The following only applies to Tedds for Word.

Example interface (SI units)
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Example interface (US units)

1. Create a new interface
1. In the Insert ribbon group, click User Interface. 
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The Manage User Interfaces dialog box appears.

2. Select where you want to insert the user interface and click New. 

The Tedds Interface Designer window opens, displaying an empty
interface template.

2. Define the interface title, page title, and buttons
1. Click the Interface Title field at the top left corner of the interface.

2. In the field, type Steel Section Tie .

3. Press Enter.

4. Click the Click here to enter a page title field at the top right corner of
the interface.

5. In the field, type Design .

6. Press Enter.

7. Go to the property pane.

8. In Buttons, select the Back Finish Cancel option.
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3. Select the page layout
The example interface only requires 5 controls, so you can use a single
interface page with a basic layout. Do the following:

1. In the Page properties property pane, go to Layout.

2. Click the ... button on the right side of the Layout property. 

The Select Page Layout dialog box opens.

3. Double-click to select the 0 [14 Controls] option.

4. Create page description
1. Click the Click here to enter page information field.

2. In the field, type Enter tie details.

5. Create the first control
To create the example interface, you have to add five different controls. First,
define the Minimum yield strength control. Do the following:

1. On the current interface page, click Add Control.

2. Click the Click here to enter a description field, and in the field, type
Minimum yield strength

3. Press Enter.

4. In the Name field (either in the property pane or on the current page),
type Fy.

5. To use subscript in the variable name, highlight the letter y and click the
X2 button on the right side of the Name field. 

The variable is now Fy.

6. Press Enter.

7. Click Units on the right side of the Default field and then, click the Units
button. 

A unit list appears.

8. Depending on the units that you want to use, in the unit list, do one of the
following:

a. Go to SI Units --> Stress/pressure and select N/mm2.

b. Go to US units --> Stress/pressure and select ksi.

9. Click the Default field, and in the field, define the default value as 275 (for
N/mm2) or 36 (for ksi).
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The first control should now appear as follows:

SI units:

US units:

6. Create the remaining controls
1. Create the remaining controls according to the 5. Create the first control

instructions. The properties for the remaining 3 controls are the following: 

Descri
ption

Variable name Units (SI) Units (US) Default value

Design
tension

Ft kN kips Not applicable

Design
compr
ession

Fc kN kips Not applicable

Slende
rness
limit

λL

TIP To access
greek
characters,
click the
Name field
and then click
the  button.
In the Name
field, type the
corresponding
roman
character (in
this case, L).

Not applicable Not applicable 300

2. To create a check box, in the toolbar, click the arrow on the right side of
Input.

3. In the menu that appears, select Check Box.
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4. Define the check box properties as follows: 

Descri
ption

Variable name Default value Checked Value Unchecked
Value

yieldin
g tie

yielding 1 0 1

7. Change the tab order of controls
By default, the user interface tabs between controls in the order that they
were created. To change the tab order, do the following:

1. Click the yielding tie control to adjust its properties.

2. On the toolbar, click Move up twice. 

The yielding tie control moves above the Design compression control.

8. Condition the Design compression control
In the example, if the yielding tie check box is selected, the Design
compression control should be disabled. To achieve this, do the following:

1. On the interface page, click the Design compression control.

2. Go to the property pane.

3. In the Enable if field, type the name of the check box that the control
depends on (yielding).

9. Use a custom template
If necessary, you can create a custom template to adjust the interface layout
according to your needs. For more information, see: Create a custom page
template (page 494).

10. Test and finalize the interface
1. In the toolbar, click Close.

2. In the calculation document, select and calculate the interface.

3. Ensure that each control works as intended. 

TIP If you need to modify the interface, do the following:

Start the Interface designer 501 Create an example interface



a. In the Insert ribbon group, click User Interface.

The Manage User Interfaces dialog box appears.

b. In the Existing list, select the interface that you want to modify.

c. Click Edit.

The Tedds Interface Designer window opens, displaying the
selected interface.

18.4 Close the Interface Designer
Once you have created your interface, you can close the Interface Designer
and insert the interface in your calculations. For more information, see the
following instructions.

NOTE The following only applies to Tedds for Word.

• On the Interface Designer toolbar, click Close. 

The Tedds Interface Designer window closes and your interface is
inserted in your calculation document.

TIP If you start the Interface Designer in a calculation that already
contains Input Interface fields, you can also modify, delete, locate,
or write out the existing interfaces.
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19 Interoperability

Tekla Tedds supports sharing your work in several ways, whether you want to
integrate your calculations within a Tekla Structures model, or a Tekla
Structural Designer model, or share documents iusing the Trimble Connect
cloud.

• The Tekla Tedds Integrator (page 503) allows Tedds documents to be
linked to Tekla Structures models.

• Integration with Tekla Structural Designer (page 504) allows you to design
specific structural elements in your Tekla Structural Designer models.

• Trimble Connect (page 504) is a cloud service that allows you to store and
share all information related to the project and can be used with various
software, including Tekla Tedds. The Trimble Connector in Tekla Tedds
allows you to upload and download documents to/from the Trimble
Connect cloud.

19.1 Tekla Tedds Integrator
The Tekla Tedds Integrator which can be downloaded from the Tekla
Warehouse allows Tedds documents to be linked to Tekla Structures models.
You can link existing documents or create new documents which you or other
Tekla Structures users can then easily modify or review during your BIM
workflow.

The Tekla Tedds Integrator can transfer geometry data from the Tekla
Structures model directly into the appropriate Tedds calculation and back to
the model when the design is finished, saving you time and reducing errors.
Refer to the Tekla Tedds Integrator User Guide for more information.

You can also create your own integrations to existing Tedds library calculations
or to your own custom calculations, refer to the Tekla Tedds Integrator
Reference Documentation for more details.
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Related videos

Tekla Tedds Integrator for Tekla Structures

Open integration Framework: Linking your own calculations

19.2 Tekla Structural Designer
Tekla Structural Designer integrates with Tedds to allow you to design specific
structural elements in your Tekla Structural Designer models. Seamless
integration transfers the design forces to the appropriate Tedds calculation
where you can check and refine your design, the final properties for the
elements will then be updated in the Tekla Structural Designer model.

For Eurocode design

Timber members and precast concrete beams and columns can be designed
using Tedds.

Video demonstration:

• Tekla Structural Designer to Tekla Tedds Eurocode Precast concrete design

• Tekla Structural Designer to Tekla Tedds Eurocode Timber design

For US design

Wood members can be designed using Tedds.

Video demonstration:

• Tekla Structural Designer to Tekla Tedds US Wood design

19.3 Trimble Connect
Trimble Connect is a project collaboration tool allowing project stakeholders
access to reliable, up-to-date project information. It is available as a cloud-
based platform (Trimble Connect Web) and a Windows application (Trimble
Connect for Windows). Projects are synchronized between the Windows app
and the cloud.

NOTE To learn more about Trimble Connect, see:

• https://connect.trimble.com/

• https://trimbleconnect.support.tekla.com/

NOTE You need to have a Trimble Identity before you can start using Trimble
Connect
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Trimble Connect Project Explorer is used within Tekla Tedds to control the
flow of information between the open Tedds project and a Trimble Connect
project.

With Trimble Connect Project Explorer you can:

• link a Tedds project to a Trimble Connect project

• create and rename folders in a Trimble Connect project

• view a file list and rename files in a Trimble Connect project

• upload the Tedds project documents to a Trimble Connect project

NOTE A Tedds project can only be linked to a Trimble Connect project from the
Trimble Connect Project Explorer and not from the web or Windows apps. The
Tedds project must be linked before any information can move between Tekla
Tedds and Trimble Connect.

Launch Trimble Connect Project Explorer from the Tedds
Application
1. Open a project in the Tedds Application.

2. Log in using your Trimble Identity, (if not already signed in).

3. On the View tab, click the Trimble Connect droplist.

4. Select Trimble Connect

Trimble Connect Project Explorer opens, either as a docked window, or
as a tab on the right of the interface.

5. Confirm that the Server Location shown at the top of the window is
appropriate to your location. Available projects are listed with link icons as
below.
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TIP If the project in which you want to collaborate is not shown, try clicking
the refresh button to synchronise with the cloud. If it still not shown you
would need somebody with the appropriate permissions to create it, or
grant you access, using Trimble Connect Web, or Trimble Connect for
Windows.

TIP If a 'Cannot find linked project' message is displayed, this indicates either
that you do not have permission to view the project; or, that the project
to which the model was previously linked has been deleted - in this
situation you would need to click 'Unlink' before you are able to link the
model with another project.

Link or unlink a project
1. To link to a project:

1. Click  next to the project you want to link to. 

When the model is linked, the project name appears at the top of the
window and the icon changes as shown below.

Any folders or files in the Trimble Connect project that you have read
access to are also displayed.

2. To unlink from a project:

2. Click  to unlink the project. 
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The full list of available projects is displayed once more.

Create folders, rename folders, rename files
When you link to a Trimble Connect project the existing project folder
structure is displayed. You can add to this, if required.

NOTE You can only create but not delete folders in Trimble Connect Project
Explorer. Folders can only be deleted in Trimble Connect Web, or
Trimble Connect for Windows.

You can only rename folders and files to which you have write access.

1. To create a folder:

1. Right click in the Trimble Connect Project Explorer window.

2. Select Create folder and enter the folder name.

2. To create a subfolder:

3. Right click on an existing folder.

4. Click Create folder and enter the folder name.

3. To rename a file or folder:

5. Right click on the file/folder.

6. Select Rename

Upload the documents from your Tedds project as pdfs
1. Right-click on the folder that you want to upload the documents to.

2. Select Upload Tedds project A progress bar is displayed while the
documents are being uploaded.
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3. When the upload is complete, open the folder to confirm the documents
have been uploaded. 

The Tedds project documents will appear in the selected folder as pdf
files. After an 'assimilation' process it will be possible for collaborators to
view these in Trimble Connect.

NOTE If the Tedds project is subsequently updated, you can upload a new
revisions of the ifc file. To do this, right-click on the ifc file name and
select Upload new version.

View the uploaded pdfs in Trimble Connect
1. To open Trimble Connect from the ribbon:

1. If not already signed in, click log in (at the top right of the interface).

2. On the View tab, click the Trimble Connect droplist.

3. Select Trimble Connect Web, or Trimble Connect for Windows as
required.

• Trimble Connect Web: This launches the in-browser web app. If the
open Tedds project is associated with a Trimble Connect project, the
project itself is opened, otherwise a default Trimble Connect page is
opened.

• Trimble Connect for Window: This launches the Windows
application. Again, if the open Tedds project is associated with a
Trimble Connect project then that project is opened.

2. To open Trimble Connect from Trimble Connect Project Explorer:

4. Right-click on a folder in the Trimble Connect Project Explorer window.

5. Select Open in Trimble Connect Web, or Open in Trimble Connect for
Windows as required. 

The in-browser web or Windows app is launched and opened at the
selected folder.

3. To view the uploaded pdfs:
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6. Navigate to the folder to which the pdfs were uploaded.

7. Double click on an individual pdf to view.
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20 References

This section contains information on the following topics:

Tedds fields and functions (page 510)

Expression text format (page 538)

Mathematical symbols (page 540)

Dimensional analysis (page 541)

Result formats and precision (page 545)

Units (page 548)

Pre-defined system variables (page 562)

Error messages (page 576)

Toolbars and buttons (page 597)

Import Tedds documents into Tedds for Word (page 627)

Shortcut keys (page 628)

20.1 Tedds fields and functions
This section covers the syntax of Tedds fields and the functions that you can
use when modifying existing Tedds fields.

Syntax conventions
The Tedds user guide uses a consistent set of conventions when describing
the syntax of available fields and functions. For more information on syntax
conventions, see the following paragraphs.
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In the following table, see the nomenclature that is used when presenting a
particular field or function syntax:

Symbols Meaning
$ $ The parameter is one of the following:

• A string: $prompt$ “Input the length”

• A string variable: $prompt$Getlength

• A string function:$prompt$“Length (max=” +
string(L_{max},”F0”,”mm^(2)”)+”mm)”

# # The parameter is one of the following:

• A number: #prompt# 235

• A number variable: #prompt# L_{max}

• An expression: #prompt# 0.75*L_{max}
¡ ¡ The parameter is one of the following:

• A logical value: ¡prompt¡ 0

• A logical variable: ¡prompt¡ Output

• A logical expression: ¡prompt¡ if (a>b,1,0)
... More variables of the same type can be added to

the function:

median(#number#, ..., ...)
[ ] The parameter is optional:

Input($prompt$,$variable$,$units$,#default#,
[¡control flag¡])

See also

Enhancing Tedds for Word calculations with Tedds fields (page 302)

Major Tedds field syntax
Using the particular Tedds field syntax allows you to create Tedds fields
simply by modifying a field in your document. For more information on the
particular syntax of each major Tedds field, see the following paragraphs.

The common syntax of all Tedds fields is the following:

{=CSC|CALL <particular Tedds field syntax>}

The elements are:

• {} at the beginning and end of the call indicate that the text is a Word field.

• =CSC|CALL means that the field is a Tedds field, rather than a result field or
an error field.
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• The particular Tedds field syntax tells Tedds for Word which type of
Tedds field it is to invoke, and gives Tedds for Word the information which
it needs to create the Tedds field.

See also

Enhancing Tedds for Word calculations with Tedds fields (page 302)

Input field syntax
The particular syntax for Input fields is the following:

Input(prompt, name, units, default, show)

The parameters are:

• prompt

is the prompt text displayed in the dialog box.

• name

is the name of the variable.

• units

are the units of the variable.

• default

is the default value of the variable.

• show

is the setting that defines whether the dialog box is displayed and what the
initial value of the variable.

(0 = Only if variable not defined, 1 = Always with current value, 2 = Always
with default value, 3 = Use system option)

Example

{=CSC|CALL Input("Length of beam ","L","m","1",1)}

Show field syntax
The particular syntax for Show fields is the following:

Show(text, show, log, resultsStyle)

The parameters are:

• text

is the text to show in the document as the field result.

• show

is an optional value which determines whether the show result is
displayed.
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(0 = Hide, 1 = Display)

The default value is 1.

• log is an optional value that determines whether the show text is added to
the Progress Log.

If True (1), theShow field text is added to the Progress Log.

The default value is 1.

• resultsStyle

is an optional value that determines whether to show the field result in the
current final results style (1 = True), or the current paragraph style (0 =
False).

The default value is 1.

Example

{=CSC|CALL Show("The value of L is "+string(L,"f0","m")+" m"")}

Message field syntax
The particular syntax for Message fields is the following:

Message(message, title, show)

The parameter are:

• message

is the message to show.

• title

is the title of the message box.

• show

is an optional flag that determines if the message is displayed.

(0 = hide, 1 = display)

Example

{=CSC|CALL Message("The value of L is "+string(L,"f0","m")+" m", "Length")}

Log field syntax
The particular syntax for Log fields is the following:

LogText(text)

The parameters are:

• text

is the message to add to the Progress Log.
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Example

{=CSC|CALL LogText("The value of L is "+string(L,"f0","m")+" m")}

Excel Link field syntax
The particular syntax for Excel Link fields is the following:

Excel_Link(fileName, linkSheet, linkFromTedds, linkToTedds, showExcel, save,
startMacro, endMacro, taskMacro, outputCellRef, waitForClose, readPassword,
writePassword)

The parameters are:

• fileName

is the string that contains the full path to the Excel workbook file.

• linksheet

is an optional string that contains the name of the worksheet which
includes the tables for linking variables to and from Excel.

• linkFromTedds

is an optional True/False value which determines if variables are linked
from Tedds to Excel.

• linkToTedds

is an optional True/False value which determines if variables are linked
from Excel to Tedds.

• showExcel

is an optional True/False value that determines if the Excel user interface is
displayed.

• save

is an optional True/False value that determines if the workbook is saved
after the linking process is finished.

If this option is False, the workbook is opened in read-only mode.

• startMacro

is an optional string that contains the name of an Excel macro to run at the
start of the linking process.

• endMacro

is an optional string that contains the name of an Excel macro to run at the
end of the linking process.

• taskMacro

is an optional string that contains the name of an Excel macro to run
during the linking process.
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• outputCellRef

is an optional string that contains the cell reference to a region in the Excel
workbook that is output to the field result as a table or chart.

NOTE If the outputCellRef parameter is used to output a table or chart to
the document, the size of the image is determined by the Tedds
sketch scale setting. For more information, see Sketch options
(page 344).

• waitForClose

is an optional True/False value that determines if the field should wait for
the workbook to be closed by the user before finishing the linking process.

• readPassword

is an optional string that contains the password to open a protected
workbook.

If the readPassword argument is omitted and the workbook requires a
password, the user is prompted for the password.

• writePassword

is an optional string that contains the password required to write to a
write-reserved workbook.

If the writePassword argument is omitted and the workbook requires a
password, the user is prompted for the password.

Data List field syntax
The particular syntax for Data List fields is the following:

DataList(fileName, defaultPage, defaultItem, prefix, suffix, itemVar, pageVar, show,
output, prompt)

The parameters are:

• fileName

is the name of the data list file to be opened.

• defaultPage

is an optional name of the page to select by default if there is no selected
page.

• defaultItem

is an optional formatted name of the item to select if there is no selected
item.

• prefix

is optional text prefixed to the field result.
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• suffix

is optional text appended to all variables names for the selection.

• itemVar

is an optional name of the variable to use for storing the selected item.

• pageVar

is an optional name of the variable to use for storing the selected page.

• show

is an optional condition that determines if the data list is shown.

If True (1), the data list is always shown. If False (0), the data list is only
shown if the current selection cannot be determined.

• output

is an optional condition that determines if text is output to the field result.

(1 = append, 0 = discard)

• prompt

is the message prompt to display at the top of the Data List dialog box.

Example

{=CSC|CALL DataList("Euro.dls", "Universal Beams", "457(152(52))", "I Section: ", "1",
"selectedItem", "selectedPage", "Show", "Append", "Select an I section")}

Data Table field syntax
The particular syntax for Data Table fields is the following:

DataTable(filename(s), prefix, suffix, show, output)

The parameters are:

• filename(s)

is the name of the data table to be opened.

TIP To open more than one data table simultaneously, separate each file
name with a comma.

• prefix

is optional text prefixed to the field result.

• suffix

is an optional text appended to all variables names for the selection.

• show

is an optional condition that determines if the data table is shown.
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If True(1), the data table is always shown. If False(0), the data table is only
shown if the current selection cannot be determined.

You can also use the pre-defined system variables Show and Hide for this
parameter.

• output

is an optional condition that determines if text is output to the field result.

(0 = discard, 1 = append)

Example

{=CSC|CALL DataTable("5950-21a.tbl", "Example DataTable: ", "1", "Show",
"Append")}

Data Graph field syntax
The particular syntax for Data Graph fields is the following:

DataGraph(fileName, prefix, suffix, var1, var2, show, output)

The parameters are:

• fileName

is the name of the data graph to be opened.

• prefix

is optional text prefixed to the field result.

• suffix

is optional text appended to all variables names for the selection.

• var1

is the name of the first variable to use for selection.

• var2

is the name of the second variable to use for selection.

• show

is an optional True/False condition that determines if the data graph
should be shown.

If True (1) the data graph is always shown. If False (0), the data graph is only
shown if the current selection cannot be determined.

• output

is an optional condition that determines if text is output to the field result.

(1 = append, 0 = discard)

Example

{=CSC|CALL DataGraph("5950-21a.dgt","Example Datagraph:
","_{1}","","",Show,Append)}
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Calc Item field syntax
The particular syntax for Calc Item fields is the following:

EvalCalcItem(fileName, itemName, output)

Parameters:

• filename

is the full path to the calculation library.

• itemName

is the name of the calculation item.

• output

determines whether to output (Append) or discard (Discard) the calculated
item.

Example

{=CSC|CALL EvalCalcItem("$(SysLbrDir)LibraryName.lbr", "ItemName", Discard)}

Other Tedds fields
In addition to the major Tedds fields, Tedds for Word contains a number of
additional fields. You can use the other Tedds fields to add specific
functionality to your documents, such as calculating a library item or running a
Word macro. For more information on other Tedds fields, see the following
paragraphs.

NOTE The following only applies to Tedds for Word.

TIP You can access all Tedds fields in the Library Access System. Go to
Writing your own custom calculations --> Calculation writing
documentation --> Tedds fields.

See also

Enhancing Tedds for Word calculations with Tedds fields (page 302)

Evaluate script calc item fields
An Evaluate script calc item field calculates a selected script calc library item,
created with the Calc designer.

To create an Evaluate script calc item field, do the following:

1. In the Calculating folder, select EvalScriptCalcItem (field).

2. Modify the template according to the syntax below.
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3. Perform your calculations.

The particular syntax for Evaluate script calc item fields is the following:

EvalScriptCalcItem(fileName, itemName, subModuleName)

The parameters are:

• filename

is the full path to the calc library.

• itemName

is the name of the calc item.

• subModuleName

is an optional field, intended for the name of a submodule to be executed.

Example

{=CSC|CALL EvalScriptCalcItem($(SysLbrDir)LibraryName.lbr", "ItemName",
"Submodule1")}

Evaluate metafile calc item fields
An Evaluate metafile calc item field calculates a selected metafile calc library
item or a sketch. The sketch can either be inserted in the document or
discarded.

To create a Evaluate metafile calc item field, do the following:

1. In the Calculating folder, select EvalMetaFileCalcItem (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Evaluate metafile calc item fields is the following:

EvalMetaFileCalcItem(fileName, itemName, output)

The parameters are:

• filename

is the full path to the calc library.

• itemName

is the name of the calc item.

• output

determines whether to output (Append) or discard (Discard) the calculated
item.

Example

{=CSC|CALL EvalMetaFileCalcItem("$(SysLbrDir)Misketch.lbr", "Sketch - Open Plan",
Append)}
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Evaluate RTF calc item fields
An Evaluate RTF calc item field calculates an RTF calc item. The item can
either be inserted in the document or discarded.

To create an Evaluate RTF calc item field, do the following:

1. In the Calculating folder, select EvalRtfCalcItem (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Evaluate RTF calc item fields is the following:

EvalRTFCalcItem(fileName, itemName, output, replace)

The parameters are:

• filename

is the full path to the calc library.

• itemName

is the name of the calc item.

• output

determines whether to output (Append) or discard (Discard) the calculated
item.

• replace

is an optional formatted string of replacement text.

If the calc item contains replacement fields, each field will be replaced with
the text in the replace parameter before the item is calculated.

NOTE • replace1 is the text that will be replaced in the item for the first
occurrence of a replacement field.

• replace[n] is the text that will be replaced in the item for the nth

occurrence of a replacement field.

Evaluate interface calc item fields
An Evaluate interface calc item field calculates a selected user interface calc
library item created with the Interface Designer.

To create an Evaluate interface calc item field, do the following:

1. In the Calculating folder, select EvalInterfaceCalcItem (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Evaluate interface calc item fields is the following:
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EvalInterfaceLibItem(fileName, itemName)

The parameters are:

• filename

is the full path to the calc library.

• itemName

is the name of the calc item.

Example

{=CSC|CALL EvalInterfaceLibItem($(SysLbrDir)LibraryName.lbr", "ItemName")}

Time fields
Time fields display the time when the selected fields were last calculated.

To create a Time field, do the following:

1. In the Date and time folder, select Time (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Time fields is the following:

Time(format)

The parameters are:

• format

is the format to output the data in.

Example

{=CSC|CALL Time("HH:mm MMM-d, yy")}

See also

Time and date formatting options (page 523)

Date fields
Date fields display the date when the selected fields were last calculated.

To create a Date field, do the following:

1. In the Date and time folder, select Date (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Date fields is the following:

Date(format)

The parameters are:
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• format

is the format to output the data in.

Example

{=CSC|CALL Date("dddd, MMMM, d, yyyy")}

See also

Time and date formatting options (page 523)

Date and time fields
Date and time fields display the date and time when the selected fields were
last calculated.

To create a Date and time field, do the following:

1. In the Date and time folder, select DateTime (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Date and time fields is the following:

DateTime(format)

The parameters are:

• format

is the format to output the data in.

Example

{=CSC|CALL DateTime("HH:mm MMM-d, yy")}

See also

Time and date formatting options (page 523)

Run macro fields
A Run macro field runs a Word macro that is available to the current
document.

To create a Run macro field, do the following:

1. In the Miscellaneous folder, select RunMacro (field).

2. Modify the template according to the syntax below.

3. Perform your calculations.

The particular syntax for Run macro fields is the following:

runMacro($macroName$)

The parameters are:
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• macroName

is the name of the Word macro to run.

Example

{=CSC|CALL RunMacro("MyMacro")}

Time and date formatting options
In Tedds for Word, you can display the time and date in virtually any format
that you require. The valid time and date formatting options are shown in the
table below. For simplicity, the results are shown for 09:05:07 on Thursday 5
June 2013.

Date formatting options
Perio
d of
time

Code Result Comment

Day d or D 5 Not applicable
dd or DD 05 Not applicable
ddd or DDD Thu

NOTE To display the day
and the date, you can
use 2 format strings.

For example, "Thu 5"
would be spelled
"ddd d", and
"Thursday 5" would
be spelled "dddd d".

dddd or
DDDD

Thursday

Month M 6
NOTE Use capital M to

differentiate months
from minutes (m).

MM 06
MMM Jun
MMMM June

Year yy or YY 13
NOTE y, Y, yyy and YYY are

not valid formats.
yyyy or YYYY 2013

Time formatting options
Perio
d of
time

Code Result Comment

Hour h 9 Based on 12-hour clock
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Time formatting options
Perio
d of
time

Code Result Comment

H 9 Based on 24-hour clock
hh 09 Based on 12-hour clock
HH 09 Based on 24-hour clock

Minut
e

m 5
NOTE Use a lower case m to

differentiate minutes
from months (M).

mm 05

Secon
d

s or S 7 Not applicable
ss or SS 07

'text' Specify text in single quotation marks to include it in the appropriate
format.

For example, Time("hh' Greenwich mean time' ") displays "09
Greenwich mean time".

charac
ter

Includes the specified character in the date or time.

For example, Time("HH:mm MMM-d, yyyy") displays "11:15 Nov-6,
2013".

See also

Other Tedds fields (page 518)

Mathematics
In the following paragraphs, we cover the mathematical operators and
functions available in Tedds for Word.

Operators

The following mathematical operators are available in Tedds for Word.

TIP You can find the symbol form of most of the following operators in the
Library Access System. Go to Writing your own custom calculations
--> Calculation writing documentation --> Math symbols.

Operator Description
Addition
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Operator Description
Subtraction

* or 
Multiplication

/ or 
Division

yx Raises y to the power of x

NOTE The maximum and minimum numbers that Tedds can handle are
10308 and 10-308.

Mathematical functions

The following mathematical functions are available in Tedds for Word.

TIP You can find most of the following functions in the Library Access
System. Go to Writing your own custom calculations --> Calculation
writing documentation --> Maths functions.

General mathematical functions
Function Description Limits and notes

xy Raise x to the power y x > 0

sqrt(x) Square root of x x > 0
√(x) Square root of x x > 0
exp(x) Exponential ex Not applicable

ln(x) Natural log of x x > 0
log(x) Log to the base 10 of x x > 0
abs(x) Absolute value of x Not applicable
degrees(x,
y, z)

Converts x° y' z'' to x.ddd
°

Not applicable

max(x,y,z,
…)

Maximum number in list Not applicable

min(x,y,z,…) Minimum number in list Not applicable
sum(x,y,z,
…)

Summation of numbers
in list

Not applicable

average(x,y,
z,…)

Average of number in
list

Not applicable

median(x,y,
z,…)

Median number in list Not applicable

quotient(x,y
)

Integer portion of x/y Not applicable
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General mathematical functions
Function Description Limits and notes

mod(x,y) Remainder on dividing x
by y

Not applicable

int(x) Integer part of x Not applicable
int(x, "unit") Integer of x when

expressed in terms of
"unit"

Not applicable

round(x, y) Rounds x to y decimal
places

-15 < y < 15

round(x,y,"
unit")

Rounds x to y decimal
places when expressed
in terms of "unit"

Not applicable

rand() Random number
between 0 and 999

Not applicable

increment(
x)
increment(
x,y)

Increment x by y, if y not
specified increment x by
1

No limits; works with units

floor(x,y) Rounds x down to the
multiple of significance y

No limits; works with units

ceiling(x,y) Rounds x up to the
multiple of significance y

No limits; works with units

Trigonometric mathematical functions
Function Description Limits

sin(x) Sine (x in degrees) Not applicable
cos(x) Cosine (x in degrees) Not applicable
tan(x) Tangent (x in degrees) Not applicable
cosec(x) Cosecant (x in degrees) Not applicable
sec(x) Secant (x in degrees) Not applicable
cot(x) Cotangent (x in degrees) Not applicable
asin(x) Inverse sine (result in

degrees)
-1 <= x <= 1

acos(x) Inverse cosine (result in
degrees)

- 1 <= x <= 1

atan(x) Inverse tangent (result in
degrees)

Not applicable

sinh(x) Hyperbolic sine Not applicable
cosh(x) Hyperbolic cosine Not applicable
tanh(x) Hyperbolic tangent Not applicable
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Trigonometric mathematical functions
Function Description Limits

asinh(x) Inverse hyperbolic sine Not applicable
acosh(x) Inverse hyperbolic

cosine
x >= 1

atanh(x) Inverse hyperbolic
tangent

- 1 <= x <= 1

NOTE All functions that take angle arguments expect them in degrees, and
all functions that return angle arguments return them in degrees.

Tedds functions

The following Tedds functions are available in Tedds for Word.

You can find most of the following functions inLibrary Access System. Go to
Writing your own custom calculations --> Calculation writing
documentation --> Tedds functions.

String functions
Function Description

StrLength("String1") Returns the number of characters in the given
string.

If a string variable is given as the parameter, the
function returns the number of characters in the
variable.

StrCompare("String1",
"String2",
CaseInsensitive)

Compares two strings to see if they are equal.

The comparison can be case sensitive or case
insensitive.

If the strings are equal, the function returns 0. If
String1 is less than String2, the function returns -1.
If String1 is greater than String2, the function
returns 1.

StrEndsWith("String1",
"String2")

Checks to see if String1 ends with String2,
returning 1 if it does and 0 if it does not.

The comparison is always case sensitive, and the
function recognizes spaces.

StrInsert("String1",
"String2", InsertPosition)

Inserts String2 into String1 at the position specified
by the InsertPosition parameter.
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String functions
Function Description

StrFirstIndexOf
("String1", "String2",
SearchStartPosition,
SearchRangeLength)

Finds the first instance of String2 within String1
after SearchStartPosition and returns the position
of the first character.

If String2 is not found within SearchRangeLength
characters, the function returns -1.

SearchStartPosition (the number of characters
from the start of String1 at which the search will
start) and SearchRangeLength are optional.

StrLastIndexOf("String1",
"String2",
SearchStartPosition,
SearchRangeLength)

Finds the first instance of String2 within String1
after SearchStartPosition, and returns the position
of the first character.

If String2 is not found within SearchRangeLength
characters, the function returns -1.

SearchStartPosition (the number of characters
from the start of String1 at which the search will
start) and SearchRangeLength are optional.

StrPadLeft("String1" the
function
returnstringLength,
"String2")

Pads the left hand side of String 1 with sufficient
characters to make it as long as the length
specified by ReturnStringLength.

String2 is optional. If String 2 is not specified,
String1 will be padded with spaces. Otherwise, it
will be padded by the characters of String2.

StrPadRight("String1"
the function
returnstringLength,
"String2")

Pads the right hand side of String 1 with sufficient
characters to make it as long as the length
specified by ReturnStringLength.

String2 is optional. If String 2 is not specified,
String1 will be padded with spaces. Otherwise, it
will be padded by the characters of String2.

StrRemove("String1",
DeleteStartPosition,
NumberOfCharsToDelet
e)

Removes the number of NumberOfCharsToDelete
characters from String1, starting at
DeleteStartPosition.

StrReplace("String1",
"Remove", "Replace")

Scans String1 and replaces all instances of the
Remove string with the Replace string.

If the Replace string is the empty string "", the
function removes all instances of the Remove
string completely.
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String functions
Function Description

StrStartsWith("String1",
"String2")

Checks to see if String1 starts with String2,
returning 1 if it does and 0 if it does not.

The comparison is always case sensitive, and the
function recognizes spaces.

StrSubstring("String1",
SubstringStart,
SubstringLength)

Obtains a string from the middle of String1 which is
has as many characters as defined in
SubstringLength, starting at SubstringStart.

If you don't specify SubstringLength, the returned
string will be the remainder of String1 from
SubstringStart.

StrToLower("String1") Converts String1 to lower case characters.
StrToUpper("String1") Converts String1 to upper case characters.
StrTrim("String1",
"UnwantedCharacters")

Removes UnwantedCharacters from the start and
end of String1.

The UnwantedCharacters parameter is optional. If
not specified, the function removes spaces from
the start and end of String1.

StrTrimStart("String1",
"UnwantedCharacters")

Removes UnwantedCharacters from the start of
String1.

The UnwantedCharacters parameter is optional. If
not specified, the function removes spaces from
the start of String1.

StrTrimEnd("String1",
"UnwantedCharacters")

Removes UnwantedCharacters from the end of
String1.

The UnwantedCharacters parameter is optional. If
not specified, the function removes spaces from
the end of String1.

StrStart("String1",
SubstringLength)

Obtains a string which has as many characters as
defined in SubstringLength from the start of
String1.

StrEnd("String1",
SubstringLength)

Obtains a string which has as many characters as
defined in SubstringLength from the end of
String1.

StrFormat("String1",
Value1, Value2, …)

Creates complex strings that contain values.

Placeholders represent the position of the values in
the string, and can specify formatting information
for the value.
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String functions
Function Description

String ("VariableName or
formula", "format",
"unit")

Converts a number variable (or a formula yielding a
number) into a string, and controls the formatting
of the string value.

The format parameter is optional. If it is omitted,
the default format is adopted.

The unit parameter is optional. If it is not used and
the value has dimensions, base system units are
used.

Str ("VariableName or
formula")

Converts an integer number variable (or a formula
yielding an integer number) into a string.

EvalString("String1") Evaluates the string as though it were an
expression.

Unit functions
Function Description Note

addunit("x",
a,b,c,d,f)

Adds unit x to the unit
database.

a, b, c and d are the
powers of the unit
dimensions (Ma, Lb, Tc,
Dd), and f is the
multiplication factor to
turn the base unit
combination to the unit
to be added.

In order to use this function, you
must be the only one using the units
database file.

getunit("x") Lists the dimensions and
the multiplication factor
for unit x.

Not applicable

listallunits() Lists all units in the units
database.

Not applicable

removeuni
t("x")

Removes unit x from the
units database.

In order to use this function, you
must be the only one using the units
database file.

showdims("
x")

Shows the dimensions
of variable x.

Not applicable

Logic functions
Function Description

If(condition,x,y) If condition is true, the function returns x.
Otherwise, the function returns y.
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Logic functions
Function Description

if(and(a<b,c>d),x,y),
if((a<b)&&&&(c>d),x,y)

If both conditions are true, the function returns x. .
Otherwise, the function returns y.

if(or(a<b,c>d),x,y),
if((a<b)||(c>d),x,y)

If either condition is true, the function returns .
Otherwise, if not then returns y.

ifelseif(a>b, v, c<d, w,
a==0, x, d<>a, y, z)

If a>b, the function returns v. If not, the function
checks if c<d, and if it is true, the function returns
w. The function continues working this way, and if
no conditions are matched the function returns z.

Not(a>b) If the specified condition is met (a>b), the function
returns 0. Otherwise, the function returns 1.

Select(variable name,
variable value 1,return
value1, variablevalue 2,
return value2,variable
value 3, returnvalue3,
variable value 4,return
value4, return value 5)

Returns the value of a variable based on the value
of another variable.

Example:

Day = "Sun"
Select(day,"Mon",2,"Tue",3,"Wed",4,"Thur",5,"Fri",6,"Sa
t",7,1) = 1.

The function returns 1 because it does not match
any of the values. If day were "Wed", the function
would return 4.

Conditions that apply to logic functions
Conditions Description

x > y, x > y Greater than.

The function returns 1 if true, 0 if false.
x >= y, x ≥ y Greater than or equal to.

The function returns 1 if true, 0 if false.
x == y, x == y Equal to.

The function returns 1 if true, 0 if false.
x <> y, x ≠ y, x != y Not equal to.

The function returns 1 if true, 0 if false.
x <= y, x ≤ y Less than or equal to.

The function returns 1 if true, 0 if false.
x < y, x < y Less than.

The function returns 1 if true, 0 if false.
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Equality functions
Function Description

_eq(x,y,Tolerance) Checks that x and y are equal within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x and y must be equal to the full
accuracy of Tedds calculations.

equal(x,y,Tolerance) Checks that x and y are equal within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x and y must be equal to the full
accuracy of Tedds calculations.

_lt(x,y,Tolerance) Checks that x is less than y within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be less than y to the full accuracy
of Tedds calculations.

lessthan(x,y,Tolerance) Checks that x is less than y within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be less than y to the full accuracy
of Tedds calculations.

_gt(x,y,Tolerance) Checks that x is greater than y within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be greater than y to the full
accuracy of Tedds calculations.

greaterthan(x,y,
Tolerance)

Checks that x is greater than y within the specified
Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be greater than y to the full
accuracy of Tedds calculations.
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Equality functions
Function Description

_le(x,y,Tolerance) Checks that x is less than or equal to y within the
specified Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be less than or equal to y to the
full accuracy of Tedds calculations.

lessorequal(x,y,
Tolerance)

Checks that x is less than or equal to y within the
specified Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be less than or equal to y to the
full accuracy of Tedds calculations.

_ge(x,y,Tolerance) Checks that x is greater than or equal to y within
the specified Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be greater than or equal to y to
the full accuracy of Tedds calculations.

greaterorequal(x,y,
Tolerance)

Checks that x is greater than or equal to y within
the specified Tolerance.

The function returns 1 if it is true, 0 if not.

Tolerance is an optional parameter. If it is not
specified, x must be greater than or equal to y to
the full accuracy of Tedds calculations.

Variable functions
Function Description

Delete
VarsInSection("x","y","z"
…)

Deletes the variables x, y and z in the current
calculation section.

If no variables are specified, the function deletes all
variables in the current section.

Delete
VarsInAllSections(("x","y"
,"z"…))

Deletes the variables x, y and z in the current
document.

If no variables are specified, the function deletes all
variables in the document.
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Variable functions
Function Description

Delete
VarsInSectionExcept("x",
"y","z"…)

Deletes the all the variables other than x, y and z in
the current calculation section.

NOTE The variables that are not to be deleted
must be specified. Otherwise, the function
generates an error.

GetVar("VariableName",
defaultValue)

Gets the value of a variable.

If the specified variable does not exist, the function
sets the variable to the default value.

The defaultValue parameter is optional. However,
the function generates an error if the variable is
not found.

SetVar("VariableName",
Value)

Sets the value of the variable to the specified value.

GetSectionVar(SectionId,
"VariableName",
defaultValue)

Gets the value of a variable from the section with
the ID SectionId.

If the specified variable does not exist, the function
sets the variable to the default value.

The defaultValue parameter is optional. However,
the function generates an error if the variable is
not found.

SetSectionVar(SectionId,
"VariableName", Value)

Sets the value of the variable in the section with
the ID SectionId to the specfied value.

GetDocumentVar
(SectionId,
"VariableName",
defaultValue)

Gets the value of the document variable.

If the specified variable does not exist, the function
sets the variable to the default value.

The defaultValue parameter is optional. However,
the function generates an error if the variable is
not found.

SetDocumentVar
(SectionId,
"VariableName", Value)

Sets the value of the document variable to the
specified value.

PromoteVariable("var1",
"var2",…)

Promotes the variables "var1", "var2", and so on in
the current calculation section, making them
document variables.

VarExists("VariableName
")

Checks to see if a variable exists.

If it does, the function returns 1. Otherwise, the
function returns 0.
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Calculation section functions
Function Description

GetSectionId() Returns the ID of the calculation section that
contains the insertion point.

If the insertion point is not in a calculation section,
the function returns 0.

GetSectionName() Returns the name of the calculation section that
contains the insertion point.

If the insertion point is not in a calculation section,
the function returns "".

GetSectionVar(SectionId,
"VariableName",
defaultValue)

Gets the value of a variable in the section with the
ID SectionId.

If the specified variable does not exist, the function
sets the variable to the default value.

The defaultValue parameter is optional. However,
the function generates an error if the variable is
not found.

SetSectionVar(SectionId,
"VariableName", Value)

Sets the value of the variable in the section with
the ID SectionId to the specified value.

GetDocumentVar
(SectionId,
"VariableName",
defaultValue)

Gets the value of the document variable.

If the specified variable does not exist, the function
sets the variable to the default value.

The defaultValue parameter is optional. However,
the function generates an error if the variable is
not found.

SetDocumentVar
(SectionId,
"VariableName", Value)

Sets the value of the document variable to this
value.

Calc library functions
Function Description

CalcItemExists
("fileName",
"itemName")

Checks to see if an item named itemName exists in
the library named fileName.

The function returns 1 if it does, 0 if it does not.
GetCalcItemLongName
("fileName" ,
"itemName")

If an item named itemName exists in the library
named fileName, the function returns its long
name. If it does not, the function returns the empty
string "".

GetCalcItemDescription
("fileName",
"itemName")

If an Item named itemName exists in the library
named fileName, the function returns its
description. If it does not, the function returns the
empty string "".
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Calc library functions
Function Description

GetCalcItemVersion
("fileName",
"itemName")

If an item named itemName exists in the library
named fileName, the function returns its Version
information. If it does not, the function returns the
empty string "".

GetCalcItemAuthor
("fileName",
"itemName")

If an item named itemName exists in the library
named fileName, the function returns its Author
information. If it does not, the function returns the
empty string "".

GetCalcItemStatus
("fileName",
"itemName")

If an item named itemName exists in the library
named fileName, the function returns its Status
information. If it does not, the function returns the
empty string "".

GetCalcItemText
("fileName",
"itemName")

If an item named itemName exists in the library
named fileName and is a text item, the function
returns its contents. If the item does not exist or is
not a text item, the function returns the empty
string "".

GetCalcItemProperties
("fileName",
"itemName",
"longName",
"description", "version",
"status", "author")

If an item named itemName exists in the library
named fileName, the function returns all its
properties into the variables named "longName",
"description", "version", "status", "author" (these
must be enclosed in quotes as shown here). If it
does not, the function returns empty strings "".

SetCalcItemLongName
("fileName",
"itemName", "Value")

If an item named itemName exists in the library
named fileName, sets its Long name to Value.

SetCalcItemDescription
("fileName",
"itemName", "Value")

If an item named itemName exists in the library
named fileName, sets its Description to Value.

SetCalcItemVersion
("fileName",
"itemName", "Value")

If an item named itemName exists in the library
named fileName, sets its Version to Value.

SetCalcItemAuthor
("fileName",
"itemName", "Value")

If an item named itemName exists in the library
named fileName, sets its Author to Value.

SetCalcItemStatus
("fileName",
"itemName", "Value")

If an item named itemName exists in the library
named fileName, sets its Status to Value.

SetCalcItemProperties
("fileName" ,
"itemName" ,
"newLongName",
"newDescription",

If an item named itemName exists in the library
named fileName, sets its Long name to
newLongName, its Description to
"newDescription", its Version to "newVersion", its
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Calc library functions
Function Description

"newVersion",
"newStatus",
"newAuthor")

Status to "newStatus" and its Author to
"newAuthor".

Locale functions
Function Description

GetLocale() Returns the current locale to which Tedds is set.
GetCountry() Returns the current country to which Tedds is set.

Version functions
Function Description

GetTeddsVersion() Returns the version number of Tedds for Word.
GetTeddsSPVersion() Returns the service pack version number of Tedds.
GetExcelVersion() Returns the version number of Excel.

Miscellaneous functions
Function Description

subcall("original function
name","parameter 1 of
the original
function","parameter 2
of the original function"
…)

Runs any Tedds for Word function in an interface.

You can use this function to run a data list or a
data table by pressing a button in an interface.

GetLanguage() Returns the user interface language identifier as a
two-character string code ("EN" = English, "FR" =
French, "DE" = German, "ES" = Spanish).

GetTeddsAppName() Returns the name of the Tedds application (Tedds
or Tedds for Word) calculating the current
document.

GetTimer() Returns the numeric value of the timer.
Pause( time ) Returns the time of a pause in milliseconds.

Example:

Pause( 5000 ) = 1.000 indicates a pause for 5
seconds.

ProgressText( text ) Sets the status text displayed in the Tedds
progress window.

Example:
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Miscellaneous functions
Function Description

ProgressText( "This is the progress text" ) = 1.000
Pause( 3000 ) = 1.000.

That indicates a pause, so that you can read the
text in the progress window.

ResetTimer() Resets the timer to zero.
ToHex( value ) Returns a value as a hexadecimal formatted string.

Example:

ToHex( 1 ) = "0x1" ToHex( "a" ) = "0x61"

20.2 Expression text format
In Tedds, superscript and subscript characters are represented truly wherever
possible. However, in some instances, representing the characters truly is not
possible. In these cases, case superscripts and subscripts are displayed using
expression text format.

Use expression text format

• Subscript characters

To create a subscript character, type _{characters}.

For example, typing p_{cx} creates the variable pcx.

• Superscript characters

To create a superscript character, type ^(characters).

For example, typing N/mm^(2) creates the unit N/mm2.

NOTE Superscript characters are normally only used for units. If used
within a variable name, Tedds interprets it as the variable raised to
the specified superscript value.

• Units

Most units can be entered using subscript and superscript characters as
above. However, the units for angles and temperature require special
consideration.

See codes for the units in the following table.

Angle and temperature units
Name Code

degrees (°) \B0
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Angle and temperature units
Name Code

degrees centigrade (°C) \B0C

• Greek characters

To type a Greek character, type \charactercode.

For example, typing \62 creates the character β.

See the codes for all characters in the following table.

Nam
e

Upper case Code Lowercase Code Roman
equivalent

alpha Α \41 α \61 A a
beta Β \42 β \62 B b
chi Χ \43 χ \63 C c
delta Δ \44 δ \64 D d
epsilo
n

Ε \45 ε \65 E e

phi Φ \46 φ \66 F f
gam
ma

Γ \47 γ \67 G g

eta Η \48 η \68 H h
iota Ι \49 ι \69 I i
kapp
a

Κ \4B κ \6B K k

lamb
da

Λ \4C λ \6C L l

mu Μ \4D μ \6D M m
nu Ν \4E ν \6E N n
omicr
on

Ο \4F ο \6F O o

pi Π \50 π \70 P p
theta Θ \51 θ \71 Q q
rho Ρ \52 ρ \72 R r
sigma Σ \53 σ \73 S s
tau Τ \54 τ \74 T t
upsil
on

Υ \55 υ \75 U u

omeg
a

Ω \57 ω \77 W w

xi Ξ \58 ξ \78 X x
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Nam
e

Upper case Code Lowercase Code Roman
equivalent

psi Ψ \59 ψ \79 Y y
zeta Ζ \5A ζ \7A Z z

TIP For Tedds for Word users:

You can access all Greek characters via Library Access System.

Go to Writing your own custom calculations --> Calculation writing
documentation --> Greek characters.

20.3 Mathematical symbols
Tedds recognizes and uses several mathematical symbols. However, there are
some mathematical symbols that do not have a function in calculations. For
more information, see the following paragraphs.

NOTE For Tedds for Word users:

The following mathematical symbols are available via the Library
Access System.

To access any one the symbols, go to Writing your own custom
calculations --> Calculation writing documentation --> Math
symbols.

All the characters use Windows Symbol font.

Mathematical symbols recognized in Tedds
Name Symbol Function in

calculations
minus - substract
plus + add
multiply × multiply
divide ÷ divide
divide / divide
equals = equal to
square root √( ) square root
less than < less than
less than or equal to ≤ less than or equal to
equal to == equal to
not equal to ≠ not equal to
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Mathematical symbols recognized in Tedds
Name Symbol Function in

calculations
greater than or equal to ≥ greater than or equal to
greater than > greater than

Mathematical symbols not recognized in Tedds
Name Symbol Function in

calculations
approximately equal to ≈ no function
equivalent to ≡ no function
therefore ∴ no function
degrees ° angle unit
infinity ∞ no function
plus/minus ± no function
proportional to ∝ no function
perpendicular to no function
superscript star * no function

20.4 Dimensional analysis
Dimensional analysis allows you to verify that your calculations are
dimensionally correct. The following paragraphs explain how to switch on
dimensional analysis, and detail the dimensions of variables that can be used
with mathematical operators or functions.

Switch on dimensional analysis (the Tedds Application)

1. On the Home tab, click Options.

The Options - Default dialog appears.

2. In the side pane, click Calculating.

3. Select the Perform dimensional checks option.

Switch on dimensional analysis (Tedds for Word)

1. In the Tedds ribbon group, click More --> Tedds Options.

The Options - Default dialog appears.

2. In the side pane, click Calculating.

3. Select the Perform dimensional checks option.
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Operators

TIP For Tedds for Word users:

You can access most of the operators in the Library Access System. Go
to Writing your own custom calculations --> Calculation writing
documentation --> Math symbols.

Dimensional analysis operators
Fu
nct
ion

Input
dimensi

ons

Result
dimensions

Example

x +
y =
z

x -
y =
z

x and y
must
have
identical
dimensio
ns

z has the same
dimensions as
x and y

(1m) + (1m) = 2m

x ×
y =
z

x ÷
y =
z

x and y
may
have any
dimensio
ns

Dimensions of
z result from
those of x and
y being
multiplied and
divided
according to ×
or ÷ function

(1m) * (1m) = 1m2

(((...
)))

Any No change to
dimensions

None

yx =
Z

10x

x has to
be
dimensio
nless, y
may
have any
dimensio
n

z's dimension
exponent is y's
dimension
altered by
exponent x

(1m)5 = 1m5
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Functions

TIP For Tedds for Word users:

You can access most of the operators in the Library Access System. Go
to Writing your own custom calculations --> Calculation writing
documentation --> Maths functions.

General dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

sqrt(x) = z x may have any
dimension

z's dimension
exponent is x's
halved

sqrt((1 m)) = 1
m0.5

abs(x) = z

int(x) = z

int(x,"unit") = z

round(x,y) = z

round(x,y,"units")
= z

mod(x, y) = z

quotient(x,y) = z

x may have any
dimension, y has
to be
dimensionless

z has the same
dimension as x

abs((-1 m)) = 1 m

sum(x,y,z,…) = z
max(x,y,z,…) = z
min(x,y,z,…) = z
average(x,y,z,…) =
z median(x,y,z,…)
= z

All items being
considered in the
list (x,y,…) must
have identical
dimensions

z has the same
dimensions as x
and y

sum((1 m),(1 m)) =
2 m

rand() = z None z is dimensionless None

Logarithmic and exponential dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

ln(x) = z

log(x) = z

exp(x) = z

x has to be
dimensionless

z is dimensionless None
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Trigonometric dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

degrees(x,y,z) = a x, y and z have to
be dimensionless.

x can be in
degrees or
radians because
those units are
dimensionless.

a is
dimensionless,
but may be in
degrees or
radians since they
are dimensionless

degrees((1,30,0) =
1.5 °

sin(x) = z

cos(x) = z

tan(x) = z

cosec(x) = z

sec(x) = z

cot(x) = z

x has to be
dimensionless
because degrees
and radians are
dimensionless

z is dimensionless sin (90 °) = 1

asin(x) = z acos(x)
= z atan(x) = z

x has to be
dimensionless

z is dimensionless
- but may be in
degrees or
radians since they
are dimensionless

asin (1) = 90 °

Hyperbolic dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

sinh(x) = z

cosh(x) = z

tanh(x) = z

asinh(x) = z

acosh(x) = z

atanh(x) = z

x has to be
dimensionless

z is dimensionless None

Logical dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

if(condition,x,y)
and(x,y,z,...)

(x && y) or
(x,y,z,...)

(x || y)

All logical
comparisons
must be between
values with
identical
dimensions

No change to
dimensions, true
and false are
dimensionless

None
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Logical dimensional analysis functions
Function Input

dimensions
Result

dimensions
Example

x > y

x >= y, x ≥ y

x == y

x <> y, x ≠ y

x <= y, x ≤ y

x < y

20.5 Result formats and precision
You can define both the format and precision of final and intermediate results.
For more information on the available formats and precision options, see the
following paragraphs.

Format strings

To define a non-default format of results, after the appropriate results symbol,
type:

1. A letter to define the format

2. A number to define the precision of the results (not applicable to the
Output format)

See the valid letters to define the format in the table below:

Letter Meaning
F Fixed format
S Scientific format
G General format
E Engineering format
O Output format

The number after the letter indicates the precision of the required results, and
should be in the range 15 to -15.

• A positive number indicates the required number of decimal places or
significant figures.

• A negative number indicates that the result is to be rounded to the nearest
value, which depends on the magnitude of the negative number (-1
signifies 10, -2 signifies 100, -3 signifies 1000, and so on).
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General and scientific formats are identical for numbers ≥107 and ≥10-7.
Otherwise, the general format is similar to the fixed format, except that any
trailing zeros after the decimal point are removed.

The engineering format gives a number between 1 and 999 × 10?, where ? is a
multiple of 3 (3, 6, 9, -3 and so on).

The following examples show some typical formats:

• ?E3 - final results field, engineering format, 3 significant figures

• #2 - intermediate results field, default format, 2 decimal places / significant
figures

• ?S-3 - final results field, scientific format, rounded to the nearest 1000

When is Output format used?

Output (O) is a special result format for transferring numeric values as strings
which ensures that precision is maintained for data Input/Output operations
or interoperability with other software applications.

It should be noted that none of the other result formats (Fixed, General,
Scientific and Engineering) guarantee to maintain precision when exporting
data.

Example formats

See examples of the different format settings in the tables below.

Large numbers, for example: 1065.1 x 1016

Deci
mal

place
s or

signif
icant
figur
es

Fixed format
(decimal places)

Scientifi
c

format
(decima
l places)

General
format
(decima
l places)

Enginee
ring

format
(signific
ant

figures)

Output format
(significant
figures)

-3 106510000000000
00000

1.065 ×
1019

1.065 ×
1019

10.7 ×
1018

106510000000000
00000

-2 106510000000000
00000

1.07 ×
1019

1.07 ×
1019

11 ×
1018

106510000000000
00000

-1 106510000000000
00000

1.1 ×
1019

1.1 ×
1019

10 ×
1018

106510000000000
00000

0 106510000000000
00000

1 × 1019 1 × 1019 10 ×
1018

106510000000000
00000

1 106510000000000
00000

1.1 ×
1019

1.1 ×
1019

10 ×
1018

106510000000000
00000
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Deci
mal

place
s or

signif
icant
figur
es

Fixed format
(decimal places)

Scientifi
c

format
(decima
l places)

General
format
(decima
l places)

Enginee
ring

format
(signific
ant

figures)

Output format
(significant
figures)

2 106510000000000
00000

1.07 ×
1019

1.07 ×
1019

11 ×
1018

106510000000000
00000

3 106510000000000
00000

1.065 ×
1019

1.065 ×
1019

10.7 ×
1018

106510000000000
00000

4 106510000000000
00000

1.0651 ×
1019

1.0651 ×
1019

10.65 ×
1018

106510000000000
00000

Small numbers, for example: 7.8831 x 10-15

Decimal
places or
significa

nt
figures

Fixed
format

(decimal
places)

Scientific
format

(decimal
places)

General
format

(decimal
places)

Engineering
format

(significant
figures)

Output
format

(significant
figures)

-3 0 7.883 × 10-15 0 7.88 × 10-15 0.0000000000
000078831

-2 0 7.88 × 10-15 0 7.9 × 10-15 0.0000000000
000078831

-1 0 7.9 × 10-15 0 8. × 10-15 0.0000000000
000078831

0 0 8 × 10-15 0 8. × 10-15 0.0000000000
000078831

1 0.0 7.9 × 10-15 0 8. × 10-15 0.0000000000
000078831

2 0.00 7.88 × 10-15 0 7.9 × 10-15 0.0000000000
000078831

3 0.000 7.883 × 10-15 0 7.88 × 10-15 0.0000000000
000078831

4 0.0000 7.8831 × 10-15 0 7.883 × 10-15 0.0000000000
000078831

Normal numbers, for example: 0.8396
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Decima
l places

or
signific
ant

figures

Fixed
format

(decimal
places)

Scientific
format

(decimal
places)

General
format

(decimal
places)

Engineerin
g format

(significant
figures)

Output
format

(significant
figures)

-3 0 8.396 × 10-1 0 840 × 10-3 0.8396

-2 0 8.40 × 10-1 0 840 × 10-3 0.8396

-1 0 8.4 × 10-1 0 800 × 10-3 0.8396

0 1 8 × 10-1 1 800 × 10-3 0.8396

1 0.8 8.4 × 10-1 0.8 800 × 10-3 0.8396

2 0.84 8.40 × 10-1 0.84 840 × 10-3 0.8396

3 0.840 8.396 × 10-1 0.84 840 × 10-3 0.8396

4 0.8396 8.3960 ×
10-1

0.8396 839.6 × 10-3 0.8396

Normal numbers, for example: 8396

Decima
l places

or
signific
ant

figures

Fixed
format

(decimal
places)

Scientific
format

(decimal
places)

General
format

(decimal
places)

Engineerin
g format

(significant
figures)

Output
format

(significant
figures)

-3 8000 8.396 × 103 8000 8.40 × 103 8396

-2 8400 8.40 × 103 8400 8.4 × 103 8396

-1 8400 8.4 × 103 8400 8 × 103 8396

0 8396 8 × 103 8396 8 × 103 8396

1 8396.0 8.4 × 103 8396 8 × 103 8396

2 8396.00 8.40 × 103 8396 8.4 × 103 8396

3 8396.000 8.396 × 103 8396 8.40 × 103 8396

4 8396.0000 8.3960 × 103 8396 8.396 × 103 8396

See also

Define result formats (page 269)
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20.6 Units
Tedds performs your calculations using its base units, but you can define
values and obtain calculation results in any previously defined units. The
following paragraphs list all previously defined units that are supplied with
Tedds.

Please note the following features of Tedds units:

• Units are case sensitive and must be defined exactly as shown below.

• All intermediate results are given in Tedds base units.

• All units must be preceded and followed by a space, an operator, or a
delimiter.

• If you define units within the body of an expression, place them in
parentheses with their associated value to avoid ambiguity. For example, x
+ (4mm).

• You must define 1/unit as unit-1. m/s is acceptable, but 1/s should be
defined as s-1.

• The system does not recognize the multiplication of two units. Therefore,
units like Nms are not recognized unless you have manually entered them
in the unit database.

• You may alter the contents of the units database using the available unit
functions. For more information, see Unit functions.

Base units of Tedds

NOTE The values shown in the following table are rounded for esthetic
reasons.

In Tedds, all values are held to an accuracy of 15 decimal places. If you
want to see the full value, place a calculation in your document and
set a precision of 15 decimal places.

Base units of Tedds
Unit US imperial SI metric Dimension

Lengt
h

1 ft 1 m 1 L

Mass 1 slugs 1 kg 1 M
Time 1 s 1 s 1 T
Temp
eratur
e

1 °C 1 °C 1 D

Angle 1°, 1 deg, 1
degs

1°, 1 deg, 1 degs Dimensionless

Tedds base
units
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NOTE Degrees are used as the angular base unit in Tedds because structural
engineering calculations typically use degrees and not radians. In the
majority of cases this simplifies calculations. It does however mean
than when working with circular sectors and calcuating length * rad
that additional conversion factors must be incorporated into the
calculations.

Derived units: SI metric

In addition to the base units, Tedds contains a series of derived units. The
complete list of units provided with Tedds are given in the following tables.

NOTE For Tedds for Word users:

All units listed in the following tables that require special characters
are available in Library Access System. Go to Writing your own
custom calculations --> Calculation writing documentation --> SI
units.

In addition, the units are listed in the TeddsUnits.doc file, which is
located in the directory where you installed Tedds for Word.

Angle units
Unit Tedds base unit Dimension

rad 180/π degs Dimensionless
rads 180/π degs Dimensionless

Length units
Unit Tedds base unit Dimension

mm 0.0001 m L
cm 0.01 m L
dm 0.1 m L
km 1000 m L
in 0.0254 m L
ft 0.3048 m L
yd 0.9144 m L
mi 1609.344 m L

Mass units
Unit Tedds base unit Dimension

gm 0.001 kg M
t 1000 kg M
tonne 1000 kg M
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Mass units
Unit Tedds base unit Dimension

oz 0.0283495 kg M
lb 0.45359247 kg M
ton 1016.047 kg M
US_ton 907.185 kg M

Time units
Unit Tedds base unit Dimension

min 60 s T
hr 3600 s T
day 86400 s T
yr 31556926 s T

Frequency units
Unit Tedds base unit Dimension

Hz 1 s-1 T-1

kHz 1000 s-1 T-1

MHz 106 s-1 T-1

GHz 109 s-1 T-1

Velocity units
Units Tedds base unit Dimension

kph 0.277777778 m/s LT-1

mph 0.4470398 m/s LT-1

Area units
Units Tedds base unit Dimension

hectare 104 m2 L2

acre 4046.8564 m2 L2

Volume units
Unit Tedds base unit Dimension

ml 10-6 m3 L3

l 10-3 m3 L3

floz 0.00002841306 m3 L3

gal 0.00454609 m3 L3

gallon 0.00454609 m3 L3
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Volume units
Unit Tedds base unit Dimension

US_gal 0.00363686 m3 L3

US_gallon 0.00363686 m3 L3

Force units
Unit Tedds base unit Dimension

N 1 kgm/s2 MLT-2

kN 1000 kgm/s2 MLT-2

MN 10 6 kgm/s2 MLT-2

kgf 9.81 kgm/s2 MLT-2

tf 9810 kgm/s2 MLT-2

dyne 10-5 kgm/s2 MLT-2

lbf 4.4497414 kgm/s2 MLT-2

tonf 9967.4207 kgm/s2 MLT-2

kip 4449.7414 kgm/s2 MLT-2

kips 4449.7414 kgm/s2 MLT-2

Moment units
Unit Tedds base unit Dimension

Nmm 10-3 kgm2/s2 ML2T-2

kNm 1000 kgm2/s2 ML2T-2

MNm 106 kgm2/s2 ML2T-2

kip_ft 1356.2812 kgm2/s2 ML2T-2

kip_in 113.023430 kgm2/s2 ML2T-2

Energy units
Unit Tedds base unit Dimension

J 1 kgm2/s2 ML2T-2

kJ 1000 kgm2/s2 ML2T-2

erg 10-7 kgm 2/s2 ML2T-2

MJ 106 kgm2/s2 ML2T-2

GJ 109 kgm2/s2 ML2T-2

Power units
Unit Tedds base unit Dimension

W 1 kgm 2/s3 ML2T-3
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Power units
Unit Tedds base unit Dimension

kW 1000 kgm 2/s3 ML2T-3

MW 106 kgm 2/s3 ML2T-3

Stress and pressure units
Unit Tedds base unit Dimension

Pa 1 kg/s2/m ML-1T-2

kPa 1000 kg/s2/m ML-1T-2

MPa 106 kg/s2/m ML-1T-2

GPa 109 kg/s2/m ML-1T-2

bar 105 kg/s2/m ML-1T-2

bars 105 kg/s2/m ML-1T-2

mwater kg/s2/m ML-1T-2

mmwater kg/s2/m ML-1T-2

mH20 kg/s2/m ML-1T-2

mmH2O kg/s2/m ML-1T-2

ksi kg/s2/m ML-1T-2

psi kg/s2/m ML-1T-2

psf kg/s2/m ML-1T-2

Temperature units
Unit Tedds base unit Dimension

Cday 86400 s°C T°C
°Cday 86400 s°C T°C

NOTE The units in the Electrical units table are based around a definition of
a coulomb as a dimensionless unit.

For all practical purposes, the following definitions are sufficient to
ensure that calculations and dimensional checking work correctly in
Tedds.

However, in rare cases, combining the following units with other
dimensionless units can mean that the dimensional analysis fails to
detect errors.

Electrical units
Unit Tedds base unit Dimension

coul Not applicable Dimensionless
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Electrical units
Unit Tedds base unit Dimension

amp s-1 T-1

A s-1 T-1

kA 103 s-1 T-1

mA 10-3 s-1 T-1

µA 10-6 s-1 T-1

V kg m2/s2 ML2T -2
volt kg m2/s2 ML2T -2
mV 10-3 kg m2/s2 ML2T -2
kV 103 kg m2/s2 ML2T -2
ohm kg m2/s ML2T-1
W kg m2/s ML 2T -1
kΩ 103 kg m2/s ML2T -1
MΩ 106 kg m2/s ML2T -1
mho kg -1 m-2s M-1L-2T
siemens kg -1 m-2s M-1L-2T
weber kg m2/s ML2T-1

henry kg m2 ML2

H kg m2 ML2

mH 10-3 kg m2 ML2

µH 10-6 kg m2 ML2

tesla kg/s MT-1

gauss 10-4 kg/s MT-1

oersted 79.577472 1/ms M-1T-1

farad kg-1m-2s2 M-1L-2T²
F kg-1m-2s2 M-1L-2T²
pF 10-12kg-1m-2s2 M-1L-2T²
nF 10-9 kg-1m-2s2 M-1L-2T²
µF 10-6 kg-1m-2s2 M-1L-2T²

Currency units
Unit Tedds base unit Dimension

£ Not applicable Dimensionless
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NOTE Like all other units, currency units must be placed after the numbers
to which they apply.

Currency units have been added to facilitate calculations which
require compound units, such as £/year.

Derived units: US imperial and SI metric

In addition to the base units, Tedds base unit contains a series of derived
units. The complete list of units provided with Tedds are given in the following
tables.

NOTE For Tedds for Word users:

All units listed in the following tables that require special characters
are available in Library Access System. Go to Writing your own
custom calculations --> Calculation writing documentation --> US
units.

In addition, the units are listed in the TeddsUnits.doc file, which is
located in the directory where you installed Tedds for Word.

Angle units
Unit US imperial

factor
Tedds base unit Dimension

rad 180/π degs 180/π degs Dimensionless
rads 180/π degs 180/π degs Dimensionless

Length units
Unit US imperial

factor
Tedds base unit Dimension

in 0.0833333 ft 0.0254 m L
ft 1 ft 0.3048 m L
yd 3 ft 0.9144 m L
mi 5280 ft 1609.344 m L
mm 0.00328084 ft 0.001 m L
cm 0.0328084 ft 0.01 m L
dm 0.328084 ft 0.1 m L
m 3.28084 ft 1 m  
km 3280.84 ft 1000 m L
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Mass units
Unit US imperial

factor
Tedds base unit Dimension

z_av 0.00194256 slugs 0.0283495 kg M
lbm 0.0310810 slugs 0.45359237 kg M
lb_av 0.0310810 slugs 0.45359237 kg M
lbs_av 0.0310810 slugs 0.45359237 kg M
slug 1 slug 14.5939 kg M
slugs 1 slug 14.5939 kg M
US_ton 62.1620 slugs 907.185 kg M
tonne 68.5219 slugs 1000 kg M
UK_ton 69.6214 slugs 1016.047 kg M
ton_av 69.6214 slugs 1016.047 kg M
gm 0.0000685219

slugs
0.001 kg M

kg 0.0685219 slugs 1 kg M

Time units  
Unit US imperial

factor
Tedds base unit Dimension

min 60 s 60 s T
hr 3600 s 3600 s T
day 86400 s 86400 s T
yr 31556926 s 31556926 s T

Frequency units
Unit US imperial

factor
Tedds base unit Dimension

Hz 1 s-1 1 s-1 T-1

kHz 1000 s-1 1000 s-1 T-1

MHz 106 s-1 106 s-1 T-1

GHz 109 s-1 109 s-1 T-1

Velocity units
Units US imperial

factor
Tedds base unit Dimension

mph 1.46667 ft/s 0.277777778 m/s LT-1

kph 0.911344 ft/s 0.4470398 m/s LT-1
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Area units
Units US imperial

factor
Tedds base unit Dimension

acre 43560.0 ft² 4046.86 m² L²
hetacre 107639 ft² 10000 m² L²

Volume units
Units US imperial

factor
Tedds base unit Dimension

floz 0.00104438 ft³ 0.0000295735 m³ L³
US_floz 0.00104438 ft³ 0.0000295735 m³ L³
gal 0.133681 ft³ 0.00378541 m³ L³
gallon 0.133681 ft³ 0.00378541 m³ L³
US_gal 0.133681 ft³ 0.00378541 m³ L³
US_gallon 0.133681 ft³ 0.00378541 m³ L³
UK_floz 0.00100340 ft³ 0.0000284131 m³ L³
UK_gal 0.160544 ft³ 0.004546094 m³ L³
UK_gallon 0.160544 ft³ 0.004546094 m³ L³
ml 0.0000353147 ft³ 0.000001 m³ L³
l 0.0353147 ft³ 0.0017 m³ L³

Force units
Units US imperial

factor
Tedds base unit Dimension

oz 0.0625 slugsft/s² 0.278013 kgm/s² MLT-2

ozf 0.0625 slugsft/s² 0.278013 kgm/s² MLT-2

lb 1 slugsft/s² 4.448216 kgm/s² MLT-2

lbs 1 slugsft/s² 4.448216 kgm/s² MLT-2

lbf 1 slugsft/s² 4.448216 kgm/s² MLT-2

kip 1000 slugsft/s² 4448.22 kgm/s² MLT-2

kips 1000 slugsft/s² 4448.22 kgm/s² MLT-2

ton 2000 slugsft/s² 8896.43 kgm/s² MLT-2

tonf 2000 slugsft/s² 8896.43 kgm/s² MLT-2

t 2000 slugsft/s² 8896.43 kgm/s² MLT-2

tf 2000 slugsft/s² 8896.43 kgm/s² MLT-2

dyne 0.00000224809
slugsft/s²

0.00001 kgm/s² MLT-2
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Force units
Units US imperial

factor
Tedds base unit Dimension

N 0.224809
slugsft/s²

1 kgm/s² MLT-2

kgf 2.20463 slugsft/s² 9.80665 kgm/s² MLT-2

kN 224.809 slugsft/s² 1000 kgm/s² MLT-2

MN 224809 slugsft/s² 1000000 kgm/s² MLT-2

Moment units  
Units US imperial

factor
Tedds base unit Dimension

lbf_in 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

in_lbf 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

lb_in 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

in_lb 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

lbs_in 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

in_lbs 0.0833333
slugsft²/s²

0.112985 kgm²/s² ML2T-2

lbf_ft 1 slugsft²/s² 0.112985 kgm²/s² ML2T-2

ft_lbf 1 slugsft²/s² 1.35582 kgm²/s² ML2T-2

lb_ft 1 slugsft²/s² 1.35582 kgm²/s² ML2T-2

ft_lb 1 slugsft²/s² 1.35582 kgm²/s² ML2T-2

lbs_ft 1 slugsft²/s² 1.35582 kgm²/s² ML2T-2

ft_lbs 1 slugsft²/s² 1.35582 kgm²/s² ML2T-2

kip_in 83.3333 slugsft²/s² 112.985 kgm²/s² ML2T-2

in_kip 83.3333 slugsft²/s² 112.985 kgm²/s² ML2T-2

kip_ft 1000 slugsft²/s² 1355.82 kgm²/s² ML2T-2

ft_kip 1000 slugsft²/s² 1355.82 kgm²/s² ML2T-2

ton_ft 2000 slugsft²/s² 2711.63 kgm²/s² ML2T-2

ft_ton 2000 slugsft²/s² 2711.63 kgm²/s² ML2T-2

tons_ft 2000 slugsft²/s² 2711.63 kgm²/s² ML2T-2

ft_tons 2000 slugsft²/s² 2711.63 kgm²/s² ML2T-2
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Moment units  
Units US imperial

factor
Tedds base unit Dimension

tm 6561.68 slugsft²/s² 8896.43 kgm²/s² ML2T-2

Nmm 0.000737563
slugsft²/s²

0.001 kgm²/s² ML2T-2

Nm 0.737563
slugsft²/s²

1 kgm²/s² ML2T-2

kNm 737.563 slugsft²/s² 1000 kgm²/s² ML2T-2

Mnm 737563 slugsft²/s² 1000000 kgm²/s² ML2T-2

Energy units
Units US imperial

factor
Tedds base unit Dimension

cal 3.08803 slugsft²/s² 4.1868 kgm²/s² ML2T-2

kcal 3088.03 slugsft²/s² 4186.8 kgm²/s² ML2T-2

BTU 778.173 slugsft²/s² 1055.06 kgm²/s² ML2T-2

J 0.737563
slugsft²/s²

1 kgm²/s² ML2T-2

kJ 737.563 slugsft²/s² 1000 kgm²/s² ML2T-2

MJ 737563 slugsft²/s² 1000000 kgm²/s² ML2T-2

GJ 737563100
slugsft²/s²

1000000000
kgm²/s²

ML2T-2

erg 0.00000007376
slugsft²/s²

0.0000001
kgm²/s²

ML2T-2

Power units
Units US imperial

factor
Tedds base unit Dimension

w 0.737563
slugsft²/s³

1 kgm²/s³ ML2T-3

kw 737.563 slugsft²/s³ 1000 kgm²/s³ ML2T-3

MW 737563 slugsft²/s³ 1000000 kgm²/s³ ML2T-3

Stress and pressure units
Units US imperial

factor
Tedds base unit Dimension

mwater 204.816 slugs/s²/ft 9806.65 kg/s²/m ML-1T-2

mmwater 0.204816
slugs/s²/ft

9.80665 kg/s²/m ML-1T-2
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Stress and pressure units
Units US imperial

factor
Tedds base unit Dimension

mH20 204.816 slugs/s²/ft 9806.65 kg/s²/m ML-1T-2

mmH2O 0.204816
slugs/s²/ft

9.80665 kg/s²/m ML-1T-2

in_HG 70.7261 slugs/s²/ft 3386.38 kg/s²/m ML-1T-2

atm 2116.22 slugs/s²/ft 101325 kg/s²/m ML-1T-2

ksi 144000 slugs/s²/ft 6894748 kg/s²/m ML-1T-2

ksf 1000 slugs/s²/ft 47880.2 kg/s²/m ML-1T-2

psi 144 slugs/s²/ft 6894.75 kg/s²/m ML-1T-2

psf 1 slugs/s²/ft 47.8802 kg/s²/m ML-1T-2

Pa 0.0208855
slugs/s²/ft

1 kg/s²/m ML-1T-2

kPa 20.8855 slugs/s²/ft 1000 kg/s²/m ML-1T-2

MPa 20885.5 slugs/s²/ft 1000000 kg/s²/m ML-1T-2

GPa 20885500
slugs/s²/ft

109 kg/s²/m ML-1T-2

bar 2088.55 slugs/s²/ft 100000 kg/s²/m ML-1T-2

bars 2088.55 slugs/s²/ft 100000 kg/s²/m ML-1T-2

Force density units
Units US imperial

factor
Tedds base unit Dimension

pcf 1 slugs/s²/ft² 157.087 kg/s²/m² ML-2T-2

Load force units
Units US imperial

factor
Tedds base unit Dimension

klf 1000 slugs/s² 14593.9 kg/s² MT-2

plf 1 slugs/s² 14.5939 kg/s² MT-2

Temperature units
Units US imperial

factor
Tedds base unit Dimension

Cday 86400 s°C 86400 s°C T°C
°Cday 86400 s°C 86400 s°C T°C

References 560 Units



NOTE The units in the Electrical units table are based around a definition of
a coulomb as a dimensionless unit.

For all practical purposes, the following definitions are sufficient to
ensure that calculations and dimensional checking work correctly in
Tedds.

However, in rare cases, combining the following units with other
dimensionless units can mean that the dimensional analysis fails to
detect errors.

Units US imperial
factor

Tedds base unit Dimension

coul Not applicable Not applicable Dimensionless
amp s-1 s-1 T-1

A s-1 s-1 T-1

kA 103s-1 103s-1 T-1

mA 10-3s-1 10-3s-1 T-1

µA 10-6s-1 10-6s-1 T-1

V 0.737563
slugsft²/s²

1 kgm²/s² ML2T-2

volt 0.737563
slugsft²/s²

1 kgm²/s² ML2T-2

mV 0.0007376
slugsft²/s²

0.001 kgm²/s² ML2T-2

kV 737.563 slugsft²/s² 1000 kgm²/s² ML2T-2

ohm 0.737563
slugsft²/s

1 kgm²/s ML2T-1

W 737.563 slugsft²/s 1 kgm²/s ML2T-1

kΩ 0.737563
slugsft²/s

1000 kgm²/s ML2T-1

MΩ 737563 slugsft²/s 1000000 kgm²/s ML2T-1

mho 1.35582
slugs-1ft-2s

1 kg-1m-2s M-1L-2T

siemens 1.35582
slugs-1ft-2s

1 kg-1m-2s M-1L-2T

weber 0.737563
slugsft²/s

1 kgm2s ML2T-1

henry 0.737563 slugsft² 1 kg m2 ML2

H 0.737563 slugsft² 1 kg m2 ML2
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Units US imperial
factor

Tedds base unit Dimension

mH 0.0000007376
slugsft²

0.001 kg m2 ML2

µH 0.0000007376
slugsft²

0.000001 kg m2 ML2

tesla 0.0685219 slugs/s 1 kg/s MT-1

gauss 0.0000068522
slugs/s

0.0001 kg/s MT-1

oersted 24.2552 /ft/s 79.5775 /m/s M-1T-1

farad 1.35582
slugs-1m-2s2

1 kg-1m-2s2 M-1L-2T2

F 1.35582
slugs-1m-2s2

1 kg-1m-2s2 M-1L-2T2

pF 0.0000000000013
56 slugs-1m-2s2

0.000000000001
kg-1m-2s2

M-1L-2T2

nF 0.0000000013558
2 slugs-1m-2s2

0.000000001
kg-1m-2s2

M-1L-2T2

µF 0.00000135582
slugs-1m-2s2

0.000001
kg-1m-2s2

M-1L-2T2

Currency units
Units US imperial

factor
Tedds base unit Dimension

£ Not applicable Not applicable Dimensionless
$ Not applicable Not applicable Dimensionless

NOTE Like all other Tedds units, currency units must be placed after the
numbers to which they apply.

Currency units have been added to facilitate calculations which
require compound units, such as £/year.

See also

Use units in calculations (page 273)

20.7 Pre-defined system variables
Tedds contains a number of pre-defined variables, which you can use in all
your calculations. The following table presents all pre-defined system variables
in Tedds.
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Predefined system variables
Base
system
variables

Gener
al

π = 3.1415926536
pi = 3.1415926536
gacc = 9.80665 m/s²

ee = 2.7182818285

Water Kinem
atic
viscosi
ty at
10°C

νwater@10 = 0.00000131 m²/s

Densit
y at
4°C

ρwater@4 = 1000 kg/m³

Concrete BS
8110

ΕS8110 = 200 kN/mm²

αC = 10x10-6°C-1

νC = 0.2

mc = 16

ρC.norm = 2400 kg/m³

ρC.norm_w = 2500 kg/m³

ρC.light = 1800 kg/m³

ρC.light_w = 1900 kg/m³

AC ρC.norm = 2400 kg/m³

ρC.light = 1800 kg/m³

BS540
0

ρC5400 = 2500 kg/m³

αC5400 = 12x10-6°C-1

Εy_5400 = 200 kN/mm²

Steel Gener
al

νS = 0.3

αS = 12x10-6°C-1

BS595
0

ρS5950 = 7860 kg/m³

ΕS5950 = 205kN/mm²

GS5950 = 78.8 kN/mm²

KS5950 = 170.8 kN/mm²

EC3 ρSEC3 = 7850 kg/m³

ΕSEC3 = 210kN/mm²

GSEC3 = 80.8 kN/mm²

KSEC3 = 175 kN/mm²
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Predefined system variables
BS540
0

ρS5400 = 7860 kg/m³

ΕS5400 = 205kN/mm²

GS5400 = 80 kN/mm²

Steel AISC /
LRFD

ρSLRFD = 490 lb/ft³

ΕSLRFD = 29000 ksi

GSLRFD = 11200 ksi

AISC /
ASD

rSASD = 490 lb/ft³

ΕSASD = 29000 ksi

GSASD = 11200 ksi

ACI ΕACI = 29000 ksi

Aluminum Gener
al

ρAl = 2720 kg/m³

ΕAl = 70 kN/mm²

GAl = 26 kN/mm²

KAl = 69 kN/mm²

νAl = 0.33

αAl = 22x10-6°C-1

See also

Use system variables (page 287)

20.8 System and user libraries
The Library Access System recognizes two types of libraries: system and user
libraries. You can recall the contents of both types into any document. You can
also modify the contents of a user library according to your needs. However,
you cannot make changes to a system library, unless you are authorized to do
so.

The information in this section is aimed at two types of users:

• Personal user:

A user that has created calculations for their own use, and thinks that they
might be useful to other Tedds users.

• Organizational user:

A user that is creating a standard set of calculations that are used in an
organization. The calculations are carefully revised and tested before they
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are released organization-wide. In addition, only the individual or group
who created the calculations can modify them.

See also

Create libraries for organizational use (page 566)

Share libraries created for personal use (page 565)

Naming libraries
Whether you are creating sets and libraries for personal use or for
organizational use, pay attention to the names that you use for your libraries
and the entries in them.

• If you plan on sharing libraries with others, ensure that the name of your
library is not the same as the name of someone else's library. Having two
libraries with the same name creates a risk of overwriting one library by
the other. In consequence, you may lose valuable data.

• Ensure that the names of libraries convey the content of the calculations to
other users.

Library Access System icons
The Library Access System indicates different types of items with different
icons. For more information on item types, see the following table.

Library Access System icons
Icon Name Description

Note item The item returns notes to assist you
in using the calculations.

Solution item The item returns a complete solution.
Component item The item returns a component

calculation. It must be used with
other items to produce a complete
solution.

Example item The item returns an example
calculation.

External file item The item returns an external file.
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Share libraries created for personal use
After you have created libraries for your personal use, you can share the
calculations to other users, if necessary. See the following instructions.

NOTE The following only applies to Tedds for Word.

• Copy the user library and the calculation set from your computer to the
same directories on the other users' computers.

Create libraries for organizational use
The following paragraphs present shortcuts and tips that may help you in
creating libraries for organizational use.

NOTE The following only applies to Tedds for Word.

WARNING The following shortcuts speed up creating libraries, but may
increase the risk of losing data. Therefore, you should:

• Make sure that you are completely familiar with using the
Library Access System, and know some Library Access
System terminology. For more information, see Start the
Library Access System (page 374).

• Ensure that you fully understand the instructions as you
proceed.

Finding items in libraries and sets
Each item in a set is a pointer that tells the Library Access System whether
the item is in a library, what the name of the library is, and finally, what the
name of the entry in that library is.

The item does not hold any information other than this. Therefore, if the
Library Access System cannot find the entry, it displays the text <item not
found>.

The Library Access System may be unable to find the entry for several
reasons:

1. The item points to a user library, but the library file has been moved to
the system libraries directory.

2. The item points to a system library, but the library file has been moved to
the user libraries directory.

3. The item points to a user library, but the library file has been moved
elsewhere.
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4. The item points to a system library, but the library file has been moved
elsewhere.

5. The library that the item points to has been deleted.

6. The entry that the item points to has been deleted from the library.

The options that are open to you depend on the event (1 to 6) that has
occurred.

Option Event Solution
A 1 or 2 Modify the set so that

the item points to the
correct library type.

For more information,
see Change the library
type of a set (page 569)

B 1, 2, 3, or 4 Move the library back to
the location where
Library Access System
tries to find it.

C 1, 2, 3, or 4 Change your Library
Access System sections
to give the new location
of the system libraries
directory or user
libraries directory.

For more information,
see Library access
system settings
(page 357).

D 5 and 6 Restore the library file
from a previous backup
or a version of the
library file containing the
deleted item.

NOTE Creating new libraries and sets requires using the options A and C repeatedly.

Tips for creating libraries
• Ensure that none of the other users use the same directories that you use

for the system libraries, user libraries and sets that you generate.

• To speed up creating system libraries, set your user libraries directory and
your system libraries directory to point to the same development location.
We recommend placing your sets in the development location as well.
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• Ensure that the names that you use for your libraries, items, and groups
reflect their contents and are not the same as the names of other users'
libraries, items, and groups.

• Keep your sets and libraries to a manageable size. A number of smaller
libraries and sets is far easier to handle than an enormous one.

• To easily modify your sets and libraries, keep master copies of each set and
library that you create in your development location. You can make
changes to the master copies, and redistribute the modified sets and
libraries.

• To simplify updating your libraries and sets, try to organize sets and
libraries so that the items and entries are linked by a particular theme
(such as material).

• To prevent anyone from modifying or deleting your sets and libraries,
ensure that the read-only attribute is set for each set and library which you
release.

• If you want to create compound sets that contain entries from several
libraries:

• It is easiest to create a separate set for each library you generate.
Ensure that the items in the set access all the entries in the library, and
that the set only includes items that refer to that library.

• It is fastest to copy the sets for the libraries to your development
location.

• You can create a new set, and begin dragging and dropping items and
groups according to your needs.

NOTE A single set can refer to several libraries and a library can be
referred to by many sets. Therefore, deleting entries from
libraries may have far reaching implications.

Frequently used procedures in creating system libraries
The following paragraphs cover procedures that you need to use repeatedly
when creating system libraries. The procedures include changing items to
point to a different library type, changing the location of the user libraries
directory, changing the location of the system libraries directory, and
importing a library.

NOTE The following only applies to Tedds for Word.

See also

Create system libraries (page 571)

Modify system libraries (page 573)
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Change items to point to a different library type
1. In Library Access System, open the set whose items are saved in the

library to be changed.

2. Ensure that you have the Advanced mode of the Library Access System
open.

3. Click Tools --> Manage Libraries.... 

The Manage Libraries dialog box opens.

4. In the Current Set list, right-click the libraries whose position you have
changed.

5. Click Edit --> Type, and select the type that you want for the library.

6. When you are finished, click Close. 

The library type to which the items point has now been changed.

7. Save the set to disk, so that the changed library types are used when you
next open the set.

References 569 System and user libraries



Change the location of the user libraries directory
1. In the Tools ribbon group, click More --> Tedds options. 

The Options - Default dialog box appears.

2. In the side pane of the dialog box, click Setup --> Calc libraries. 

The following view opens.

3. Do one of the following:

• In the User field, type the new location for the system libraries
directory.

• Click the Browse... button on the right side of the field to navigate to
and locate the directory.

4. To start using the new directory, click OK.

5. To ensure that Library Access System can still find the items in your sets,
open Library Access System and click View --> Refresh.

Change the location of the system libraries directory
1. In the Tools ribbon group, click More --> Tedds options. 

The Options - Default dialog box appears.

2. In the side pane of the dialog box, click Setup --> Calc libraries. 
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The following view opens.

3. Hold down the Ctrl key and right-click the dialog box twice. You can now
modify the System field and change the location of the system libraries
directory.

4. Do one of the following:

• In the System field, type the new location for the system libraries
directory.

• Click the Browse... button on the right side of the field to navigate to
and locate the directory.

5. To start using the new directory, click OK.

6. To ensure that Library Access System can still find the items in your sets,
open Library Access System and click View --> Refresh.

Import a library
See Basic Library Access System procedures: Advanced mode (page 380).

Create system libraries
Creating system libraries is a multi-step process, and therefore, it is divided
into several sub-tasks. To create system libraries, see the following
instructions.

NOTE The following only applies to Tedds for Word.

See also

Modify system libraries (page 573)
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Before creating system libraries
1. Write the calculations which you want to include in your Tedds for Word

documents in a normal manner.

2. Change the user libraries directory and system libraries directory so that
they point to the same location, or your development location.

Create system libraries
1. To create a new set where the new items will be located, click File -->

New.

2. If you have already an idea of the structure that you want the set to have,
you can create new groups within the set.

3. Select the calculations which you want to add in the set.

4. Click Edit --> New Item to create new items in the set.

a. If you have selected the Select format and category of item
contents setting, select the format in which the item is saved.

The New item properties dialog box appears.

5. Name the item and select the library to which you want to add entries. 

At this point, the new library is a user library, and the items in the set
point to it as a user library.

6. According to your needs, determine other details for the new item.

7. Click OK.

8. Click File --> Save as and save the set to your development location.

9. Repeat steps 3 to 6 for each item and entry that you want to add to the
set and library. 

NOTE Remember to save the set regularly.
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Save system libraries
1. Change the set so that it points to the library as a system library. 

For more information, see Frequently used procedures in creating system
libraries (page 568).

2. To ensure that all items are correctly displayed, do the following:

a. To expand a group, select the group and press the * key on the
numeric keypad.

b. To collapse a group, select the group and press the - key on the
numeric keypad.

3. Save the set into your sets directory.

4. Copy the set and the library to a disk or to a central area on your network.

NOTE Keep the original copies of the set and library in the original
location, and remember to back them up.

After creating system libraries
1. To protect the files from any accidental damage, set the read-only

attribute on the copied set and library file using File Explorer.

2. Inform other users about location of the set. Tell them to place the sets in
their own sets directory. If necessary, ask them to copy the system library
to their own system libraries directory. 

NOTE If your organization uses a central system libraries area, copy the
system library to the central system libraries area, and only
distribute the set.

Other users are now able to access your calculations.

3. Change your user libraries directory and system libraries directory, so that
they point back to their previous locations.

Modify system libraries
From time to time, you may need to make changes to your system libraries
due to an update or a similar event. To modify system libraries, see the
following instructions.

NOTE The following only applies to Tedds for Word.

WARNING We strongly recommend that:
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• Only a specific group of advanced Tedds users have the authority to
modify system libraries.

• You back up the existing libraries and sets before any changes are
made.

• You do not make changes to the files in the locations that other
Tedds users use. Instead, you should copy the files to a development
location and work on these development copies.

See also

Create system libraries (page 571)

Before modifying system libraries
1. Ensure that the set and library that you modify are in your development

location, and that they are the up-to-date copies.

2. Ensure that read-only attributes of the set and library are not set.

3. Change the user libraries directory and system libraries directory so that
they point to your development location.

Modify system libraries
1. Open the set.

2. Change the set so that it points to the library as a user library. 

For more information, see Change items to point to a different library type
(page 569).

3. To ensure that all items are correctly displayed, do the following:

a. To expand a group, select the group and press the * key on the
numeric keypad.

b. To collapse a group, select the group and press the - key on the
numeric keypad.

4. Open a new Tedds for Word document.

5. According to your needs, do one of the following:

• Write the calculations that you want to add.

• Recall the calculations you want to modify and make the necessary
changes.

6. Select the calculations that you want to add or modify, and proceed
according to the separate instructions.

7. Change the set so that it points to the library as a system library.

8. Repeat step 3.
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9. Save the set into your sets directory. and copy it with the system library to
a disk or to a central area on your network. In addition, keep the original
copies in the original location. Make sure that you backup the original
copies of the set and the library.

10. Copy the set and library to a disk or to a central area on your network. 

NOTE Keep the original copies of the set and library in the original
location, and remember to back them up.

Add items
1. Click Edit --> New Item.

a. If you have selected the Select format and category of item
contents setting, select the format in which the item is saved.

The New item properties dialog box appears.

2. Name the item and select the library to which you want to add entries. 

At this point, the new library is a user library, and the items in the set
point to it as a user library.

3. According to your needs, determine other details for the new item.

4. Click OK.

Modify items
1. To change the details for an entry in the library, click Edit --> Edit Item

Contents....

2. Give the new properties for the item.

3. Click OK.

After modifying system libraries
1. To protect the files from any accidental damage, set the read-only

attribute on the copied set and library file using File Explorer.

2. Inform other users about location of the set. Tell them to place the sets in
their own sets directory. If necessary, ask them to copy the system library
to their own system libraries directory. 

NOTE If your organization uses a central system libraries area, copy the
system library to the central system libraries area, and only
distribute the set.

Other users are now able to access your calculations.
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3. Change your user libraries directory and system libraries directory, so that
they point back to their previous locations.

20.9 Error messages
In general, all error and warning messages that Tedds displays should be clear
in themselves. However, if you do have difficulties understanding an error
message, you can see the likely causes and solutions of all Tedds error
messages in the following tables.

General error and warning messages
Message Description Action

A problem has
occurred in the
Expression Evaluation
filter

The Expression Evaluation filter
has failed to initialize correctly,
but has not returned an error.
The error may occur when you
are running low on memory.

1. Close some
applications.

2. Try again.

A problem has
occurred while
initializing the
Expression Evaluator -
expression evaluation
has been aborted

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.

A problem has
occurred while
initializing the filter to
the Expression
Evaluator - expression
evaluation has been
aborted

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.

Memory full condition
detected

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.
Unable to launch the
Library Access System.

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.
Unable to launch the
Sketch Viewer.

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.
Unable to create
temporary variable
( .VBL) file

The error usually occurs when
your computer is running low
on memory.

1. Close some
applications.

2. Try again.
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General error and warning messages
Message Description Action

Tedds is already
running only one
instance is allowed

You have attempted to load the
Tedds system when it is already
loaded. It is not possible to have
two copies of the Tedds system
open for one copy of Word.

Not applicable

The clipboard format
is invalid

The error is very unlikely to
occur in normal use of Tedds.

• Report the error
and the actions
that lead to it to
the Tekla Support
Department.

The clipboard is
locked by another
application

The error is very unlikely to
occur in normal use of Tedds.

1. Close all other
applications.

2. Try again.

3. If steps 1 and 2
fail, report the
error and the
actions that lead
to it to the Tekla
Support
department.

The data in the
temporary library file
is invalid

The error usually occurs when
your disk has become corrupted
in some way.

1. Verify the
situation of the
disk with a
commercially
available disk
checking
package.

2. Try again.
Unable to create a
temporary copy of the
variable ( .VBL) file

The error usually occurs when
you are running low on disk
space.

1. Delete some old
files or
documents.

2. Try again.
The Tedds document
variable file ( .VBL)
does not exist; - a
complete document
recalculation is
required

A Tedds for Word document
consists of two files: a Word
document and a Tedds variable
file with a .VBL file extension.

For some reason, the variable
file cannot be found.

• Recalculate the
entire document
in order to
recreate it.

Unable to copy
temporary variable
file to the document
variable ( .VBL) file

The error usually occurs when
you are running low on disk
space.

1. Delete some old
files or
documents.
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General error and warning messages
Message Description Action

2. Try again.
The Tedds document
and its associated
variable file ( .VBL) are
out of sync. An error
occurred while trying
to delete the variable
file. You must delete
this file and then
perform a complete
document re-
calculation

A Tedds for Word document
consists of two files: a Word
document and a Tedds variable
file with a .VBL file extension.

The integrity of the information
is ensured through time stamps.

For some reason, the two files
are no longer synchronized.
That is why the stored variable
file must be deleted. However,
the automatic deletion of the
Tedds variable file has failed.
This may occur when the
variable file is set to be read-
only.

1. Delete the .VBL
file manually.

2. Recalculate the
entire document
in order to
recreate it.

The Tedds document
and its associated
variable file ( .VBL) are
out of sync. The
variable file has been
deleted - a complete
document re-
calculation is required

A Tedds for Word document
consists of two files: a Word
document and a Tedds variable
file with a .VBL file extension.

The integrity of the information
is ensured through time stamps.

For some reason, the two files
are no longer synchronized.
That is why the stored variable
file has been deleted.

• Recalculate the
entire document
in order to
recreate it.

Unable to tidy the
temporary variable
file. The variable file
has been deleted - a
complete document
re-calculation is
required

The temporary variable files are
tidied periodically during your
session. A problem has
occurred during this process.

The error may occur when you
are running low on disk space.

• Remove any
unwanted files
from your disk.

Tedds error messages
Tedds error messages can be divided into the following three categories:

• Fatal errors

• Non-fatal errors

References 578 Error messages



• Variable errors

Fatal errors
Message Description Action

Unable to open unit
database (in read-only
mode)

The unit database file
cannot be found, does
not exist, or is corrupt.

1. Reinstate the unit
database.

2. Try again.
Memory error - out of
memory

The errors occur for a
number of reasons.
However, they are very
unlikely to occur during
normal use of Tedds.

• Contact your dealer
or the Tekla Support
Department for
assistance.

Reassigning floating point
error handler
Unable to add to an
internal list
Unable to create an
internal function object
Unable to create an
internal list
Unable to create an
internal module object
Unable to create an
internal object
Unable to delete an
internal list
Unable to initialize the
Expression Evaluator
Wrong output type

Non-fatal errors
Message Description Action

Argument has incorrect
dimensions

The units of an
argument are
incompatible with the
expected units.

1. Check the
expression for any
unit errors.

2. Correct the errors.

3. Try again.
Dimensional analysis is
switched off

In Tedds options, the
option to perform
dimensional checks is
switched off.

1. In Tedds options,
switch on
dimensional
checking.

2. Try again.
Dimensional equality
expected in expression

The dimensions within
the expression are not
correct.

1. Check the
expression for any
errors in the units of
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Non-fatal errors
Message Description Action

any variables or
constants.

2. Correct the errors.

3. Try again.

or

• Switch off
dimensional
checking.

NOTE If you switch off
dimensional
checking, be
careful to
ensure that the
results are still
valid.

You can confirm
the dimensional
analysis of the
expression by
looking up its
functions. For
more
information, see
Mathematics
(page 524).

Dimensional equality
required for addition/
subtraction

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors, such as 1 m +
1 kg = ?.

2. Correct the errors.

3. Try again.
Dimensional equality
required for numeric
comparison

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors, such as if(1
m < 1 kg, 1,0).

2. Correct the errors.

3. Try again.
Dimensionless value
expected in expression

You have specified a
value with dimensions

1. Confirm the
dimensional
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Non-fatal errors
Message Description Action

that the function cannot
accept, for example
sin(45 m).

analysis of the
expression by
looking up its
functions.

For more
information, see
Mathematics
(page 524).

2. Alter the
expression.

3. Try again.
Divide by zero Tedds has found an

expression containing a
division by zero.

1. Check your
document for
errors.

2. Correct the errors.

3. Try again.
Equal sign expected in
expression

An equal sign is missing
from the expression.

1. Check the
expression for a
missing equal sign.

2. Correct the errors.

3. Try again.
Expression contains a
variable which references
itself

The calculated
expressions contain a
circular calculation.

1. Check the
expression for
errors.

2. Correct the errors.

3. Try again.
Expression contains an
unexpected delimiter

The expression is
incomplete.

1. Correct the
expression.

2. Try again.
Expression is too complex
to evaluate

The most likely reason
for the error to occur is
that the expression is
recursive, for example a
= a + 1.

1. Correct the
expression.

2. Try again.

Function argument must
be dimensionless

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors, such as log(1
m) = ?.

2. Correct the errors.
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Non-fatal errors
Message Description Action

3. Try again.
Function argument
number - - - is not within
its permissible range

An argument of a
function is outside the
allowable range.

1. Check the allowable
argument values by
looking up the
function.

For more
information, see
Mathematics
(page 524).

2. Correct the errors.

3. Try again.
Function arguments have
mismatched dimensions

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors, such as
min(3m, 5 kg) = ?.

2. Correct the errors.

3. Try again.
Illegal mathematical
relationship

The values that you have
entered in an equation
are of different types.

1. Check your
document for
errors, such as a ==
1.

2. Correct the errors.

3. Try again.
Incorrect argument in
function

The function contains an
incorrect type of
argument.

1. Check the types of
argument which the
function requires by
looking up the
function.

For more
information, see
Mathematics
(page 524).

2. Correct the errors.

3. Try again.
Incorrect number of
arguments in function

The function contains an
incorrect number of
arguments.

1. Check the number
of arguments that
the function
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Non-fatal errors
Message Description Action

requires by looking
up the function.

For more
information, see
Mathematics
(page 524).

2. Correct the errors.

3. Try again.
Interrupted by user You have chosen to

interrupt a calculation.
Not applicable

Invalid expression Tedds is unable to find a
valid expression.

1. Correct the
expression.

2. Try again.
Invalid expression to call a
module

The expression contains
a call to an invalid
module, possibly
because the module has
been overwritten.

1. Do one of the
following:

• Alter the call.

• Reinstate the call
from the library.

2. Try again.
Invalid result format
defined

Usually The error occurs
when you have specified
an incorrect format
character in a results
format string.

1. Check the allowable
result formats.

For more
information, see
Result formats and
precision
(page 545).

2. Try again.
Missing or misplaced
parenthesis

Tedds has found
unmatched left and right
parentheses.

1. Correct the
expression.

2. Try again.
Missing semicolon (;) Tedds cannot find a set

of complete expressions.
1. Check the

document for
errors.

2. Correct the
expression.

3. Try again.
Multiple final results
defined on one line

You have defined several
final results fields within

1. Correct the
expression.
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Non-fatal errors
Message Description Action

a single equation, for
example a + b = ? = ? .

2. Try again.

Multiple intermediate
results defined on one line

You have defined several
intermediate results
fields within a single
equation, for example a
+ b = # = # .

1. Correct the
expression.

2. Try again.

Multiple variable
assignments defined on
one line

You have defined several
variables within a single
equation, a=b=?.

1. Correct the
expression.

2. Try again.
No expression to evaluate! The area of the

document which you
have chosen to evaluate
does not contain any
complete expressions.

1. Modify the chosen
area.

2. Try again.

Numeric domain error The value of the function
is not appropriate, for
example asin(5).

1. Correct the
expression.

2. Try again.
Numeric power must be
dimensionless

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors such as 105

kg.

2. Try again.
Numeric range error Calculating the

expression has resulted
in a number which is too
large (> 10306), or too
small (< 10-306) to
handle.

1. Correct the
expression.

2. Try again.

Security violation - unable
to obtain a licence for this
function

You are using a function
that is secured. It is not
possible to run more
copies of this function
than your licence allows.

1. Wait until a licence
becomes available.

2. Try again.

Specified result units do
not match dimensions of
expression

The dimensions within
the expression are not
correct.

1. Check the
expression for
errors, such as 1 m +
5 m = ? kg.

2. Correct the
expression.

3. Try again.
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Non-fatal errors
Message Description Action

Square root of a negative
number

Tedds has found an
expression containing
the square root of a
negative number.

1. Check the
document for
errors.

2. Correct the errors.

3. Try again.
Unable to add a unit to
the unit database

Either the unit database
file does not exist or it is
corrupt, or the unit you
have specified already
exists in the unit
database.

• Reinstate the unit
database.

or

1. Remove the old
definition of the
unit.

For more
information, see
Delete system units
(page 276).

2. Add a new definition
for the unit.

For more
information, see
Add system units
(page 275).

Unable to decompose
units

Tedds cannot split the
units of your calculations
into components that it
recognizes.

1. Check the
document for
errors.

2. Correct the errors.

3. If necessary, add a
new unit to the unit
database.

For more
information, see
Add system units
(page 275).

4. Try again.
Unable to delete a unit
from the unit database

Either the unit database
file does not exist or it is
corrupt, or it does not
contain the unit you are
trying to delete.

1. Check the
document for
errors.

2. Correct the errors.
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Non-fatal errors
Message Description Action

3. If necessary, add a
new unit to the unit
database.

For more
information, see
Add system units
(page 275).

4. Try again.
Unable to get a unit from
the unit database

Either the unit database
file does not exist or it is
corrupt, or it does not
contain the unit you are
trying to display or
delete.

1. Reinstate the unit
database file.

2. Try again.

For further information,
see Units (page 548).

Unable to open variables
file

A Tedds for Word
document consists of
two files: a Word
document and a Tedds
variable file with a .VBL
file extension.

The variable file that you
are using has been
deleted or has become
corrupt.

1. Save and close the
document.

2. Delete the .VBL file.

3. Open the
document.

4. Recalculate the
document.

Unable to re-apply units
to value

There is an error in your
units.

1. Check the units for
errors.

2. Correct the errors.

3. Try again.
Unknown keyword The expression uses an

unknown keyboard.
1. Modify the

expression to
remove the
unknown keyboard.

2. Try again.
Unknown module called The expression calls an

unknown module.
1. Modify the

expression to
remove the
unknown module.

2. Try again.
Unknown variable in
expression

A variable in an
expression has not been

1. Define the variable.

2. Try again.
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Non-fatal errors
Message Description Action

defined, and you have
not given it a value.

Unrecognized unit The unit does not exist
in the unit database.

1. Add the unit in the
unit database.

For more
information, see
Add system units
(page 275).

2. Try again.
Unable to add a section to
the variables file

A Tedds for Word
document consists of
two files: a Word
document and a Tedds
variable file with a .VBL
file extension.

When one of these
errors occurs, the
variable file either does
not exist, or it is corrupt.

1. Save and close the
document.

2. Delete the .VBL file.

3. Open the
document.

4. Recalculate the
document.

Unable to add a variable
to the variables file ( .VBL)
Unable to close the
variables file ( .VBL)
Unable to delete a section
from the variables file
( .VBL)
Unable to delete a
variable from the
variables file ( .VBL)
Unable to get a section
from the variables file
( .VBL)
Unable to get a variable
from the variables file
( .VBL)
Unable to get sync code
for the variables file
( .VBL)
Unable to initiali ze the
variables file ( .VBL)
Unable to set sync code in
the variables file ( .VBL)
Unable to tidy the
variables file ( .VBL)
Unable to close the unit
database

The unit database file
does not exist, or is
corrupt.

1. Reinstate the unit
database file.

2. Try again.Unable to enumerate
units in the unit database
(unit)
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Non-fatal errors
Message Description Action

Unable to initialize the
unit database (unit)
No system variables file
found

The errors occur for a
number of reasons. They
are very unlikely to arise
during normal use of
Tedds.

• Contact your dealer
or the Tekla Support
Department for
assistance.

No unit database
specified
Unable to create a DLL
instance
Unable to enumerate
variables
Unable to execute
program
Unable to open the
system variables file
(read-only mode)
Unable to open the unit
database (read-write
mode)
End of buffer reached
while reading RTF

The errors occur for a
number of reasons. They
are very unlikely to arise
during normal use of
Tedds.

• Contact your dealer
or the Tekla Support
Department for
assistance.

Internal ris assertion
failure
Invalid font name
Invalid hex character
found
RTF Stack overflow
RTF Stack underflow
RTF table (sym or prop)
invalid
Unmatched brace
Bad field The errors occur for a

number of reasons. They
are very unlikely to arise
during normal use of
Tedds.

• Contact your dealer
or the Tekla Support
Department for
assistance.

Building output from
results … …
Cannot add to list
Cannot create list
structure
Cannot create object
Error can't enlarge buffer
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Non-fatal errors
Message Description Action

Invalid CSC bookmark
(nested!)
Mismatched bookmarks
Out of memory

Rare fatal errors

Message Description Action
floating point error -
invalid

The floating point errors
occur for a number of
reasons. They are not
specifically located
within Tedds because
they are very unlikely to
arise.

• Contact the Tekla
Support Department
for assistance.floating point error -

denormal
floating point error -
divide by zero
floating point error -
overflow
floating point error -
underflow
floating point error -
inexact
floating point error -
unemulated
floating point error - sqrt.
neg number
floating point error - stack
overflow
floating point error - stack
underflow

Library Access System error messages

Library Access System error messages
Message Description Action

Failed to get Clipboard
data!

The error usually occurs
when your computer is
running low on memory.

1. Close calculation
sets or other
running
applications.

2. Try again.
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Library Access System error messages
Message Description Action

Failed to open Clipboard! The error usually occurs
when your computer is
running low on memory.

1. Close calculation
sets or other
running
applications.

2. Try again.
File does not exist: You have entered a set

name which does not
exist.

1. Do one of the
following:

• Enter the correct
set name.

• Select the set in
the list of
available sets.

2. Try again.
Incorrect set format The format of the set

which you have selected
is incorrect.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Invalid Library File name The name of the library
file that you have given
contains invalid
characters.

• Type a name that
only contains valid
characters.

Problem adding new item
into calculation set

When a calculation set is
modified, a temporary
file is created to contain
the changed
information.

Either the file cannot be
created, or cannot be
extended to hold the
required information.

The error is most likely
to occur because the
disk is full.

1. Delete some old
files or documents.

2. Try again.

Problem retrieving valid
library item data from
clipboard

You have attempted to
add data into the library,
but the data on the
clipboard is invalid.

1. Try to paste data
that is appropriate
for a library item.

Problem updating
selected library item in
calculation set

When a calculation set is
modified, a temporary
file is created to contain

1. Delete some old
files or documents.

2. Try again.
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Library Access System error messages
Message Description Action

the changed
information.

Either the file cannot be
created, or cannot be
extended to hold the
required information.

The error is most likely
to occur because the
disk is full.

Sketch viewer error messages

Sketch Viewer error messages
Message Description Action

An unknown file format
has been selected

The data in the file
cannot be imported.

The file may have the
wrong file extension or
be in an old format.

• Select a file
containing correct
information.

This Sketch cannot be
enlarged any further

The error occurs when
you have repeatedly
zoomed into the picture.

The result of the zoom
that you have tried to
perform would be a
picture which is too
large to be displayed.

• Try another zoom
setting.

This Sketch cannot be
reduced any further

The error occurs when
you have repeatedly
zoomed out of the
picture.

The result of the zoom
that you have tried to
perform would be a
picture which is too
small to be displayed.

• Try another zoom
setting.
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Data Tables error messages

Data Tables error messages
Message Description Action

File does not exist The Data Tables tool
has tried to open a table
that cannot be located.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Invalid Data Table file
format

The Data Tables tool
has tried to open a data
table that is corrupt.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Range values for "item
name" cannot be
extrapolated in table
"table name"

Extrapolation of data
tables is not permitted.

The values that you
specify for interpolation
must be greater than the
smallest value and less
than the largest value of
the range item which is
being interpolated.

1. Check the table for
errors.

2. Correct the errors.

3. Try again.

The zoom factor must be
between 50 and 200%

You have specified a
zoom factor that is
outside the allowable
range of 50–200%.

• Enter a zoom value
that is within the
allowable range.

This table has no value
ranges and therefore
cannot be interpolated

The opened data table
does not contain any
items that can be
interpolated.

You can only interpolate
tables that have ranges
of information in them,
for example various
spans.

• Open a table that has
items that can be
interpolated.
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Data Graph error messages

Data Graph error messages
Message Description Action

Failed to connect to your
user registry key. Your
user defined options have
not been loaded and any
changes made to the user
options will not be saved.

The Data Graph tool
has tried to save your
settings to the Windows
registry, but for some
reason, the connection
has failed.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Failed to create Data
Graph registry key.

The Data Graph tool
has tried to create a
basic set of settings in
the Windows registry,
but for some reason, the
process has failed.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Failed to connect to
Tedds. Changes to
variables will not be
updated in your
document.

The Data Graph tool
has tried to connect to
Tedds, so that the details
of your selections could
be returned to your
document. For some
reason, the connection
has failed.

1. Close and restart
Tedds.

2. If the problem
continues, you may
need to re-install
Tedds.

For further assistance,
contact the Tekla
Support Department.

Failed to open the 'Users'
registry key.

The Data Graph tool
has tried to save your
settings to the Windows
registry. For some
reason, the connection
has failed.

1. You may need to re-
install Tedds.

For further assistance,
contact the Tekla
Support Department.

Value already exists
(Interpolation dialog).

You have tried to
interpolate a graph, but
the value you have
specified is the same as
for a curve that already
exists.

• Specify a value that
does not correspond
to an existing curve.
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Section Designer error messages

Section Designer error messages
Message Description Action

The detail specified for the
shape, places it off the
canvas. The shape has
been deleted.

In the Section Designer,
all shapes must lie
completely within the
canvas.

The details that you
defined for the last
shape did not meet this
requirement. The shape
has been deleted.

1. Save the shape to
Tedds.

2. Select a larger
canvas size.

3. Define the shapes
for your section.

The length of the hole is
greater than the length of
the parent shape.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The hole that you have
just defined does not
meet these
requirements. The hole
has not been created.

• Do one of the
following:

• Increase the size
of the parent
object.

• Reduce the size of
the hole.

The width of the hole is
greater than the width of
the parent shape.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The hole that you have
just defined does not
meet these
requirements. The hole
has not been created.

• Do one of the
following:

• Increase the size
of the parent
object.

• Reduce the size of
the hole.

The diameter of the hole
is greater than the width/
length of the parent
shape.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The hole that you have
just defined does not
meet these
requirements. The hole
has not been created.

• Do one of the
following:

• Increase the size
of the parent
object.

• Reduce the size of
the hole.

The diameter of the hole
is greater than the
diameter of the parent
shape.

In the Section Designer,
all holes must lie

• Do one of the
following:

• Increase the size
of the parent
object.
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Section Designer error messages
Message Description Action

completely within their
parent shape.

The hole that you have
just defined does not
meet these
requirements. The hole
has not been created.

• Reduce the size of
the hole.

The detail for the hole
places it outside its parent
shape.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The hole that you have
just defined does not
meet these
requirements. The hole
has not been created.

• Do one of the
following:

• Increase the size
of the parent
object.

• Reduce the size of
the hole.

The hole has been moved
outside of its parent
shape. The move has been
cancelled.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The move that you tried
to make would cause the
hole to lie outside its
parent shape. The move
has been cancelled.

• Do one of the
following:

• Move the parent
shape and the
hole together.

• Increase the size
of the parent
shape, so that it
can contain the
hole in its new
location.

The hole has been resized
to make it too big to fit in
its parent shape. The
resize has been cancelled.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The resize that you
applied would cause the
hole to lie outside its
parent shape. The resize
has been cancelled.

1. Increase the size of
the parent shape so
that it can contain
the larger hole.

2. Increase the size of
the hole again.

This shape has been
resized making it too
small to contain its
existing hole(s). The resize
has been cancelled.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The resize that you
applied would cause the

1. Decrease the size of
the hole so that it
will fit within the
new size of the
parent shape.
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Section Designer error messages
Message Description Action

hole to lie outside its
parent shape. The resize
has been cancelled.

2. If necessary,
decrease the size of
the parent shape.

This shape has been
modified preventing it
containing all its existing
hole(s). The editing has
been cancelled.

In the Section Designer,
all holes must lie
completely within their
parent shape.

The modification that
you applied to the
parent shape would
cause the hole to lie
outside its parent shape.
The modification has
been cancelled.

1. Modify the holes so
that they fit within
the new size of the
parent shape.

2. If needed, decrease
the size of the
parent shape.

The size of canvas you
have chosen has changed.
This could result in loss of
shapes or shapes which
are too small to be seen.

You have chosen a
canvas size that is
different to the one that
you used when you last
calculated the section
properties for this
section.

If there are any shapes
that do not lie
completely within the
canvas, they are deleted.
Conversely, if there are
any small shapes on
your canvas, you might
not be able to see these
even at the largest
possible zoom factor.

If this is acceptable:

• Click Next.

Otherwise:

• Select another
canvas size.

This will lose all the work
that you have done on
this canvas. Are you sure
that you want to proceed?

You have made changes
to the canvas, and have
chosen to create a new
canvas. The changes
that you have made will
be lost.

If this is acceptable:

• Click OK.

Otherwise:

• Save the changes
before attempting to
open a new canvas.

The snap details specified
for the shape, places it off
the canvas. The snap
shapes has been
cancelled.

In the Section Designer,
all shapes must lie

1. Move the shapes so
that both shaped
will lie on canvas
when snapped
together.
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Section Designer error messages
Message Description Action

completely within the
canvas.

The modification that
you applied by snapping
the shapes to one
another would cause
one of the shapes to lie
off the canvas. The
modification has been
cancelled.

2. Try snapping the
options to one
another again

Your input ini file does not
exist. Please contact Tekla
support.

One of the files required
by the Section Designer
does not exist.

• Contact the Tekla
Support Department.

Your output ini file does
not exist. Please contact
Tekla support.

One of the files required
by the Section Designer
does not exist.

• Contact the Tekla
Support Department.

Input ini file is corrupt or
invalid. Please contact
Tekla support.

One of the files required
by the Section Designer
is damaged.

• Contact the Tekla
Support Department.

Output ini file is corrupt
or invalid. Please contact
Tekla support.

One of the files required
by the Section Designer
is damaged.

• Contact the Tekla
Support Department.

20.10 Toolbars and buttons
This section covers the toolbars and buttons that allow you access many
functions with a single click.

See also

Tedds ribbon commands (the Tedds Application only) (page 597)

Tedds ribbon groups (Tedds for Word only) (page 607)

Library Access System toolbars (page 616)

Sketch Viewer toolbar (page 619)

Data Tables toolbar (page 620)

Data Graph interpolate bar (page 621)

Section Designer toolbars (page 622)
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Tedds ribbon commands (the Tedds Application only)
The following tables cover the different commands and their functions on the
Tedds ribbon.

NOTE The following only applies to the Tedds Application.

file menu

Button Action Further information
New

• create a new empty
calculation document

• create a new project

.

After performing a calculation
(page 241)

Open...

• browse to open an existing
calculation document

• open a recent calculation
document

Open Project...

• browse to open an existing
project

• open a recent project

Save

• save the active calculation
document

• save the active project

Save All

Save All

saves all active documents.

Save As...

Save As...

• save the active document
as PDF

• save all documents in the
active project as PDF

• save the active document

• save the active project
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Button Action Further information
• save the the active

document to a Trimble
Connect location

• save the the active project
to a Trimble Connect
location

Send To

allows you to send the current
calculations to another
application, such as Tedds for
Word or Microsoft Word, or to
another Tedds user via email.

Print

Print

• print the active document

• quick print

• print preview

• print setup

• page setup

Properties..
.

Properties...

display properties for the
active document

 

Close

Close

close the active document

 

Close All

Close All

close all documents

 

Close
Project

Close Project

close the active project
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Home tab

Button Action Further information
New

creates a new empty
calculation document.

After performing a calculation
(page 241)

Open

allows you to open and modify
an existing calculation
document.
Save

saves the current calculation
document.
Duplicate

creates an identical copy of the
current calculation document.
You can modify the versions
separately without any
changes affecting the other
version.
Send To

allows you to send the current
calculations to another
application, such as Tedds for
Word or Microsoft Word, or to
another Tedds user via email.
Header

allows you to modify the
information on the header of
the current calculation
document

Adjust calculation sheet
details (page 249)

Calculate

re-calculates the current
calculation document and
allows you to modify the
calculation details.

After performing a calculation
(page 241)

Variables

allows you to view and manage
the variables of the calculation
document.

Use the Variables dialog box
(page 245)
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Button Action Further information
Find

allows you to search the
calculation document with a
specific search text.

Not applicable

Next

moves to the next point in the
calculation that matches the
current search text.
Locale

allows you to select which
regional calculations and data
you want to use in your
calculation document.

NOTE • Depending on your
licence and
location, you may
have one or several
locales installed by
default.
Calculations and
data for other
locales is available
at additional cost. If
you only have one
locale installed, the
Locale list is not
active.

• The appearance of
the locale list varies
slightly depending
on the locale that
you are using.

Change the locale (page 243)

Options

allows you to adjust different
Tedds options.

Configuring settings
(page 337)
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Project tab

Button Action Further information
New Project

creates an empty
project.

Create a new project
(page 252)

Open Project

allows you to select and
open an existing project.

Open or close existing
projects (page 255)

Save Project

saves the current
project.

Not applicable

Send To Tedds For
Word

send all or some of the
documents in the
current project to Tedds
for Word

After performing a
calculation (page 241)

Project Header

allows you to create and
adjust a project header
that is common to all the
documents within the
current project.

Modify document
headers or project
headers (page 253)

Calculate Project

allows you to re-
calculate the entire
project and modify the
calculation details.

Not applicable

New Document

adds an empty
calculation document to
the current project.

Add documents into a
project (page 253)

Active Document

adds the currently active
document to the current
project.
Existing Document

allows you to select an
existing document that
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Button Action Further information
you want to add in the
current project.
Folder

adds a folder within the
currently open project.

Reorganize documents
within a project
(page 253)

Rename

allows you to rename
the document or folder
that is currently selected
in the Project Manager
window.

Not applicable

Move Up

moves the document or
folder that is currently
selected in the Project
Manager window up by
one step.

Reorganize documents
within a project
(page 253)

Move Down

moves the document or
folder that is currently
selected in the Project
Manager window down
by one step.
Remove

removes the document
or folder that is currently
selected in the Project
Manager window from
the current project.

Not applicable

View tab

Button Action Further information
Start Page

opens the Tedds Start
Page.

Start Tekla Tedds
(page 57)

Project Manager

allows you to select
whether you want Tedds
to display the Project
Manager window or
not.

Organize projects with
the Project Manager
(page 252)
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Button Action Further information
Status Bar

allows you to select
whether you want Tedds
to display the status bar
at the bottom of the
Tedds window.

Not applicable

Document Tabs

allows you to select
whether you want Tedds
to display tabs for each
currently open
calculation document or
not.
Hidden Text

allows you to select
whether you want Tedds
to display the hidden
text in your calculation.

View hidden text,
semicolons, or variables
(page 244)

Semicolons

allows you to select
whether you want Tedds
to display the hidden
semicolons that
separate your
calculation.
Progress Log

allows you to select
whether you want Tedds
to display the Progress
Log or not.

The Progress Log
(page 298)

Zoom

allows you to define the
zoom percentage that
you want to use.

Adjust the zoom level
(page 248)

100 %

displays the calculation
document at 100 %
zoom percentage.

Not applicable

Page Width

displays the calculation
document at the
maximum page width in
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Button Action Further information
which it fits in the
window.
Whole Page

displays the entire
calculation document in
the window, so that you
can view it without
scrolling.
Windows

allows you to activate,
save, close, organize and
minimize currently open
documents.

Not applicable

Cascade

cascades the currently
open documents in the
Tedds window.
Tile Horizontally

places the currently
open documents side by
side in the Tedds.
Tile Vertically

stacks the currently
open documents in the
Tedds window.

Help tab

Button Action Further information
Help

opens the Tekla User
Assistance website
where you can access
user instructions,
support articles, and
other useful material
related to Tedds.

Not applicable

Release Notes

opens the Tekla Tedds
release notes in a new
dialog box.
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Button Action Further information
Quick Start Guide

opens the Tedds quick
start guide that helps
you
Engineering Library

opens a PDF file
describing some of the
different calculations in
the Tedds engineering
library.
User Guide

opens the Tedds user
guide as a PDF file.
Contact Support

opens a web form that
allows use to contact the
Tedds support.

Feedback options
(page 356)

Send Feedback

allows you to send
feedback to the
TeddsTedds
development team via
email.
Check For Updates

checks whether there
are any new Tedds
updates available either
for the software itself or
for the engineering
library.

Update service options
(page 355)

License Manager

opens the Software
License Manager dialog
box that allows you to
activate your product,
view the status of your
licenses, request
product activation keys
or send a support
question, and modify
license settings.

Not applicable
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Tedds ribbon groups (Tedds for Word only)
Tedds for Word uses ribbon groups and associated command buttons to
provide a single-click access to many functions. The following table presents
the different Tedds ribbon groups and the buttons that they include.

NOTE The following only applies to Tedds for Word.

Library group
The Library group contains a button that allows you to launch Library Access
System.

Library group
Button Action Further

information
Launch the Tedds Library Access
System

launches the Library Access System,
so that you can browse the Tedds
library of calculations and
engineering data.

• Start the
Library Access
System (Tedds
for Word only)
(page 374)

• Data lists
(page 398)

• Data tables
(page 404)

• Data graphs
(page 414)

Calculate group
The Calculate group contains buttons that allow you to perform calculations
within the document. See the buttons included of the Calculate group in the
following table:

Calculate group
Button Action Further

information
All

calculates all calculations in the
current document.

Calculate results
(page 291)

Expression

calculates all calculations within the
current paragraph or expression.

References 607 Toolbars and buttons



Calculate group
Button Action Further

information
Calc Section

calculates all calculations within the
current calc section.
Start to Here

calculates all calculations from the
beginning of the document to the
current insertion point position.
Here to End

calculates all calculations from the
current insertion point position to the
end of the document.
Selection

calculates all calculations in the
highlighted part of the document.
Recalc Selection

recalculates the calculations in the
part of the document that was
highlighted last time that you
calculated a selection.

NOTE You do not need to highlight
the previously selected area
again. Tedds for Word always
remembers the scope of the
last calculation.

Header group
The Header group contains a button that allows you to modify the
information and layout of the page header.

Header group
Button Action Further

information
Edit

opens a dialog box that allows you to
modify the text in the document
header.

Modify the header
or footer of a
calculation
template
(page 367)
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Calc Section group
The Calc Section group contains buttons that allow you to manage calc
sections within the document.

Calc Section group
Button Action Further information

Insert

adds a new calc section into your
calculations.

Calc sections (page 289)

Edit

allows you to modify the title of
the current calc section.
Cut

allows you to cut a calc section
and paste it elsewhere.
Delete

deletes the current calc section,
including its variables.
Copy

allows you to copy a calc section
and its variables to the clipboard
and paste it elsewhere.
Go To

moves the insertion point to the
start of the next or previous calc
section within your document.

TIP To change the direction,
click the arrow next to the
Go To button.

Paste

pastes a calc section, including its
variables, from the clipboard into
your calculations.
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Show/Hide group
The Show/Hide group contains check boxes that allow you to modify the
display of the document.

Show/Hide group
Check box Action Further

information
Show field codes

displays or hides the results, and the
formatting options that have been
used to generate the results.

None

Show hidden calcs

displays or hides any calculations in
your document that have been
defined using one of the Hidden
paragraph styles.

Find errors
(page 297)

Show expression delimiters

displays or hides any semicolons in
your document, whether they
separate calculations from one
another or not.

Show or hide
semicolons
(page 272)

Font group
The Font group contains buttons that allow you to change the font used in the
text.

Font group
Button Action Further

information
Greek text

If you have highlighted a piece of text,
the button changes the highlighted
text to Greek characters.

If no text is highlighted, the button
varies switches between typing in
Greek and Roman characters.

Expression text
format (page 538)

Superscript
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Font group
Button Action Further

information
If you have highlighted a piece of text,
the button changes the highlighted
text to superscript.

If no text is highlighted, the button
switches between typing in normal
and superscript fonts.
Subscript

If you have highlighted a piece of text,
the button changes the highlighted
text to superscript.

If no text is highlighter, the button
switches between typing in normal
and subscript fonts.

Insert group
The Insert group contains buttons that allow you to insert fields, symbols,
characters, and unit into the document.

Insert group
Button Action Further information

Tedds field

adds a desired type of
Tedds field at the
current position in the
document.

Creates a link for full
data transfer between
Tedds for Word and
Excel.

Enhancing Tedds for
Word calculations with
Tedds fields (page 302)

Insert user interface

allows you to create
your own input
interfaces.

Start the Interface
designer (page 475)

Insert multiplication
symbol

adds a multiplication
symbol at the current
position in the
document.

None
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Insert group
Button Action Further information

Insert square root
symbol

adds a square root
symbol at the current
position in the
document.
Equals not calculated

adds an equals symbol
that Tedds for Word will
ignore while calculating.
Lowercase Greek
letters

allows you to add
lowercase Greek
characters in the
document.

Expression text format
(page 538)

Uppercase Greek
letters

Allows you to add
uppercase Greek
characters in the
document.
SI/US Units

Allows you to quickly
access and add all the SI
or US units that Tedds
for Word contains,
depending on your
locale. The unit that you
select will be inserted at
the current position in
the document.

Units (page 548)
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Tools group
The Tools group contains buttons for accessing various Tedds tools, including
the Variables dialog box, Tedds options, and Progress Log

Tools group
Button Action Further

information
Variables

displays all variables in the
current document.

TIP Clicking the arrow next to
the button displays a
menu that allows you to
copy, paste or delete
variables.

Use variables
(page 276)

Locale

displays a list of different
locales, and allows you to access
calculations and data of a
particular locale.

NOTE • Depending on your
licence and location,
you may have one
or several locales
installed by default.
Calculations and
data for other
locales is available at
additional cost. If
you only have one
locale installed, the
Locale button is not
active.

• The appearance of
the locale button
varies slightly
depending on the
locale that you are
using.

None

Show Progress log

switches between showing and
hiding the Progress Log. The

None
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Tools group
Button Action Further

information
Progress Log summarizes
important calculation steps and
output results when a
document is calculated.
Help

displays a menu that allows you
to access Tedds help and
documentation.

None

Go to Next/Previous Error

finds the next or previous visible
error in your document and
moves the insertion point to
that position.

Find errors
(page 297)

More

Displays the following menu
providing access to:

• Launch the Tedds Sketch
viewer

launches Sketch Viewer, so
that you can import pictures,
and place them at
appropriate points within
your calculations.

• Import Tedds document

• Start the Sketch
Viewer (page 468)

• Import Tedds
documents into
Tedds for Word
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Tools group
Button Action Further

information
• allows you to import the

contents of a Tedds
document into a Tedds for
Word document.

• Duplicate document

allows you to copy document
output, variables and header
properties into another
document.

• Unlink document

changes the AutoText fields
in the document header to
normal text.

This button can be useful if
you want to send a
document to someone who
does not have Tedds for
Word installed.

• Unlink fields

displays the actual
calculations of a document,
instead of a single field
replacing automated
calculations.

This button can be useful if
you want to send a
document to someone who
does not have Tedds for
Word installed.

NOTE If you use
automated
calculations, they
may contain other
nested automated
calculations. In such
cases, you will have
to click Unlink fields
several times in
order to unlink the
field around each
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Tools group
Button Action Further

information
automated
calculation.

• Remove Tedds field results

removes field results from
the document.

• Remove linked paragraph
styles

removes linked paragraph
styles from the document.

• Tedds options

allows you to adjust Tedds
for Word options.

Library Access System toolbars
There are two different Library Access System toolbars. The toolbar that you
see depends on whether you use the Simple or the Advanced mode of the
Library Access System. For more information on the toolbars and the
buttons, see the following paragraphs.

NOTE The following only applies to Tedds for Word.

Simple mode

Library Access System toolbar: Simple mode
Button Action Further information

Index

displays the index of the
current sets installed in
the Library Access
System.

Basic Library Access
System procedures:
Simple mode (page 376)

Find

allows you to find
groups or items by
typing a part of their
names in the Find field.
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Library Access System toolbar: Simple mode
Button Action Further information

Execute

opens the selected set
or inserts a selected
item into your
document.
Preview

displays a preview of the
selected item.

Advanced mode

Library Access System toolbar: Advanced mode
Button Action Further information

New Calc Set Wizard

allows yo to create a
new set into which you
can add groups and
items.

You can either copy
groups and items from
other sets or create
them directly into the
new set.

Create new sets
(page 385)

Open

opens an existing set, so
that you can access the
items that the set
contains.

Basic Library Access
System procedures:
Advanced mode
(page 380)

Save

saves the details of a
modified set to disk.

None

Find

allows you to find
groups or items by
typing a part of their
names in the Find field.

Basic Library Access
System procedures:
Advanced mode
(page 380)

Execute

inserts a selected item in
your document.
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Library Access System toolbar: Advanced mode
Button Action Further information

New Group

allows you to add a new
group into the current
set.

Later, you can add
groups or items into the
new group to achieve a
logical structure.

Add new groups into a
set (page 387)

New Item

allows you to add a new
item into the current set.

Add new items into a set
(page 388)

Index

displays the index of the
current sets installed in
the Library Access
System.
Show calculation
examples

switches between
displaying and hiding
calculation examples in
the index.

None

Show calculation
components

switches between
showing and hiding
calculation components
in the index.

None

Preview

displays a preview of the
selected item.

Basic Library Access
System procedures:
Advanced mode
(page 380)

Properties

displays the properties
of the selected group or
item.

TIP By clicking the right mouse button in the Library Access System view,
you have access to context-sensitive menus and their submenus.
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Context-sensitive menus give you instant access to commands that are
relevant to the position of the mouse pointer.

Sketch Viewer toolbar
The Sketch Viewer toolbar contains buttons that represent the various
features of the Sketch Viewer. For more information on the buttons in the
Sketch Viewer toolbar, see the following table.

NOTE The following only applies to Tedds for Word.

Sketch Viewer toolbar

Button Action Further
information

Copy

copies the current sketch to the
clipboard.

Copy a sketch to
your calculations
(page 473)

Paste

pastes the content of the clipboard
into the current sketch window.

Transfer a sketch
to the Sketch
Viewer (page 470)

Paste new

pastes the content of the clipboard
into a new sketch window.
Zoom to fit

fits the current sketch so that it fills
the sketch window.

Adjust the view of
a sketch
(page 471)

Zoom in

allows you to zoom in on a desired
point in the current sketch.
Zoom out

allows you to zoom out of a desired
point in the current sketch.
Zoom previous

returns to the previous zoom state.
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Sketch Viewer toolbar

Button Action Further
information

Move

allows you to move the sketch around
in the sketch window.
Settings

allows you to adjust the colors of the
Sketch Viewer window.

NOTE By right-clicking in the Sketch Viewer window, you have access to context-
sensitive menus and their submenus. Context-sensitive menus give you
instant access to commands that are relevant to the position of the mouse
pointer.

Data Tables toolbar
The Data Tables toolbar contains buttons that allow you to easily access the
features of Data Tables. For more information, see the following table:

Data Tables toolbar
Button Action Further information

Copy to calcs

returns the variables of
the selected item into
your document, so that
you can use them in
your calculations.

Return data table
information to your
calculations (page 410)

Interpolate

allows you to insert and
calculate values that lie
between the values that
are displayed in a data
table.

Interpolate data within a
data table (page 407)

Search

allows you to search for
values that lie within a
range that you specify.

Search specific
information in a data
table (page 409)
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Data Tables toolbar
Button Action Further information

Tile Horizontal

allows you to tile open
data tables horizontally.

None

Tile Vertical

allows you to tile open
data tables vertically.

None

Cascade Windows

allows you to cascade
open data tables.

None

Data Graph interpolate bar
The Data Graph interpolate bar contains buttons, text boxes, and list boxes
that allow you to modify the Data Graph window. For more information, see
the following table:

Data Graph interpolate bar
Button Action Further

information
Copy to calcs

returns the variables for the selected
item into your document, ready for
future use in your calculations.

Return data graph
information to
your calculations
(page 418)

Interpolate

allows you to insert and calculate
values that lie between the values
that are displayed in the data graph.

Interpolate data
within a data
graph (page 417)

Choose curve

If a graph contains more than one
curve, the Choose curve list allows
you to select one curve in the list of
existing curves.

Select a point in a
data graph
(page 415)
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Data Graph interpolate bar
Button Action Further

information
X-axis position

displays the position of the current
point along the x-axis of the graph. To
move a point, type a value in the field.

NOTE The label of the field depends
on the data that is displayed
in the data graph.

None

Y-axis position

displays the position of the current
point along the y-axis of the graph. To
move a point, type a value in the field.

NOTE The label of the field depends
on the data that is displayed
in the data graph.

None

NOTE By right-clicking in the Data Graph window, you have access to
context-sensitive menus. The context-sensitive menus give you instant
access to commands that are relevant to the position of the mouse
pointer.

Section Designer toolbars
The Section Designer toolbars contain buttons that allow you to insert,
modify and move objects, and adjust the view of the canvas.

Standard toolbar

Standard toolbar
Button Action Further

information
New

deletes any objects that you may have
defined, and allows you to create a
new section from scratch.

None
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Standard toolbar
Button Action Further

information
Open

opens an existing Section Designer
canvas with its associated objects.

NOTE To open a canvas in Section
Designer, you must have
previously saved the canvas
to disk using Section
Designer.

Save

allows you to save the current canvas
and the objects it contains to disk.

When saving a canvas and objects
this way, all details of the objects are
saved as well.

• Save a section
to disk
(page 466)

Copy to calcs

calculates the properties of the
section, and returns them back to
your document as variables.

• Return section
properties to
your
calculations
(page 467)

Show Properties

calculates and displays the properties
of the section.

TIP You can define whether the
Section Designercalculates the
section properties continuously
or only when you request.

• View section
properties
(page 465)

Undo

undoes the most recent modification
done the selected shape.

None

Cut

removes the selected objects and
their properties from the canvas and
places them on the clipboard.
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Standard toolbar
Button Action Further

information
Copy

copies the selected objects and their
properties from the canvas and
places them on the clipboard.
Paste

places the objects from the clipboard
into your calculation document,
creating new objects, if necessary.

NOTE If you are copying and
pasting within the same
document, the pasted objects
will be placed in the positions
where they were copied
from.

Drawing toolbar

Drawing toolbar
Button Action Further

information
Rectangle

allows you to add a rectangle on the
canvas.

• Create
sections in the
Section
Designer
(page 448)Circle

allows you to add a circle on the
canvas.
Triangle

allows you to add a triangle on the
canvas.
Predefined

allows you to add shapes that
represent standard sections on the
canvas.

You can either select the shape and
serial size that you require in a list, or
select a custom section shape and
modify it manually.
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Section Designer tools toolbar

Section Designer tools toolbar
Button Action Further

information
Select

activates the selection tool that allows
you to select and move existing
objects.

None

Pan

allows you to move the currently
zoomed display around.
Zoom

allows you to zoom in or out of a
certain pointer in your canvas. To
zoom in, click the left mouse button.
To zoom out, click the right mouse
button.

TIP You can also hold the left
mouse button down and drag
the pointer to create a rectangle
on the screen.

When you release the mouse
button, the display zooms to
show the area inside the
rectangle.

Zoom to Fit

zooms the display so that you can see
the entire section.
Zoom to Selection

zooms the display so that you can see
all currently selected objects.
Rotate

allows you to rotate the selected
objects around their midpoints.

• Rotate objects
(page 458)

Snap Shapes

allows you to attach two objects to
one another. Snapping shapes allows
you to position the objects with
respect to each other.

• Snap objects
with respect to
each other
(page 461)
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Nudge toolbar

Nudge toolbar
Button Action Further

information
Nudge Up

nudges the selected objects upwards.

• Move objects
on the canvas
(page 456)

Nudge Down

nudges the selected objects
downwards.
Nudge Left

nudges the selected objects to the
left.
Nudge Right

nudges the selected objects to the
right.

Structure toolbar

Structure toolbar
Button Action Further

information
Group

allows you to create a group of two or
more objects.

Once the objects are grouped, you
can move and rotate them as a single
entity.

• Structure
sections
(page 454)

Ungroup

allows you to destroy groups.

Once objects are ungrouped, each
object can be handled separately
Front

moves the selected object in front of
all other objects.
Back

moves the selected object behind all
other objects.
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Structure toolbar
Button Action Further

information
Forward

moves the selected object in front of
the object immediately in front of it.
Backward

moves the selected object behind the
object immediately behind it.

20.11 Import Tedds documents into Tedds for Word
If you have created calculations in the Tedds Application, you may sometimes
want to import them into Tedds for Word. For this purpose, Tedds for Word
provides an import facility, intended to help in importing Tedds documents
into Tedds for Word.

Import Tedds documents into Tedds for Word
1. In the Tools ribbon group, click More --> Import --> Tedds document.

2. Find and select the .ted file that you want to import.

3. Click Open. 
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The Import Tedds document dialog box appears.

4. Select the location where and the method how you want to import the
Tedds document. For help, see the table below.

Option Description
New document Inserts the Tedds document in a new Tedds for

Word document.

Append to active document Inserts the Tedds document at the end of the
current Tedds for Word document.

Insert in active document Inserts the Tedds document in the current Tedds
for Word document at the position of the
insertion point. <clarify!>

Add new Calc Section Inserts the Tedds document in a new calc section
in the current Tedds for Word document.

Insert page break Adds a page break into the Tedds for Word
document before the calc section.

5. Click OK.
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20.12 Shortcut keys
Using some shortcut keys may speed up creating and modifying your
calculations in Tedds for Word. For more information on the available shortcut
keys, see the following table.

NOTE The following only applies to Tedds for Word.

Attribute Short cut keys
Subscript text Ctrl + T + ´
Superscript text Ctrl +T + 6
Hidden text Ctrl + Shift + H
Normal text Ctrl + Shift + Z
Calculate expression Ctrl + T + E
Calculate section Ctrl + T + S
Calculate all Ctrl + T + A
Calculate expression Ctrl + T + H
Calculate section Ctrl + T + R
Calculate all Ctrl + T + Home
Calculate selection Ctrl + T + End
Add calc section Ctrl + T + Insert
Cut calc section Ctrl + T + X
Copy calc section Ctrl + T + C
Paste calc section Ctrl + T + V
Delete calc section Ctrl + T + Delete
Previous calc section Ctrl + T + Page up
Next calc section Ctrl + T + Page down
Go to previous error Ctrl + T + <
Go to next error Ctrl + T + >
Insert a Tedds field Ctrl + T + I
Modify calculation sheet header Ctrl + T + D
Open the Variables dialog box Ctrl + T + M
New default calculation document Ctrl + T + N
Launch the Library Access System Ctrl + T + L
Show/hide field codes Ctrl + T + F9
Greek text on/off Ctrl + T + G
Insert square root symbol Ctrl + T + 9
Insert multiplication symbol Ctrl + T + 8
Show/hide hidden calculations Ctrl + T + F10
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